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END-USER LICENSE AGREEMENT
ThisMicroSurveyEnd-User License Agreement ("Agreement") is a legal and binding agreement between you ("Licensee") andMicroSurveySoftware
Inc., a BC corporation ("MICROSURVEY") concerning the use of theMicroSurveyproducts (the "Product"), the software provided in connection with the
use and operation of the Product, including firmware and storedmeasurement data (collectively the "Software") and all related documentation provided
in connection with the acquisition of the Product ("Documentation"). The Software includes software owned by, and licensed from, third party licensors.

By clicking the "I ACCEPT" checkboxand completing the processof installing the Software, LICENSEE consents to and agrees to be bound byall of the
termsand conditionsof thisAgreement. BYCLICKINGTHE "I DO NOT ACCEPT"CHECKBOXor IF LICENSEEdisagreeswith anyof the termsor con-
ditionsof thisAgreement, LICENSEE IS not permitted to install and/or use the Software, PRODUCT AND DOCUMENTATION. IF LICENSEEHASANY
questionsOR COMMENTSCONCERNINGTHISAGREEMENT LICENSEEMAYCONTACT MICROSURVEYATWestbank, BC Canada.

1. Title to Product and Rights to Use Software and Documentation. Title to the Product and the rights to use the Software and Docu-
mentation are conditioned upon the payment of the required purchase price and anyapplicable license andmaintenance feesand Licensee's
acceptance of the termsand conditionsof thisAgreement.

2. License.

1. License Grant. MICROSURVEYherebygrants Licensee a nonexclusive, non-transferable, non-sublicensable right to (i) install and
use one copyof the Software and Documentation on the Product and one copy for use on nomore than one personal computer sim-
ultaneously, and , (ii) to access the storedmeasurement data generated by the Software, for Licensee's own internal businesspurposes
and in accordance with the termsand conditionsof thisAgreement. MICROSURVEYalso herebygrants Licensee a nonexclusive, non-
sublicensable right to reproduce the Documentation, solely asnecessary for Licensee's internal use of the Product and Software.

2. Conditions and Restrictions. The following conditionsand restrictionsapply to the use of the Product, Software and Documentation:

i. Licensee shall not, and shall not attempt to, reverse engineer, decompile, disassemble or otherwise attempt to identify the
source code of anyobject code portionsof, distribute, modify, encrypt, or create derivative worksof the Software, Docu-
mentation, and/or any storedmeasurement data in whole or in part, including, but not limited to, storedmeasurement data.

ii. Licensee shall not use the Software or Documentation for anypurpose not expressly permitted by thisAgreement.

iii. Licensee shall not copyanypart of the Software, except that Licenseemaymake one copyof the Software for backup purposes
only.

iv. Licensee agreesnot to remove or destroyany copyright, logo, trademark, trade name, proprietarymarkings, or confidentiality
legendsplaced upon or contained within the Software or Documentation. Licensee shall not, and agree not to assist others to,
circumvent or disable the license provisioning technology for the Software.

v. Licensee's license to the Software under thisAgreement continuesuntil it is terminated byLicensee or MICROSURVEY.
Licenseemay terminate the license bydiscontinuing use of all or anyof the Software and bydestroying all Licensee copiesof the
Software and Documentation.

vi. ThisAgreement will terminate automatically if (x) Licensee violate anyof the termsor conditionsof thisAgreement, (y)
MICROSURVEYpublicly posts a written notice of termination on itswebsite www.microsurvey.com (that, or any successor site,
the "Site"); or (z) MICROSURVEY revokes thisAgreement or issuesa new agreement in writing or electronic form and con-
ditionsLicensee continued use of the Software upon acceptance of the new agreement.

3. Ownership.All rights, title and interest in and to the Software and Documentation including, without limitation, all copyright, patent, trade secret
and other intellectual property rights shall at all times remain the property of MICROSURVEY, it licensors, or its suppliers, as applicable. The Soft-
ware and Documentation are licensed, not sold, and are protected by copyright and other intellectual property lawsand treaties. Licensee shall
take appropriate steps reasonably calculated to notify others of MICROSURVEYand its licensor's/suppliers' ownership of the Software and
Documentation.

4. Warranty.MICROSURVEYwarrants that the Product will, for 90 daysafter the Effective Date (the "WarrantyPeriod"), substantially conform to
the Documentation; provided, that Licenseemust notifyMICROSURVEY in writing of anybreach of the foregoing warrantywithin theWarranty
Period. For anybreach of the foregoing warranty reported during theWarrantyPeriod, MICROSURVEYwill use reasonable efforts to promptly
correct such defect without further charge. If MICROSURVEY is unable to correct such defect, thenMICROSURVEYwill refund the license fees
paid for the Product. This representsMICROSURVEY'S exclusive liability and Licensee's sole and exclusive remedy in the event of a breach of
the foregoing warranty.

5. Warranty Disclaimer.EXCEPT ASDESCRIBED IN SECTION 4 (WARRANTY), MICROSURVEYHEREBYDISCLAIMSALLWARRANTIES
RELATINGTOTHEPRODUCT, SOFTWARE, AND DOCUMENTATION, INCLUDINGWITHOUT LIMITATION THE IMPLIED
WARRANTIESOF MERCHANTABILITY, NON-INFRINGEMENT AND FITNESSFOR APARTICULAR PURPOSE.MICROSURVEYDOES
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NOT REPRESENT THAT THEOPERATIONOF THEPRODUCT AND/OR SOFTWAREWILL BEUNINTERRUPTEDOR ERROR-FREE.
WITHOUT LIMITINGTHEGENERALITYOF THEFOREGOING,MICROSURVEYMAKESNOWARRANTYTHAT: (A) OPERATIONOF
THEPRODUCT AND/OR SOFTWAREWILL BEUNINTERRUPTEDOR ERROR-FREE, (B) THEPRODUCT AND/OR SOFTWAREWILL
MEET LICENSEESPECIFIC NEEDS, (C) SPECIFIC RESULTSWILL BEACHIEVEDWITH THEPRODUCT AND/OR SOFTWARE, OR (D)
ALL ERRORSOR FAILURESWILL BECORRECTED. IN NOEVENT SHALLMICROSURVEY'S, ITS LICENSORS', OR ITSSUPPLIERS'
LIABILITYTOLICENSEEFOR THEPRODUCT AND/OR SOFTWARE,WHETHER BASEDONCONTRACT, TORT,WARRANTY, OR ANY
OTHER LEGAL THEORY, EXCEED THEAMOUNT OF PURCHASEPRICEPAID FOR THEPRODUCT AND ANYRELATED LICENSEOR
MAINTENANCEFEESPAID BYLICENSEE.

6. Exclusion of Damages. TOTHEMAXIMUMEXTENT PERMITTED BYAPPLICABLELAW, IN NOEVENT SHALLMICROSURVEY, ITS
LICENSORS, OR ITSSUPPLIERSBELIABLEFOR ANYSPECIAL, INCIDENTAL, PUNITIVE, INDIRECT, OR CONSEQUENTIAL
DAMAGESWHATSOEVER (INCLUDING, BUT NOT LIMITED TO, DAMAGESFOR LOSSOF PROFITSOROTHER DATAOR
INFORMATION, OR FOR BUSINESS INTERRUPTION) ARISINGOUT OF OR IN ANYWAYRELATED TOTHEUSEOF OR INABILITYTO
USETHEPRODUCT AND/OR SOFTWARE, EVEN IN THEEVENT OF THEFAULT, TORT (INCLUDINGNEGLIGENCE), STRICT
LIABILITY, BREACHOF CONTRACT OR BREACHOFWARRANTYOF MICROSURVEY, ITS LICENSORSOR ANYSUPPLIERS, AND
EVEN IF MICROSURVEYOR ANYof ITS LICENSORSOR SUPPLIERSHAVEBEEN ADVISEDOF THEPOSSIBILITYOF SUCH
DAMAGES. BECAUSESOMEJURISDICTIONSDONOT ALLOWTHEEXCLUSIONOR LIMITATIONOF LIABILITYFOR
CONSEQUENTIALOR INCIDENTALDAMAGES, THEABOVELIMITATIONMAYNOT APPLYTOLICENSEE.

7. Limitation of Liability.NOTWITHSTANDINGANYDAMAGESTHAT LICENSEEMIGHT INCUR FOR ANYREASONWHATSOEVER
(INCLUDING,WITHOUT LIMITATION, ALL DAMAGESREFERENCED ABOVEAND ALLDIRECT ORGENERALDAMAGES), THE
ENTIRELIABILITYOF MICROSURVEYAND ANYOF ITS LICENSORSOR SUPPLIERSUNDER ANYPROVISIONOF THISAGREEMENT
AND LICENSEEEXCLUSIVEREMEDYFOR ALLOF THEFOREGOINGSHALL BELIMITED TOTHEAMOUNT ACTUALLYPAID BY
LICENSEEFOR THEPRODUCT AND ANYRELATED LICENSEORMAINTENANCEFEESPAID BYLICENSEE. THEFOREGOING
LIMITATIONS, EXCLUSIONSAND DISCLAIMERS (INCLUDINGSECTIONS5 AND 6ABOVE) SHALL APPLYTOTHEMAXIMUMEXTENT
PERMITTED BYAPPLICABLELAW, EVEN IF ANYREMEDYFAILS ITSESSENTIAL PURPOSE. LICENSEEACKNOWLEDGESTHAT (A)
THEPROVISIONOF THEPRODUCT AND SOFTWARE ISCONDITIONALUPONMICROSURVEYEXCLUDINGAND/OR LIMITING ITS
AND ITS LICENSORS' AND SUPPLIERS' LIABILITYTOLICENSEE IN ACCORDANCEWITH THISAGREEMENT, AND (B) THE
EXCLUSIONSAND LIMITATION CONTAINED IN THISAGREEMENT AREFAIR AND REASONABLE IN ALL THECIRCUMSTANCES
KNOWNAT THEDATEOF THISAGREEMENT.

8. Indemnification. Licensee agrees to defend, indemnify and holdMICROSURVEY, its affiliates, distributors, licensors, and suppliers harmless
from and against anyand all losses, damages, costs or expenses (including reasonable attorney's fees) (a) suffered byLicensee related in any
way to the Product, Software, or thisAgreement and/or (b) related to any claim or demandmade byany third party in connection with or arising
out of (i) anybreach byLicensee of anyof the termsand conditionsof thisAgreement, (ii) Licensee use or misuse of the Product or Software, (iii)
Licensee violation of applicable laws, and/or (iv) Licensee violation of the rights of anyother person or entity. MICROSURVEY reserves the right,
at its own expense, to assume the exclusive defense and control of (but not liability for) anymatter otherwise subject to indemnification by
Licensee. Licensee will be liable toMICROSURVEY for reasonable attorney's fees in any such case.

9. Support.

a. General.Except as set forth in Section 9(b) (Website Support) and 9(c) (Contract Support), MICROSURVEYshall have no obligation
under thisAgreement to maintain or support the Software. Licenseemaycontact MICROSURVEY to inquire about MICROSURVEY'S
commercially available support andmaintenance servicesprovided pursuant to separate agreements. ThisAgreement shall not oblig-
ate either party to enter into any such separate agreement. Anyupdatesor error corrections to the Software that maybe provided to
Licensee from time-to-time, if any, shall be deemed Software hereunder and shall be licensed to Licensee under the termsand con-
ditionsof thisAgreement. If any such updatesor error correctionsaremade available to Licensee, then Licensee shall promptly (a) imple-
ment such updatesor error corrections, (b) cease using the earlier versionswithout such updatesor error corrections, and (c) make
such updatesor error correctionsavailable to the users of the earlier versions. Licensee shall be solely responsible for procuring all hard-
ware and third-party software necessary to operate the Software.

b. Website Support.MICROSURVEYwill use reasonable commercial efforts to host andmaintain a web site (the "Support Site") for the
Software during its commercial life (as reasonably determined byMICROSURVEY) that will include some or all of the following features:

l A "FrequentlyAskedQuestions" section with answers to common questionsabout the Software.

l A searchable "Helpdesk" section with general user instructionsand information about the Software.

l A link to allow end users of the Software to download anybug fixes, error correctionsor other updates to the Software that
MICROSURVEYmaymake available through the Site.
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l "Contact MICROSURVEY" electronic response capability. MICROSURVEYwill use reasonable commercial efforts to respond
within two (2) businessdays to a customer inquiry received via this system. Answers to such inquireswill be added to the FAQ's,
as appropriate.

c. Contract Support.Uponmutual agreement in writing between Licensee andMICROSURVEY, or between Licensee and one of
MICROSURVEY'S authorized reseller's, MICROSURVEYwill provide contracted support services to Licensee asmaybe agreed upon
and related to the Software.

10. Term and Termination.

a. ThisAgreement is effective until terminated. Licenseemay terminate thisAgreement at any time, with or without cause, upon notice to
MICROSURVEY.MICROSURVEYmay terminate thisAgreement for Licensee's breach of thisAgreement.

b. Upon termination of thisAgreement, Licensee shall immediately cease all use of the Software and Documentation and return to
MICROSURVEYall copiesof thereof within five (5) daysafter such termination. UponMICROSURVEY'S request, Licensee will certify in
writing toMICROSURVEY that all such copieshave been returned toMICROSURVEY. The following provisionsof thisAgreement shall
survive termination or expiration of thisAgreement: Sections2(b) (Restrictions), 3 (Ownership), 5 (WarrantyDisclaimer), 6 (Exclusion of
Damages), 7 (Limitation of Liability), 10 (Term and Termination), and 11 (General).

11. General.

a. Assignment.MICROSURVEYmayassign thisAgreement without notice to Licensee. Licensee shall not assign thisAgreement or
transfer anyof the rights, duties, or obligationsarising under thisAgreement without the prior written consent of MICROSURVEY. This
Agreement shall be binding upon, and inure to the benefit of, the permitted successors and assignsof the parties thereto.

b. Amendments;Modifications. Noticesof changes to thisAgreement or other mattersmaybemade to Licensee bydisplaying noticesor
links to notices to Licensee generally on the Site.

c. Governing Law; Forum; Attorney'sFees, Injunctive Relief. The termsof thisAgreement shall be construed and governed exclusively
by the lawsof the province of British Columbia, excluding the application of its conflict of law provisionsand rules. Anydispute, con-
troversyor claim between the parties arising out of or relating to thisAgreement or a breach of thisAgreement shall be settled pursuant
to the termsof thisSection 11(c) byarbitration before three neutral arbitrators (selected from a panel of personshaving experience with
and knowledge of the computer business), provided at least one of which arbitrators shall be an attorney, and administered by the Arbit-
ratorsAssociation of British Columbia in accordance with itsCommercial Arbitration Rules in Kelowna, British Columbia. Anyprovisional
or equitable remedywhich would be available from a court of law shall be available from the arbitrators to the parties. Judgment upon
the award of the arbitratorsmaybe enforced in any court having jurisdiction thereof. The parties hereby consent to the non-exclusive jur-
isdiction of the courts of the Province of British Columbia for anyaction (i) to compel arbitration, (ii) to enforce the award of the arbitrators
or (iii) prior to the appointment and confirmation of the arbitrators, for temporary, interim or provisional equitable remedies, and to ser-
vice of process in any such action by registeredmail, return receipt requested, or byanyother meansprovided by law. The application of
the United NationsConvention of Contracts for the InternationalSale of Goods is expressly excluded.

d. Severability. The illegality, invalidity or unenforceability of one or more provisionsof thisAgreement shall not affect the legality, validity
or enforceability of anyother provision, and thisAgreement shall be construed in all respects as if such illegal, invalid or unenforceable
provision were deemed amended to achieve asnear aspossible the same economiceffect as the original in a legal, valid and enforce-
ablemanner if possible.

e. Further Relationships.Neither party is obligated by thisAgreement to enter into any further business relationship after the ter-
mination or expiration of thisAgreement.

f. Notices.All noticesunder thisAgreement shall be in writing, and shall be deemed given when personally delivered, when received if by
nationally recognized courier, or three daysafter being sent bypostage prepaid, certified or registered CanadianMail, as applicable, to
MICROSURVEYatMICROSURVEY's addressas set forth herein or to Licensee at the address that Licensee provided upon entering
into thisAgreement, or such other addressasa party last provided to the other bywritten notice.

g. Independent Contractor.MICROSURVEYand Licensee are independent contractors. No partnership, joint venture, or other joint
relationship is created by thisAgreement.

h. Entire Agreement. ThisAgreement represents the entire agreement between the parties relating to its subject matter and supersedes
all prior representations, discussions, negotiationsand agreements. All changes, modifications, additionsor deletions shall be effective
immediately upon notice thereof, whichmaybe given bymeans including, but not limited to, posting on the Site, or byelectronic or con-
ventionalmail, or byanyother meansbywhich Licenseemayobtain notice thereof. Use of the Product and/or Software after such notice
constitutesacceptance of such changes, modificationsor additions. ThisAgreement maybe amended at any time bymutual agreement
of the parties.

12. Internet-Based Services.
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a. Consent for Internet-Based Services. Certain Software features connect to MICROSURVEYor service provider computer
systemsover the Internet. In some cases, you will not receive a separate notice when they connect. Byusing these features, you
consent to the transmission of this information. MICROSURVEYdoesnot use the information to identify or contact you. For more
information, see http://www.microsurvey.com/MicroSurvey-Privacy-Policy.htm

b. Computer Information. The Software featuresuse Internet protocols, which send to the appropriate systemscomputer inform-
ation, such as your Internet Protocol address, the type of operating system, name and version of the software you are using, and
the language code of the device where you installed the software. MICROSURVEYuses this information tomake the Internet-
based servicesavailable to you.
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TECHNICAL SUPPORT
MicroSurvey Software Technical Support is available to help you get themost out of your MicroSurvey product. The following
information explains how to prepare for your call so that your inquiry can be answered promptly and accurately.

Please prepare yourself before you call for Technical Support

Take a few minutes before you place your call to check the printed documentation and the online help files to see if the answer
is already at your disposal. OurWeb site on the Internet can also save time. Please check it for assistance if you can. Please
have the following information available if requested: version of the program, operating system version and architecture, and
your Technical Support Number.

Pleasemake sure that you have all the steps you completed prior to your problem and can explain them to the technical sup-
port representative. Wemay ask that you forward a copy of your data to us if we cannot find the problem immediately.

MicroSurvey offers a 90-day complimentary support period to all of our registered users, starting the date of purchase. Intro-
ductory support is available weekdays between 8:00 am and 5:00 pm (Pacific Time) excluding holidays.

Yearly Support

For clients who have had their original 90-day complimentary support period expire and feel that they will need on going support
over the next year, we have a Yearly Support Contact option available. This gives you the ability to contact us for technical sup-
port, as much as you require, and you pay a flat fee once a year. This option is not to be used in place of training but is to assist
you on the occasions when you really need it. The charge for the Yearly Support Contract is to be billed and paid for prior to the
support commencing. This rate is subject to change, call for current rates.

Electronic Support

MicroSurvey Software Inc. maintains and provides at no charge, our Internet Helpdesk at helpdesk.microsurvey.com

This web site has sections on frequently asked questions, Technical Notes, Technical Specifications, and as required, free
updates and program fixes, along with a lot of other helpful information.

Training

MicroSurvey Software Inc. can provide training to you, in your office or in a classroom situation (where facilities and numbers
allow. MicroSurvey has training staff that will travel to almost anywhere and provide you with the professional skills you require
to operate your MicroSurvey program. Please feel free to call and ask for a quotation or inquire about potential classroom situ-
ations. Your local dealer may also be able to setup or arrange a training session for you. Contact our head office for more inform-
ation about training.

http://helpdesk.microsurvey.com/
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CONTACT INFORMATION
MicroSurvey STAR*NET is a product of MicroSurvey Software Inc.

Internet

CorporateWebsite: www.microsurvey.com
Technical Support: helpdesk.microsurvey.com

Telephone

Phone (Toll Free): 1-800-668-3312
Phone (International): 1-250-707-0000
Fax: 1-250-707-0150

8:00 am to 5:00 pm (Pacific Time)
(Monday to Friday, except holidays)

Mailing Address

MicroSurvey Software Inc.
205 - 3500 Carrington Road
West Kelowna, BC V4T 3C1
Canada

MicroSurvey, FieldGenius, OfficeSync, andMapScenes are registered with the U.S. Patent and Trademark Office by MicroSur-
vey Software Inc.

MicroSurvey is part of HEXAGON.

http://www.microsurvey.com/
http://helpdesk.microsurvey.com/
http://www.hexagon.com/
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CHAPTER 1: INTRODUCTION
1.1 ABOUT STAR*NET
The STAR*NET software suite handles general purpose, rigorous least squares analysis and adjustments of 2D, 3D and
Level/1D land survey networks.

Several STAR*NET editions are available to fit the particular needs of the user:

l STAR*NET LEV Edition – This subset edition handles differential leveling network adjustments only, a perfect low-
cost solution for consultants requiring this type of adjustment only.

l STAR*NET Standard Edition – Handles 2D/3D survey networks. Differential leveling datamay also be combined in a
3D adjustment. This edition includes all the base features that make STAR*NET so useful to surveyors. Some of these
base features include an instrument library facility, points reformatter tool, DXF transfer tool, grid-to-ground coordinates
converter, network graphics display with zoom, pan, find and inverse capabilities, point and connection inquiry from the
graphics display, andmuchmore.

l STAR*NET PLUS Edition – Adds a separate 1D differential leveling network adjustment facility to all base features of
the Standard Edition.

l STAR*NET PRO Edition – This high-end edition adds GPS handling and geoid/deflectionmodeling capabilities to all
features of the PLUS Edition. It includes a vector importer that supports most popular baseline formats. Special GPS
options allow scaling of vector weighs and application of centering errors separately in horizontal and vertical directions.
Combining conventional, leveling andGPS is made easy!

l STAR*NET ULTIMATE Edition – This highest-tier edition can adjust larger networks, and can be run via a command-
line interface from batch files or third-party monitoring applications. The ultimate solution for themost demanding land
survey network adjustments!

The demo program is a fully functional version of STAR*NET. It includes all the capabilities of the STAR*NET-ULTIMATE edi-
tion, except that after the 10-day free trial period ends , network adjustments cannot be run without acquiring a license.

One of themain features of STAR*NET is the capacity to weight all input data both independently or by category. This means
that accurately knownmeasurements can be givenmore weight in the adjustment than thosemeasurements known to be less
accurate. Completely unknown quantities, such as the coordinates of a new station, may be given a special code indicating
that they are "FREE" in the adjustment. The user can "FIX" other data with a code so that they receive no correction. In addi-
tion, the user can apply standard deviations to components of any station coordinate so that it will act as an observation and
affect the results of an adjustment. The ability to control the weighting of data provides the user with a powerful adjustment
tool.

The user may select a number of options to determine the type of adjustment to be performed. All option selections and pro-
gram commands aremade through a dialog interface, making program operation simple, even for casual users. Every attempt
has beenmade to simplify the input of data, and the analysis of the results. The program performs gross error checking, and
warns the user if input data appear incorrect.

STAR*NET can be used to adjust many kinds of networks. Here are a few examples:

l Traditional 2D or 3D survey traverse data. STAR*NET will perform a rigorous adjustment of the data, compute coordin-
ates for all traverse stations, and compute error ellipses for the computed points. STAR*NET will take into account the
accuracy of the various angular and distancemeasurements, and adjust the network correctly. This rigorous approach
is far superior to the old Compass Rule or other approximatemechanical adjustment methods.
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l Highly redundant surveys performed with a total station for deformationmonitoring of dams, walls, tunnels and other
structures. STAR*NET performs a simultaneous adjustment of the 3D input measurements. It handles slope distances
and zenith angles rigorously, and computes final X, Y & Z coordinates with standard deviations and ellipse confidence
regions for the computed stations. Changes in coordinate values from a previous analysis can also be output.

l Survey planning using preanalysis. STAR*NET can be used to plan survey layouts, so that accuracy specifications are
satisfied using an efficient survey design. The user simply inputs the approximate locations of points to be surveyed,
along with a list of intended field observations connecting the points. STAR*NET will compute the predicted error
ellipses and relative accuracies between stations, allowing the surveyor to decide whether additional (or fewer) obser-
vations are required.

1.2 ABOUT THE DOCUMENTATION
All documentation required for using the Standard and PLUS editions is included in this manual. Themain body of themanual
(chapters 1-10) describes the general use of the program common to all editions. A supplemental manual (chapters 11-16)
describes special features in the PRO edition including the importing and inclusion of GPS vectors in adjustments, and the use
of Geoid and Vertical Deflectionmodeling. A separate, much-abbreviatedmanual, describes just the input data, options and
operation of the subset STAR*NET-LEV edition.

Nomatter how easy STAR*NETmay be to use, it is still performing a very complex task which requires some understanding
on the part of the user. Therefore, the beginning user is encouraged to review themainmanual carefully, especially Chapter 4,
"Options," Chapter 5, "Preparing Input Data" and Chapter 8, "Analysis of Adjustment Output." Appendix-A, "A Tour of the
STAR*NET Package," provides a tutorial introduction to STAR*NET, with several sample project data files to experiment with.

If you ordered the PRO edition, the PROEdition Supplement describing GPS vectors andmodelingmust also be reviewed.
And it is recommended that you run the additional tutorial examples in Appendix-A of the supplement which demonstrates
importing and adjusting vectors, and combining conventional observations with vectors in a network.

Although this manual provides all information needed to use STAR*NET, it is not a substitute for a textbook on survey adjust-
ments. Several recommendations for further study are given in Appendix-B, "References" in this manual.

1.3 TRAINING MOVIES
A small but growing collection of online trainingmovies is available through theMicroSurvey Helpdesk. A high-speed internet
connection is recommended but not required. Themovies can be streamed online, or downloaded for offline viewing.

http://www.microsurvey.com/helpdesk2/index.php?/Knowledgebase/Article/View/378/0/microsurvey-online-training-movies
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CHAPTER 2: INSTALLATION
2.1 INSTALLING STAR*NET
This chapter explains the steps that are required to install STAR*NET package. If you have problems, you can obtain assist-
ance by contactingMicroSurvey Technical Support.

MicroSurvey STAR*NET 10 is compatible with 64-bit versions of Windows 8.1, andWindows 10. Administrator privileges are
required for installation.

Double-click on the STAR*NET installation file, and follow the installer instructions. You can accept the recommended default
C:\Program Files\MicroSurvey\StarNet 10\" destination folder, or you can browse for another.

Once the installation is complete, the STAR*NET program is ready to run. See the next section for starting the STAR*NET pro-
gram.

If you have purchased a STAR*NET license, you will need to use theMicroSurvey USB LicenseManager application (which is
installed with STAR*NET) to activate your USB license key before the full version of the program can be run. Please refer to
the USB License Key Reference section for additional details.

If you have not purchased a STAR*NET license, you can run STAR*NET in demomode for 10 days by visitingmicros-
urvey.com or calling 1-800-668-3312 and requesting a demo.

After installing STAR*NET, we encourage you to review "A Tour of the STAR*NET Package" in Appendix-A for a detailed over-
view of program use. We highly recommend you run the supplied example projects before reading themainmanual in detail.

2.2 STARTING STAR*NET
First, attach the supplied License Key (dongle) to one of your USB ports. The dongle should co-exist with other USB devices
youmay have on your system. You can also run STAR*NET without the dongle and it will operate in a demomode. In demo
mode, all features of the "Professional" edition will function, but all "Run" functions (adjustment, preanalysis, data check, etc.)
are limited to 10 days.

To run STAR*NET, press theStartmenu, select All Programs > MicroSurvey StarNet 10, and then click theStarNet pro-
gram selection to start the program.

The program will run as the STANDARD, LEV, PLUS, PRO, or ULTIMATE edition depending on which version you licensed.

If you are using a Network License, you will be prompted to enter the server name and the desired product level.

2.3 BATCH PROCESSING FROM THE COMMAND LINE
Using the STAR*NET Batch File Feature

STAR*NET Ultimate can be executed from a command line and told to run a given project. Upon completion, it writes a run
status file and exits. If you wish to use this feature, you or your staff must have the ability to create and execute a batch file
(*.bat) and also create additional programs to parse the various output files if that is required for your use for running
STAR*NET in a batch fashion.

Below is a simple batch file we used to test STAR*NET using the batch file feature. The batch file executes STAR*NET,
opens up an existing project “Trav3D.snproj” and then the “/RUN” command-line option causes the program to run an adjust-
ment. Upon completion of the run, a status file “Trav3D.run” file is created to document the status of the run.

The /RUN parameter is only available in STAR*NET Ultimate. An Ultimate license is required.

https://www.microsurvey.com/
https://www.microsurvey.com/
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The test batch file:

@echo off
:Top

REM User programs for constructing STAR*NET data go here

REM Run STAR*NET
"C:\Program Files\MicroSurvey\StarNet 10\StarNet.exe" C:\JOBS\BatchTest\Trav3D.snproj /RUN
echo STAR*NET ran and created a run status file C:\JOBS\BatchTest\Trav3D.run ...

REM User programs for checking run status file and analyzing data files go here
REM User programs may sleep for a time between runs
REM User programs may loop to top or go to End depending on the logic scheme

REM This batch test loops to the top and keeps rerunning until manual termination
echo -------
echo This test loops to run again - Press Ctrl-C to terminate
goto Top

:End

Note that there are remarks before and after the command line that runs STAR*NET. These lines indicate location of your pro-
grams that prepare STAR*NET data and analyze resulting STAR*NET output.

The batch test above simply loops continuously - starting up STAR*NET running it, writing a status file, exiting and then doing
all over again until youmanually terminate by pressing Ctrl-C. Please let us know if you have questions about this.

Command Line Syntax

The format for the command line that executes the STAR*NET program is:

Path\StarNet.exe Path\ProjectName.snproj /RUN

The /RUN parameter causes the program to run the adjustment and to create a run status file upon completion. By default, the
name of the status file is the project namewith a “.run” extension and it will be located in the same directory as the the original
“.snproj” file.

If the path and/or project filename contains a space character, youmust surround it with double quotes. For example:

"Path\StarNet.exe" "Path\ProjectName.snproj" /RUN

The .RUN Status File

The status file contains one or more lines. The first line always contains a single number which is the status of the run. This
number is constructed by setting status bits as defined below. One or more bits are combined to create the status number. A
program written by your programmers can read this status number and by examining the individual bits that are set, determine
some resulting information about the run. For example, your program logic may be designed to continue the batch process if the
adjustment was completed and only bit 0x0001 and/or 0x0002 were set. But it may be designed to terminate if 0x0004 or
0x0008 bits were on. If any of the status bits set in the lower group are on, your batch program sequencemust be designed to
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terminate because the adjustment did not complete! The following shows the status bits (expressed in hexidecimal) and the
meaning of each:

Adjustment completed:

Run Warnings = 0x0001
Run Failed Chi Square Test Lower = 0x0002
Run Failed Chi Square Test Upper = 0x0004
Run Did Not Converge = 0x0008

Adjustment not started or not completed

Run Errors = 0x0100
Security Key Failure = 0x0200
Project File Open Failure = 0x0400
Project File Errors = 0x0800
Unable To Start Adjustment = 0x1000

When the status number is zero, this indicates the adjustment ran successfully and there were no errors or warnings. When
there are errors or warnings, the status number will be non-zero and your program should decide what to do by testing which
bits are set in the status number. When the status number is non-zero, additional lines are printed in the file giving you a way to
visually check which errors or warnings were found.

The example status file below shows the status number (expressed in decimal) followed by the individual bits (also expressed
in decimal) that were set. This adjustment did not run because there was a problem accessing the security key –most likely it
could not be found by STAR*NET.

512
512 Security Key Failure

The example status file below shows the status number (expressed in decimal) followed by the individual bits (expressed in
decimal) that were set. In this example, the adjustment successfully ran, but there were warnings. The fact that the adjustment
did not converge should be reason enough for your to terminate the batch process so you can determine why this is happening.

13

1 Run Warnings
8 Run Did Not Converge
4 Run Failed Chi Square Test Upper Bound

ERRORLEVEL Return Codes

When STAR*NET exits, it returns an ERRORLEVEL that can be analyzed in the batch file or other calling application. The
ERRORLEVEL return code corresponds to the combined status number in the .run file as detailed above. Therefore 0 indicates
Success, 1 or higher indicates a RunWarning, 256 or higher indicates a Run Error, and so on. STAR*NET does not produce
any negative return codes.

Return codes can be checked like the following:
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@ECHO OFF

"Path\StarNet.exe" "Path\ProjectName.snproj" /RUN

ECHO The return ERRORLEVEL code is %ERRORLEVEL%
IF ERRORLEVEL 256 GOTO SNError
IF ERRORLEVEL 1 GOTO SNWarning
IF ERRORLEVEL 0 GOTO SNSuccess

:SNSuccess
ECHO The run was successful!
REM Place your "success" handling code here
GOTO SNEnd

:SNWarning
ECHO The run resulted in a Warning!
REM Place your "warning" handling code here
GOTO SNEnd

:SNError
ECHO The run resulted in an Error!
REM Place your "error" handling code here
GOTO SNEnd

:SNEnd

It is important to note that when checking return codes this way, you are actually checking if ERRORLEVEL is equal to or
greater than the specified value. Because it is not a check for equality, it is important to check for specific return codes in
decreasing order as shown above.

Command Extensions & The START Command

By default, when a process (such as starnet.exe) is executed from a batch file, the next command in the batch file will not be
executed until the process has finished executing and stops.

However, if Command Extensions are enabled in your batch environment then this is not the case and the batch file will con-
tinue to the next line before the process ends. In this case, you can use the "Start" command to explicitly start the process and
wait for it to finish before proceeding to the next line in the batch file. For example:

START "" /WAIT Path\StarNet.exe Path\ProjectName.snproj /RUN

or with the quoted paths:

START "" /WAIT "Path\StarNet.exe" "Path\ProjectName.snproj" /RUN

Tip: Note the empty set of double-quotes – while this Title parameter is documented as optional, it is well-established that, if
excluded, its absence can cause the first quoted parameter bemisinterpreted as the Title so it is common practice to always
include it.

The WAITFORFILE Utility
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When STAR*NET is executed from a batch file as illustrated in the example file shown above, before the run status file is writ-
ten for the current run, STAR*NET will delete the run status file from a previous run if one exists. Therefore, since the next com-
mand in the batch file will not be executed until STAR*NET has finished, the run status file is guaranteed to be fresh.

However, if STAR*NET is executed from another program in the batch file (i.e. it becomes a separate process), there is no
guarantee that STAR*NET will finish and create a new run status file before another program in the batch file checks for it.In
case you wish to do this, we have another program available called "WaitForFile" which should be executed just before your
program that checks the run status file. Note that to use this program, it will be your responsibility to delete an existing run
status file before the batch program runs StarNet. We can email you this program.

TheWaitForFile.exe program and command line parameters are as follows:

WaitForFile.exe path\filename [interval [interval_count]]

where:

Filename:
Full or relative path

Interval:
Sleep time inmilliseconds between checks for file
Optional, default is 100ms

Interval_count:
Number of check attempts before timeout
Optional (to be present requires interval to also be present
Default: no limit

Return value:
0 File Found
1 Timeout
2 Bad parameter found

Again, this program (or a similar facility written by your programmers) need be used only when the execution of STAR*NET is
not started directly from the batch file.

The following illustrates how theWaitForFile programmight be used in a batch file. This batch file is basically the same as the
original example except that STAR*NET is run from another program - not directly from the batch program. This causes
STAR*NET to be run in a separate process. Any existing run status file must be deleted before STAR*NET is executed as illus-
trated below. A separate program “WaitForFile.exe” is then executed to wait for a status file to be created from STAR*NET.
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@echo off
:Top

REM User programs for constructing StarNet data go here

REM Delete existing run status file if present
Del C:\StarNet\BatchTest\Trav3D.run

REM Assume some other user program runs the StarNet program here using the same
REM project name as illustrated in the original batch example. StarNet is now
REM running as a separate process ...

REM Now run the WaitForFile program which keeps looking for the run status file
WaitForFile C:\StarNet\BatchTest\Trav3D.run
if errorlevel 2 goto BadParam
if errorlevel 1 goto Timeout

REM No errors returned from WaitFor File, therefore the run status file was found
echo StarNet ran and created a run status file C:\StarNet\BatchTest\Trav3D.run ...

REM User programs for checking run status file and analyzing data files go here
REM User programs may sleep for a time betweem runs
REM User programs may loop to top or go to End depending on the logic scheme

REM This batch test loops to the top and keeps rerunning until manual termination
echo -------
echo This test loops to run again - Press Ctrl-C to terminate
goto Top

:BadParm
echo Bad Parameter for WaitForFile program
goto End

:Timeout
echo Timeout for WaitForFile program
goto End

:End

2.4 FILE REFERENCE
A few words should be said about the files used by the program, what their functions are and where they are located.

Program Files

All of the executable (*.exe/*.dll) files are installed into the folder you specify during install, normally:

l C:\Program Files\MicroSurvey\StarNet 10\

This folder also contains all of the STAR*NET data conversion utilities, the STAR*Geoid extraction utility, the USB License
Manager, help files, and product manuals. All files can be accessed via an appropriate shortcut in yourWindows Start menu.

System Configuration Files

The following are files that contain customizable information that may be used by any project.
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FILE DESCRIPTION

COMPANY.DEF Default company option settings and company instrument library items - created the first time
STAR*NET is run

DXF_LAYERS.DEF Default layer definitions for the DXF Exporter tool - installed
STARNET.FMT Output coordinate format styles for the Points Reformatter tool - installed
STARNET.CUS Custom linear units definitions - installed

STARNET.INI Customizable data editor options including font and colors, and syntax highlighting rules -
installed

TEMPLATE.DAT Template data file copied into all new projects - installed

These files, and others, are located in STAR*NET "System" directory, normally:

l C:\ProgramData\MicroSurvey\StarNet\10\

All of your Geoid and Vertical DeflectionModeling files need to be placed in the "Mapping" subfolder of this directory.
STAR*NET will automatically access all geoid models and height models contained here. TheMapping directory initially con-
tains many required coordinate system files when STAR*NET is installed, but to save space no geoid files are installed with
STAR*NET. Geoid files (.byn or .bin format) must be downloaded from theMicroSurvey Helpdesk or your geodetic agency.
Unlike previous STAR*NET versions, it is no longer necessary to use the STAR*Geoid utility to convert geoidmodels from
their original .bin or .byn format to the .ght format, but this is still supported for compatibility with existing .ght geoidmodels. Ver-
tical Deflection Files must be created using the STAR*Geoid application as necessary.

FILE DESCRIPTION

Mapping\Coordsys Coordinate system definitions, including those created for any custom coordinate systems -
installed

Mapping\Datums Datum definitions, including those created for any custom coordinate systems - installed
Mapping\Elipsoid Ellipsoid definitions, including those for any custom coordinate systems - installed
Mapping\*.BYN, *.BIN GeoidModeling files (downloaded fromMicroSurvey Helpdesk or your geodetic agency)
Mapping\*.GHT GeoidModeling files (created by the STAR*Geoid application)
Mapping\*.VDF Vertical DeflectionModeling files (created by the STAR*Geoid application)

Additionally, all of the example files installed with STAR*NET will be installed to an "Examples" subfolder of the System dir-
ectory, and on startup STAR*NET will copy the contents of this Examples folder to your default projects folderMy Docu-
ments\MicroSurvey\StarNet\Examples\ if it does not yet exist.

FILE DESCRIPTION
Examples\*.* Example tutorial files - installed

User Configuration Files

The following files are also used by the STAR*NET application.

FILE DESCRIPTION
ServerList.INI Search location for your floating network license (if applicable).

Project Files

The default STAR*NET projects directory is inMy Documents\MicroSurvey\StarNet\ although you can change this to any
folder on your computer or local network in which you have full access privileges.

http://www.microsurvey.com/helpdesk2/index.php?/Knowledgebase/Article/View/479/146/world-geoid-models-download
http://www.microsurvey.com/helpdesk2/index.php?/Knowledgebase/Article/View/479/146/world-geoid-models-download
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The following are "project-related" files that contain input data, options and output. Input data files must be created before an
adjustment. Output files are created during the run and take on the name of the project. For example, if you are working with a
project named "JOB", output files will inherit that name as illustrated below.

By default, all files for a project are located in one directory, normally called the project folder, although your .DAT and .GPS
data files may be located elsewhere.

FILE DESCRIPTION

JOB.PRJ

STAR*NET V6 (or older) Project File. Contains data file references, project options and project
instrument library items. Created when a project is first created in STAR*NET V6 or older. If a
.prj file is opened in STAR*NET V7, a new .snproj file will be created based on it and the original
.prj file will be left untouched so it can still be used in V6 if necessary.

JOB.SNPROJ

STAR*NET V7 (or newer) Project File. Contains data file references, project options and project
instrument library items. Created when a project is first created in STAR*NET V7 or newer, or
when a V6 .prj file is opened in V7 or newer.While the internal file format has not changed, there
are new options present in the .snproj file which are not compatible with V6.

JOB.DAT One ormore input data files - the "DAT" extension is suggested however other file names and
extensions may be used

JOB.GPS One ormore GPS vector input data files - the "GPS" extension is suggested however other file
names and extensions may be used

JOB.LST Output - adjustment listing
JOB.ERR Output - error listing - created when errors or warnings found

JOB.SBF Output - Star Binary File - adjusted information used for the creation of plots, reformatted points
and DXF export

Depending on settings in the Project Options, the following additional files may also be created during an adjustment:

FILE DESCRIPTION
JOB.PTS Output - Cartesian Coordinates
JOB.POS Output - Geodetic Positions
JOB.GND Output - Ground-scaled Cartesian Coordinates
JOB.DMP Output - Ground station information dump file.
JOB.RUN Output - run status file created when adjusting a network via the Batch Processor.

Additional files can also be exportedmanually:

FILE DESCRIPTION
JOB.DXF Output - DXF Exporter.

JOB.REF Output - Point Reformatter. This is the default filename, however the filename, extension, and
default extension can all be customized.

2.5 REGISTRY REFERENCE
The STAR*NET programmakes use of your computer’s registry to keep track of certain default directories, files and options.
The items saved in the registry are automatically created andmanaged by the program.

The following describes some of the information stored there.

l The location of the STAR*NET "system" directory, the directory containing the system files described in the previous
section.
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l The size and location of themain STAR*NET window, plus the size and location of most sub-windows (i.e. the listing
and plot windows) when the program was last used. The windows will come up looking the same the next run.

l The Text Editor and Start-in Directory items selected by you using dialogs accessed from the File menu.

l The "Recent Projects" list appearing at the bottom of the File menu.

l Printer and Plotter device preferences.

l The options last-used by the Points Reformatter tool.

l The options last-used by the GPS vector importer in the PRO edition for specific baseline formats.

When you install STAR*NET on another computer, these registry entries, of course, are not copied and they will be rees-
tablished by the program or reset by you.

If you reinstall the program (or install an updated version) over the original installation on your computer, all existing registry
information is preserved.

If you uninstall the program, all existing registry information for the program is removed.

Since this information is internally managed by STAR*NET, no documentation is given to externally edit information in the
registry.
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CHAPTER 3: USING STAR*NET
3.1 WORKFLOW
This chapter briefly describes the steps in running a typical STAR*NET adjustment. Subsequent chapters will cover these top-
ics and specialized features in detail. The list below summarizes the sequence of tasks you generally follow when creating a
project and performing adjustments with the STAR*NET program.

Open a new project.

Create a new project by choosing File > New Project or by pressing the New tool button. Browse if required to a folder where
you want to create the project. Enter the name of the project (with no extension) and press Open. For example, if you enter the
project name SouthPark, a new SouthPark.snproj file is created which will contain options for the your new project.

Open an existing project by choosing File > Open Project, or by pressing the Open tool button. Browse if required to the folder
containing your project. Highlight your existing project’s "SNPROJ" file and press Open – or simply double-click the existing
"SNPROJ" file.

Alternately, if your project is one you recently worked with, open it by selecting its name from the "recent projects" list at the
bottom of the File menu.

Set options describing your project.

STAR*NET saves a group of option settings for each project. These options define characteristics of the survey network
adjustment and are remembered for the duration of the project. ChooseOptions > Project Options or press the Project
Options tool button. A tabbed dialog with eight categories is shown: Adjustment, General, Instrument, Listing File, Other Files,
Special, GPS andModeling. Make changes to settings in one or more of the option pages and press OK to save. TheGPS and
Modeling option pages are active only in the Professional edition. (See "PRO" edition supplement.) 

See Chapter 4, "Options" for complete details on setting  project options.

Create one or more input data files containing observations and control points.

Before you can run an adjustment, STAR*NET needs at least one input data file containing your field observations. Choose
Input > Data Files or press the Input Data Files tool button. An Input Data File dialog appears and is used to specify what data
files to include in your adjustment. For a new project, a file namewith your project name and the "DAT" extension is auto-
matically provided for your convenience. Data files are standard text files that consist of lines of data conforming to
STAR*NET’s rules. To edit new survey observation data into this file, highlight its name in the dialog’s Data File List, and press
the Edit button.

Additional text files may be added to the project by pressing the Add button in the dialog and then selecting an existing file or
new file. When an adjustment is performed, each file is read intomemory in the order it appears in this dialog.

See Chapter 5, "Preparing Data" for details on using the Input Data Files dialog and a complete description of input data
formats.

Run the Adjustment

To run an adjustment for your project, chooseRun>Adjustment, or press the Run Adjustment tool button. STAR*NET loads
your data file or files into memory, checks the information, and then runs the adjustment. A "Processing Summary" window
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opens so you can see the progress of the adjustment. When the processing finishes, a short statistical summary is shown
which should be inspected to judge the success of the adjustment. 

Besides the full adjustment, there are several other choices that may be selected from the Runmenu: Data Check Only reads
and checks the data but does not perform an actual adjustment. Blunder Detect helps you detect gross errors in your input
data. And Preanalysis analyzes the survey network configuration and predicts the accuracy of a proposed survey

See Chapter 6, "Running Adjustments" for complete details on these Run features.

Check the Error File

If errors or warnings were found, check the error listing for specific details.

When STAR*NET encounters problems during the adjustment run, it lists amessage in the "Processing Summary" Window
that errors or warnings were detected. To view this error file, chooseOutput > Errors, or press the Errors tool button. Based
on what the error file says, youmay need to change one of the project options or edit an input data file to correct a data error,
and then rerun the adjustment. 

The error file viewed below shows that typing errors were found in two lines of a data file. In the first case, a non-numeric char-
acter was found in an elevation value. In the second case, an invalid horizontal angle was found - the "minutes" value is too
large. Whenever possible, STAR*NET tries to show you where the error is by printing a line of asterisks "*******" over to a bad
character or to an illegal value.

STAR*NET Error Log

[FILE: C:\Users\Brian\Documents\MicroSurvey\StarNet\Examples\Trav3D.dat]

ERROR [Line: 4] Missing or Invalid Coordinate Value
C   A2    9866.00    7900.00     9x98.89  ! ! !
***********************************

ERROR [Line: 15] Missing or Invalid Zenith Angle
T   4   101-39-39.6   1396.76   88-93-31.8  5.23/5.25
***********************************

Processing Terminated Due to Errors.

For a listing of the common error and warningmessages youmight encounter, see Appendix-D, "Error andWarningMes-
sages."

Edit your input data files to correct any errors found.

To edit your data files, or to add additional data files, use the Input Data dialog as described in "Creating Input Data Files"
earlier in this section. 

This dialog allows you edit any file by pressing the Edit button or by simply double-clicking the file name. The dialog also allows
you to add or remove data files from the list, and to rearrange their order. You can also "uncheck" a data file whichmeans it
remains part of the project, but will not be read for the next adjustment run.

Repeat the edit-run-review cycle as necessary until there are no errors generated when the adjustment is run.
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Review the Listing

When you run an adjustment for a project, STAR*NET writes the results to an output listing file. To review this file, chooseOut-
put>Listing, or press the Listing tool button. TheOutput Listing window appears, and it includes its own tool buttons which
allow you to jump forward or backward in the file to view different sections.

Click the Listing Tree Index tool button, or right-click anywhere in the listing window and a small "Listing Index Tree" window
will appear which allows you to quickly navigate to any section of the listing you are interested in seeing.

The output listing file contains many sections depending on the type of project being adjusted and the options set. You control
whether the sections marked "optional" in the list shown below are included in the listing file by setting listing-content options in
the Project Options dialog discussed earlier.

l Summary of Files Used andOptions Settings

l Listing of Input Data Files (optional)

l Adjustment Solution Iterations (optional)

l Summary of Unadjusted Input Observations (optional)

l Adjustment Statistical Summary

l Adjusted Station Information (optional)

l Coordinate Changes from Entered Provisionals (optional)

l Adjusted Observations and Residuals (optional)

l Adjusted Bearings and Horizontal Distances (optional)

l Convergence & Grid Factors at each Station (for grid jobs, optional)

l Traverse Closures of Unadjusted Observations (optional)

l Sideshot Coordinates Computed After Adjustment (optional)

l Error Propagation (if requested)

For details on viewing and printing the listing, see Chapter 7, "Viewing and Printing Output." For descriptions of the various sec-
tions of the listing, including a discussion of how to analyze your results, see Chapter 8, "Analysis of Adjustment Output."

Review the Network Plot

Youmay view a diagram of your adjusted network, including station and relative error ellipses. ChooseOutput>Plot, or press
the Network Plot tool button.

If you are using STAR*NET-LEV to perform a leveling adjustment, youmust enter horizontal “reference coordinates” for all sta-
tions in your level network data in order to generate a Network Plot.

Several tool buttons on the plot window allow you to zoom in and out, pan, center the plot at amouse click, find a point by giv-
ing its name, and inverse between given points. You can also zoom by dragging a box round an area with your mouse. Right-
click your mouse on the plotting window to bring up a "Quick-Change" menu where you can quickly turn off or on plot items
such as point names, markers or ellipses.

Click on the plot window Options tool button to bring up a tabbed options dialog. Here you can set many options including what
items to show on the plot and the sizes of names andmarkers and ellipses.
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Review Other Output Files

As a result of an adjustment, other output files may be created depending on whether they were requested in the Project
Options settings. These text files may include:

l Coordinates (adjusted coordinates - elevations only for a Lev Network run)

l Latitudes and Longitudes (adjusted positions for grid jobs)

l Ground File (scaled-to-ground coordinates)

l Dump File (comma-delimited station information details)

As with the listing file, you can choose to view any one of these output files from theOutput menu. For details, see Chapter 7,
"Viewing and Printing Output."

Repeat the edit-run-review cycle

Repeat all previous steps as necessary until you have satisfactory results within your required tolerances.

Print output listing, coordinate information and plot diagrams.

Any of the output files can be previewed and printed from within the program. For example, the listing file is themain output doc-
ument for your adjustment, and you will usually want to print it when the project is adjusted to your satisfaction. To print any out-
put file, its window must be active.

To preview how the printed output will look, choose File>Print Preview or press the Print Preview tool button. To print the out-
put, choose File>Print or press the Print tool button. You can highlight any section of an output text file and print just that part.

In your plot window, only display the items you want to see on your printed plot. For example, if you do not want to see point
names or ellipses, turn them off. Resize the window to approximate the shape of your printed sheet. Zoom in or out to fill the
image space to the way you want the image to appear on your printed sheet.

Preview how the plot will look on a printed sheet by choosing File>Print Preview, or by pressing the Print Preview tool button.
Then actually print your network plot by choosing File>Print, or by pressing the Print tool button.

See Chapter 7, "Viewing and Printing Output" for complete details on viewing output listing files and network plots, and printing
them.

3.2 HOW STAR*NET HANDLES OUTPUT WINDOWS
Before going on, a word should be said about how window sizing and placement is handled by STAR*NET. The size and loc-
ation of themain program window as well as all the output windows (listing window, plot window, etc.) are remembered! You
have full control of the size and location of these windows, and therefore you should set them the way you feel is most con-
venient for you. When you exit the program and later restart it, all the windows locate and size themselves the sameway.

For example, the output listing file window is one that you will always view, therefore you shouldmake it as large as possible
vertically and as wide as the output listing text. Once you do this, it will stay this way. You should also choose a convenient
size and location for your plot window.

Note that you can leave output windows open while you edit data and rerun an adjustment. Output windows (listings and plots)
that are left open, will automatically regenerate to show the newly adjusted results.

See Chapter 7, "Viewing and Printing Output" for more details on output windows.
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3.3 CUSTOMIZABLE SCREEN LAYOUT
STAR*NET 10 features a new fully integrated user interface. Please note that the default screen layout may not be appropriate
for all display sizes and resolutions, and we do recommend that you customize the interface to best suit your specific needs
and workflow habits. The following customization abilities are available...

Docking Panels
Every "panel" (Input Data Files, Output Files, Processing Summary, Network Plot, Find Point Tool) within STAR*NET 10 can
be rearranged to your own preferences. Panels can be dock or floating, auto-hidden to a small tab, or hidden from view com-
pletely,

Panels can be drag-and-dropped into a new position, easily snapping into a desired position. While dragging the title-bar of any
panel, you will see various icons appear on your screen which you can drop the panel onto, causing it to snap into the interface
in a specific way as follows:

Snap Top: This icon will appear centered horizontally near the top of your window; dropping a panel here will
snap it along the top edge of the window.
Snap Left: This icon will appear centered vertically near the left edge of your window; dropping a panel here
will snap it along the left edge of the window.
Snap Right: This icon will appear centered vertically near the right edge of your window; dropping a panel
here will snap it along the right edge of the window.
Snap Bottom: This icon will appear centered horizontally near the bottom edge of your window; dropping a
panel here will snap it along the bottom edge of the window.

Dock Primary: This group of four icons will appear centered over the primary (Data File Editor) area of your
window as you drag over it. Dropping a panel onto one of the four directional icons in this group will snap it
along the selected edge of themain editor area. The screen space will be split equally between themoved
panel and the existing editor panel.

Dock Secondary: This group of five icons will appear centered over any other docked or floating secondary
panels (Project File List, Network Plot, Processing Summary, Output Files, Network Plot) as you drag over
them. Similar to the above, Dropping a panel onto this central docking icon (or onto the title bar of another
panel) will cause the two panels to share the same screen space, one over top of the other with a "tab" con-
trol along the bottom of the panel to switch between them.

Float: Dropping a panel onto any empty space on your screen will float it above themain interface. This is
useful for moving items onto a secondary display.

Auto-Hiding Panels
Every secondary panel (Project File List, Output Files, Processing Summary, Network Plot, Find Point Tool) within
STAR*NET 10 can be hidden or shrunk from view if desired.

All docked secondary panels show the following icons in the top-right corner of their title bar:

Window Position: This icon displays a pulldownmenu which can be used to set the display mode for that panel with
options for Floating, Docking, Auto Hide, or Close. Right-clicking on the title bar of a floating or docked panel will also display
this menu.
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Auto Hide: This icon causes the panel to collapse down to a tab docked along an edge of themain window, or return a pre-
viously auto-hidden panel to its previous docked position.

Close: This button closes the panel.

Once a panel has been closed, it can be reopened using the appropriate option under theViewmenu.

Resizing Panels
Any of the docked panels can be resized by dragging the horizontal or vertical "splitter" bar between two adjacent panels. You
will see themouse cursor change to a splitter icon when hovering over a splitter bar; simply drag the splitter bar left-right or up-
down to adjust the panel sizes as desired.

Floating panels can be resized by dragging the window edges or corners as desired.

Reset Layout
You can reset your layout customizations using the Tools > Reset Layout command.

3.4 MENU AND TOOLBARS

STAR*NETmenu items are arranged so that you work from left to right when creating and running a project. First you use the
File menu to open a new or existing project. Then you set specific project Options, prepare one or more Input data files, Run
your adjustment, and finally, review theOutput listing and plot.

The Tools menu item offers additional utilities described later in Chapter 9.

Buttons on the tool-bar provide quick access to the "most-used" menu functions:

l Project Manager

l Create a New Project

l Open an Existing Project

l Save Current Data File

l Save All Data Files

l Print

l Print Preview

l Help
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l Undo

l Redo

l Cut

l Copy

l Paste

l Find

l Find Next

l Toggle Bookmark

l Next Bookmark

l Previous Bookmark

l Clear All Bookmarks

l Run Adjustment

l Run Adjustment with Cluster Detection

l Data Check Only

l Blunder Detect

l Preanalysis

l Level Loop Check

l GPS Loop Check

l AddNew Data File

l Add Existing Data File

l Import GPS Vectors

l Remove Selected Data File

l Delete Selected Data File

l Open Selected Data File

l Open Selected Data File with External Editor
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l Move Selected Data File Up

l Move Selected Data File Down

Also note that all toolbars andmenus can be customized using theView | Customize command, as discussed in the Cus-
tomize topic.

3.5 PROJECT MANAGER
The STAR*NET Project Manager provides an easy means of opening and creating your STAR*NET projects. It is auto-
matically displayed on start up by default, and it can also be opened by selecting File > Project Manager.

A list of your 10most recently used project (*.snproj) files will be listed on the dialog for quick one-click access. While only the
filename is displayed on the dialog, hovering your mouse over any of the filenames will display a tooltip containing the full path
and file name.

TheShow On Startup checkbox controls whether or not to automatically display this Project Manager on startup. If you do not
wish to use the Project Manager, you can disable this option.

New Project

Pressing theNew Project icon will step you through creation of a new STAR*NET project. You will be prompted for a folder
and filename to create. When a new project is created, it will look for amatching .dat file with the same name and if one is
found it will automatically add it to the new project; if a matching .dat file is not found, one will be created using the cus-
tomizable template data file.

The Template data file is located in one of the following default locations, and can be customized or deleted for your preferred
behavior.

Windows XP or older:
C:\Documents and Settings\All Users\Application Data\MicroSurvey\StarNet\10\template.dat
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Windows Vista or newer:
C:\ProgramData\MicroSurvey\StarNet\10\template.dat

Open Project

Pressing theOpen Project icon will let you select any project file in your computer. You will be prompted for a folder and file-
name to open.

If you open a .prj project file from previous versions of STAR*NET, a new .snproj project file will be created and the original .prj
file will be left untouched.

3.6 INTEGRATED DATA EDITOR
STAR*NET 10 features an integrated and customizable data file (*.dat, *.gps) editor, which provides the following powerful fea-
tures...

Syntax Highlighting 
Your input data files will be displayed (by default) with syntax highlighting enabled, with the following defaults:

o Data Record Types - Blue

o .Inline Options - Magenta

o Text/Numbers - Black

o Fixity Codes - Red

o #Comments - Green

o 'Descriptions - Light Blue

Help Tips
Clicking on any data line or inline option will display various details about that command.

For example, clicking on the following E line shows its syntax:

For more detailed information about the displayed command, pressing F1 when any Help Tip is displayed will automatically
open the relevant topic in the STAR*NET help file.

The Help Tips can be toggled on/off, made either floating or inline, and their contents can be controlled via the Editor Options
command.

Error Tips
When an adjustment is run, if there are any error or warningmessages generated to the Error File, any errors that are related to
a specific data line will also appear directly in the editor at the corresponding position. They aremarked with a red bookmark, so
you can easily cycle between all of the Error Tips by pressing F2 or Shift-F2 to jump to the next or previous bookmark.



MicroSurvey STAR*NET ReferenceManual

- 22 -

Autocompletion
When entering input data (*.dat, *.gps) by hand, the STAR*NET editor will suggest keywords as you begin typing them, allow-
ing them to be automatically completed without having to type the entire word and remembering all of the available keywords
for each command.

For example, typing ".D" can be autocompleted as either the .DATA or .DELTA commands:

Some keywords, like ".SCALE 0.3048", will require that you enter an additional parameter or value and you can do so by first
using the suggestion to autocomplete the .SCALE keyword after typing ".SC" (because .S starts both the .SCALE and
.SEPERATOR commands). After the ".SCALE" command is inserted into the data file, the Help Tip for it then indicates that a
numeric scale factor value is required, which you can type in as desired.

Other commands, like ".ORDER", can accept multiple parameters, and the same process applies for these. For example, let's
assume you want to add the line ".ORDER NE AtFromTo" which tells STAR*NET that you want the coordinates ordered as
Northings before Eastings, and the angles to be ordered in At-From-To format. As you begin typing starting with the "."
STAR*NET knows you are about to type an inline option and so it will suggest all of the inline option keywords it knows. As you
continue typing with the letter "o" STAR*NET narrows the list of inline option keywords down to the ".ORDER" command
since this is the only one beginning with the letter "o" but in other cases theremay be additional matches. You can click the sug-
gestion with your mouse or press the up/down arrows to select the desired suggestion (if there is more than one) and press
Enter to accept it. The Help Tip will then suggest that it requires an NE or EN parameter, and/or an AtFromTo or FromAtTo
keyword.

Block Commenting
You can automatically comment and un-comment blocks of selected text by pressing the # key with multiple lines selected.
Any selected lines will automatically be commented or uncommented via the addition or removal of one # character at the start
of each line. If all of the selected lines are already commented, they will be uncommented by the removal of one # character. If
any of the selected lines are uncommented, all selected lines will receive one new # character.

In the example below, lines 6 through 15 were highlighted then the # key was pressed.



Chapter 3: Using STAR*NET

- 23 -

Gutter
The "Gutter" area along the left-side of the editor, as shown in the screenshot above, serves several purposes:

o Bookmarks - bookmark icons can be displayed in the gutter, and toggled by clicking in the gutter. See below for more
details. Bookmarks can be seen on lines 6 and 17 in the above screenshot.

o Line Numbers are displayed in the gutter by default, but can be turned off. See below for more details.

o Select Line - you can select any line by left-clicking on the line number in the gutter.

Bookmarks
You can set and use bookmarks within your data files, allowing you to easily jump back and forth between different areas
within one or multiple data files at ease.

Bookmarks can be set on any line by clicking in the "gutter" area along the left-hand side of the data file editor at the desired
line, or by placing the cursor in the appropriate line then using theEdit > Toggle Bookmark command.

Existing bookmarks can be removed by clicking on a bookmark icon in the gutter area, or by placing the cursor in the appro-
priate line then using theEdit > Toggle Bookmark command. All existing bookmarks can be removed by using theEdit
> Clear All Bookmarks command.

Jump between existing bookmarks using theEdit > Next Bookmark andEdit > Previous Bookmark commands.

Line Numbers
Line numbers can be displayed within the "gutter" area on the left-hand side of the data file editor. They can be enabled or dis-
abled by toggling the Line Number option in the Tools > Change Font or Color command. Clicking on a line number will
select that line.

3.7 EXTERNAL DATA EDITOR
STAR*NET uses text files as data. Therefore to enter or modify data, you will be using a text editor.
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By default STAR*NET will use its own integrated data editor, but if you prefer it can be configured to use any external text
editor application.

Windows Notepad is assigned as the default external editor, but you can redefine the default editor be to your own favorite text
editor:

1. Choose File > Set Editor.

2. In the dialog, type the name of your editor including its full path in the field, or press Browse to select the editor program
using standardWindows file dialogs.

To open a data file with your selected program instead of the internal editor panels, use theEdit External button on theData
Input Files panel.

3.8 CUSTOMIZE
Yourmeans of access to all commands within STAR*NET is customizable using theView > Customize command, as fol-
lows:

Commands

The Commands tab shows a list of all commands available within the program, organized by their Category. For consistency,
each category represents onemenu, and when you select that category you will see all of the Commands contained within its
correspondingmenu.

Commands can be added to any existing toolbar or menu by drag-and-dropping them from the commands list onto the desired
toolbar or menu within themain interface.



Chapter 3: Using STAR*NET

- 25 -

Toolbars

You can customize your toolbars by adding or removing buttons from the existing toolbars, or creating entirely new ones with
your most commonly used commands. Toolbars can either be docked to themain interface, or float freely over your screen.

Toolbars can be docked along the top, left, or right edges of themain STAR*NET window, or they can be left floating anywhere
on your display.

The Toolbars tab shows a list of all toolbars existing within the program. You can reset any of the stock toolbars, removing any
extra buttons youmay have added to them, either individually via the Reset button or enmass via the Reset All button. You
can also create your ownNew custom toolbars if you prefer, and you can Rename or Delete any of your ownCustom toolbars
(but you cannot rename or delete the stock toolbars).

You can check/uncheck any of the toolbars to display/hide them.
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Keyboard Shortcuts

You can assign keyboard shortcuts for any command in the program, for example like Ctrl-N for New Project. The Shortcuts
tab is where you can assign, modify, or reset any keyboard shortcuts in the program.
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Menus

TheMenus tab allows you to Reset any customizations you havemade to themenus, removing any commands that were
added to them.

You can also change some display options for themenus, including specifying animation and shadow effects.

The Context Menus section currently has no effect on the program and can be ignored.
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Options

TheOptions tab contains a few display options, including

l Show ScreenTips on toolbars: when you hover over a toolbar button, you'll see a tooltip describing that command.

l Show shortcut keys in ScreenTips: when a ScreenTip is visible, you'll see any defined shortcut keys (like Ctrl-N) for
that command.

l Large Icons: toolbar buttons will be displayed with small or large icons. Large icons are easier to see, but take upmore
slightly more screenspace.

3.9 FIND POINT
The Find Point tool provides an easy means of locating any references to any particular point ID within any input data file in
your project, directly from any output file in your project.

Double-clicking on any point ID within any output file in the program (the listing file, coordinate file, error file, ground file, etc)
will initiate the Find Point tool. It will quickly search through all of the currently enabled Data Input files belonging to the current
project and locate all references to that point ID. The search results will be displayed in the Find Point panel, in a tree form
showing the file each result was found in, the line number (in parenthesis) the result was found on, and the data line itself.

Double-clicking on any result displayed in the Find Point panel will then open that data file (if necessary) and take you to the
appropriate data line, and highlight the found point.
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In the screenshot above, point 0012 was double-clicked in the Listing file and the search results from both data input files were
immediately displayed in the Find Point panel, then double-clicking on a search result in the Find Point panel jumps to that line
and highlighted point 0012 in the data editor.

Note that the Find Point tool will only search through input files listed and enabled in the Data Input Files panel; it will not
search through input files referenced via a .INCLUDE inline option.

The Find Point tool does not currently find aliases to the point that was searched for, but this will be expanded upon in a future
update.
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CHAPTER 4: OPTIONS

4.1 OVERVIEW

STAR*NETmaintains a list of settings for each job called "Project Options." Most of these options are settings and values that
control how STAR*NET processes an adjustment, and they are set by the user in dialogs discussed on the following pages.
Other stored settings relate to the contents of plotting diagrams and DXF exports.

STAR*NET stores the options for a project by creating a file named "PROJECT.SNPROJ," where "PROJECT" is the name of
the project, for example, SouthPark.snproj. All project specific options are saved in this file. If you open an existing project at a
later date, those options automatically load and will remain in effect until you change them.

A special "default options" file named STARNET.DEF is referred to as the Company options file. Initially, the Company
options file contains no default values and if you create a new project, the program simply assigns built-in generic defaults as
your project options. Therefore you should set the Company options to settings typical of your projects as soon as possible
after installing the software. These option settings are then automatically applied to any new project saving you the time of
manually setting them yourself. Setting Company options are discussed later in this chapter.

When you have a single project that requires several different weighting schemes (different instruments used, or combining an
old survey with a new survey), you can store several sets of instrument standard error values in a special "Instrument Library".
This informationmay be saved in the Company options file for use in any project, or in the project’s own "SNPROJ" file for use
only by that project. Using special "inline" codes, these settings can be referenced anywhere in the data files to change the
weighting scheme of subsequent observations. Using the Instrument Library is discussed in detail later in this chapter.

4.2 CHANGING PROJECT OPTIONS USING OPTIONS DIALOGS
To set or change options for the current project, chooseOptions > Project, or press the Project Options toolbar button.

An options dialog appears with eight tabbed dialog categories: Adjustment, General, Instrument, Listing File, Other Files, Spe-
cial, GPS andModeling. The last two dialogs (GPS andModeling) are used only with the "Professional" edition and are
described in the separate "PRO" manual supplement attached.

To review any option category, click the tab to open that specific options dialog. Make necessary changes on one or more of
the tabbed dialogs, and press OK to save your changes. Or press Cancel to ignore all changes you havemade.

As discussed on the previous page, when you save options, these settings will be stored in a "PROJECT.SNPROJ" file hav-
ing your project name. For example, if your project name is SouthPark, the options are stored in a file named SouthPark.snproj.

Specific details on settings for each of the option dialogs are described in detail on the following pages.

4.3 CHANGING PROJECT OPTIONS USING INLINE OPTIONS
The options set in the project option dialogs described above assume the settings relate to an entire project. However there are
some settings related to observation data that may not remain the same throughout an entire data file. Changes to option
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settings within the data file are controlled by "Inline Options."

For example, the setting for "linear units" in the options dialog has a single value. But if you want to change this value one or
more times for groups of observations in a data file, insert a line like the one below to change the units for observations fol-
lowing it:

.UNITS Meters

These "inline" options give youmuch flexibility – you are not tied down just to option settings in the option dialogs. "Inlines"
allow you to change units anywhere in your data, change between 2D and 3D formatted data, change weighting of obser-
vations using instrument library scheme names, andmuchmore.

Some of these inline options arementioned in the descriptions of the project option dialog settings on the following pages.
Since these inline options are entered right in your data files, their full descriptions along with examples are discussed later in
Chapter 5, "Preparing Data," in a section named "Using Inline Options."

4.4 PROJECT OPTIONS
To set options for your project, chooseOptions > Project, or press the Project Options tool button. Use the tabbed dialog to
change settings in the several categories and press OK to save. The following pages describe all option settings in detail.

Adjustment Options
General Options
Instrument Options
Listing File Options
Other Files Options
Special Options
GPS Options (STAR*NET-PROOnly)
Modeling Options (STAR*NET-PROOnly)

Adjustment Options
In the Adjustment Options dialog, you select the settings which describe your adjustment such as whether it is a 2D,  3D  or
Lev adjustment, the units to be used, whether it is a local or grid job, plus a few other basic settings.
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Only relevant options are available, based on the Adjustment Type (2D, 3D, or Lev) and Coordinate System (Local or Grid)
selected. Settings made in this dialogmay also cause sections in other options dialogs to become active or inactive.

Option Group: Adjustment Type

Select whether your adjustment is 2D, 3D or Lev. Results from a 2D adjustment contain northings and eastings, a 3D adjust-
ment also includes elevations and a Lev adjustment contains elevations only.

When an adjustment is 2D, an average project elevation should always be entered so that certain data reduction calculations
(i.e. slope reduction of 3D observations to horizontal) can be accurately performed using curved earth-geometry for both local
and grid jobs. In addition, when adjusting a local job, and you wish to have data reduced to a common datum as described in
the next option group, an average project elevationmust be known. Likewise, for a grid job, an average project elevationmust
also be available to calculate proper grid factors. For some additional elevation-related issues for 2D jobs, see "Entering Refer-
ence Elevations in 2D Projects" in Chapter 5, "Preparing Data." An inline ".PELEVATION" optionmay be entered in data files
to redefine the default project elevation for various parts of a 2D project when you feel it is necessary.

Option Group: Units

Select the linear and angular units for your project from the dropdown selection list. Adjustment results are always published
using the selected units. By default, your input data is assumed to be entered in these units.
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An inline ".UNITS" option, however, may be used in your data to allow entry of measurements in other units.  Measurements
entered in these alternate units are automatically converted to the units set for the project during the run.

Along with the typical linear unit settings (International Feet, US Survey Feet andMeters), you can also define your own cus-
tom linear units such as Yards, Chains, Links and so on. Please refer to the "Defining Custom Units" chapter for details.

Option Group: Coordinate System

Grid Jobs

Select the coordinate system used in the adjustment.

For grid adjustments, a value should be given for AverageGeoid Height which is the average geoid-ellipsiod separation for your
project. This value is always entered inmeters. Be sure to use the correct sign! For example, the geoid height is negative in the
contiguous United States but may be positive in other areas.

This average geoid-ellipsiod separation is used in the calculation of scale and elevation factors, and of course, in the determ-
ination of ellipsoid height output values calculated from given or adjusted elevation values, and visa versa.

For the standard STAR*NET edition, the entered geoid height value is used for the entire project and therefore any deflections
of vertical due to gravity variations are assumed to be zero. But in the "Professional" edition, which includes the handling of
GPS vectors, values for geoid height and vertical deflectionmay be defined for every point, or they may be set by geoid and
deflectionmodeling.

See Chapter 10, "Adjustments in Grid Coordinate Systems" for detailed information on setting options for grid system adjust-
ments

When you select "Grid," your input and output coordinates are based on some defined grid system. Published geodetic cal-
culations are rigorously employed in the adjustment process to produce properly calculated grid coordinates and geodetic pos-
itions. You can choose from over 3800 predefined grid systems, or you can create your own custom systems.

Select Ellipsoid to use - Users can select to use either the local ellipsoid contained in the current coordinate system or the
WGS84 vertical system. This affects the input and output of all geodetic positions (lat/long) and ellipsoid heights in a
STAR*NET project.

Special input issues for grid projects are discussed in detail in Chapter 10, "Adjustments in Grid Coordinate Systems."

Local Jobs
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When you select "Local," your input and output coordinates are based on some local scheme. Themethod used to scale your
input distance observations to produce the desired local coordinates is set in the "Local Jobs - Default Datum Scheme" adjust-
ment options described later in this section.

A coordinate datummust be assumedwhen you are performing a local adjustment so that adjusted observations are con-
sistent with the given coordinates. Observations will be reduced to your coordinate datum using one of twomethods:

l Apply an Average Scale Factor – If your controlling coordinates are at your default project elevation, set a factor equal to
1. But if your coordinates are at a different datum and you know the scale factor (perhaps you are simulating a grid
adjustment and know the average grid factor), enter this scale factor and STAR*NET will apply it to the horizontal com-
ponent of all distances during the adjustment to produce coordinates at your desired datum.

An inline ".SCALE" optionmay be used to change the default scale factor anywhere in your data file. 

l Reduce to a Common Elevation – Using this alternate scheme, observations at various elevations are reduced to your
given elevation datum using curved-earth geometry. If the elevation is given as 0.00, horizontal components of distance
observations are reduced to sea level. Therefore controlling coordinates at sea level must be given as input, and coordin-
ates at sea level will be produced as output. Likewise, if your given elevation is at some other value, say 1000 feet, the
distance observations will be reduced or expanded to this datum. Coordinates at this datummust be used as input, and
adjusted coordinates at this datum will be produced.

See Appendix C for more a detailed explanation of these data schemes.

Option Group: Geoid/Vertical Deflections

This section is simply a quick reference to review the currently selectedModeling Options. These options are read-only; to
change them youmust switch to theModeling Options screen.

4.5 COORDINATE SYSTEM EDITOR
Select Coordinate System
Coordinate system selection is accessible from the Adjustment Options dialog, by pressing either theCoordinate System but-
ton which always displays the name of the selected coordinate system.
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Coordinate System Details
The Coordinate System Editor is accessible from the Adjustment Options dialog, by pressing theCoordinate System Details
button. It will display the Ellipsoid, Datum, and Projection parameters for the project's coordinate system. The displayed para-
meters are read-only and cannot bemodified.

Create Custom System
The Coordinate System Editor is accessible from the Adjustment Options dialog, by pressing theCreate Custom System but-
ton. It can be used to specify the Ellipsoid, Datum, and Projection parameters required to define your own coordinate system.
This replaces the text-based StarNet.cus file used in previous versions of STAR*NET.
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Custom coordinate systems must always include a colon character ":" anywhere in the name. (This is how the program dif-
ferentiates predefined and custom systems.)

Supported datum types include:

l None

l Molodensky

l Molobadekas

l Bursa

l 7 Parameter

l 6 Parameter
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l 4 Parameter

l 3 Parameter

Supported projection types include:

l Lambert Conformal Conic, One Standard Parallel

l Lambert Conformal Conic, Two Standard Parallels

l TransverseMercator or Gauss Kruger Projection

l Universal TransverseMercator System

l Albers Equal Area Conic Projection

l Rectified Skew Orthomorphic, Azimuth at Projection Center

l Mercator Cylindrical Projection with Standard Parallel

l Mercator Cylindrical Projection with Scale Reduction

l Lambert Azimuthal Equal Area Projection

l Lambert Azimuthal Equidistant Projection

l Miller Cylindrical Projection

l Oblique Sterographic Projection

l Polar Sterographic Projection

l Sinusoidal Projection, Optionally Interrupted

l Equidistant Cylindrical Projection

l Cassini Projection

l Robinson Cylindrical Projection

l Bonne Pseudoconical Projection

l Krovak Oblique Conformal Conic, Czechoslovakia

General Options
TheGeneral options dialog includes "preference" type settings that are very general in nature and that you will seldom need to
change during the life of a job.
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Only relevant options are available, based on the Adjustment Type (2D, 3D, or Lev) and Coordinate System (Local or Grid)
selected in the Adjustment Options.

Option Group: Adjustment Solution

l Convergence Limit –When the change in the sum of the squares of the standardized residuals from one iteration to the
next is less than the Convergence Limit, the adjustment has converged, and iterations stop. Coordinates have been
adjusted into their "best-fit" positions and are not changing. A setting of 0.01 allows most networks to converge in reas-
onable number of iterations. Increasing the value to 0.10 or larger may help reduce the number of iterations in some lar-
ger networks. Just because your adjustment converges does not necessarily mean that you have a good solution. See
Chapter 8, "Analysis of Adjustment Output," for more details.

l Maximum Iterations – Iterations stop when the Convergence Limit is satisfied,  however if convergence is not reached,
this provides a stopping point. A value of 10 is usually sufficient. Setting a larger number does not necessarily mean that
your adjustment will converge because problems in the datamay prevent a solution. In this case, the problems must be
found and corrected! This field is not active for level network adjustments as the solution is linear and iterations are not
required.
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l Chi-Square Significance Level – A 5% level is the usual significance level preferred by most statisticians, but an altern-
ate level may entered if you have some reason to do so. The Chi-Square test is discussed inmore detail in Chapter 8.

l Fixed Std Err (Linear and Angular) – STAR*NET holds fixed points by assigning them a very small StdErr value (res-
ulting in a very large weight). "Fixed" angles and distances in an adjustment are not actually totally fixed, they are
simply given very great weight.All observations are adjusted, but observations of such large weights change so little
that the changes do not show in the residuals. If you are encountering singularity problems (non-solution) during an
adjustment, you can relax the StdErr values that STAR*NET will use for holding fixed points.

Option Group: Error Propagation

Here you indicate whether or not to perform error propagation, and what confidence level to use. Themost commonly used con-
fidence level is 95%. You can enter confidence level values from 50% up to 99.999% depending on your project requirements.

Error propagation is a separate function from the adjustment and it calculates standard deviations and confidence information
for all network station coordinates; if error propagation is not selected, standard deviations and confidence information are not
computed and will not be in the listing. It also calculates error ellipse information for all network station coordinates and relative
error ellipse information between station pairs.

For large networks, the processing time for error propagation can become significant. Therefore when working with large jobs,
youmay want to temporarily turn off error propagation until the adjustment is debugged and working to your satisfaction.

Option Group: Input/Output Coordinate Order

These settings allow you to define the North/East order to be used for coordinates in the data files and in the resulting output
listing file. In addition, you can define how they should be labeled. For example, certain international regions prefer to enter and
list coordinates in East/North order, and label them as X and Y.

An inline ".ORDER" optionmay be used anywhere in data files to change the default order of coordinates being entered.

Option Group: Longitude Sign Convention

In grid jobs, this setting controls themeaning of the sign of longitude values for both input data and computed output. The use
of "positive" west longitudes (those west of Greenwich) is the convention preferred by most users in the USA and Canada. The
use of "negative" west longitudes is usually preferred by the international community. Select your preference, and that con-
vention will be used for all grid systems, NAD27/83, UTM andCustom. For example, if you are a user in the United States and
have the option set to the positive west convention, you can switch between NAD83 and UTM, and continue to input the same
positive longitudes and see positive longitudes in your results.

An inline ".LONGITUDE" optionmay be used anywhere in data files to change the default sign convention of longitude values
being entered.

Option Group: Angle Data Station Order

This option gives the order (At-From-To or From-At-To) of the stations that define angles in the input data for your project. The
output listing will also display the angles using this station order.

An inline ".ORDER" optionmay be used anywhere in data files to change the default station order of angles being entered.

Option Group: Distance/Vertical Data Type

This option changes how STAR*NET interprets input distance and vertical information in 3D data. If set to "Slope Dist/Zenith",
distance observations are interpreted as slope values and vertical observations as zeniths. If set to "Horiz Dist/Elev Diff," they
are interpreted as horizontal distances and elevation differences.
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An inline ".DELTA" optionmay be used anywhere in data files to change the default type of Distance/Vertical data being
entered.

Option Group: Earth Radius/Refraction Information

l Earth Radius of Curvature for Local Jobs –When running local jobs, this value is used inmany curved-earth geometry
calculations including the reduction of slope distances to horizontal, and the reduction of observations to specified
datums.

The generally accepted average value of 6,372,000meters is set as the default when the program is installed, however you can
change it to another value if it is known to be different for your geographical area. Note that this radius is used only for local
jobs. Earth radius values for grid jobs are automatically calculated based on station position and azimuth using published geo-
detic formulas.

l Default Coefficient of Refraction – The value of 0.07 is set as the default when the program is installed, however you
may reset it to any value you feel is proper for the atmospheric conditions known for your job. The value of the coef-
ficient only affects internal corrections applied to zenith angles during the adjustment. The zenith angles shown in the
output listing do not reflect these corrections for refraction.

Note that a "Reset" button is present for both items in this group. Press it to reset a value back to the default setting value
present in the "Company" options.

An inline ".REFRACTION" optionmay be used anywhere in data files to change the default refraction value for different sec-
tions of your data.

Note that STAR*NET uses the "classical text book" index value of 0.07 as the generally accepted average value for most field
conditions This average refraction index value and themethod used to apply the correction is detailed in the publication
"Geodesy" by G. Bomford. See Appendix section C.2 for additional information.

STAR*NET assumes that all entered data are normal measurements taken on the face of the earth. If you have removed the
effects of earth curvature and refraction by hand-modifying your zenith angles by somemethod, youmust indicate this in your
data by using the ".CURVE OFF" inline option so that STAR*NET will not perform curvature corrections on already corrected
data. See Chapter 5, "Preparing Data," for a description of the ".CURVE OFF" inline option.

Instrument Options
Standard errors are used in weighting your data. In this dialog, you enter standard error values for most types of conventional
and leveling observations used in an adjustment. Your observations will default to these values unless explicit values are
entered with the observations in your data, or unless you use "Instrument Library" inline options to apply alternate values to
your data.

You should always set your standard error the values to those consistent with the actual instruments and procedures used for
your project! If you determine that your projects normally use certain option values, you can change the startup defaults for new
projects by revising the values in the Company Options. See "Company Options" later in this chapter for details.



MicroSurvey STAR*NET ReferenceManual

- 42 -

Only relevant options are available, based on the Adjustment Type (2D, 3D, or Lev) selected in the Adjustment Options.

Linear and angular units shown in this dialog are based on the project units set in the Adjustment Options. If you change the
units settings in the Adjustment Options dialog (from FeetUS toMeters, or DMS to GONS for example), the standard error val-
ues and their displayed units in the dialog are automatically converted. You never have tomanually convert standard error val-
ues from one unit to another.

When working in DMS, angular standard errors are entered in seconds. And when working in GONS, standard errors are
entered inmilligons, where onemilligon is equal to 1/1000GON. (There are about 0.309milligons per second.)

Conventional Observations Group: Standard Error Settings

What standard errors should be used as project defaults? Before you can determine what values to use as project defaults, you
must know the standard deviations of measurement types based on the actual equipment used. These are called the "pop-
ulation" standard deviations, meaning they are statistically derived from a large number of measurements. There are two ways
of determining these values:

1. Compute Them from Testing: You can set up a controlled field test and observemany repetitions of angles and dis-
tances. The procedure is described inmany text books, however it is seldom used because of the time and effort
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required.

2. UseManufacturer’s Specifications: This method is used by most surveyors. If your equipment is in proper working order
and you follow accepted procedures, you can use themanufacturer’s population standard deviation estimates as a
basis for determining what standard errors to use as default settings for your project.

Note that most theodolite specifications are stated in terms of a "pointing" precision, the ability to repeat a reading to a single
point. An "angle" is made up of two pointings. Therefore, if a given pointing specification is 5 seconds, you would propagate an
angle standard deviation by taking 5 seconds times SQRT (2) = 7.07 seconds.

As an example of population standard deviations for a total station, let’s use 7.0 seconds for angles, 5.0 seconds for pointings,
and 0.03 feet plus 4 ppm for distances. Using thesemanufacturer’s population standard deviations, what standard error values
should be used as the project options instrument default settings?

First of all, the term "standard error" is short for "standard error of themean." It is an estimate of the uncertainty of themean (or
average) of a set of field observations. The equation for standard error of themean is:

Std Error  =  Std Deviation / SQRT ( Number of Observations Averaged )

If you average 4 angles, use 7.0 / SQRT (4) = 3.5 seconds as the standard error setting for angles. If you average 4 direction
pointings, use 5.0 / SQRT (4) = 2.5 seconds as the standard error setting for directions. And likewise, if you average 2 dis-
tances, divide the 0.03 feet and 4 ppm by SQRT (2) and use 0.021 feet and 2.8 ppm as the standard error settings for dis-
tances.

It is important to note that the standard errors calculated above are dependent only on the population standard deviations and
the numbers of observations averaged. They are in no way dependant on the values or spreads of the actual averaged obser-
vations!

If you do not average observations (i.e. you enter every repeatedmeasurement), simply use themanufacturer’s standard devi-
ations as your default standard errors. For example, if you repeat an angle 4 times and enter all 4 observations, each angle
would be given the standard error of 7.0 seconds. Althoughmore lines of data are created by entering every measurement,
some users prefer doing this knowing that their observations are always correctly weighted in the adjustment, independent of
the number of repeats.

The remaining settings in the conventional instrument settings group are either centering error values, or proportional errors
(PPM) for distances or elevation differences.

Horizontal and Vertical Centering Errors

l Horizontal Instrument and Target Centering - This is an estimate of the horizontal centering error, the inability to center
over amark. These values are used to inflate the standard errors of horizontal angles, directions, distances, and to
some extent, observed zenith angles. Horizontal centering error inflates standard error more for angle readings observed
over short sights than those over long sights. Therefore, angles observed over short sights are given less influence
(weight) in the adjustment.

What values are reasonable? As a rough guide, for instrument centering error we find values around 0.005 feet (0.0015
meters) commonly used for optical plumbs, and 0.010 feet (0.003meters) or more for string plumbs. Target centering
depends on the kind of target and care used in setting up. What values you use for centering error must be based on
equipment, field conditions, your crew and experience.

l Vertical Centering – This is an estimate of the vertical centering error, the inability to measure the exact instrument or tar-
get height from the ground. The value is assumed to be the same at both instrument and target. Vertical centering is
used to inflate the standard errors of zenith angles, elevation differences, and to some extent, slope distances. Vertical
centering error inflates the standard error more for zenith angles observed over short sights than those observed over
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long sights. Therefore zenith angles observed over short sights are given less influence in the adjustment.

As with horizontal centering, a vertical centering value of 0.005 feet (0.0015meters) might be considered reasonable,
but what value you actually usemust be based on equipment, field conditions, your crew and experience.

Note that "fixed" observations are not affected by horizontal or vertical centering errors. Also by default, standard errors
explicitly entered on a line of input data are not affected by centering unless the ".ADDCENTERING" inline option has
been used in the data. See "Inline Options" in Chapter 5 for details of its use.

PPM (Parts per Million) Settings for Distances and Elevation Differences

l Distance PPM - The actual standard error used for the distance observation is made up of two parts, the constant and
the proportional (distance times ppm). A value entered here represents the proportional distancemeasuring error of an
EDM in parts per million. Say for example your EDM is rated as plus or minus 5millimeters, and plus or minus 3 ppm,
you would enter the value 0.005meters (assuming your data is in meters) in the distance standard error field previously
described, and the value 3 in this ppm field. Remember, if your project units are set to feet, you have to convert any mil-
limeter rating to feet. In the example above you would enter 0.016 feet for standard error, and the same 3 ppm.

The default method used in STAR*NET to compute the actual standard error used for a distance is to add the constant
and the proportional parts. This method, called the "additive" method, is preferred by most manufacturers.

For a distance of 2,000 feet, a constant of 0.016 feet and a 3 ppm part:

Std Error  =  0.016  +  (3 ppm  x  2,000 feet) / 1,000,000  =  0.022 feet

Another method preferred by some is called the "propagated" method in which the standard error is computed by taking
the square root of the sum of the squares of the two parts. This method is available by using a special ".EDM" inline
option. See the section " Inline Options" in Chapter 5 for details on its use.

Note that standard errors for distances explicitly entered on data lines are not affected by an entered ppm value. Only
those distances accepting the default standard error are affected by the proportional ppm part.

l Elev Diff PPM –Since an elevation difference is often derived frommeasuring a zenith angle and slope distance, you
may want to inflate its actual standard error based on how large the distance is by applying a PPM. This PPM is based
on the slope distance between the instrument and target, not the elevation difference. STAR*NET calculates this slope
distance using the given or computed approximate coordinates for the instrument and target stations. Entering a ppm
value for elevation difference observations cause larger total standard errors (less weight) to be applied when long slope
distances are involved than short.

Themethod used to compute the actual standard error value is to add the constant and the proportional parts. For
example, using a standard error of 0.05 feet and 25 ppm, the total standard error for an elevation difference observation
measured along a slope distance of 1,000 would be:

Std Error  =  0.05  +  (25 ppm  x  1,000 feet) / 1,000,000  =  0.0750 feet

The value you actually use for "ppm" must be some value you feel comfortable with, and should be based on your exper-
ience in the field. A good value to start with might be the 25 ppm figure used in the example above. To do a rough validity
check on this figure, assume a zenith angle uncertainty of plus or minus 5 seconds. Therefore, the vertical distance
error calculated using a 5 second arc swing over a distance of 1,000,000 feet is about 25 feet, therefore the 25 ppm. Or
for example, if you feel your zenith angle uncertainty is more in the 10 second range, then youmight use 50 ppm for your
proportional elevation difference standard error.

This method of calculating the total standard error for an elevation difference is an empirical approach. An alternate but
more complex method is to propagate the uncertainties of both themeasured distance and zenith angle. However,
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based on normal survey measurements and practices, we believe this method will provide a proper yet easy to under-
stand way of weighting these derivedmeasurements.

Leveling Observations Group: Standard Error Settings

If you have differential leveling observations in your network, you set the default weighting for these observations here. Weight-
ing for differential leveling is based on either a standard error per unit length or a standard error per turn.

l Sections as – Select whether you want the "length" numerical value in your leveling observation data lines to be inter-
preted as linear length or number of turns.

l Elev Diff – Enter the standard error per unit length or standard error per turn you want assigned to your elevation dif-
ference observations.

When sections are defined as "Length", the standard error per unit length value is based on current project units. Therefore:

l If units are Feet (US or Int), the standard error per unit length is in Feet/Mile.

l If units areMeters, the standard error per unit length is in Meters/Km.

l If units are anything else, the standard error per unit length is in Units/Unit.

When sections are defined as "Turns", the standard error is in Units/Turn.

So, how is the total standard error of a level line between two stations computed?

The total standard error is propagated based on the number of "sections" in the level line, and as indicated above, these sec-
tions are defined as Length or Turns.

Below are two examples, one based on sections entered as Length, the other as Turns.

1. Sections Defined as Length: Project units are in FeetUS, therefore standard error per unit length is in FeetUS/Mile. So
for a level line distance of 25,000 FeetUS between two stations and an assigned standard error per unit length of 0.015
FeetUS perMile, the total elevation difference standard error for the level line will be:

StdErr = 0.015 FeetUS/Mile x SQRT(25,000 FeetUS/5280 FeetUS/Mile)
StdErr = 0.015 FeetUS/Mile x SQRT(4.7348Miles) = 0.0326 FeetUS

2. Sections Defined as Turns: Project units are in FeetUS, therefore standard error is based on FeetUS per Turn. So for a
level line having 35 turns between two stations and an assigned standard error of 0.008 FeetUS per Turn, the total elev-
ation difference standard error for the level line will be:

StdErr = 0.008 FeetUS/Turn x SQRT(35 Turns) = 0.0473 FeetUS

An inline option ".LWEIGHT" is available if you need to change the default weighting and the type of weighting (section length-
based or turn-based) anywhere in your data. See "Inline Options" in Chapter 5 for details of its use.

Online Tools

Tip: A free online tool that can help you determine appropriate instrument settings is available at http://sup-
port.microsurvey.com/convert/instrumentsettings.html

Listing File Options
These settings allow you to control the contents and appearance of your listing file that results from an adjustment. With all the
contents settings unchecked, aminimum sized listing will be produced. But even with all contents items selected, some sec-
tions will be listed only if applicable to a particular kind of run. For example, Geodetic Positions will not be created when the pro-
ject is a "local" (non-grid) adjustment.

http://support.microsurvey.com/convert/instrumentsettings.html
http://support.microsurvey.com/convert/instrumentsettings.html
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Only relevant options are available, based on the Adjustment Type (2D, 3D, or Lev) and Coordinate System (Local or Grid)
selected in the Adjustment Options.

Option Group:  Unadjusted Contents

l Network Observations –When selected, all unadjusted network observation data will be listed in the output listing file.
This is an organized review of all your input data, sorted by data type. Although this sectionmay be turned off to shorten
the listing file, it is a highly recommended part of any output adjustment report.

l Sideshot Observations –When selected, all sideshot observation data will be listed in the output listing file. Sideshots
(defined by SS data lines) are shown in a separate section of the listing. If you have a very large number of sideshots,
youmay wish to uncheck this option tomake the listing file shorter.

l Copy of Input Data File(s) –When selected, an exact copy of your input data file or files will be copied to your output list-
ing file. Including this section in your listing greatly increases its length and therefore for normal runs, you will probably
not want to include it. However, in certain cases, it can be very useful for creating a complete history of an adjustment
project including a listing of all original field observation input data along with the final results.

Option Group: Adjusted Contents



Chapter 4: Options

- 47 -

l Observations and Residuals –When selected, adjusted observations, residuals, the standard errors and standardized
residuals will be shown in the listing file. This is a tabulation of all adjusted observations, organized by the type of obser-
vation. Although this sectionmay be turned off to shorten the output listing file, it is an important part of any final report
and normally should be included because it clearly shows how much each observation was changed in the adjustment
process.

l Coordinates, Sideshot Coordinates, Geodetic Positions –When these items are selected, final adjusted coordinates,
sideshot coordinates (when the job includes sideshots) and geodetic positions (when the job is grid) will be listed in the
output listing file. When the presence of these adjusted coordinate items in the listing file is not important, it can be
unchecked to significantly reduce the size of the listing file.

l Convergence andGrid Factors –When selected and the job is grid, a table showing the convergence angle, grid factor,
elevation factor, and combined grid factor at each station in the network will be created.

l Azimuths and Horizontal Distances –When selected, a table of adjusted bearings and horizontal distances will be cre-
ated between all points connected by observations. If error propagation is performed, the table also includes relative con-
fidences of the azimuth and distances. This table also includes additional connections that can be defined by using the
".RELATIVE" inline data option.

l Traverse Closures –When selected, and if observations have been entered in your data using the Traverse data type, a
summary of each unadjusted traverse closure, along with closure precisions, will be included in the listing file.

l Standard Deviations, Station Error Ellipses, Connection Relative Ellipses –When selected, these sections will be
included in the listing if error propagation is performed. Each can be independently selected depending on what you want
shown in your listing. In a Lev adjustment, vertical confidence values are computed per the Station Error Ellipses option.

l Coordinate Changes from Entered Provisionals –When selected, a tabulation of the differences between hand-entered
provisional coordinates and the final adjusted coordinates is included in your listing. This is particularly useful in deform-
ation studies when you are trying to determine themovement of specific stations since the previous survey was per-
formed. Only those stations that have explicitly hand-entered provisional coordinates are listed in this section - not
those stations whose approximate coordinates are computed by the program.

l Coordinate Changes for Each Iteration –When selected, changes in coordinates plus the sum of squares and changes
in the sum for each iteration are shown in the output. You would normally not include this section, but it sometimes can
be useful when debugging a problem adjustment. If an adjustment takes excessive iterations, for example, youmay
want to review this section to see if coordinates in some area of the network are having difficulty converging to a solu-
tion, or perhaps to determine if a larger convergence valuemay be required in some unusual cases.

l File References –When selected, references to the file and line number of the first occurrence of the point will be appen-
ded to adjustment results. While it seems useful to always have this enabled, some users may want to leave this fea-
ture off to ensure that the listing file does not exceed 80 characters wide, which will result in long lines wrapping over
onto a second line when printed.

l Full Point Names –When selected, long point names will be displayed in full in the listing file; when not selected, point
names will be truncated to 10 characters whenever more than one point name is listed on a single line. While it seems
useful to always have this enabled, some users may prefer to leave this feature off to ensure that the listing file does not
exceed 80 characters wide, which will result in long lines wrapping over onto a second line when printed.

l Cluster Detection Details -When checkedON and an Adjust Network with Cluster Detection has been ran this feature
will generate a new section in the listing file displaying the details of all point aliases found . This report will show the
user a summary of the options and settings used in the feature, a summary of the end result using the Cluster Detection
and a list of all the generated .Alias inline options, If left unchecked, then nothing is written to the listing file after a Net-
work Adjustment with Cluster Detection has been ran.

Option Group: Conventional and Leveling Observations Appearance
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l Show Azimuths as Bearings – By default, directions between points in the listing file are shown as traditional azimuths
from north (i.e. 45-30-20). When this option is selected, quadrant bearings (i.e. N45-30-20E) commonly used in the
United States and Canada are shown in the listing.

l Show Solved Direction Set Orientations – Selecting this option causes the solved orientation (azimuth or bearing)
solved for each direction set to be printed at the top of each adjusted set output. Some surveyors find special uses for
these values.

l Show Extended Linear Precision – By default, the number of decimal places shown for linear values in the listing is set
to show adequate precision for normal survey observations. (For example, 4 places for coordinates, distances, standard
errors and residuals.)When this option is selected, 2 additional  places of precision are shown for most linear items.
This option satisfies a certain group of users who record distance observations using very high precisionmeasuring
equipment.

l Sort Coordinates by – You can select to have coordinates shown in the output listing shown in the same order the points
were first found in the input data, or sorted by point name. Requesting that coordinates be sorted by name also causes
sorting in the other output files selected in the "Other Files" options dialog.

l Sort Unadjusted Input Observations by – Likewise, you can select whether to have the review of unadjusted input
shown in the same order as originally found in the input data, or sorted by their point names. When sorted, data is sorted
first by the instrument name, then the backsight name (in the case of angles), followed by the target name.

l Sort Adjusted Observations and Residuals by – Just as with unadjusted observations, the adjusted observations may
be shown in the same order as originally found in the data, or sorted by point names. In addition, adjusted observations
may be sorted by the size of their residuals which in some cases may be helpful while debugging a network adjustment.

Other Files Options
This dialog is used to select additional output files to be created during an adjustment.
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Only relevant options are available, based on the Adjustment Type (2D, 3D, or Lev) and Coordinate System (Local or Grid)
selected in the Adjustment Options.

Create Coordinate (PTS) File - When selected, a coordinate file will be created during an adjustment. This is a text file which
will have the name of your project plus a "PTS" extension (i.e. SouthPark.pts). This file can be viewed from a selection in the
Output menu.

Points in this file (and the "GND" file below) are created using a format selected from the Format dropdownmenu. The
"Default" format will satisfy most needs, but youmight prefer to select another format (i.e. "comma separated") that your
COGO program can read directly. A few standard formats are supplied and others may be defined by you. See "The Points
Reformatter" in Chapter 9, "Tools" for full details on using these formats and creating your own output formats.

Create Ground Scale Coordinate (GND) File –When selected, a coordinate file is created based on "Ground File" para-
meters you provide by pressing the "Settings" button. Themain purpose of creating this file is to provide a set of ground scaled
coordinates from adjusted grid coordinates. Calculations available include scaling, rotation and translation. This is a text file
which will have the name of your project plus a "GND" extension (i.e. SouthPark.gnd) and it can be viewed from a selection in
the Output menu. See "Creating aGround Scale File" directly following this section for full details.

Create Geodetic Positions (POS) File –When selected, a Geodetic Positions file will be created by the adjustment of a grid
job. The file consists of station names, latitudes and longitudes, ellipsoid heights (in a 3D job), and station descriptors. This is a
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text file which will have the name of your project plus a "POS" extension (i.e. SouthPark.pos) and it can be viewed from a selec-
tion in the Output menu.

Default Precisions – The decimal precisions set in these fields for coordinates, geodetic positions and elevations are used for
creating the files described above unless specific precisions are defined in the "format" selected. The DMP file described
below outputs full precisions and is not controlled by these settings.

Create Station Information Dump (DMP) File –When selected, a comma-delimited file will be created by an adjustment. It
will contain information about each station. The file will have your project name plus a "DMP" extension (i.e. SouthPark.dmp)
and it can be viewed from a selection in the Output menu. This text file may imported by spread sheet (Excel, etc.), database
(Access, etc.) or other external programs to create custom reports.

The first line of text contains headings which describe what information is in the following fields, and each subsequent line con-
tains information for a station. Linear units are in the units of your job when it was last run, angular units are always in degrees,
and text fields (point names and descriptors) are surrounded by double quotes. The example below shows the first few lines
from an actual "Dump" file. The lines have been truncated because they are very long.

"Name","Description","Northing","Easting","Elevation","Latitude","Lon ...
"0001","Iron Pipe",229833.3213615992,110158.0133318822,215.7733154476 ...
"0002","Jones & Taylor",230797.4132695578,111270.0991547375,216.67223 ...
"0003","",229169.8786997623,111439.5398236188,181.9398806813738,33.06 ...
"0004","Iron Pipe",229887.8965116776,112041.5939534157,174.5938744477 ...
"0005","",219827.9211207605,113465.0155055414,202.5212603320946,32.97 ...
etc.....

When an adjustment is performed for a local (non-grid) job, grid and elevation factors will have values of 1, and latitudes, lon-
gitudes and ellipsoid heights, values of 0. When error propagation is not performed, the standard deviations, variances and cov-
ariances will have values of 0.

In addition, when the "Include Relative Connection Covariances" box is checked, another section to the dump file is created
which includes covariance values between  connections in the network. These connections are by default, all connections cre-
ated by observations, otherwise those named using the ".RELATIVE" inline. A heading for this section describes the content of
this extra information.

A user with knowledge of the relationships between standard deviations, variances and covariances can use these values for
specialized purposes such as in deformation analysis.  Details of thesemathematical relationships are not discussed here.

Ground File Options
The purpose of the "Create Ground Scale Coordinate (GND) File" in the Other Files Options dialog is to compute a set of
ground coordinates by scaling, rotating and translating the adjusted coordinates during the adjustment run. In some cases, the
user may want to create another set of coordinates that are rotated to a different basis of bearings. In other cases, the user may
want to create another set of coordinates scaled-to-ground from the adjusted grid coordinates to use for construction.

To set parameters for the "Create Ground Scale Coordinate (GND) File" item feature in the Other Files Options dialog, press its
"Settings" button.

During the adjustment, a file with the name of your project plus a GND extension (for example, SouthPark.gnd) is created using
the parameter settings described below.
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The dialog consists of settings for three functions - scaling, rotation and translation. Select which functions to perform by
checking one or more of the columns.

Scaling: The scaling function is performed by dividing the adjusted coordinates by a factor, either a given value or one that is
computed. If the job is "local," the factor is always a given value. For a "grid" job, the value can be selected as one of three
ways.

l Given Factor – If you already know a combined grid factor for the area you want coordinates created for, entered this
value.

l Computed at Station – Enter a station name, and then during the adjustment, STAR*NET will use the combined grid
factor computed at this point as the value.

l Computed Average – This selection causes the average combined grid factor for all points in the job computed during
the adjustment to be used.

Rotation: The adjusted coordinates can be rotated in one of two ways.

l Given Azimuth or Bearing – Enter names of From and To points in the network plus the azimuth or bearing you want to
exist between these two points in the computed ground file. When units are in DMS, you can enter an azimuth (45-22-
33) or a quadrant bearing (S45-22-33E). When units are in GONS, you can enter an azimuth only (50.1234).

l Given Rotation – Enter the positive or negative rotation you would like applied to the coordinates.  (Examples,  2-35-
46.76 in DMS, -15.12457 in GONS.) A positive rotation value is clockwise.

Translation: The coordinates can be translated using one of twomethods.

l Coordinates at a Station – Enter the name of a point in the network you want to be assigned specific coordinates. There
are two ways coordinates can be assigned:

1. Use Adjusted Coordinates – Coordinate values computed for the point during the adjustment run are assigned to
the that point in the ground file. The result of this is that the ground coordinates for the named point will be exactly
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the same as its grid coordinates, and the remining ground points will have coordinates slightly different than their
grid coordinates because of the scaling.

2. UseGiven Coordinates – Coordinate values that you enter are assigned to that point in the ground file.

l Arbitrary Coordinates – Choose this method if you don’t care what values are assigned to the ground points. Coordin-
ates in the computed ground file will be shifted an arbitrary amount so that they will look "different" than the adjusted net-
work coordinates.

Special Options
This dialog is used to set special features not specifically related to other project options:

Positional Tolerance Checking

Selecting this option creates an extra listing section in the Error Propagation part of the output listing. Some government agen-
cies require that the positional certainty of points relative to other points in a survey be within certain a tolerance. For example,
the ACSM/ALTA committee in the United States has set up specifications for this, and they publish tolerances for various
classes of surveys. The allowable tolerance for a connection is the summation of some published value (such as 0.08 Feet)
plus a parts per million (PPM) value calculated using the horizontal length of the connection.
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For any checked connection, a relative ellipse is computed at the specified confidence region between the two points. The tol-
erance specification is satisfied when the semi-major axis ellipse size does not exceed an allowable positional tolerance cal-
culated for that connection.

When this checking option is turned on, the connections checked by default are all those containing observations. For small
surveys, these connections may be all those necessary to check. But for larger surveys, youmay wish to create other con-
nections spanning between selected points, not those just between observed points.

See discussion of the ".PTOLERANCE" inline option. This inline option is used to generate your own list of connections to be
checked.

The sample printout shows an "exhaustive" set of connections created for a small survey network. The report indicates one tol-
erance check failure.

Positional Tolerance Check (FeetUS)
Allowable Tolerance = 0.0800 + 50 PPM
Tolerance Check Confidence Region = 95%

Stations         Horizontal        Semi-Major-Axis         Ratio
From     To        Distance       Actual      Allowed   Actual/Allowed
1        2        1709.4352       0.0973       0.1655       0.5878
1        3        2184.5310       0.1139       0.1892       0.6019
2        A2       4030.2628       0.1002       0.2815       0.3558
3        4        2043.7068       0.2212       0.1822       1.2142 *
3        5        2044.7969       0.0828       0.1822       0.4546
etc...
5        A1       3904.3385       0.1081       0.2752       0.3928
5        A2       3641.8400       0.1081       0.2621       0.4125
A1       A2       2104.1206       0.0000       0.1852       0.0000

Connections Checked = 21
Number of Failures  = 1

Check Sideshots

Selecting one or both of these options causes the program to check sideshot names (those in SS lines) against main network
station names and/or other sideshot names, and issue warning or error messages when repeats are found.

If it is important that all main network station names in a project be unique, select one of the "Network Matches" warning or
error options.  If it is important that all sideshot names be unique, select one of the "Repeated Sideshot Names" warning or
error options. Note, however, that the checking of a very large number of sideshot names (say 50,000) against each other to
assure that all names are unique can slow down processing time significantly!

Cluster Detection

This section contains the quality control settings STAR*NET uses in the Adjust Network with Cluster Detection routine. From
here the user will select the tolerance type, either 2D or 3D and enter in a Hz and Vt distance tolerance to be applied to the
cluster detection process. These tolerance checks assists the user in determining which points in the clusters are good and
which are not by displaying the horizontal and vertical ties from the aliased point to its assigned true point. Any distances over
the set tolerance level will be shown in RED in the cluster detection report. The user can then go over the report and un-check
any point that falls outside of the set tolerance distances. There is an additional check box option to automatically deselect
points that fall out of range to the assigned true point.
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Note: If the project adjustment type is set to 2D then only the 2D option will be available in this section, however if the project
adjustment type is set to 3D then both 2D and 3D options will be selectable. The tolerance value cannot be greater than 10.0
nor less than 0.0.

Detect Sideshots

Selecting this option causes the program to detect M lines with no redundancy and automatically convert them to SS lines.
These SS lines will be treated like any other conventional SS lines, allowing you to toggle or modify their display in the network
plot. Additionally, they will not be included in the calculation for the chi-square test, increasing the accuracy of the test. This
option works well with data converters and field files that do not automatically recognize sideshots in the data and write them
as such.

Level Loop Tolerance Check

Selecting this option causes STAR*NET to perform additional tolerance checking during the Level Loop Check routine. Specify
the standard and classification that you want to confirm your level loops comply with, or choose Custom to enter any value.
When you run the Level Loop Check, themaximum allowable vertical misclosure for every loop with be calculated using the fol-
lowing formula, and the actual vertical misclosure will be validated against it. Any loop that exceeds this allowable tolerance
will generate a warningmessage in both the Listing and the Error Log.

Tolerance = Constant * √ ( total loop length in km ormiles)

Standards of Accuracy, United States National Geodetic Survey:

Classification Metric Imperial
First Order, Class I 4mm √K 0.017 ft √M
First Order, Class II 5 mm √K 0.021 ft √M
SecondOrder, Class I 6mm √K 0.025 ft √M
SecondOrder, Class II 8 mm √K 0.035 ft √M
Third Order, Class I 12mm √K 0.050 ft √M
Fourth Order, Construction 24mm √K 0.100 ft √M

Standards of Accuracy, Natural Resources Canada:

Classification Metric Imperial
Special 3 mm √K 0.012 ft √M
First Order 4mm √K 0.017 ft √M
SecondOrder 8mm √K 0.035 ft √M
Third Order 24mm √K 0.100 ft √M
Fourth Order 120mm √K 0.500 ft √M

For example, the SecondOrder Class II tolerance for a loop that is 111200 feet long is calculated as:

Tolerance = (0.035 ft) * √ (111200ft / 5280ft/mi)
                    = (0.035 ft) * √ ( 21.0606miles)
                    = 0.1606 ft

Or if the same loop is in meters,

Tolerance = (8mm) * √ (111200m / 1000m/km)
                    = (8mm) * √ ( 111.2 km)
                    = 84.3mm
                    = 0.0843m
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                     Differential Level Loop Check Closures
                     ======================================

Tolerance Check Standard: NGS, Second Order Class II (0.035 ft √M)

From       To             Elev Diff    StdErr  Length
128        130              10.3360    0.0148   32100
130        129             -22.1300    0.0160   37400
129        128              11.8100    0.0169   41700
Error of Closure:           -0.0160            111200
Error of Closure Tolerance: ±0.1606  OK
Standard Error:              0.0275
Standardized Error:          0.5811

130        125               3.8330    0.0138   28100
125        BM75            -15.9200    0.0146   37500
BM75       129             -10.0230    0.0131   25300
129        130              22.1300    0.0160   37400
Error of Closure:           -0.0200            128300
Error of Closure Tolerance: ±0.1725  OK
Standard Error:              0.0288
Standardized Error: 0.6935

GPS and Modeling Options
The remaining two option sections in the Project Options dialog are for settings features available in the "Professional" edition.
TheGPS dialog provides for settings that control GPS vector weighting, centering errors, transformation solving andmany set-
tings which control the output content and appearance, and theModeling dialog sets upGeoid and Deflectionmodeling para-
meters.

If you are using STAR*NET-PRO, see the supplemental referencemanual provided for details on these option settings and
other features.

4.6 COMPANY OPTIONS
The Company Options serves as a template for initializing your Project Options. When you create a new project, the default set-
tings that appear in the Project Options are those settings that exist in the "Company Options."

If you find that most of your projects are similar, for example, most are 3D grid jobs using a certain grid zone, and you enter
most of the instrument settings the sameway from job to job, then you should set these options up as Company Options.

First, chooseOptions > Company. The Company Options dialog appears.
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Then, change settings in all of the options dialogs to those settings most commonly used for your typical jobs, and press OK to
save.

Company Options are stored in the file company.def located the STAR*NET system directory. Whenever you create a new
project, this file is automatically read to initialize the Project Options settings for the new project, saving you the time to do it
yourself. Then, after that, you can fine-tune the settings using the Project Options dialogs when required.

The Company Options default settings can be changed as often as you wish. Just remember that changing default settings in
the Company Options only affects initial defaults assigned to new projects being created. Existing projects are not affected!

4.7 INSTRUMENT LIBRARY
The Instrument Library is where you can store weighting schemes. Each scheme is identified by an "Instrument Name"
although a scheme doesn’t necessarily relate to a conventional instrument or total station. Different weighting schemes might
describe:
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l Standard error settings for a particular total station, or instrument being used.

l Expected standard errors for a particular crew using certain equipment. One crew may bemore experienced than
another and therefore youmight set standard errors based on the quality of work you expect from the crew with the
equipment.

l Approximate standard errors for measurements surveyed "years ago" that are being included in your project. Youmay
want to give thesemeasurements larger standard errors (less weight) than thosemeasured with modern equipment.

Working with the Instrument Library Dialog

Open the Instrument Library by choosingOptions > Instrument Library. Two kinds of instruments can be defined, "Com-
pany" and "Project" instruments:

l Company Instruments – These instruments are stored in the COMPANY.DEF file along with other company default set-
tings. These instruments are considered public and can be used by any project. Set up weighting schemes that you
think are general and that any project could use as a "Company" instrument.

l Project Instruments – These instruments are stored in your project’s own SNPROJ file (for example, SouthPark.snproj)
and can be used by that single project only. These instruments are considered private. Set up any kind of special weight-
ing scheme that is unique to your project as a "Project" instrument.

Note that when the name specified in an ".INST" inline option in your data file exists in the library for both "Company" and "Pro-
ject" instruments, the "Project" instrument settings will be used by the program during an adjustment.

For projects containingmany unique weighting schemes, it is beneficial to define all instruments as "Project" instruments. This
causes the project to be completely self-contained, with all its unique weighting schemes stored in its own SNPROJ file.

Before you can start using the instrument library settings for an adjustment, you have to add instruments to the library. To add
an instrument:

1. Press the "New Company Instrument" or "New Project Instrument" button on the Instrument Library dialog shown on
the previous page, depending on which you want to add. An instrument settings dialog will open as shown below.
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2. Enter an Instrument Name and an optional Note describing your weighting scheme.

3. Make any changes to the settings required for your weighting scheme.

4. Press OK to save this named instrument to the library.

You have now added a named instrument, a new weighting scheme, to the library. To addmore weighting schemes, continue
repeating the steps above.

Notes regarding Instrument Settings:

l The units shown in the dialog are the same as your project. If you change your project units, both the values and units
labels in this dialog will be converted.

l The "Note" entered in the field above is only for your own reference and has no other purpose in program operation.

l The "Copy Settings to Current Project Defaults" button in the settings dialog shown above allows you copy these set-
tings to your current project.

When the Instrument Library contains one or more Company or Project Instruments, the tree diagram in the Instrument Library
dialog can be opened to show the instrument names similar to the way Windows Explorer shows file names.

For example, open or close the Company Instruments tree by double-clicking its title, or by pressing the [+] or [-] tree item.
With all trees open, the instrument list tree diagram shown below contains two Company instruments and one Project instru-
ment.
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Note that "Default Settings" are also shown here for Company and Project defaults. Although their instrument settings can also
be viewed and edited from this dialog, you normally view or edit them in the Company or Project Options dialogs.

Editing an Instrument – Edit any established instrument in the library by highlighting its name and pressing the Edit button, or
by simply double-clicking its name. The same settings dialog appears. Make changes to its settings and press OK to save.

Deleting an Instrument – Highlight an instrument in the tree and press the Delete button. You will be asked to confirm.

Copying Settings From –When creating a new instrument, settings are copied from the current Company Defaults unless you
specify otherwise. If you want to use settings from an existing instrument as the starting settings, first highlight the desired
instrument and press the "Copy From" button, and then create your new instrument.

Copying Settings To – To copy settings from one instrument to another, first assure the "Copy From" instrument is the one you
want to copy settings from, then highlight the instrument you want settings copied to, and press the "Copy To" button.

Using Multiple Instruments in a Project
If a project contains survey observations being combined from two ormore sources, each being of different quality, the use of
the instrument library offers an easy method of setting up correct weighting for a proper network adjustment. (Changing weight-
ing for leveling andGPS observations are handled separately using individual inline options.)

In general, you will follow these steps when using the Instrument Library:

1. First, select Instrument Library from theOptions menu. Use the dialogs to define one or more weighting schemes by giv-
ing each scheme a unique instrument name such as TOPCON3,  OSCAR or PENFIELD-1945. A namemay be upper or
lower case and up to 15 characters. Set desired standard errors for each scheme.

2. Then when creating your input data, organize the data so that observations having the sameweighting scheme are
grouped together, and insert an .INSTRUMENT inline option line before each group.

The following lines from a data file illustrate switching between weighting schemes:
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M  3-2-19   133-44-23   2344.112
M  3-2-20   145-34-54   2558.665
.INST TOPCON3
M  19-3-21  109-22-17   1099.213
M  19-3-22   98-55-34   2011.129
M  19-3-24   89-24-54   2117.876
.INST OSCAR
M  12-9-42  255-43-52   3325.222
etc...

Whenever a switch is made from one Instrument Name to another, all weighting defaults (standard errors, PPM and centering
errors) are reset to new values and applied to subsequent data in the file until another Instrument Name is again entered. Note
that an Instrument Name is not case sensitive so upper or lower casemay be used when entering the identifier names in the
data file.

Note that any data lines before the first ".INST" line are assigned the current Project Options/Instrument dialog settings values.
You can switch back and forth between any scheme in the Instrument Library as many times as needed. When an ".INST" line
is entered with no identifier name included, subsequent lines will again be assigned the current Project Options/Instrument dia-
log setting values.

4.8 EDITOR OPTIONS
Various Editor Options are available to control the appearance and functionality of the Integrated Data Editor.

To access the Editor Options, chooseOptions > Editor...:

These options are saved in a file calledEditorSettings.ini and deleting this file will restore the default options.
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Text Zoom
The zoom level (or text size) of all text-based panels within the integrated data editor can be increased or decreased by adjust-
ing the slider.

Alternatively, you can also press Ctrl+ (or Ctrl ScrollUp), Ctrl- (or Ctrl ScrollDown) and Ctrl / to increase, decrease, and reset
the zoom level directly within a specific text panel, and only that panel will be affected.

Assist
Show Help lets you toggle on/off, and control the appearance of, the context-sensitive Help Tips that appear when clicking on
a line in your input data files.

l Inline displays the Help Tip into a virtual line below the current line, temporarily shifting any input data on subsequent
lines down below the tip.

l Floating displays the Help Tip as a floating tooltip above the data editor, temporarily obscuring any input data on sub-
sequent lines behind the tip.

l Syntax Only adds details that show the specific syntax of the command. The given syntax is affected by certain Pro-
ject Options and Inline Options.

l Detailed Info adds details that show other related commands and a description of the command, in addition to the spe-
cific syntax of the command.

Note that complete context-sensitive documentation is also available by pressing F1 when any Help Tip is displayed.

Show Hover Tips lets you toggle on/off the Hover Tips that are displayed as youmove your mouse over data lines within the
Integrated Data Editor to indicate what type of data that value represents, such as perhaps a slope or horizontal distance, or a
horizontal or zenith angle, etc.

Show Errors and Warnings lets you toggle on/off the Error Tips that are displayed directly within the Integrated Data Editor if
certain adjustment errors occur. Note that the Error File (*.err) is still always generated, and only those error/warningmessages
that relate directly to a specific data line will result in an Error Tip. The Error Tip is a virtual line that never becomes part of the
actual data file, and the Error Tips will be updated or cleared as appropriate when the adjustment is run again.

Show Command Completion lets you toggle on/off the Command AutoCompletion that is displayed when you start typing
an inline option into your input data file.

Tabs and Whitespace
l Tab Size controls the default tab width when you press the Tab key.

l Insert Tabs inserts a Tab character when you press the Tab key.

l Insert Spaces inserts multiple Space characters when you press the Tab key.

l Show Whitespace displays visible markers for characters like Space and Tab.

Miscellaneous
l Highlight Current Line toggles whether the current line is marked in a light grey color.

l Show Line Numbers toggles the line numbers in themargin.

l Show Block Cursor toggles whether the cursor is displayed as a thin line or a thick block.
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l Show Fold Point Margin toggles whether you can collapse and expand data lines that fall within any .DATA OFF and
.DATA ON lines.

l Enable Line Wrap toggles whether long lines are wrapped within the data editor without having to scroll horizontally.

l Link Station Names toggles whether station names in your input data are displayed with a hyperlink that causes a Find
Point to be run on that station name.

l Use Dark Theme toggles whether the text-based panels use an inverted display themewith a black background. This
affects the Processing Summary, Input Data, andOutput Data panels only; it does not affect the Data Input Files, Net-
work Plot, or Find Point panels.

Reset to Factory Defaults
Pressing theReset to Defaults button will restore the factory default Editor Options. It will not affect any other Project or Com-
pany Options.

4.9 DEFINING "CUSTOM" LINEAR UNITS
Parameters for Custom units are stored in a text file named STARNET.CUS located in your STAR*NET system folder. It con-
tains optional custom linear units information. A listing of the supplied file is shown later in this section. This file is a standard
text file, and using any text editor, you can view it or modify its contents to add linear unit definitions as needed. When running
STAR*NET, this information becomes available in the Project Options/Adjustment dialog.

(Please note that previous versions of STAR*NET also used this STARNET.CUS file for custom ellipsoids and grid zone para-
meters. As of STAR*NET 8, only Unit definitions are read from this file and any other previously used record types will be
ignored.)

These optional definition data lines are needed only if you wish to enter linear data (coordinates, distances, etc.) in units other
than those already built into the program which include US Feet, International Feet, andMeters. Units defined in this file will be
added to the available linear units already built into the program and will appear in the "Units" selection list of your Project
Options/Adjustment dialog. A unit line begins with a "U" character and includes its name and the ratio of the unit to themeter.
The name of the unit may be up to 8 characters and is terminated by a ":" colon character. We have supplied two custom units
as examples, however they have been "commented out" so that they won’t show up in your Project Options unless you want
them to.

In the STARNET.CUS file, all linear values are entered inmeters! The program automatically performs any conversions neces-
sary to conform to units you are actually using in a project.

Contents of the STARNET.CUS file:

# Linear Units (Note that example entries below are commented out!)
# =======================
# UnitName: UnitsPerMeter
# -----------------------
#U Yards:      1.09361330   
#U Links:      4.970969538 

The installed STARNET.CUS file contains additional notes not shown here for the sake of space. Units present in this file that
you will never use can, of course, be commented out or deleted from the file so they will not show up in your project options dia-
logs.
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CHAPTER 5: PREPARING INPUT DATA
5.1 OVERVIEW
This chapter describes the preparation of STAR*NET input data files. It includes instructions on using the Input Data Files dia-
log, a general description of the file format, a detailed explanation of each STAR*NET data type, a description of "inline" data
options and a discussion of weighting observations.

5.2 INPUT DATA FILES
Data for a STAR*NET adjustment consists of one or more text files. For small jobs you will probably have just a single data file
(as in the example below). But for large projects, youmay wish to use several. For example, youmight prefer to keep separate
areas of your project in separate files. The Input Data dialog allows you to add or remove files from the project, edit or view the
files, and rearrange the order in which they will be read during an adjustment.

Each file in the list has a check box. When checked, the file will be read when an adjustment is run; when unchecked, it will
not. This ability to easily include or exclude a particular file can be very helpful when debugging a network adjustment

When a project is first created, an input data file name using the name of your project is automatically added to the list in this
dialog. For example if your new project is named SouthPark, a file named SouthPark.dat is added to the list. Although a file
named in this way is not required for your project (you can replace it with another if you wish), most users will find it a con-
venient name to use.

Using the Input Data Files Panel
To open the Input Data files panel, chooseView > Input Data Files, or press the Input Data Files tool button.

The Input Data files dialog is where youmaintain the list of all data files your project will use during an adjustment. The fol-
lowing describes the use of this dialog and the functions of its buttons:

l New – Press this button to add a new data file to the list. A file selection dialog will open so that you can specify a file-
name. It will default to using a DAT extension, however you can use the Files of type" field to show other extensions.

l Add – Press this button to add a data file to the list. A file selection dialog will open as shown below. Select an existing
file or create a new file. When creating a new file, type its name in the File name field and press Add. The files dialog
defaults to a DAT extension, however you can use the "Files of type" field to show or add other extensions. Or add a file
of any extension by enclosing the file name and extension in quotes (for example, "SouthPark.obs").
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l Import GPS Vectors – Press this to open theGPS Vector Importer which you can use to import various baseline
formats into a new or existing data file.

l Remove – Press to remove one or more highlighted files from the list. Files are not deleted from your computer system,
just removed from the list.

l Delete – Press to delete one or more highlighted files from the list. Files are completely deleted from your computer sys-
tem.

l Edit – Press to view a highlighted file in the internal editor.

l Edit Externally – Press to edit a highlighted file, or simply double-click the file in the list. Note that you can quickly edit
the currently highlighted file without even opening the data files dialog! Just right-click the Input Data Files tool button.
(The tool tip for that button shows the "current" file name.)

l Move Up/Down –When two or more files exists in the list, you canmove a file name to a new position. Highlight the
file and press Up or Down to change its position. The order the files appear is the order they are read when you run an
adjustment.

5.3 AN OVERVIEW OF STAR*NET DATA FILES
STAR*NET input data files are relatively free in format. Generally, lines begin with a one or two character code identifying the
type of data, followed by the station names and actual observations. These data elements do not have fixed positions on a line,
but they must appear in the proper order.

Youmay insert comment lines anywhere in the file using the "#" symbol. Anything following the "#" on a line is interpreted as a
comment, and is ignored. We highly recommend that you add notes and comments to your data files documenting survey data,
field conditions, or any unusual situations that may prove valuable later. Tomany users, comments added to their data files
become part of an historical document.

Input data files are standard text (ASCII) files that can be created with a text editor, either inside the STAR*NET program or
external to the program.

Data files might also be generated as output from some another program, such as a third party COGO program or a data col-
lector routine. MicroSurvey Software Inc., for example, supplies several utility programs that convert raw data collector field
files to files formatted for STAR*NET use. And certain large companies and public organizations have written their own data
converter utilities based on the way their surveyors collect field data and how they wish to use that data in the STAR*NET pro-
gram.

Data lines may be up to 500 characters long.
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Blank lines can be placed anywhere in the file. You can use spaces and tabs to align the data items if you wish. Comments,
beginning with "#" characters, can be freely entered, both as separate lines, and attached to the ends of data lines.

5.4 NAMING DATA FILES
File dialogs have been designed in STAR*NET to expect, by default, that input data files will have a DAT extension. This is a
descriptive extension which is very easy to distinguish from all other file types.

However, the use of DAT as an extension is not required. For example, in the "Professional" edition, a GPS extension is used
when adding GPS vector data to the data file list. Although it is recommended that observations be created in data files using
the DAT extension so that you can use default file types built into the dialogs, any extensionmay be used as long as it is not
one of the several reserved output file extensions automatically used by the program when creating output files.

The following reserved extensions and should not be used for data files: SNPROJ, PRJ, LST, PTS, POS, GND, DMP, ERR,
SBF and DXF.

5.5 THE GENERAL CONTENT OF DATA LINES
This section provides a general description of data lines used in STAR*NET. Individual types of data lines are fully discussed
in "Description of Data Format and Content," later in this chapter.

The box below shows the elements of a data line. Items in [brackets] are optional:

Code Stations Observations [Std Errors] [HI/HT] [Description]

Data Code
The first one or two characters of a line of data is a code that defines the content of the line.

For example, the line below defines a single distance observation:

D    TOWER-823      132.34                   0.03

Likewise, the line below defines all the 2D measurements, angle and distance, from one point to another including optional
standard errors the two observations:

M    P25-12-HUB     163-43-30 197.65         4 0.03

Some lines define 2D data like the ones above, and other lines define 3D data like the one shown below. This line includes all
themeasurements from one point to another. In this line we include the optional standard error values and an HI/HT entry:

M    T20-T19-T55    33-21-30 89.5 91-22-50   4 0.03 15      5.2/5.7
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By default, whether a data line should be formatted as 2D or 3D data is determined by what kind of adjustment is to be per-
formed. Therefore, for 2D adjustments, your data should normally be formatted as 2D data. And for 3D adjustments, your data
should normally be formatted as 3D data.

There are times, however, when you will want to enter 3D data into a 2D adjustment so that STAR*NET can automatically do
the reduction to horizontal for you. And likewise, there are times when you will want to enter some 2D data into a 3D adjust-
ment. There are special ".2D" and ".3D" inline options that can be inserted directly in the data to change themode of the input
from 2D to 3D and visa versa. These are very useful options! See "Using Inline Options" later in this chapter for details on the
use of these inline options and others.

The following table lists all data type codes that may be used to prefix each line of data. These codes may be entered in upper
or lower case. The "#" symbol is a special code, indicating that a comment follows, and can be used anywhere on a line.

Code Meaning
# Remainder of line is a comment and is ignored
C or CH Coordinate values for a station
E or EH Elevation value for a station
P or PH Geodetic Position for a station (Grid jobs only)
A Turned Angle
D Distance
V Zenith Angle or Elevation Difference (3D data only)
DV Distance and Vertical (3D Data only)
B Bearing or Azimuth
M Measure (Observations to another network point)
BM BearingMeasure (Observations to another network point)
SS Sideshot (Observations to a sideshot point)
TB Traverse Begin
T Traverse (All observations to next network point)
TE Traverse End
DB Begin Direction Set
DN Direction
DM Direction with Measure Data
DE EndDirection Set
L Differential Level Data

Blank lines in data files are ignored by STAR*NET. They may be inserted anywhere to separate parts of your data tomake the
informationmore readable.

Station Names
The data type code is normally followed by one or more station names. Depending on the type of data line, theremay be up to
three station names.

On a data line that contains a coordinate or elevation value, a single name is present to define the station.

Multiple names are separated by a dash. For example, in a distance or leveling observation line, the station name string
"TOWER-823" defines the FROM and TO stations of the distance observation. Or on a data line that contains a horizontal
turned angle, a station name string such as "TOWER-805-823" includes an additional namewhich defines the backsight sta-
tion.
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Stations can have alphanumeric names up to 15 characters long. Youmay use upper or lower case letters. Case is significant,
so "corner25" and "CORNER25" are recognized as different station names. Although it requires some care, you can actually
mix upper and lower case to create unique station names, or include special characters such as "/", "+" or a decimal point in
names for special identification purposes.

Below are a few examples of "distance" data lines using a variety of station naming schemes we have seen in user’s data files:

D   231-257                      1567.123
D   R3052E-A0144W                1567.123
D   NorthBridge-ChevronTank      1567.123
D   N564.027-T582.033            1567.123
D   NGSBM/CE31-RedBluff3         1567.123
D   H16+50.80-4th&Dearborn       1567.123

Note that since the dash character is used as the separator between station names in station strings, it should not normally be
used within a station name itself. However, if station names in your existing office records include the dash character, and it is
important to continue their use, a special ".SEPARATOR" inline option is available which allows you to change the default sep-
arator character in your data file from the default dash to some other character, perhaps a comma. See "Using Inline Options"
later in this chapter for details on the use of this inline option.

Enter station names in a From-To order for distances, zenith angles, delta elevations, and bearings or azimuths. You can enter
station names for horizontal angles either as At-From-To or From-At-To depending on a setting in the Project Options/General
dialog. You can also use a special ".ORDER" inline option to change the order within the data file so that you can easily include
data that has been prepared perhaps by someone else using a different order. See "Using Inline Options" later in this chapter
for details on the use of this inline option.

Avoid using the following characters within station names: comma, equal sign, the number sign (#), single quote and double
quote. They are reserved for other special purposes. Also avoid using the name "DUMMYnnnn" where "nnnn" is a number.
This name string is reserved by STAR*NET for internal use as dummy stations that define fixed backsight bearings.

Station/Observation Data
Next on the data line comes one or moremeasurements. A measurement might be a distance, angle, direction, zenith angle,
azimuth, bearing, elevation difference, or a coordinate. By default, linear and angular observations are expected to be entered
in same units as set in the Project Options. When your data consists of amixture of units (for example feet andmeters), there
is a special ".UNITS" inline option you can use so that your entered data will be automatically converted to the proper project
units. For details, see "Using Inline Options" later in this chapter.

Angular observations can be entered as DMS or GONS depending on the Angular Units setting in the Project Options. When
entering angular data in DMS, two formats, dash-separated and packed, may be used which ever you prefer:

l D-M-S format is entered like this:123-44-55.66

l Packed format is entered like this:123.445566

Packed format is commonly used by calculators. The format is DDD.mmss where the degrees are to the left of the decimal
point, the first two characters to the right of the decimal areminutes, the next two are seconds, and the remaining are decimals
of seconds. Leading zeros for values of minutes and seconds less than 10 are essential! Below are examples of DMS data
lines using both D-M-S and Packed formats:
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M  A3-A2-A4  123-23-45.6  500   91-00-55  #D-M-S format
M  A3-A2-A4  123.23456    500   91.0055   #Packed format
M  A3-A2-A6  123-20-00    500   89-00-00  #D-M-S format
M  A3-A2-A6  123.2        500   89        #Packed format
B  A5-A8     N55-1-23.4E  !               #D-M-S format
B  A5-A8     N55.01234E   !               #Packed format

Many users prefer to use packed format for hand entering angles because less typing is required, but the D-M-S format is
easier to read. No special setting is required to use this format. When STAR*NET reads an angle, if two "-" separators are
present, it is decoded as a D-M-S angle. Otherwise it is decoded as a packed angle. For consistency, examples in this manual
are illustrated using the D-M-S format.

Angular information entered in GONS is always entered in decimal format. A Bearing line entered using GONS must contain an
Azimuth. Bearings are not used with GONS. Below are two data lines entered using GONS angular units:

M  A3-A2-A4  155.66434  500   102.34255   #GONS Angles
B  A5-A8     68.235824   !                #GONS Azimuth

A positive turned angle (123-23-46.6 or 155.66434) is clockwise and a negative turned angle (-123-23-46.6 or -155.66434) is
counterclockwise.

Zenith angles observed in the "inverted" position (those in the 270 degree range) may be entered, and their inverted values will
be properly handled. For example, a zenith angle entered as 275-30-00 will be handled in the program as if it were 84-30-00, but
it will appear in the data and adjustment listings in its original inverted form so that listings can be easily compared to original
fieldbook information.

As you will see in the next section "Description of Data Format and Content", some data lines are for entering single obser-
vations such an angle or a distance, and others are for enteringmultiple observations such as an angle, a distance and perhaps
a zenith angle. Whether data is entered with single or multiple observation lines, adjustment results will be the same as long as
the observations are the same.

Themain advantage in usingmultiple observation data lines is that data preparation is easier. For example, the name string (At-
From-To) and any HI/HT data are entered only once, but relate to all the observations on the line. Also, for 3D data, a very sig-
nificant advantage to entering the slope distance and zenith anglemeasurements on the same line of data is that these obser-
vations can be automatically reduced to horizontal by STAR*NET if you decide to process the data using a 2D adjustment.

Standard Errors
A "standard error" is a value used to weight an observation. When you enter standard error values on a data line, they always
directly follow the group of observations, one standard error value for each observation. A standard error may be entered as a
numeric value or as a special fixity symbol. The following table explains the various entries.

Entry Explanation
Numeric Value An actual Standard Error value (i.e. 0.03)
Nothing Entered Defaults to the value defined in the instrument options
The "&" Symbol Defaults to the value defined in the instrument options
The "!" Symbol The observation is FIXED
The "*" Symbol The observation is FREE
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Examples of entering explicit standard errors are shown in the next section "Description of Data Format and Content", but in
practice you will likely do this only in special cases. The normal procedure is to enter nothing so that the default instrument set-
tings in the Project Options are assigned. Or, if the "Instrument Library" facility is used, the defaults for a particular weighting
scheme are assigned.

Height of Instrument and Height of Target
When entering 3D data, STAR*NET allows you to input height of instrument (HI) and the height of target (HT) information for
data lines that contain zenith angles, slope distances and elevation differences. The HI and HT information is entered as a
single entry of two values separated by a slash "/" character. For example, if your HI/HT values are 5.65 and 5.25 respectively,
your entry would be 5.65/5.25.

1. You can input an HI/HT entry for zenith angles. If the instrument and target were not at the same height when the zenith
was read, this entry allows STAR*NET to internally correct the angle during adjustment processing.

2. Likewise, you can input an HI/HT entry for slope distances so STAR*NET can internally correct the length of the line for
the HI and HT difference.

3. The HI/HT can also be included with elevation difference readings when the readings have not already been corrected
for the HI and HT difference.

Whenever the HI/HT entry is used, it is always the last element on a data line, except for any possible descriptor. It goes after
the standard error entry, if there is one.

The examples below show a 3D "measure" line, each with HI/HT entries. The second example includes three standard errors
following the three observations, and then directly followed  by the HI/HT entry.

M  1-2-3  123-44-55 1555.666  91-22-33                 5.1/5.3
M  1-2-4  142-33-24 1244.231  89-54-33     3 .05 6     5.1/5.6

Important! Older versions of STAR*NET allowed entering a single HI-HT difference rather that entering both values. For
example, using HI and HT values of 5.1 and 5.3, you could enter a single value of -0.20 using the oldmethod. If the HI was
greater than the HT, the value would be positive. If the HI was less than the HT, the value would be negative. Using this
method, the first line above would look like this:

M  1-2-3  123-44-55 1555.666  91-22-33                  -0.20

To support these old data files, this method is still supported, but it is recommended that it not be used for new data entry.
Entering both values rather than a single HI minus HT difference is preferable because both values are carried through all cal-
culations for curved earth geometry in local jobs, and combined scale in grid jobs, to produce results that aremore correct. Just
as important, entering both values accurately documents the actual instrument/target heights measured in the field!

Point Descriptors
A point descriptor, if entered, is always the last item on a data line. A descriptor may be assigned to any station. A descriptor is
prefixed by a single or double quote character and can be up to 48 characters in length.

Descriptors can be entered on Coordinate or Elevation data lines, Geodetic Positions data lines, or any kind of observation
data line.
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For Traverse lines, the descriptor is assigned to the "AT" station name. For all other kinds of observation lines, the descriptor is
assigned to the "TO" station name. Examples:

C  4      5644.445  6645.526 ! !  'Jones & Taylor
M  2-1-6  38-24-76   963.672      'Descriptor for Sta6
D  2-7    2044.334                'Descriptor for Sta7

Once a descriptor has been assigned to a network station, any subsequent descriptor entered for the same station will be
ignored. Point descriptors are written to the output coordinate file as well as the listing file.

5.6 DESCRIPTION OF DATA FORMAT AND CONTENT
This section describes each STAR*NET input data type, and gives examples of complete data input lines.

Note that in the format description of each type, elements enclosed in square brackets, [ ], are optional.

The codes are broken down into seven sections : (1) Coordinate, Position and Elevation data types; (2) Single Observation
data types; (3) Multiple Observation data types; (4) Traverse data type; (5) Direction Sets data type; (6) Leveling data type, and
the (7) Sideshot data type.

Coordinate, Position & Elevation Data Types
Single Observation Data Types
Multiple Observation Data Types
Traverse Data Type
Direction Set Data Types
Sideshot Data Type
Leveling Data Type

Coordinate, Position & Elevation Data Types (C,P,E,CH,PH,EH)
The "C" Code: Coordinates for a Station

Format for 2D data:

C Station North  East [Std Errors] [Description]

Format for 3D data:

C Station North  East  Elevation [Std Errors] [Description]

By default, STAR*NET expects coordinate data in 2D format for a 2D adjustment, and 3D format for a 3D adjustment. In some
cases, you can enter 3D coordinates into a 2D adjustment, or 2D coordinates into a 3D adjustment using the ".2D" and ".3D"
inline options. Note that a level network is considered “3D” because of the vertical element and therefore by default expects
any entered coordinates to be in a 3D format; if you find it more convenient to enter coordinates in 2D format (as shown in the
tutorial) youmust enter a “.2D” inline option before these coordinate lines so that STAR*NET will interpret the data correctly.
For information about using the “.2D” and “.3D” inline options,  see “Using Inline Options” later in this chapter.

Coordinates can be entered in "NE" or "EN" order depending on your setting in the Project Options/General dialog. You can
change the input order of the coordinates within the data using the inline ".ORDER" option See "Using Inline Options" later in
this chapter for details on the use of these options.
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Coordinates are normally entered as completely fixed so they won’t be adjusted, or as completely free to be adjusted. However
at times youmay wish to enter coordinate values with specified standard error values so that the coordinates are not con-
sidered completely fixed, and will be allowed somemovement. These entered standard errors might be standard deviations res-
ulting of some previous adjustment, or possibly standard deviations supplied along with someGPS points provided by others.
In all cases, standard errors are entered in the same "order" as the coordinates.

Any coordinate component entered with a standard error is considered an observation just like any entered angle or distance.
This "partially fixed" component (Northing, Easting or Elevation) will be counted in the statistics and will show up as an obser-
vation in the "Adjusted Observations and Residuals" section of the Listing file.

Horizontal coordinates (northing and easting values) are not required to perform a level network adjustment. However,
STAR*NET can plot a diagram of your level network if you enter reference horizontal coordinates for every station in your net-
work. A plot helps organize and debug a project allowing you to actually see what stations are connected. These coordinates
do not have to be real-world values – they can be at any scale, perhaps measured from a sketch, or simply estimated. They
play no part in the adjustment and are used only for plotting a diagram. Likewise, the horizontal coordinates do not require stand-
ard errors or fixity characters provided as they play no part in the level adjustment.

Example 1: (2D Data)

C A101 1022.21   1023.78 ‘Iron Bar

Station "A101" has input coordinates given. A setting in the Project Options indicates whether these are NE or EN coordinates.
No standard error values are entered, so the coordinates are assumed  "free" to be adjusted. A descriptor is given.

Example 2:

C A102 1022.21   1023.78 !   ! ‘Found Pipe

Station "A102" has input coordinates given and both are considered "fixed" by use of the "!" symbol. A descriptor is given.

Example 3: (3D Data)

C A103 1000   1000   700

Station "A103" is given 3D coordinates of 1000, 1000 and 700. No standard error values were entered, so they are completely
free to be adjusted. And no descriptor is entered, however some subsequent input data observation linemay define one for it.

Example 4:

C A104 1233.13  1011.78  745.9 !  !  ! ‘GPS Point

Station "A104" has coordinates of 1233.13 and 1011.78, and an elevation of 745.9, all considered fixed by use of the "!" sym-
bol.

Example 5:

C A105 1492   1776   745.29 *   *   ! ‘Benchmark A

Station "A105" has approximate coordinates of 1492 and 1776, which are considered free in the adjustment because of the "*"
symbol. The elevation of 745.29, however, is held fixed by use of the "!" symbol.

Example 6:

C A106 1978.23  1844.76  965.2 0.023   0.03   0.095
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Station "A106" has given coordinates, each with an entered standard error. These standard error values cause the coordinates
to be neither completely free nor completely fixed. These values may be standard deviation values computed from some pre-
vious adjustment, and represent the strength of the coordinates in this adjustment. Therefore these coordinates will be con-
sidered as observations in the adjustment.

C A101 1050 2150
C A101 1050 2150 624.352 * * ! 'Found Pipe

The "P" Code: Geodetic Positions for a Station (Grid Jobs Only)

Format for 2D data:

P Station Latitude Longitude [Std Errors] [Description]

Format for 3D data:

P Station Latitude Longitude Elev [Std Errors] [Description]

When preparing data for grid a job (NAD27, NAD83, UTM, Custom, etc.) youmay enter a Geodetic Position for any station
rather than a grid coordinate. The order of data entered on a "P" line is always latitude followed by longitude and is not affected
by the "NE" or "EN" order specified in the project options for coordinates.

Standard errors entered, however, are not angular standard errors for the Latitude and Longitude values, they are the standard
errors for the corresponding North and East values calculated from the positions. Therefore on a "P" line, the order of the stand-
ard errors is always in NE order to correspond to the latitude and longitude entries and is not affected by the order specified for
coordinates in the project options.

Since STAR*NET uses a coordinate-based system, any entered latitude and longitudes are internally converted to grid coordin-
ates during processing, and the program then adjusts the job just as if these coordinates had been entered in the first place.
Any "partially" fixed latitude or longitude entered with a north or east standard error will be handled as a coordinate observation.
It will be counted in the statistics and will show up as an observation in the "Adjusted Observations and Residuals" section of
the output listing file.

The "Longitude Sign Convention" selected in the project options must be followed when when entering geodetic positions data.
See Chapter 4 for details on this option setting. You can use positive west longitudes (as preferred in the United States and
Canada), or negative west longitudes (as preferred by the international community). Whichever option preference is selected,
that convention controls the interpretation of signs of longitudes for all grid systems, NAD27/83, UTM andCustom!

The following lines illustrate a variety of 2D and 3D Geodetic Positions entries:

Example 1: (2D Data)

P DIABLO 34-22-44.55436  120-23-41.67581

Station "DIABLO" has the given latitude and longitude values. No standard error values or fixity codes are entered, so the 2D
grid coordinates created by these geodetic positions will be assumed completely free to be adjusted. Note that the longitude is
entered as a positive value. If the "PositiveWest Longitudes" sign convention preference in the project options is selected, this
longitudemeans west of Greenwich. If the "NegativeWest Longitudes" preference is selected, this longitudemeans east of
Greenwich.

Example 2: (3D Data)

P 2001 33-45-22.3665  -14-24-55.6658  733.25 !  !  !
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Station "2001" has latitude and longitude values given plus an elevation. Since all items are entered as fixed, all the resulting
3D coordinates (grid coordinates and elevation) will be fixed in the adjustment. Note the longitude is negative. Its meaning will
be interpreted based on the "Longitude Sign Convention" project option settingmentioned above.

Example 3:

P X3 34-22-44.554  120-23-41.671  733.25 0.02  0.015  ! ‘GPS 073

The resulting north and east grid coordinates created by this entry will be assigned standard errors of 0.020 and 0.015 respect-
ively. The elevation will be held fixed.

The "E" Code: Elevation for a Station

This entry is for 3D data only:

E Station Elevation [Std Error] [Description]

This data type allows you to assign an elevation to a station. The elevationmay be fixed, free or partially fixed depending on
what is entered for the standard error field.

The "E" data type is useful when you wish to specify an elevation, but leave the horizontal coordinates to be determined some
other way, either by manual entry or by letting the program calculate them. For example, you can enter a list of fixed benchmark
elevations, but leave the northings and eastings to be calculated by the program.

Example 1:

E 301 982.53

Station "301" is assigned an elevation of 982.53. No standard error values or fixity symbol is entered, so the elevation will be
assumed completely free to be adjusted.

Example 2:

E 302 845.25 ! ‘Benchmark 105

Station "302" is assigned an elevation of 845.25. This elevation will be held fixed.

Example 3:

E Doug 1256.5 0.015 ‘GPS E007

An elevation for "Doug" is entered with a given standard error. The elevation will be considered an observation. It will be coun-
ted in the statistics and will show up in the "Adjusted Observations and Residuals" section of the output adjustment listing file.

Using "CH", "PH" and "EH" Codes: Specifying Ellipsoid Heights

This data type causes the entered elevation value to be taken as an ellipsoid height rather than an orthometric elevation. The
data format is identical to the "C", "P" and "E" formats, except the appended "H" causes the alternate interpretation of the elev-
ation value. This data type is particularly useful in the STAR*NET-PRO edition where ellipsoids heights are commonly used in
networks containing GPS vectors.

This entry is for 3D grid data:

CH Station North   East   Ellipsoid Height [Std Errors] [Description]
PH Station Latitude   Longitude   EllipsoidHeight [Std Errors] [Description]
EH Station EllipsoidHeight [Std Error] [Description]
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Example:

PH 335 33-22-44.123  120-24-41.122  835.32 !  !  ! ‘GPS BM335

Point "335" has given latitude and longitude values, plus an ellipsoid height of 835.32. See Chapter 10, "Adjustments in Grid
Coordinate Systems" for more details on grid systems, and the use of ellipsoids heights and orthometric elevations.

Single Observation Data Types (A,D,V,B)
The following types of data lines are used to define a single measurement: an angle, a distance, a vertical observation, or a
bearing or azimuth.

The "A" Code: Horizontal Angle

A At-From-To Angle [Std Error]

Stations defining an angle can be entered as At-From-To or From-At-To. You indicate which order you have chosen by a setting
in the Project Options. Youmay also change the input order anytime in your data using the inline ".ORDER" option.

Example 1:

A 3-2-4 102-34-12.5 2.5

The clockwise horizontal angle at station "3", turning from station "2" to station "4" is 102-34-12.5, and its standard error is 2.5
seconds.

Example 2:

A 3-2-4 102-34-12.5

Same as above, except that no standard error is entered. The default standard error for angles as set in the Project Options is
used.

Example 3:

A 3-2-4 102-34-12.5 ! ‘POST

Same as above, except the angle will be held fixed in the adjustment because of the "!" symbol entered as the standard error. A
descriptor is assigned to station "4."

Example 4:

A 3-2-4 -102-34-12.5

This illustrates entering a counter-clockwise angle (entered negative).

The "D" Code: Distance

Format for 2D Data:

D From-To Horizontal Distance [Std Error]

Formats for 3D Data - Depending on the "Distance/Vertical Data Type" mode:

D From-To Slope Distance [Std Error] [HI/HT]
D From-To Horizontal Distance [Std Error]
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Example 1: (When entered as 2D Data)

D Roger-Frank 1034.23 0.05

The horizontal distance between stations "Roger" and "Frank" is 1034.23. A standard error value of is 0.05 is entered.

Example 2: (When entered as 2D Data)

D 211-212 342.45

The horizontal distance between "211" and "212" is 342.45. No standard error is given, so the default standard error for dis-
tances set in the Project Options is used.

Example 3: (When entered as 3D Data)

D 211-212 342.45 5.4/5.1

The slope distance between "211" and "212" is 342.45. There is an HI/HT entry made indicating that height of instrument is 5.4
and the height of target is 5.1.

Note that when only a standard error or an HI/HT is given, as in the example above, the program checks for a "/" character to
determine if the item is an HI/HT entry.

The "Distance/Vertical Data Type" option, in the Project Options can be set so that the distance value is interpreted as a Slope
distance or Horizontal distance. Themode of the "Distance/Vertical Data Type" can also be changed anywhere in your data file
by using the ".DELTA ON/OFF" inline option. This mode setting also affects vertical observations as discussed next. For more
details see "Using Inline Options" later in this chapter.

The "V" Code: Vertical Observation

Formats for 3D Data Only - Depending on the "Distance/Vertical Data Type" mode:

V From-To Zenith [Standard Error] [HI/HT]
V From-To Elevation Difference [Standard Error] [HI/HT]

Example 1: (Zenith Angle)

V oak-new 91-23-45.0 10.0 5.4/5.1

The zenith angle from "oak" to "new" is 91-23-45.0. The standard error of the zenith is 10.0 seconds. The height of instrument is
5.4 and the height of target is 5.1.

Example 2:

V oak-new 91-23-45.0 5.4/5.1

Same as above except no standard error value is entered, so the default zenith standard error is applied. An HI/HT entry is
made, and as previously described, when only a standard error entry or an HI/HT entry exists, the program checks for a "/" char-
acter to determine if the item was an HI/HT entry.

Example 3:

V 1022-1021 89-45-23.5

The zenith angle from "1022" to station "1021" is 89-45-23.5 and the default standard error for zeniths will be applied. The HI
and HT are both assumed 0.0.
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Example 4:  (Elevation Difference)

V post-pipe 13.46

In this case, the "Distance/Vertical Data Type" setting in the Project Options dialog is set such that the value is interpreted as
an elevation difference. The elevation difference from "post" to "pipe" is 13.46. (Station "pipe" is higher than station "post".) The
mode of the "Distance/Vertical Data Type" can also be changed anywhere in your data file by using the ".DELTA ON/OFF"
inline option. See "Using Inline Options" later in this chapter for details.

The "B" Code: Bearing or Azimuth

B From-To Bearing or Azimuth [Standard Error]

Example 1:

B tower-flagpole N34-23-45.7E !

The bearing from "tower" to "flagpole" is N34-23-45.7E. The bearing will be fixed in the adjustment because of the "!" symbol.
Bearings are distinguished from azimuths by the presence of an "N" or "S" at the beginning and "E" or "W" at the end.

Example 2:

B 5660-5661 243-43-46 20

The azimuth from station "5660" to "5661" is 243-43-46 and it has an entered standard error of 20 seconds. This might, for
example, represent data entered for an observed solar azimuth.

Example 3:

B 1022-1023 111-23-14.0

The azimuth from "1022" to "1023" is 111-23-14.0. The standard error defaults to the standard error for bearings and azimuths
as set in the Project Options.

Example 4:

B 51-52 150-33-44 *

The azimuth from "51" to "52" is 150-33-44 but is set free using the "*" symbol. A "free" observation will not influence the res-
ults of an adjustment, however its residual  (the difference between the entered and the adjusted observation) will be shown in
the listing file.

Setting a specific observation free is a technique often used when trying to isolate suspected blunders in a network adjust-
ment.

Sample Data Using Single Observation Data Types

The following example illustrates the use of some of the observation data types discussed so far. The observations are for a
simple 2D network using distances and angles. The network has four stations. One of the stations is fixed, a bearing is fixed
between two of the points, and some of the observations have explicit standard error values entered. Note that with the single
station coordinates given, plus a fixed bearing adjacent to that tion, STAR*NET has enough information to automatically com-
pute approximate coordinates for the remaining stations. The order in which these lines of data are enteredmakes no difference
in the results of an adjustment.
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# Fixed Coordinates
C   1     503991.197   495316.983  ! !
# Fixed Bearing
B   1-2   N45-00-00W  !
# Angles
A   4-3-2   48-42-06
A   4-2-1   34-14-04
A   1-4-3   44-32-07
A   1-3-2   47-54-01
A   2-1-4   53-19-16   9.5
A   2-4-3   45-04-01   9.5
A   3-2-1   33-42-29
A   3-1-4   52-31-13
# Distances
D   1-4   542.891
D   1-3   678.944
D   2-4   676.289
D   2-3   509.180   0.035
D   4-3   479.810
D   2-1   380.931

Multiple Observation Data Types (M,BM,DV)
The "M" Code: Measure - All Measurements to Another Station

Format for 2D Data:

M At-From-To Angle  Distance [Std Errs]

Formats 3D Data - Depending on the "Distance/Vertical Data Type" mode:
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M At-From-To Angle   Slope Dist   Zenith [Std Errs] [HI/HT]
M At-From-To Angle   Horiz Dist   Elev Diff [Std Errs] [HI/HT]

TheMeasure data type is used for entering all the angular and distance information from one station to another station in a sur-
vey network. TheMeasure data type can be used alone to completely define a network, or it can be used along with any other
data type discussed in this chapter. It is particularly useful when used along with the Traverse data type discussed later in this
chapter to add in extra shots and cross ties.

TheMeasure data line contains the three station names used for themeasurement in either an At-From-To or From-At-To order,
as specified in the Project Options. Measure data includes ALL observations required to completely define another station, a
turned angle, a distance, and if entering 3D data, a vertical observation. The distance and vertical information in 3D datamay
be either a Slope Distance and Zenith Angle, or a Horizontal Distance and an Elevation Difference, depending on the setting of
the "Distance/Vertical Data Type" option in the Project Options/General dialog. Themode of the "Distance/Vertical Data Type"
can also be changed anywhere in your data file by using the ".DELTA ON/OFF" inline option. See "Using Inline Options" later
in this chapter for details.

If a descriptor is added to the end of ameasure line, it is assigned to the "TO" station.

For simplicity, the examples below all use the At-From-To angle format.

Example 1: (2D Data)

M 2-1-3 12-34-13   1102.42 ‘Found Iron Pipe

The horizontal angle at station "2", backsighting station "1" and turning clockwise to station "3" is 12-34-13, and the horizontal
distance from "2" to "3" is 1102.42. Default standard error values are assumed for both.

Example 2: (2D Data)

M 2-1-3 12-34-13   1102.42 5      .03

Here themeasurements are the same as before, but we have added explicit standard error values for the angle and distance of
5 seconds and .03 respectively.

Note that youmust either enter two standard errors for the two observations on a data line, or  none and let them all default to
the global values.

Standard errors may be entered as explicit values or as any of the special codes previously discussed: "!" to fix the obser-
vation, "*" to free it or "&" to cause the default standard error as set in the Instrument Options to be assigned.

Example 3: (3D Data with Slope Distance and Zenith Angle)

M 2-1-3 12-34-13   1102.42   89-13-12

The horizontal angle at "2", turning from station "1" to station "3", is 12-34-13. The slope distance and zenith angle from "2" to
"3" are 1102.42 and 89-13-12 respectively. Default standard errors are assumed for all themeasurements. The "Distance/Ver-
tical Data Type" option was set to the "Slope Dist/Zenith" choice since we are entering zenith angles, not elevation dif-
ferences.

Example 4: (3D Data)

M 2-1-3 12-34-13   1102.42   89-13-12 5.25/5.55
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Themeasurements are the same as above, but we have added an HI/HT entry, meaning an HI value of 5.25 and an HT value
of 5.55. Note that a single entry following themeasurements which contains a "/" is interpreted by the program as an HI/HT
entry.

Example 5: (3D Data)

M 2-1-3 12-34-13   1102.42   89-13-12 4    &    10

Here again, themeasurements are the same, but we have added standard error values for themeasurements to the line. The
standard error values are 4 seconds for the horizontal angle, default value for slope distance, and 10 seconds for zenith angle.
Note that three values are entered following themeasurements as shown above, one value for each observation.

Example 6:  (3D Data)

M 2-1-3 12-34-13   1102.42   89-13-12 &    .03    10 5.25/5.55

Again, the samemeasurements, but now we have standard error values, plus an HI/HT entry. Note that when four values are
entered following the 3D measurements as shown above, they are interpreted as three standard errors plus an HI/HT value.

As illustrated by the example 3D data lines above, youmust either enter all three standard errors on a data line, or leave them
all out so that defaults are assumed. A single item entered will be read as an HI/HT, three items as three standard errors, and
four items as the three standard errors plus an HI/HT entry. Any other combination will cause an error message.

Example 7: (3D Data with Horizontal Distance and Elev Difference)

M 2-1-3 12-34-13    1102.31    15.22 5.2/5.1

In this example, the "Distance/Vertical Data Type" option in the Project Options has been set to "Horiz Dist/Elev Diff." The hori-
zontal angle does not change, but now the distance from station "2" to station "3" is a horizontal value of 1102.31, with a dif-
ference in elevation of 15.22. (Station "3" is higher than station "2.") Default standard errors are assumed for all measurements.
An HI/HT entry is included.

Example 8: Using the Special "?" Data Code

M 33-32-55 95-38-44.5    ?    ? 4.5  &  &
M 8-DUMMY-5 ?     1502.55    93-44-52 5.25/5.10

The questionmark character "?" may be used in ameasure line to indicate that a particular item is missing (or not measured).
The "?" code allows the "M" line to be used for entering a variety of data types, making it helpful to users writing programs that
create STAR*NET data files.

In the first line above, the only observation defined is an angle, exactly the same as if an "A" data type line had been entered
instead. In the second line, we entered values only for a distance and zenith angle, omitting the angle. These readings, for
example, might be thosemade for a backsight observation. Note that the string At-From-To is entered as "8-DUMMY-5." Since
the turned angle entry is omitted, the backsight name is never used, and can be named anything. We chose the name
"DUMMY" to use here. This entry is exactly the same as if a "DV" data type line as described in a later section had been
entered instead.

The "BM" Code: Bearing and Measurements to Another Station

Format for 2D Data:

BM From-To Bearing (or Azimuth)  Distance [Std Errs]

Formats 3D Data - Depending on the "Distance/Vertical Data Type" mode:
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BM From-To Bearing (or Az)  Slope  Dist   Zenith [Std Errs] [HI/HT]
BM From-To Bearing (or Az)  Horiz  Dist   Elev Diff [Std Errs] [HI/HT]

The "BM" data line is identical to the standard "M" data line except that it contains a bearing or azimuth value rather than an
angle. The station string contains only the "From-To" stations rather than the "At-From-To" stations required for an angle.

This data line type is particularly useful for setting a point when a bearing or azimuth (rather than a turned angle) is known to the
target station.

Just as with the "M" data line, the distance and vertical information in 3D datamay be either a Slope Distance and Zenith
Angle, or a Horizontal Distance and an Elevation Difference, depending on the setting of the "Distance/Vertical Data Type"
option in the Project Options. And themode can also be changed anywhere in your data file by using the ".DELTA ON/OFF"
inline option.

The examples shown below illustrate 2D and 3D data lines, one with a bearing and the other with an azimuth.

Example 1: (2D Data)

BM 5-88 N32-44-52.5   1245.425 !   ! ‘Mark 887

The bearing and distance from "5" to "88" are both given, and both will be fixed in the adjustment because of the "!" fixity sym-
bols assigned to each.

Example 2: (3D Data with Azimuth, Slope Distance and Zenith Angle)

BM 44-42 23-33-46.7   1102.42   89-13-12 2  &  &

The azimuth from "44" to "42" is 23-33-46.7 and it is given a standard error of 2.0 seconds. The distance and zenith angle
entries will be assigned the default standard errors as defined in the project options.

The "DV" Code: Distance and Vertical Measurements to Another Station

Formats 3D Data Only - Depending on the "Distance/Vertical Data Type" mode:

DV From-To Slope Distance   Zenith [Std Errs] [HI/HT]
DV From-To Horiz Distance   Elev Diff [Std Errs] [HI/HT]

This data type has been provided to enter distance and vertical observations. It is often used to enter the extra distance and ver-
tical information recorded when the surveyor takes a backsight reading.

The distance and vertical datamay be either a Slope Distance and Zenith Angle, or a Horizontal Distance and Elevation Dif-
ference, depending on the "Distance/Vertical Data Type" option setting in the Project Options. The "Distance/Vertical Data
Type" mode can also be changed anywhere in the data file by using the ".DELTA ON/OFF" inline option. For more details see
"Using Inline Options" later in this chapter.

Example 1: (Slope Distance and Zenith Angle)

DV 8-5 1102.42    93-44-52 5.25/5.10

The slope distance and zenith angle between "8" and "5" is 1102.42 and 93-44-52. Default standard errors are assumed. An
entry is made defining HI and HT values.

Example 2: (Horizontal Distance and Elevation Difference)

DV 27-28 554.7    -14.2 0.04   & 5.25/5.10
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In this example, the "Distance/Vertical Data Type" option in the Project Options has been set to "Horiz Dist/Elev Diff." A hori-
zontal distance and elevation difference between "27" and "28" is 554.7 and -14.2. We have entered optional standard errors for
the observations as well as an HI/HT entry.

Note that youmust either enter two standard errors for the two observations on a data line, or  none so that defaults are
assumed. A single item will be read as an HI/HT, two items as two standard errors, and three items as the two standard errors
plus an HI/HT entry. Any other combination will cause an error message.

Traverse Data Types (TB,T,TE)
The Traverse data type allows you to quickly traverse from point to point in a traditional manner, with aminimum of data entry.
Theremay be as many traverses as required within a project data file. Each traversemust begin with a single "TB" line, con-
tinue with one or more "T" lines, and end with a single "TE" line. The format of the Traverse line is described below, followed
later by descriptions of the Traverse Begin and Traverse End lines.

The "TB" Code: Beginning a Traverse

Begin a traverse by entering either a backsight station name, or a fixed backsight bearing or azimuth. When you enter a bearing
or azimuth, always enter it in a direction away from the first traverse station. An optional "Traverse Description" will display as
a traverse description in the "Traverse Closures" section of the listing.

TB BS Station Name ['<Traverse Description>]

TB BS Bearing (or Azi-
muth) ['<Traverse Description>]

Example 1:

TB 25   ‘Smith Ranch Road to South Creek

In this example, we begin the traverse by backsighting to station "25", another station in the network. A description is entered
to identify the traverse in the output listing.

Example 2:

TB S30-42-15W   ‘South Creek to Leland

Here we begin the traverse by entering a backsight along a fixed bearing rather than to another station in the network. An
optional traverse description is entered.

Traverse datamay also be entered using "Bearings" or "Azimuths" rather than turned angles using the ".MAPMODE" inline
option. When used in conjunction with ".MAPMODE ON" the TB record should contain neither the backsight direction nor the
backsight station name. When used in conjunction with ".MAPMODE ON ANGLECALC" the TB record should contain both
the backsight direction and the backsight station name. See "Using Inline options" later in this chapter for details on the use of
this special mode of data entry.

Internally, STAR*NET generates a dummy backsight station for each data line of this type, beginning with DUMMY0001. The
dummy station is located at an arbitrary distance of 1000 units (feet, meters, etc.) from the first traverse point along the back-
sight bearing or azimuth. You will see these stations in the angle observation summary, but they do not appear in the plot files
or the output coordinate file. You cannot use these dummy stations for any purpose in your data.

In the "TB" line, the data item is either a station name, or a bearing (or azimuth) value. If the item contains dashes and can also
be interpreted as a valid bearing or azimuth, then it is used as such. Otherwise, it will be used as a station name.
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When you enter a bearing or azimuth using "packed" DMS format or GONS, youmust prefix the entry with the characters "B="
or "b=" so that STAR*NET will not interpret it as a station name. Examples: B=S30.4215W or B=44.1135.

It is generally preferable to backsight to an "actual" station in the network as shown in the first example rather than having
STAR*NET create a "dummy" station at a given bearing but an arbitrary distance away. You can easily create your own back-
sight station using one of several data types – by using the "BM" data line for example.

The "T" Code: Traverse - All Measurements to Next Traverse Point

Format for 2D Data:

T At Angle   Distance [Std Errs]

Formats for 3D Data - Depending on the "Distance/Vertical Data Type" mode:

T At Angle   Slope Dist    Zenith [Std Errs] [HI-HT]
T At Angle   Horiz Dist    Elev Diff [Std Errs] [HI-HT]

The following example shows the organization of the data for a small 2D traverse. In data files containingmultiple traverses,
each traversemust be ended before beginning another. Measure lines and other data types, however, can be freely intermixed
with Traverse lines to define other independent angle or distance observations.

# Simple traverse data
#
TB  5                       # Backsight on 5
T   7   100-00-00  100.00   # Start at 7, traverse to 9
T   9   240-00-00  150.00   # At  9, traverse to 10
T   10   78-50-00   85.00   # At 10, traverse to 15
TE  15                      # End at 15

Regarding output of traverse observations, the individual observations are shown in the listing file just like observations from
other data type lines. However, if you have set the option in the Project Options/Listing dialog to include traverse closures in
your output, an additional section is created in the listing file showing a summary of each traverse along with its closure errors
and precisions. See Chapter 8, "Analysis of Adjustment Output," for further information on this.

Data entries for the Traverse line are the same as for theMeasure line, except the traverse line contains only the "At" station
name. The Traverse data line includes all the observations required to completely define the next traverse point. The horizontal
angle is measured from the previous traverse point to the next traverse point. All other measurements (distance and vertical
observations) are taken to the next traverse point.

Traverse datamay also be entered using "Bearings" or "Azimuths" rather than turned angles using the ".MAPMODE" inline
option. See "Using Inline options" later in this chapter for details on the use of this special mode of data entry.



Chapter 5: Preparing Input Data

- 83 -

Example 1: (2D Data)

T 2 12-34-12    1102.42 ‘Found Iron Pipe

At station "2" we turn an angle of 12-34-12 from the previous traverse point andmeasure a distance of 1102.42 to the next tra-
verse point. No standard errors values are entered, so global defaults are assumed. A descriptor is entered for station 2.

Example 2: (2D Data)

T 2 12-34-12     1102.42 4     .03

Same 2D data as example 1, except we have added explicit standard error values of 4 seconds for the turned angle and .03 for
the distance.

Example 3: (2D Data)

T 2 12-34-12     1102.42 4     !

Same as example 1, except we have added an explicit standard error value of 4 seconds for the turned angle and we have fixed
the distance using the "!" symbol.

Example 4: (3D Data with Slope Distance and Zenith Angle)

T 8 55-34-22   1255.25   89-25-58

At station "8" we turn an angle of 55-34-22 from the previous traverse point andmeasure a slope distance of 1255.25 and a
zenith angle of 89-25-58 to the next traverse point. Default standard errors are assumed for all measurements.

Example 5: (3D Data with Slope Distance and Zenith Angle)

T 8 55-34-22   1255.25   89-25-58 4   0 .03    10 5.1/5.9

Same as example 4, except standard error values are entered for all observations, as well as an HI/HT entry.

As previously discussed for the 3D Measure data type, youmust either enter all standard errors on a particular data line, or
leave them all out so that defaults are assumed. A single item will be taken as an HI/HT, three items as three standard errors,
and four items as the three standard errors plus an HI/HT entry. Any other combination will cause an error message.

Example 6: (3D Data with Horizontal Distance and Elev Difference)

T 8 55-34-22    1255.25    12.43 4   0.03   .075

In this example, the "Distance/Vertical Data Type" option in the Project Options has been set to "Horiz Dist/Elev Diff". The hori-
zontal angle remains the same, but a horizontal distance of 1255.25 and a difference in elevation of 12.43 are entered. Explicit
standard errors have been entered for all three observations.

Example 7: (3D Data with Horizontal Distance and Elev Difference)

T 8 55-34-22    1255.25    12.43 5.0/5.85

Same observations as above, except an HI/HT entry is entered which, in the case of horizontal distance and elevation dif-
ference observations, will only affect the elevation differencemeasurement.

The "TE" Code: Ending a Traverse

You can end a traverse by simply closing to an existing station. You can also end a traverse and include a closing angle to
either a particular station, or to a fixed bearing or azimuth. When you enter a fixed bearing or azimuth value, it is always entered
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in a direction away from the ending traverse station. Use one of the following formats:

TE End Station Name
TE End Station Name Close Angle    Close Station [Std Error of Angle]
TE End Station Name Close Angle    Close Bearing [Std Error of Angle]

Example 1:

TE 15

The traverse ends at station "15". No closing angle is entered for the traverse.

Example 2:

TE 15 125-13-26        24 5.0

The traverse ends at "15." A closing angle of 125-13-26 was turned from the previous traverse station to station "24". The angle
has a standard error of 5.0 seconds.

Example 3:

TE 15 125-13-26     N45-10-36E

The traverse ends at station "15" and a closing angle of 125-13-26 was turned into a fixed bearing of N45-10-36E. No standard
error was entered for the closing angle, therefore the default standard error for angles is assumed. As discussed in the previous
section, a dummy foresight station will be generated for this fixed bearing.

In the "TE " line, the target of the angle observation is either a station name, or a bearing (or azimuth) value. If the item contains
dashes and can also be interpreted as a valid bearing or azimuth, then it is used as such. Otherwise, it will be used as a station
name.

When you enter the bearing or azimuth using "packed" DMS format or GONS, youmust prefix the entry with the characters
"B=" or "b=" so that STAR*NET will not interpret it as a station name. Examples: B=S30.4215W or B=44.1135.

Example Traverse using 3D Traverse and Measure Data

The following example illustrates a very simple single loop 3D traverse with four stations, and two independent shots to two
additional stations. Note that since the fixed bearing from 3 to 2 is not adjacent to the given coordinates at station 1, we
provided approximate coordinates at an adjacent station 4 so that the remaining approximate coordinates could be auto-
matically computed.
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C   1    5000   5000   900  ! ! !
C   4    5000   5300   970
#
# Hold Bearing from 3 to 2
B  3-2    N75-02-21W  !
#
# Traverse Data
TB 4 'Albert B. Cadwell Boundary
T  1      -90-00-00   274.00   85-14-00  5.25/5.24
T  2      -75-00-00   311.10   82-50-00  5.22/5.24
T  3     -105-00-00   193.50   93-28-00  5.20/5.21
M  3-2-5   75-00-00   100.00   90-00-00  5.20/5.18
M  3-2-6  165-00-00    75.00   90-00-00  5.20/5.22
T  4      -90-00-00   302.30   99-30-00  5.25/5.21
TE 1

Example Interconnected 2D Traverses

This example illustrates a small project with two interconnected 2D traverses. The first traverse begins with a fixed bearing,
and has known coordinates at each end. The second traverse begins on the first traverse, and ends at the same station the first
traverse ended, and with a closing angle turned to another station. An extra distance tie measured between the traverses adds
some redundancy.
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# Sample Multi-Loop Traverse Data
#
C   1    5000.00    5000.00   !  !
C   5    4427.12    7245.55   !  !
#
TB  N45-30-40W                 # Backsight to fixed bearing
T   1   123-40-28   537.52
T   2   217-11-37   719.56
T   3   113-52-15   397.66
T   4   260-19-24   996.23
TE  5                          # End traverse at 5
#
TB  1                          # Backsight to 1
T   2   120-11-12   473.25
T   6  -101-32-30   625.76
T   7   198-13-09   533.66
T   8   172-07-27   753.22
T   9   -84-32-20   661.01
TE  5   -73-02-46     4        # End, turn angle to 4
#
D   4-8   361.30               # Extra distance tie

Direction Set Data Types (DB,DN,DM,DE)
The direction set data type lets you enter sets of directions observed from a station to two or more other stations. Directions
are not angles, they are simply pointings or plate readings taken with an instrument such as a direction theodolite.

The direction set computes an internal orientation value that provides the correlation among all of the direction readings. As
such, direction sets that contain nomeasurement to a known or connected point will be unable to compute a position for their
points.

The "DB", "DN" and "DE" Codes: Direction Sets

The direction set data types includes three types of data lines. A set always begins with a "DB" line, continues with two of
more "DN" (or "DM") lines which are the readings, and ends with a "DE" line. An optional "Description" on the "DB" line will dis-
play as a description in the "Directions" sections of the output listing.

DB From Station Name [Direction Set Description]
DN To Station Name Direction [Standard Error]
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DE

Example of the Direction Begin "DB" data line:

The "DB" data line begins a set of direction readings, and indicates the "From" station name. This is the instrument station
used to observe the series of directions. In this example we begin a series of direction entries by setting up on "Post1." An
optional description is entered describing the direction set.

DB Post1    ‘Coyote Dam pins shot from control point 1

Example series of Direction "DN" data lines:

The "DN" data line is used to enter the individual direction readings in the set. In the example we entered a set of three dir-
ections. The first direction to station "A004" was read as 02-33-54. No standard errors were entered for any of the readings,
therefore the default standard error values for directions, as set in the Project Options are assigned. A descriptor is assigned to
station "A006."

DN A004 02-33-54
DN A005 34-56-11.6
DN A006 135-44-23 ‘Marker 700-98

Example of Direction End "DE" data line:

The "DE" data line is used simply to end a set of directions, and contains no data.

DE

The "DM" Code: Direction with All Measurements to Another Station

The "DM" data type is used in the same fashion as the "DN" data type. The difference between the two data types is that the
"DM" line includes all other measurement data needed to define the station being shot. This includes the distance, and if enter-
ing 3D data, a zenith angle or elevation difference.

You can intermix "DM" lines and "DN" lines in the same direction set.

Format for 2D Data:

DM To Sta Name Direction  Distance [Std Errs]

Formats for 3D Data - Depending on the "Distance/Vertical Data Type" mode:

DM To Sta Name Direction   Slope Dist   Zenith [Std Errs] [HI/HT]
DM To Sta Name Direction   Horiz Dist   Elev Diff [Std Errs] [HI/HT]

Typical Example: (3D Data with Slope Distance and Zenith Angle)

DM 3 12-34-13   1346.33   91-55-31 5.25/5.55

Pointing to "3", the direction reading is 12-34-13. The slope distance and zenith anglemeasured to "3" are both given. Default
standard errors are assumed for all themeasurements and an HI/HT entry is made.

Only a single typical 3D example of a "Direction with Measurements" line is given above. The rules for entering 2D and 3D data
lines for these data type lines are exactly the same as those previously discussed for the "M" Measure data line.
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See the "M" data type line for full details on 2D and 3D data, entering standard errors, and entering instrument and target
heights. Likewise, the same rules apply for the interpretation of distance and vertical observation data entered depending on
themode setting of the "Distance/Vertical Data Type" option in the Project Options. This mode can also be changed anywhere
in your data by using the ".DELTA ON/OFF" inline option. For more details see "Using Inline Options" later in this chapter.

Example Direction Set

The example below shows part of a 2D data file that includes the someDirections data. This particular example illustrates that
direction datamay be entered anywhere, even conveniently embedded within traverse data so as to preserve fieldbook order.
The sample data uses both the "DN" and "DM" codes within the same direction set.

# Sample Direction Set Data Using Both "DN" and "DM" lines
#
C   110  10000.00  10000.00  ! !
C   100   9904.53   9821.32  ! !
TB  100                        # Traverse, backsight 100
T   110 –62-32-55    589.34
T   111  85-28-00    775.19

DB  111                        # At 111 begin reading directions
DN  7    00-59-31              # Direction to 7
DN  6    08-44-11              # Direction to 6
DM  5    22-27-18    753.55    # Direction & Distance to 5
DM  4    33-10-11    726.78    # etc...
DN  3    38-31-19
DE                             # End the direction set         

T   2    85-58-33    157.33    # And continue traversing
T   3   132-11-24     87.54
T   4   220-16-43    142.44
T   5   116-38-12    210.24
T   6   236-00-00     98.03
T   7   121-22-55    401.21
TE  110

Using Reverse-Face Observations
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While a zenith angle can be entered for 3D direction set data, it is important to remember that the horizontal component of the
set is entered as a direction and not a horizontal angle. The direction relations in face two are the same as in face one.

A set can contain face-one and/or face-two plate readings, and there is no need to separate them. They will be automatically
recognized as Face-1 or Face-2 and adjusted together. A zenith angle is required for automatic recognition of Face-1 and Face-
2 values. Without a zenith angle (ie. 2D project, Distance/Vertical Data Type entry, .DELTA ON) all horizontal angles will be
treated as though they are Face-1.

Note that would be invalid to mathematically convert the face-two horizontal plate readings to their equivalent face-one values
in order to combine both into a single direction set. Doing so would assume that there is no systematic error in flipping the
scope which is not true, and the residuals would be exaggerated by doing this.

The example below shows part of a 3D data file that includes the someDirections data. This particular example illustrates that
both Face-1 and Face-2 data can be provided, with each face entered within a separate direction set.

# Sample Direction Set Data Using Both Face-1 and Face-2 DM lines
#
C   1    1000.00  1000.00  100.00  ! ! !
B   1-2  90-00-00  !

DB 1 # Direction set for Face-1 measurements
DM 3 30-00-00 125.00 90-00-00
DM 2 90-00-00 100.00 90-00-00
DE

DB 1 # Direction set for Face-2 measurements
DM 3 210-00-00 125.00 270-00-00
DM 2 270-00-00 100.00 270-00-00
DE                            

The example below shows part of a 3D data file that includes the someDirections data. This particular example illustrates that
both Face-1 and Face-2 data can be provided and placed in the same direction set.

# Sample Direction Set Data Using Both Face-1 and Face-2 DM lines
#
C   1    1000.00  1000.00  100.00  ! ! !
B   1-2  90-00-00  !

DB  1    # Mixed Direction Set with Face-1 and Face-2 measurements
DM  3    30-00-00    125.00    90-00-00
DM  3   210-00-00    125.00   270-00-00
DM  2    90-00-00    100.00    90-00-00
DM  2   270-00-00    100.00   270-00-00
DE                            

Note that mixed-face direction sets are not possible if .NORMALIZE OFF is specified, in this case the two faces must be sup-
plied in separate sets as shown in the first example above.

Sideshot Data Type (SS)
The Sideshot data type allows you to add unlimited sideshots to your data without affecting processing of the network stations
from which they were observed. The format is the same as the "Measure" line except that standard error values are not
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entered.

Sideshots are diverted during loading of the input data file, and are not processed until after the network is adjusted. Because
they are processed after the adjustment is finished, they do not affect the adjustment results. No error propagation is performed
on sideshots. The sideshot data type is included so that you can process a network containing hundreds or thousands of
sideshots without slowing down the network adjustment. This approach lends itself to the processing of large data sets down-
loaded from data collectors.

You cannot occupy a sideshot point or backsight to a sideshot! Only main network stations may be occupied or used as back-
sights! Multiple sideshots to the same point are not adjusted – you will get multiple sets of coordinates published for that point.

Note that a sideshot station namemay have the same name as a network station or any other sideshot. However, you can
instruct STAR*NET to check these sideshot names against network station names and/or against other sideshot names and
issue warning or error messages if repeated names are found. See "Special Options" in Chapter 4 for setting of these sideshot
name checking options.

The "SS" Code: Sideshot (All Observations to a Sideshot Point)

Format for 2D Data:

SS At-From-To Angle  Distance   ['Description]

Formats for 3D Data - Depending on the "Distance/Vertical Data Type" mode:

SS At-From-To Angle   Slope Distance    Zenith   [HI/HT] ['Description]
SS At-From-To Angle   Horiz Distance    Elev Diff [HI/HT] ['Description]

Example: (3D Data with Slope Distance and Zenith Angle)

SS A33-A4-72 153-21-44   874.5   91-22-54 5.25/5.90 ‘Lone Pine

The data above is a 3D sideshot. With the instrument at A33, backsighting to A4, a shot was made to station 72 reading an
angle of 153-21-44, a slope distance of 874.5 and a zenith angle of 91-22-54. An HI/HT entry and a point descriptor are
included.

Leveling Data Type (L)
The leveling data type defines differentially leveled observation information for use in STAR*NET-LEV as well as for Lev-only
adjustments in the PLUS and PRO editions. This data type is also used to integrate leveling observations in with 3D adjust-
ments in the Standard, PLUS and PRO editions as described in themain STAR*NETmanual.

Leveling observations are similar to "elevation difference" observations which are entered with the "V" line, except that weight-
ing for differential leveling is based on either a given distance or a number of turns between the stations.

Weighting for differential leveling is based on either a given distance or a number of turns between the stations. Therefore a dis-
tance or number of turns value is entered as part of each data line.

The  "L" Code: Differential Level Observation Information

L From-To ElevDiff Distance [StdErr] ['Description]
L From-To ElevDiff Turns [StdErr] ['Description]

The distance value entry on the "L" line is used along with the default standard error per unit length value specified in the Instru-
ment settings of the Project Options to compute the actual standard error for the observation used in the adjustment.
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If you select to have leveling weighting based on "Turns" rather than "Distance" in the Instrument settings of the Project
Options, the value for Distancemust be entered as the number of turns between the From and To stations, not the linear dis-
tance between.

If an optional standard error value is entered, this value is used as the actual standard error rather than a standard error com-
puted based on the section Distance or Turns. You can also enter the special "!" or "*" character in the standard error field to
indicate the observation is to be completely fixed or free.

Example 1: (Assuming Sections are Entered as Lengths)

L 101-105 -7.476 12634

The difference in elevation between stations 101 and 105 is -7.476 and the distance traversed between the two stations while
taking observations is 12,634. The default standard error per section length will be used to calculate the observation standard
error.

Example 2: (Assuming Sections are  Entered as Turns)

L BM335-BM336 3.522 24

The difference in elevation between BM335 and BM336 is 3.522 and the number of turns taken is 24. When entering Turns
rather that Distances, select Sections as "Turns" in the Instrument settings of the Project Options. The default standard error
per turn will be used to calculate the observation standard error.

Example of Differential Leveling Data

Leveling data can be independently adjusted In the PLUS, PRO or LEV editions using the built-in "Lev" adjustment type avail-
able in those programs. All that is required are one or more fixed elevations for control and the leveling observations.

However, leveling data can also be included with other data in 3D network adjustments available in the Standard, PLUS and
PRO editions. Leveling data can be entered to supply vertical observations to some or all stations in a network or to add ver-
tical redundancy to stations already being defined by other types of observations such as zenith angles or elevation dif-
ferences. In this case, any station named in leveling datamust also have other data present which will define its horizontal
location. Therefore, a station in a 3D adjustment named only in an "L" line will cause an error and the adjustment will terminate.

The example below illustrates a small segment of leveling data that may be integrated with some other data in a 3D adjust-
ment.

# Leveling Data
L   33-79   2.546   1798
L   79-80  -4.443    931 'Bench 81-1987
L   79-81   0.231    855
L   80-132  1.322   2509  0.14     #Example of explicit Std Error
L   92-93  -5.024    752
.LWEIGHT  0.05                     #Change Default Weighting
L   12-15   0.244   1245
L   15-16   3.145    955
etc...

Assuming that units for this project is Meters and the standard error per unit length is set to 0.008Meters/Km in the Instrument
options, the actual standard error used for the initial elevation difference observations are propagated from this 0.008 value and
the distance between stations.
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On the "L" line describing observations between stations "80" and "132" an explicit standard error value of 0.14meters is given.
This actual standard error value will be used for the observation rather than a propagated value.

Note that the default weighting entered in the Instrument settings may be changed using the ".LWEIGHT" inline option as illus-
trated above. This inline option is described later in this chapter along with other inline options available.

When viewing a plot diagram of a network containing leveling observations, straight lines are drawn between stations con-
taining these observations even though in reality, these lines are likely made up of many turning points whichmay wander as
the actual survey did, perhaps around a hill or along a road.

See Example 10 of the tutorial in Appendix-A for a complete data set illustrating a small stand-alone differential leveling net-
work project.

5.7 INLINE OPTIONS
There is a category of data called "inline" options that you insert directly into an input data file, and they affect only those data
lines that follow them. Some of these inline options change default settings originally defined in option dialogs already dis-
cussed. Others perform special functions unrelated to other option settings. These inline options are described in detail on the
following pages.

Option Settings
.2D/.3D/.3REDUCE (none)
.ADDCENTERING ON|OFF
.ALIAS [NAME|PREFIX|SUFFIX|ADDITIVE [parameters]] [ON|OFF|CLEAR]
.COPYINPUT ON|OFF
.CURVE ON|OFF
.DATA ON|OFF
.DELTA ON|OFF
.EDM ADDITIVE|PROPAGATED
.ELEVATION ORTHOMETRIC|ELLIPSOIDAL
.ELLIPSE stations
.GRID BEARING|DISTANCE[=ELLIPSOIDAL]|ANGLE|DIRECTION
.INCLUDE filename
.INSTRUMENT [instrumentname]
.LONGITUDE [POSITIVEWEST|NEGATIVEWEST]
.LOSTSTATIONS stations
.LWEIGHT [value [TURNS]
.MAPMODE ON|OFF [ANGLECALC]
.MEASURED BEARING|DISTANCE|ANGLE|DIRECTION
.MULTIPLIER [value]
.ORDER [NE|EN] [ATFROMTO|FROMATTO]
.PELEVATION [value]
.PRISM {constant1 [constant2]}|ON|OFF|CLEAR
.PTOLERANCE connections|/OBSERVATIONS|/CONNECT[=group] stations|/EVERY
.REFRACTION [value]
.ROTATION [angle]
.RELATIVE connections|/OBSERVATIONS|/CONNECT[=group] stations|/EVERY
.SCALE [value]
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.SEPARATOR [character]

.UNITS [LinearUnit] [AngularUnit] [StdErrUnit]

.VLEVEL SectionLengthUnits|NONE[=StdErr]|OFF

Not all inline options make sense for all adjustment or data types. If an inline option is used that doesn’t work with certain data,
the program will either issue an error and quit, or a warning indicating the inline option is ignored depending on the situation.

Using Inline Options
The inline option is a very powerful feature in the STAR*NET program. Using inline options allow you control many aspects of
your data.

For example, if the units setting in your Project Options is set to meters, the program will output results in meters, and it will
also expect input data to be entered inmeters. But if part of your observations aremeasured in feet, perhaps supplied to you by
another surveyor, you can simply use the ".UNITS" inline to tell the program that those observations are in feet. The program
does the conversion tometers automatically!

Example use of the ".UNITS" inline option to change units of input data:

# Default units are FeetUS as set in the Project Options

M   24-23-25   68-33-44.5   655.678   #Data in FeetUS
.UNITS Meters
M   26-25-27   98-45-55.4   201.335   #Data in Meters
M   27-26-28   79-33-24.3   194.667
.UNITS FeetUS                         #Resets to FeetUS
M   32-27-55   87-43-52.1   702.345
etc...

The following are a few rules for constructing inline options:

1. An inline option begins with a period "." and is directly followed by the option name in either upper or lower case.
(Examples: .UNITS or .units)

2. An option namemay be abbreviated to as little as one character, however sufficient characters must be supplied to dif-
ferentiate it from other options beginning with the same letters. (Examples: .UNITS or .U, .DATA or .DA, .DELTA or
.DE)

3. Most inlines contain parameters which turn an option ON or OFF, toggle a setting one way or another, or change a
value. The same rules apply to parameter names as with option names. They may also be upper or lower case, and be
abbreviated to as little as one character as long as they are unique. (Examples: ON or OF)

Even though you can abbreviate option and parameters names, it is recommended that you spell out enough of the identifier
names so that you and others reading your data files can easily recognize themeanings of the options.

Data for a project may consist of one or more data files. Inline options entered in one data file do not affect subsequent files. As
each file is read during an adjustment, all options that affect data are reset to the project defaults for the next file. For example,
if you use the ".REF" inline to change the refraction index in one file, it will be automatically reset to the Project Options default
value for the next file.

Example with Inline Options
The following "fabricated" example illustrates the use of a few common inline options:
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# Sample data for a "Local" 3D job using various inline options
# Default project units are FeetUS

c     1   100000.0   500000.0   3126.648  ! ! !

.SCALE 0.9999879        # distance scale factor

.DELTA ON               # use HorDist/ElevDiff mode

tb   n00-17-02e
t    1   240-26-54   2650.42    15.94  5.1/5.2
t    2   180-00-00   2643.19     8.33  5.2/5.6
t    3   264-33-08   2155.22   -33.28  5.5/5.4
t    6   198-55-32    599.23   -22.27  5.4/5.3
te   1

.DELTA OFF              # switch to SlopeDist/Zenith mode

tb   6
t    3   -88-33-45   1932.66   89-44-33  5.3/5.4
t    10  299-36-55   4332.11   93-56-12  5.4/5.4
t    11  334-39-40   1060.30   77-20-21  5.3/5.5
te   7   116-43-17   1

.SCALE 0.9999765        # change scale again

.REFRACTION 0.055       # change refraction from default

.UNITS Meters           # define following linear as meters

m    6-7-10  -156-24-10   871.56  89-09-49  1.76/1.72
m    6-7-2    113-31-07   987.10  89-36-07  1.68/1.71

.UNITS                  # set units back to FeetUS default

.REFRACTION             # set refraction back to default

dv   2-6    3566.10   90-23-52  5.7/5.4

.3REDUCE                # reduce the following sideshots to 2D

# Note that –99999 will be published for these SS elevations
ss   6-7-81   143-33-45   221.76   90-45-34
ss   6-7-82    98-44-54   463.45   91-55 26
ss   6-7-83    82-23-41   612.56   93-02-48

.3D                     # return to standard 3D mode

# Note that a true elevation will be published for this sideshot
ss   6-7-94   122-43-34   733.44   89-55-34  5.4/5.5

.ELLIPSE  2 10 11       # only plot selected ellipses

.RELATIVE 1-2 1-6 10-11 # only plot selected relative ellipses

Inline Options that Relate to Settings in Options Dialogs
The following inline options allow you to override certain Project Options default settings that affect the interpretation of your
entered data.
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Inline Option .UNITS [LinearUnit] [AngularUnit] [StdErrUnit]

By default, input datamust be in the units specified in the Project Options. This inline option, however, allows you designate
the units in data lines that follow. You can specify linear units, angular units, or both. This option, for example, allows you to
easily mix meters, International feet and US feet in the same data. Knowing the units, the program converts all data to default
units as set in the Project Options with no work on your part.

The "Linear" keywordmay be any item from the dropdown list of the "Linear Units" field in the Project Options/Adjustment dia-
log (i.e. Meters, FeetInt or FeetUS).

The "Angular" keywordmay be either DMS or GONS.

.UNITS  FeetUS          #Changes linear units for following data

.UNITS  DMS             #Changes angular units for following data

.UNITS  Meters  GONS    #Changes both linear and angular units

.UNITS                  #Resets all units to project defaults

In addition, the ".UNITS" inline can be used to redefine the units of explicitly-entered standard error values when angular data is
being entered in GONS.

In this STAR*NET version, standard errors for angular data entered in GONS are stated as Milligons (GONS/1000) by default
rather than Centesimal Seconds (GONS/10,000) as in earlier versions. This change to the program was made by popular
demand from the international surveying community.

If you have existing data files that contain explicitly entered standard errors stated as Centesimal Seconds, you can do one of
two things: either edit your files changing all these entered standard error values toMilligons, or simply use the ".UNITS" inline
with the "CSECONDS" keyword to indicate the units of following data lines, and let the programmake the necessary con-
versions toMilligons. The "MGONS" keyword is also provided to change back the to theMilligons default in the same file if
necessary.

.UNITS  CSeconds        #Units for angular std errors following

.UNITS  Mgons           #Units for angular std errors following

.UNITS  Met Gons CSec   #Changing several on a single line

.UNITS                  #Resets all units to project defaults

Note that the "CSECONDS" units keyword is also useful for those using GONS who still prefer to enter explicit standard errors
in their data as Centesimal Seconds.

Inline Option .DELTA ON|OFF

This inline option allows you to change the "Distance/Vertical Data Type" default set in the Project Options/General dialog.
This option relates only to 3D-formatted data. When set to "OFF", subsequent data will be interpreted as slope distance and
zenith angle observations. When set to "ON", subsequent data will be interpreted as horizontal distance and elevation dif-
ference observations.

For example, if the "Distance/Vertical Data Type" option in the Project Options is set to the "Slope Dist/Zenith Angle" setting,
the following inline options illustrate how to change to the input data to the "Horiz Dist/Elev Diff" mode, and then back again:
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M   24-23-25  68-33-44.5  655.678  91-23-56  5.13/5.25
.DELTA ON
M   26-25-27  98-45-55.4  543.335   12.35    5.15/5.32
M   27-26-28  79-33-24.3  523.667   -3.21    5.55/5.43
.DELTA OFF
M   32-27-55  87-43-52.1  702.345  89-26-53  5.55/4.89
etc...

Note that "3D-formatted" data can be entered in both 2D and 3D projects. This inline controls only how the distance and ver-
tical information is interpreted on data lines.

Inline Option .ORDER [NE|EN] [ATFROMTO|FROMATTO]

This inline option allows you to change the "Coordinate" and the "Angle Data Station" order settings within a data file. Using
this inline, you can easily include coordinates or observations in your data files that perhaps had been prepared by someone
else, and were typed using an order different than that set in your project options.

The "NE/EN" keywords allow you to switch the north and east order of the coordinates, and likewise, the
"AtFromTo/FromAtTo" keywords allow you to switch the station name order that defines angles. This inline option changes the
order for input data only! The original default order specified in the Project Options/General dialog still controls the order dis-
played in the adjustment output listing and coordinate files.

C  1  50345.334  20423.155   #Using original project options orders
.ORDER EN FROM               #Change both order types          
C  4  20445.167  50443.675   #All following data is affected   
etc...  
.ORDER NE                    #Change only coordinate order back
etc...

You can enter one or both keyword types on a single inline option line. The example shown above illustrates setting both, and
then resetting one back.

Inline Option .LONGITUDE PositiveWest|NegativeWest

This inline option allows you to switch the way that signs of longitudes are interpreted in your data. As previously described in
Chapter 4, Options, the default sign convention can set to PositiveWest or NegativeWest longitudes for the project.

Using this inline option, you can include latitude/longitude data in your input file that perhaps had been prepared by someone
else, and was created using a sign convention for longitudes different than that set for your project. The inline option changes
the way signs of longitudes are interpreted in your input data only! The sign convention specified in the "Longitude Sign Con-
vention" setting in the Project Options/General dialog still controls the signs of longitudes listed in the adjustment output.

P  1  38-44-27.123  122-45-21.321  ! !  #Positive west default
.long neg                        
P  2  38-48-33.667  -122-45-38.315  ! ! #Negative west convention
P  2  38-48-33.667  -122-45-38.315  ! !  
.long
P  2  38-48-33.667   122-45-38.315 ! !  #Back to the default 
etc...
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Assuming that project options are set to the "PositiveWest Longitude" convention in the short example above, the first inline
changes the input to a "NegativeWest Longitude" convention and the second changes it back to the original default.

Inline Option .REFRACTION [Value]

This inline option allows you to change the "Default Coefficient of Refraction" value set in the Project Options/General dialog to
a new value whenever required due to special atmospheric conditions encountered in the field.

.REF  0.05     #Change the current refraction coefficient

.REF  0        #Turn off refraction corrections

.REF           #Reset refraction coefficient to project default 

When the ".REFRACTION" inline is entered without a value, the coefficient is returned to the default specified in the Project
Options.

When this inline option is used to change the refraction coefficients within a project, the actual coefficients used are listed with
the zenith angle data review in the listing. Note that the zenith angles shown in the output listing do not reflect the correction for
refraction. The correction is only applied internally during the adjustment process.

Inline Option .SCALE [value]

This option applies to 2D/3D "Local" coordinate system jobs only. When the "Apply an Average Scale Factor" option is selec-
ted in the Project Options/Adjustment dialog, this inline option allows you to change the entered scale factor. The scale factor
is used to scale horizontal distances, or the horizontal components of slope distances. You can insert this inline option into
your data as many times as needed to vary the scale in your project.

If the ".SCALE" inline is entered without a scale value, the scale factor is reset to the default value originally set in the Project
Options.

Inline Option .PELEVATION [value]

This option applies to "2D" local and grid jobs only. It allows you to redefine a default project elevation for various parts of a pro-
ject when you feel the elevation changes enough tomake a difference in the results. A reference elevation for a station used in
calculations is assigned the first time the station name is seen in your data. Therefore by careful placement of this inline in your
data, you can accurately assign reference elevations to stations in different regions of your project.

In the example below, assume the "Default Project Elevation" in set to 1000 in the Project Options. Stations 1, 2 and 4 will
have a reference elevation of 1000 assigned and stations 5, 6 and 7 a reference elevation of 875.

C  1       20000      20000      ! !
C  2       20007.432  19182.223  ! !
M  1-2-4   89-53-22   842.12
.PELEV 875                            #Change default to 875
C  5 21543.244  22832.432  ! !
M  5-4-6   67-25-11   645.98
M  6-5-7   87-56-38   987.12
.PELEV                                #Reset to project default
etc...
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As shown above, entering the ".PELEVATION" inline option with no value, resets to the original default setting in the Project
Options.

Inline Option .COPYINPUT ON|OFF

When the "Copy of Input Data Files" option in the Project Options/Listing File dialog is selected, your data file or files are
copied to the listing file. Using this inline option, you can completely control which parts on your data will be copied, and which
parts will not. This option is very useful for excluding bulky sections from your listing file that you don’t really care to see. Sim-
ply place a ".COPY OFF" inline before any group of lines you wish not to be copied to the listing file, and then a ".COPY ON"
inline where you wish to resume copying. When the "Copy of Input Data Files" listing option is turned off in the Project Options, 
the ".COPY" inline has no affect.

Inline Option .LWEIGHT [value [TURNS]]

This inline option allows you to change the leveling data "Elev Diff" standard error per section value specified in the Instrument
Options to a new value. Enter the inline option preceding the differential leveling data to be affected and it will remain in affect
until again changed or until the end of the file. At the end of a data file, the the weighting reverts back to that specified in the pro-
ject options.

When the inline option is entered with a value only (i.e. without the "Turns" key word), the program considers the section type
based on "Length." When the "Turns" key word is included, the program considers the section type based on "Turns."

The first example sets the value to 0.038 with the section type as "Length."

The second example sets the value to 0.012 with the section type as "Turns."

.LWEIGHT 0.038          #Sets 0.038 value and "Length" section type
L   BM75-125   15.920   31200
L   129-130    22.130   37400
L   130-125     3.833   28100
.LWEIGHT 0.012 Turns   #Sets 0.012 value and "Turns" section type
L   130-126    24.065     46
L   128-126    34.422     38
L   126-127   -15.485     42
.LWEIGHT                #Reset to project defaults
L   127-128     9.234   24660
etc...

Units of the entered data are the same units set for the project in the adjustment options, or the current units if redefined using
the ".UNITS" inline option.

If the current units are FeetUS, the new Elev Difference standard error per section length set for the first example above would
be 0.038 Feet/Mile. And the total standard error propagated for the 31200 foot survey line would be:

Total Std Error = 0.038 FeetUS/Mile x SQRT(31200/5280) = 0.0924 FeetUS.

Likewise the new Elev Difference standard error per section length set for the second example above would be 0.012
Feet/Turn. And the total standard error propagated for the survey line having 46 turns would be:

Total Std Error = 0.012 FeetUS/Turn x SQRT(46) = 0.0814 FeetUS

When the inline is entered without parameters as illustrated by the third example, the weighting scheme reverts to the original
default set in the Project Options.
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Inline Options that Perform Special Functions
The following inline options perform certain tasks completely on their own, and are not used to change any options initially set
in the various project option dialogs.

Inline Option .DATA ON|OFF

This option is used to easily exclude blocks of data from being loaded by the program, and is very useful for debugging of data.
Simply place a ".DATA OFF" inline before and a ".DATA ON" inline after any group of lines that you want ignored.

M  2-1-3   132-33-22   1200.234
.DATA OFF
M  3-2-4   125-14-54   1422.345    #These two lines are ignored
M  3-2-5   155-23-34   1023.117
.DATA ON
M  3-2-7   154-43-31   2021.554    #Data is now read again

Inline Option:.INSTRUMENT [InstrumentName]

A variety of weighting schemes can be defined using the "Instrument Library" facility as previously discussed in Chapter 4,
"Options." Each weighting scheme is given an Instrument Name so it can be easily identified. The identifier name can be upper
or lower case and up to 15 characters long. Instrument names used in data files are not case sensitive, therefore the instrument
"OSCAR" is the same as "Oscar" or "oscar."

This inline option lets you set different weighting schemes for sections of data. Entering a new instrument name causes a
whole set of weighting parameters to become the new defaults. This allows you to easily change the weighting characteristics
applied to sections of your data that were surveyed with instruments of different precisions, or by field crews of varied exper-
ience and talent.

M  3-2-19   133-44-23   2344.112
.INST TOPCON3                    #Change weighting scheme to Topcon3
M  19-3-21  109-22-17   1099.213
M  19-3-22   98-55-34   2011.129
.INST OSCAR                      #Change weighting scheme to Oscar
M  12-9-42  255-43-52   3325.222
.INST                            #Reset scheme to project defaults
etc...

If the instrument inline option is entered without the name parameter as shown above, the weighting scheme is reset to the
default weighting (standard errors, PPM, centering errors, etc.) as set in the Project Options/Instrument dialog.

Inline Option .2D / .3D / .3REDUCE

When running a 2D adjustment, the program expects data in 2D format. Likewise, when running a 3D adjustment, the program
expects data in 3D format.

The ".2D" and ".3D" inline options allow mixing both 2D formatted and 3D formatted data in both 2D and 3D adjustments.
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#Data for a 3D job
M   1-2-5   55-44-66   345.128  89-11-43  5.4/5.6
.2D     #Change data format mode to 2D
M   5-1-8  133-22-54   934.241 
M   8-5-9   23-35-34   234.112
.3D     #Change back to 3D data format
M   7-5-6   78-42-61   435.448  89-44-41  5.6/5.7

When using the ".2D" inline option to enter 2D sideshots in a 3D adjustment, elevation values of -99999 are shown in the res-
ults to indicate they are undetermined.

The ".3REDUCE" inline option, just like the ".3D" option, specifies that following data is in 3D format. But in addition, it causes
the program to reduce all slope distances with zeniths down to horizontal distances only.

Why would you want to do this? One likely reasonmight be that you havemeasured some 3D observations and didn’t record
the instrument and target heights, but you still want to use the angles and reduced horizontal distance information in a 3D
adjustment. The ".3REDUCE" inline will do this for you.

.3R    #Reduce the following to angles and horizontal distances
M   1-2-3   45-33-55  1357.234  91-22-33
M   1-2-5   55-44-66   345.128  89-11-43
.3D    #Change back to normal 3D format mode

Don’t forget that in a 3D adjustment, any "network" station referenced in "reduced" datamust have other data in the adjustment
that will establish its vertical location.

When 3D "sideshots" are entered under the "3R" mode, the observations are reduced to 2D just like with normal observations,
but elevation values of -99999 are shown in the results for the sideshot points to indicate they are undetermined.

The 2D, 3D and 3R options are exclusivemodes. Entering one will turn another off.

See Section 5.8, "Entering 3D Data in a 2D Adjustment," Section 5.9, "Entering 2D Data in a 3D Adjustment" and Section
5.10, "Entering Reference Elevations in a 2D Project"  for more details onmixing 2D and 3D data in a single adjustment.

Inline Option .MEASURED [BEARING] [DISTANCE] [ANGLE] [DIRECTION]

Inline Option .GRID [BEARING] [DISTANCE[=ELLIPSOIDAL]] [ANGLE] [DIRECTION]

These options are used only for "Grid" projects. When preparing data for grid jobs, the ".MEASURED" and ".GRID" inline
options may be used to change themeaning of a type of observation. These options affect "network" observations but not
sideshot data (observations entered with the "SS" line). Sideshots (topo or detail observations) are calculated after the adjust-
ment and are always handled as measured data, not grid.

By default, entered bearings or azimuths are assumed to be "grid" values. Similarly, entered distances, angles and directions
are assumed to bemeasured values, i.e. observed in the field. During an adjustment of a grid project, the program applies
standard grid corrections to "measured" observations, but not to entered "grid" observations.

The keywords BEARING, DISTANCE, ANGLE and DIRECTION may be used with these two inline options to indicate which
observations types you want to redefine.
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For example, the inline option below specifies that all subsequent bearings should be interpreted as measured (geodetic) bear-
ings. The program will apply grid corrections to these bearings (t-T and convergence), and the resulting adjusted bearings will
be shown in the output listing with their own headings indicating they aremeasured.

.MEASURED BEARING     #following bearings are measured
B 21-22 N33-44-55.78E
B 33-37 S22-35-11.84W
B etc...
.GRID BEA             #to change back to grid if necessary

One ormore of the keywords may be placed on a single option line. For example, if you are combiningmeasured field obser-
vations with "grid" values from an existingmap, youmight prepare your 2D data as shown in the example below. Angle and dis-
tance observations you are "creating" from themap are defined as "grid" using the inline option, and therefore no grid
corrections will be applied to them.

M  52-51-53   133-23-55  143.243    #default is measured
M  53-52-54    97-44-31  135.981
.GRID ANG DIST                      #change to grid mode
M  78-74-75   120-27-56   76.502
M  78-74-77   102-44-34  102.324
A  74-73-85    91-02-53
D  74-82        255.258
.MEAS ANG DIST                      #back to measured mode
M  65-62-94   112-22-33  234.278
etc...

Note that when you specify distance observations as "grid" distances, they must be entered as horizontal distances. A "grid
slope distance" doesn’t make any sense!

The ".GRID" inline optionmay also be used to define an entered distance as ellipsoidal.

Some organizations are known to reduce field distances to ellipsoidal and then database these values for future use. Then
later, to include these databased distances in a network adjustment, the values must be defined as ellipsoidal so the software
can properly handle them. The particular ellipsoid assumed for the distance values is the ellipsoid defined for the grid zone pro-
jection selected for your project.

To define a distance as ellipsoidal, add an "=Ellipsoidal" qualifier to the "DISTANCE" keyword. This qualifier can be upper or
lower case and it can be abbreviated.

For example, if you are combiningmeasured field observations with ellipsoidal distance values, youmight prepare your 2D
data as shown in the example below. The ellipsoidal distances will be scaled to grid during the adjustment.
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M  62-60-63   133-23-55  435.243    #default is measured
M  63-62-64    97-44-31  535.981
.GRID DIST=ELLIP                    #change distances to ellipsoidal
D  74-78       535.4355
D  78-79       675.1483
D  74-77       355.2574
.MEAS DIST                          #back to measured mode
M  95-72-94   112-22-33  554.275
etc...

Note that when you specify distance observations as "ellipsoidal" distances, they must be entered as horizontal distances. An
"ellipsoidal slope distance" doesn’t make any sense!

Inline Option .SEPARATOR [character]

This inline option allows you to change the default "dash" used to separate station name strings in observation data lines. For
example, if you wish to use dashes within your station names, youmust change the separator to some other character. To do
this, enter the ".SEPARATOR" inline option along with the new separator character, just before the data to be affected. You
can change the character wherever needed, and to whatever character you wish as long as it will be unique in the string of sta-
tion names.

M  A2-A1-A3    132-33-22  1200.234   #using default "-" separator
.SEP ,                               #change to a ","
M  A3,A2,A4    125-14-54  1422.345   #using comma separator
M  A3-1,A2,A5  155-23-34  1023.117   #using dash in a name
.SEP #back to default "-" separator
M  A4-A3-A8    143-45-22  1562.123

If you enter the inline option without a character parameter, as shown by the second example,  the separator character is
returned to the original "dash" default.

Inline Option .ELLIPSE StationNames

By default, when you run an adjustment with error propagation, error ellipses are generated at all stations. These ellipses will be
shown in your listing and plot.

But if you wish to show error ellipse information only for specific stations, include one or more ".ELLIPSE" inline options in your
data file. Each line should contain one or more station names separated by commas or spaces. This allows you to generate
error ellipse listing information and error ellipse plots only for critical stations in a network.

#List of specific ellipses to show in listing and plot results
.ELL   1 4 6 77 76 74 35 A202 A203 R60
.ELL   A207 132 133 153
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Inline Option .RELATIVE connections | /OBSERVATIONS | /CONNECT[=group] stations | /EVERY

Inline Option .PTOLERANCE connections | /OBSERVATIONS | /CONNECT[=group] stations |
/EVERY

By default, when you run an adjustment with error propagation, relative error ellipses are generated between all station pairs
connected by observations, and output for these ellipses are shown in your listing and plot. Also, when the "Positional Tol-
erance Checking" feature in the Project Options/Special Settings dialog is selected, the same relative ellipses are used to cre-
ate the tolerance checking report.

But youmay wish relative error ellipse information listed and plotted only between specific station pairs in the network (whether
or not they are connected by observations). Likewise, youmay wish Positional Tolerance Checking performed only between
specific station pairs in the network.

You can include one or more ".RELATIVE" and/or ".PTOLERANCE" inline option lines in your data file to create separate lists
that control what output of each type is generated by the adjustment. Each line should contain one or more dash delimited sta-
tion name pairs separated by commas or spaces. If you want either list to also contain all the station pairs connected by obser-
vations, add a ".REL" or ".PTOL" line with a single "/OBSERVATIONS" keyword.

The example below illustrates creating two connection lists, one of each type.

#List of connections for relative ellipse listing and plotting
.REL  4-35 4-53 77-A203 133-134 133-138 124-152 124-155
.REL  125-160 155-170 156-174
.REL  /OBS
#List of connections for tolerance checking
.PTOL 5-155 22-173 133-184
.PTOL /OBS

When building "Relative" and "Positional Tolerance Checking" lists, themethods shown in the previous example are usually all
you need. However, the "/CONNECT" keyword is available to provide an additional method for generating connection lists.

Use the "/CONNECT" keyword to specify a list of station names that you want the program to exhaustively create con-
nections between. In the data below, connections are created exhaustively between all 10 points for a "positional tolerance
checking" list. These two lines will create a total of  45 connections: 51-52, 51-55, 51-60, 51-65, etc.

.PTOL /CON 51 52 55 60 65 66 71     #Total 10 points

.PTOL /CON 43 43 47

Use the "/CONNECT=GroupName" keyword when you want the program to exhaustively create connections in separately
named groups. A group name, just like a point name, can be up to 15 characters.  In the data below, connections are created by
exhaustively connecting points separately in each group.

.PTOL /CON=North 71 72 78 81 82   #Total 7 point in group North

.PROL /CON=North 81 85

.PTOL /CON=South 127 155 164      #Total 4 points in Group South

.REL  /CON=South 177
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Note that a "named" connection group can be shared by both types of lists. So in the case of the last two lines above, both the
"positional tolerance checking" and the "relative" lists will have connections added by exhaustively connecting 4 points. To
keep named connection groups unique between the two lists, simply use unique group names.

You can use any combination of the techniques shown to create a "Relative" or a "PTolerance" list of connections. Con-
nections created by all techniques are combined into a single list. Any duplicated connections are ignored.

For small networks, youmay wish to create a connection between "every" point in your project rather than using the techniques
above. Simply use the "/EVERY" keyword. The example below creates a "Relative" list containing every connection.

.REL /EVERY    #Creates an exhaustive list connecting every point

Caution – The "/EVERY" keyword causes matrix operations performed during an adjustment to becomemore laborious, and in
a large network, processing time can increase dramatically! This keyword is not generally useful for typical survey work. It is
particularly useful for specialized projects such as deformation studies where complete covariance information is required for
additional analysis. "/EVERY" provides themeans to compute a full covariancematrix which can be exported by the "Dump
File" facility described in the "Other Files"  project options settings.

Inline Option .MAPMODE ON|OFF [ANGLECALC]

When this option is used in a data file, the "horizontal angle" field in traverse lines will be read as a bearing or azimuth. The pur-
pose of the option is to provide an easy way to enter traverse information directly from a recordmap. Please note that bearings
and distances from a recordmap are not field observations and therefore, in general, shouldn’t be combined with actual field
observations in a network adjustment. (Recordmap information has already been adjusted in one way or another.) However,
for those using STAR*NET as tool for readjusting and resolvingmaps for their GIS, this special option can save time.

To use this option, simply enter ".MAP ON" before any traverses you wish to affect. You cannot change the "MAPMODE"
within a traverse. If you have other traverses later on in your data that are entered using the default "horizontal angle" method,
then be sure to end this mode with the ".MAP OFF" option.

When this mode is on, the traverse "TB" linemust not contain data, and the "TE" linemust contain only the ending station
name. The short example below  illustrates two traverses entered with "MAPMODE" turned on:

.MAP ON                           #MAPMODE is turned on
TB                                #Traverse begins
T   101  N00-11-12E  255.32       #Bearing & distance map data
T   102  N89-35-27E  503.25
T   103  S00-44-56W  264.18 ! &   #Bearing is fixed
T   104  N89-56-31W  504.66
TE  101                           #Traverse ends on 101
TB                                #Another traverse begins
T   104  N62-46-16W  698.33       #Single course 104 to 102
TE  102
.MAP OFF                          #MAPMODE is turned off

Just like any other data entered in STAR*NET, the standard errors for data entered when "MAPMODE" is on is controlled by
default standard error values set in the Project Options/Instrument dialog, or by values from the Instrument Library set when
the Instrument Library ".INSTRUMENT" inline option is used. Also explicit standard error values or fixity symbols may be
entered on the data lines as illustrated on the traverse station 103 line above.



Chapter 5: Preparing Input Data

- 105 -

When "MAPMODE" is on, datamay be 2D (as shown above) or 3D. Traverse lines entered as 3D follow all the same rules as
normal 3D traverse lines, except that a bearing or azimuth is entered rather than a horizontal angle. The purpose of the
"MAPMODE" option is to allow for easy preparation of already-reduced horizontal map information, therefore its use in the 3D
datamode is likely very limited.

When you add the optional "ANGLECALC" keyword to the "MAPMODE" inline option, the program subtracts the back bearing
and fore bearing at each traverse station to calculate a "neutral" turned angle. This allows you to easily combine data from two
ormoremaps having different bases of bearing! The created angles will be used in the adjustment, not the incompatible bear-
ings.

When beginning a traverse, set the initial back bearing by entering a bearing or azimuth, plus the backsight station name on the
"TB" line.

The "MAPMODE" examples below illustrate data for open and closed traverses using the optional "ANGLECALC" extension.
As illustrated in the second example, closed traverses are a special case. When a traverse closes on itself, the initial back
bearing and backsight station namemay be omitted. The back bearing and backsight station namewill be automatically taken
from the last "T" line data.

.MAP ON ANG
TB N10-00-00E 125            #Backsight station 125
T  101 N60-22-33E 543.21     #Angle of  50-22-33 is created
T  102 N73-30-55E 650.00     #Angle of 193-08-22 is created
T  103 N00-00-00E 533.25     #Angle of  73-30-55 is created
TE 104

TB                           #For closed traverses, the initial
T  501 N00-00-00E 100.00     #back bearing and station name may
T  502 N90-00-00E 200.00     #be omitted. The initial backsight
T  503 S00-00-00E 100.00     #in this example is assumed to be
T  504 N90-00-00W 200.00     #to station 504.
TE 501

.MAP OFF

In the open traverse above, if a bearing and station name are placed on the "TE" line as illustrated below, the program will cre-
ate a "closing" angle to the specified station, and that angle will be included in the adjustment.

T  103 N00-00-00E 533.25
TE 104 N20-00-00W 105 #closing angle of 70 deg to 105 is created

Caution! If you are using this option along with the ".Measured Bearing" mode so that bearings are interpreted as geodetic
rather than grid, geodetic angles will be created just as you would expect. But beware that there is no consideration for change
in convergence along the traverse line! This is only a data preparation tool which creates angles while reading input data. The
program simply subtracts the adjacent bearings to get an angle, much like you would do by hand.

Inline Option .CURVE ON|OFF (Default is ON)

By default, STAR*NET assumes that all survey observations entered as data are normal measurements taken on the face of
the earth. In all the calculations performed to determine "horizontal" distances, the effects of both earth curvature and refraction
are taken into consideration. These calculations affect all 3D adjustments containing zenith angle observations and 2D adjust-
ments where zenith angles are used to reduce slope distances to horizontal.
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If you have removed the effects of earth curvature and refraction by modifying your zenith angles by somemethod, youmust
tell STAR*NET so this will be taken into consideration during processing. Enter the ".CURVE OFF" inline option before any
zenith angle observations that have beenmodified for earth curvature and refraction.

M  52-51-53   133-23-55  95-30-22  #pure field observations
M  53-52-54    97-44-31  96-11-56
.CURVE OFF                         #hand-modified zenith angles
M  78-74-75   120-27-56  94-26-34
M  78-74-77   102-44-34  95-21-54
M  77-78-79    84-54-33  89-53-42
.CURVE ON                          #back to field observations
M  65-62-94   112-22-33  234.27
etc...

And then be sure to return back to the default ".CURVE ON" mode when entering pure, unmodified field observations so
STAR*NET will again consider standard curved earth geometry and refraction in its calculations.

Inline Option .ADDCENTERING ON|OFF (Default is Off)

By default, standard error values explicitly entered on data lines are used exactly as given. By default, they are not affected by
any centering error values entered in your project options or instrument library. If you have a reason for wanting centering
applied to explicitly entered standard errors, (or to cause weighting in your data files be handled exactly the same as in earlier
versions which did apply centering to explicitly entered standard errors), you can use this inline option.

M  2-1-3  45-33-44  1357.234  91-22-46   2 .03 9   5.4/5.6
.ADDC ON
M  2-1-4  88-11-22  1234.321  89-33-57   2 .03 9   5.4/5.6
.ADDC OFF   #Change back to normal

For example, in the first data line above, the explicitly entered standard errors shown underlined will be by default used exactly
as entered. In the second data line, the entered standard errors will be inflated by any centering error settings currently in effect.

Inline Option .EDM ADDITIVE|PROPAGATED (Default is Additive)

The computed standard error value for a distancemeasured with an EDM is made up of two parts, the constant and the pro-
portional (distance times ppm). There are two schools of thought on how the standard error should be computed from these two
parts. The default method used in STAR*NET is the "additive" method which simply adds the two parts. This method is pre-
ferred by most manufacturers and authorities. The other method preferred by some is called the "propagated" method in which
the total error is the square root of the sum of the squares of the two parts.

You can use this inline option to change themethod from the default "additive" method to the "propagated" method by inserting
the inline at the beginning of your data file. And for those advanced users whomay wish to switch back and forth using both
methods of computing distance standard errors in the same data file, we’ve included an inline option to reset to the "additive"
method:

#Examples of the EDM inline option formats
.EDM PROPAGATE       #or simply ".EDM P"
.EDM ADDITIVE        #or simply ".EDM A"
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Simply include the appropriate inline option before the data you wish to affect. Remember that the "additive" method is the
default so you need to do nothing if this is themethod you wish to use - which is just what we suggest.

Inline Option .LOSTSTATIONS stations

Surveying projects are often adjusted repeatedly as observations are collected over time, sometimes lasting years. Over time,
some stations that were once occupied become obliterated. While the stationmay be gone physically, the observations to that
station are still valid in subsequent re-adjustments. To avoid a field crew's attempt to re-occupy a lost station, the lost stations
are not drawn on the survey plot.

The command can specify a single station, or a list of stations separated by at least one space or tab character. The command
without any stations is ignored. The command for a given station can be placed anywhere in a data file, regardless of its pos-
ition in relation to data defining the station.

The command can be repeated any number of times in any one data file, and can be placed in one or more data files in the pro-
ject. Specifying the same station name inmore than one command line is okay.

In the output listing file, lost stations are listed in the section "Summary of Unadjusted Input Observations" or "Summary of
Controlling Stations" depending on whether network observations are included in the file. Otherwise listing file is no different
from any other adjustment.

The network plot does not show the lost points or any connecting lines between lost points and any other points, lost or not.

Other outputs including the Coordinate, Lat/Long, Ground, and Dump files, Point Reformatter, and DXF Export do include the
lost stations.

# Project Settings
# Adjustment
# Type 3D
# Units Meters
# Grid NAD83
# Zone CA Zone 3
# Geoid -32
# GPS
# Enable default weight for G1 only vectors
#
.LOSTSTATIONS 4
#
C 1 646210.759201 1844193.216901 100.000000 ! ! !
B 1-2 N20-00-00E
G1 1-2 53.8602 24.8819 80.4983
G1 1-3 147.9357 0.1464 134.5920
G1 1-4 64.9198 -34.5161 31.5287
G1 2-3 94.0756 -24.7354 54.0937
G1 2-4 11.0596 -59.3980 -48.9696
G1 3-4 -83.0159 -34.6626 -103.0632

Specifying a "lost" point that is not part of the project generates an error message and stops the adjustment. The error text for
".LOST 5" in the sample data above would be as follows:

ERROR Unknown Station in Inline Lost Station Option: 5



MicroSurvey STAR*NET ReferenceManual

- 108 -

Inline Option .ALIAS [NAME|PREFIX|SUFFIX|ADDITIVE [parameters]] [ON|OFF|CLEAR]

This option allows you to specify point aliases, or to specify an aliasing scheme. When a point alias is defined, aliased point
IDs which refer to other existing points with a different ID can be translated to that other true point ID, so that redundant meas-
urements stored with unique point names can be adjusted without having tomodify the point names specified in the input data
as collected in the field.

The .ALIAS command can take several forms, all of which contain one or more specific keywords and/or a list of parameters.
The NAME, PREFIX, SUFFIX, and ADDITIVE keywords allow you to define rules for each of the four specific aliasing
schemes, as described below. TheON, OFF, and CLEAR keywords allow you to enable/disable/reset the aliases either en
mass or for a specific aliasing scheme.

Aliases, like point IDs, are case sensitive so "A" and "a" are not equivalent.

Point Aliases act on a line-by-line and file-by-file basis in the order that they are read, meaning that any aliases must be defined
before they appear in the data files. Aliases will carry over between files, whichmay or may not be desired, so a CLEAR
keyword is also provided which can be used to reinitialize any previously defined aliases.

.ALIAS NAME [ point points | ON | OFF | CLEAR ]

You can specify a list of one or more explicit point aliases using this format.

Please note that you can only specify aliases for one unique point per line, but you can specify multiple aliases to that point
within the same line. To define aliases for multiple unique points, youmust specify each unique point in its own line.

You can also turn on or off aliasing of named points using the ON or OFF keywords, and you can clear any previously defined
named aliases using the CLEAR keyword.

.ALIAS NAME 1 1a 1b 1c    #points 1a, 1b and 1c are explicitly aliased to point 1

.ALIAS NAME 2 2a          #point 2a is explicitly aliased to point 2
C 1 1000.0 1000.0         #point 1 is defined here
BM 1-2 0 100.0            #point 2 is defined here
...
M 12-11-1a 123.45 90.0130 #reobservation of 1 was stored as 1a
M 12-11-2a 134.23 90.1234 #reobservation of 2 was stored as 2a
...
M 15-14-1b 543.21 89.5830 #another reobservation of 1 was stored as 1b
...
.ALIAS NAME OFF
M 21-20-1c 231.31 90.2015 #point 1c is no longer aliased to point 1
.ALIAS NAME 3 47          #note that the ON paramater is implicit
M 21-20-47 134.23 90.1234 #reobservation of point 3 was stored as 47

.ALIAS PREFIX [ prefixes | ON | OFF | CLEAR ]

You can use the PREFIX keyword to specify a list of one or more prefixes used to define your aliasing scheme. Any point IDs
beginning with the specified prefix(es) will automatically be aliased to their corresponding point IDs without that prefix. Each
prefix can be 1 or more characters in length.

You can also turn on or off prefix aliasing using the ON or OFF keywords, and you can clear any previously defined alias pre-
fixes using the CLEAR keyword.

For example...
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.ALIAS PREFIX chk
#any following point IDs that start with chk will automatically alias their corresponding point.
...
M 12-11-chk1 15-35-10 123.45 #reobservation of 1 was stored as chk1
M 12-11-chk2 30-30-15 135.42 #reobservation of 2 was stored as chk2
M 12-11-chk3 44-22-55 185.44 #reobservation of 3 was stored as chk3

Note that it is inadvisable to use a numeric prefix if you use numeric point IDs, as a prefix like 1 will cause any point numbers
beginning with it (like 10, 11, 12, 100, 1234, etc...) to be interpreted as aliases, whichmay not be your intention. Similarly, exer-
cise caution when combining alpha prefixes with alpha/alphanumeric point IDs.

.ALIAS SUFFIX [ suffixes | ON | OFF | CLEAR ]

You can use the SUFFIX keyword to specify a list of one or more suffixes used to define your aliasing scheme. Any point IDs
beginning with the specified prefix(es) will automatically be aliased to their corresponding point IDs. Each suffix can be 1 or
more characters in length. TheOFF Keyword will disable any previously defined alias suffixes. You can also turn on or off suf-
fix aliasing using the ON or OFF keywords, and you can clear any previously defined alias suffixes using the CLEAR keyword.
For example...

.ALIAS SUFFIX a b
#any following point IDs that end with a or b will automatically alias their corresponding point.
...
M 12-11-1a 15-35-10 123.45 90.0110 #reobservation of 1 was stored as 1a
M 12-11-2a 30-30-15 135.42 90.1230 #reobservation of 2 was stored as 2a
M 12-11-3a 44-22-55 134.23 89.5805 #reobservation of 3 was stored as 3a
...
M 14-13-1b 20-20-20 185.45 90.0110 #reobservation of 1 was stored as 1b
M 14-13-2b 40-20-30 104.23 90.1230 #reobservation of 2 was stored as 2b
M 14-13-3b 50-40-30 134.23 89.5805 #reobservation of 3 was stored as 3b
...
.ALIAS SUFFIX OFF
#any following point IDs will no longer be aliased by their suffix.
...
M 17-16-1b 15-20-20 185.45 90.0110 #point 1b does NOT alias point 1 anymore
M 17-16-2b 30-20-30 104.23 90.1230 #point 2b does NOT alias point 2 anymore
M 17-16-3b 40-40-30 134.23 89.5805 #point 3b does NOT alias point 3 anymore

Note that it is inadvisable to use a numeric suffix if you use numeric point IDs, as a suffix like 1 will cause any point numbers
ending with it (like 11, 21, 31, 221, 1231, etc...) to be interpreted as aliases, whichmay not be your intention. Similarly, exer-
cise caution when combining alpha suffixes with alpha/alphanumeric point IDs.

.ALIAS ADDITIVE [ numbers | ON | OFF | CLEAR ]

You can use the ADDITIVE keyword to specify a list of one or more additive numbers used to define your aliasing scheme.
Any numeric point IDs with this number added to them will automatically be aliased to their corresponding point ID (the alias
point ID minus the additive number). The ADDITIVE keyword cannot be used with an alpha or alphanumeric value. You can
also turn on or off additive aliasing using the ON or OFF keywords, and you can clear any previously defined additive aliases
using the CLEAR keyword. For example...
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.ALIAS ADDITIVE 1000 2000
#any numeric point IDs in the 1000- or 2000- ranges will automatically alias their corresponding point.
...
M 12-11-1001 15-35-10 123.45 90.0110 #reobservation of 1 was stored as 1001
M 12-11-1002 30-30-15 135.42 90.1230 #reobservation of 2 was stored as 1002
M 12-11-1003 44-22-55 134.23 89.5805 #reobservation of 3 was stored as 1003
...
M 14-13-2017 20-20-20 185.45 90.0110 #reobservation of 17 was stored as 2017
M 14-13-2018 40-20-30 104.23 90.1230 #reobservation of 18 was stored as 2018
M 14-13-2019 50-40-30 134.23 89.5805 #reobservation of 19 was stored as 2019
...
.ALIAS ADDITIVE OFF
#any following point IDs will no longer be aliased by their additive number.
...
M 17-16-1b 15-20-20 185.45 90.0110 #point 1b does NOT alias point 1 anymore
M 17-16-2b 30-20-30 104.23 90.1230 #point 2b does NOT alias point 2 anymore
M 17-16-3b 40-40-30 134.23 89.5805 #point 3b does NOT alias point 3 anymore

.ALIAS ON | OFF | CLEAR

TheON, OFF, and CLEAR keywords can be used alone or in conjunction with one of the four aliasingmethods described
above when used with a NAME, SUFFIX, PREFIX, or ADDITIVE option (like .ALIAS NAME CLEAR) andON/OFF/CLEAR
instruction will affect only that specific scheme.

TheON, OFF, and CLEAR keywords can also be used on their own (like .ALIAS CLEAR) without a specific scheme, in which
case the instruction will affect all aliases. TheON andOFF keywords can be used to enable or disable any previously defined
aliases. The CLEAR keyword can be used to clear any previously defined aliases. These can be useful if you have varying
point aliases in different files. For example...

#Sample file A.DAT, which contains an additive aliasing scheme
.ALIAS ADDITIVE 1000
C 1 1000.0 1000.0 'HUB #this defines point 1
...
M 12-11-1032 20-45-10 123.45 90.0130 'IP #reobservation of 32 was stored as 1032
M 12-11-1033 70-00-30 145.67 90.0025 'IP #reobservation of 33 was stored as 1033

#Sample file B.DAT, which contains unique point IDs in the 1000-range that are NOT aliases
#Assuming that A.DAT is processed before B.DAT, we want to prevent aliases from being inherited.
.ALIAS CLEAR #.ALIAS ADDITIVE CLEAR would have the same effect in this case
...
M 47-46-1045 23-45-30 1324.5 89-57-45 'POST
#point 1045 is a unique point completely unrelated to point 45 in A.DAT

Note that aliases defined in one project are always cleared when you close and open a new or different project. If you want the
same aliases to be applied in all of your projects, you can add the appropriate .alias lines into your template.dat file.

Inline Option .PRISM { constant1 [constant2] } | ON | OFF | CLEAR

This option allows you to specify a prism offset correction for distances that weremeasured using incorrect field settings.
When a prism offset is defined, all distances that follow will have the specified correction applied to them.
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The .PRISM command can take one or two constants as described below, always in millimeters (mm). TheON, OFF, and
CLEAR keywords allow you to enable/disable/reset the corrections throughout the file.

You can specify one constant, in millimeters (mm), and that distance will be scaled to your distance units and added to the dis-
tances that follow.

Or, you can specify two constants, both in millimeters (mm), and the difference between those two values (constant1minus
constant2) will be scaled to your distance units and added to the distances that follow. This format is helpful because you can
show both the correct offset value that should have been used in the field during the data collection (constant1) as well as the
incorrect offset value that was accidentally used (constant2).

Prism corrections act on a line-by-line and file-by-file basis in the order that they are read, meaning that any corrections must be
defined before the observations to which it should be applied. Prism corrections will carry over between files, whichmay or
may not be desired, so a CLEAR keyword is also provided which can be used to reinitialize any previously defined corrections.

.2D

.UNITS meters
C 1 1000.0 1000.0 ! !
C 2 1100.0 1000.0 ! !
M 1-2-3 30-00-00 100 # distance = 100.0000m
.PRISM 30
M 1-2-4 40-00-00 100 # distance = 100.0000m + 30mm = 100.0300m
.PRISM -30
M 1-2-5 50-00-00 100 # distance = 100.0000m - 30mm = 99.9700m
.PRISM OFF
M 1-2-6 60-00-00 100 # distance = 100.0000m
.PRISM ON
M 1-2-7 70-00-00 100 # distance = 100.0000m - 30mm = 99.9700m
.PRISM 30 17.5
M 1-2-8 80-00-00 100 # distance = 100.0000m + (30mm - 17.5mm) = 100.0125m
.PRISM CLEAR
M 1-2-9 90-00-00 100 # distance = 100.0000m

Inline Option .NORMALIZE ON|OFF

This option controls whether Reverse Face or Face Two observations (containing a zenith angle greater than 180 degrees or
200 gons) will be automatically normalized prior to the adjustment.

By default, STAR*NET 9.2 and newer behave as if .NORMALIZE ON is set, while previous versions behaved as if
.NORMALIZE OFF is set.

For example, the following data will result in stations 31 and 32 being computed at the same coordinate:

.NORMALIZE ON  #Default
M  1-2-31   00-00-00  100.00   90-00-00  'Direct face observation
M  1-2-32  180-00-00  100.00  270-00-00  'Reverse face observation

While the following data will result in stations 41 and 42 being computed at the same coordinate:
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.NORMALIZE OFF  #Legacy
M  1-2-41  00-00-00  100.00   90-00-00  'Direct face observation
M  1-2-42  00-00-00  100.00  270-00-00  'Reverse face observation (same HA)

Please note that with .NORMALIZE OFF set, it is not possible to combine Face-1 and Face-2 observations within a single
Direction Set.

Legacy Inline Options
The following inline options were present in older versions but have been replaced by  improved features or new options. These
inline options are still maintained for the time being, however, to provide compatibility with existing data files.

Inline Option .INCLUDE FileName

In earlier versions of STAR*NET, there was only one primary data file for a project, but the ".INCUDE" inline option could be
used repeatedly to insert data from other files.

Since the current program version allows you to define as many data files as you wish for a project, the ".INCLUDE" option is
no longer really necessary. However, it is still maintained in the program so that existing projects can run unchanged, and to
support users who still wish to use this feature.

To use the option, insert the ".INCLUDE" inline anywhere in the primary data file or any included file. Whenever the program
finds the option, it will start reading data from the specified file. After data has been completely read from the included file, the
program continues reading data from the preceding data file.

#Sample file containing ".INCLUDE" inlines
.INCLUDE DAVID.001
M  2-1-3   132-33-22   1200.234
M  3-2-4   125-14-54   1422.345
M  3-2-5   155-23-34   1023.117
.INCLUDE DAVID.002
.INCLUDE NORTH40.DAT
etc...

There are a couple simple rules to remember when using this option. In the discussion of the rules below, we call the file con-
taining the ".INCLUDE" option the "parent" and the file to be included, the "child."

1. The child file inherits all options currently in affect in the parent file, however any options set or changed within the child
file are not transferred back to the parent. For example, if you use the ".2D" inline option in the parent file, the child file
inherits the "2D" datamode. But, if themode is changed using the ".3D" option in the child file, the changedmode is not
transferred back to the parent. The parent retains its original "2D" datamode.

2. An "included" file may also contain an ".INCLUDE" inline option, and all the rules mentioned above relating to parent
and child files continue to apply. Also, if a path is given with the file name, any ".INCLUDE" option lines in the child file
also inherit this path.

Inline Option .MULTIPLIER value

In earlier versions of STAR*NET, this option was used to convert between different linear units (i.e. feet to meters, etc.) by
applying amultiplier. The current program version has a better method, the ".UNITS" inline option previously described.
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But, this inline option is maintained so that existing projects can run unchanged. If for example, linear units in your Project
Options are set to FeetUS, but parts of your data are entered inMeters, apply amultiplier to the respective data as illustrated
below:

M  24-23-25   68-33-44.5   655.678   #Normal data in FeetUS
.MULT 3.28083333                     #Multiply by 3.28083333
M  26-25-27   98-45-55.4   201.335   #Data in Meters
M  27-26-28   79-33-24.3   194.667
.MULT                                #Resets to 1.000 again
etc...

An entered inlinemultiplier affects all linear items including coordinate values, distances, elevation differences, HI-HT values
and any explicitly entered standard error values relating to these linear items.

Inline Option .ELEVATION  ORTHOMETRIC|ELLIPSOIDAL

In earlier versions of STAR*NET, this inline option allowed you to specify that an elevation entered on a C, P and E data line
was to be interpreted as an ellipsoid height rather than an orthometric elevation. In this version, CH, PH and EH data line codes
have been provided tomake entering of ellipsoid heights more straight forward. See descriptions of the CH, PH and EH data
lines earlier in this chapter.

But, this inline option is maintained so that existing projects can run unchanged. The option only affects the interpretation of
elevation values on C, P and E data lines.

The example below illustrates entry of few Position and Elevation lines. The elevation values on the initial lines are interpreted
as orthometric. Themode is changed to ellipsoidal, and then back again to orthometric.

P 125  37-25-29.345  122-04-25.324  955.32  ! ! ! #Ortho by default
.ELEV ELLIP
P 153  37-26-22.177  122-03-55.411  923.52  ! ! ! #Ellipsoid heights
P 157  37-25-29.345  122-03-45.235  924.95  ! ! !
E 165  924.66   !
E 166  924.98   !
.ELEV ORTHO
E 133  955.37   !                                 #Back to orthometric
etc...

Inline Option .VLEVEL SectionLengthUnits|NONE|OFF

This inline allows data from the discontinued DOS-based STAR*LEV program to be used unchanged in STAR*NET by intern-
ally converting the original "V" line leveling data to information compatible with new the "L" line data format.

The old STAR*LEV program allowed section values to be entered in a variety of units: Feet (handled as US feet), Miles,
Meters, Kilometers, Turns or None. However STAR*NET expects a section value to be either a Length (in the same units as
the current project units, usually Feet or Kilometers), or as number of Turns.

Enter the ".VLEVEL" option preceding your old STAR*LEV data. Add a keyword to describe the old data: FEET, MILES,
METERS, KILOMETERS, TURNS or NONE. The examples below illustrate themost common of ways one would use this
inline.
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The first example inline option tells STAR*NET that the sections are entered as Miles. Assuming the current project units are in
FeetUS, the program will internally convert the section lengths fromMiles to FeetUS.

The second example inline option says to interpret the section value as number of turns.

The third example illustrates the "None" option. In the old STAR*LEV program, the "None" section length optionmeant that the
section value was not to be used for weighting and that a given total standard error was to be used for each section. So in this
example, if the project units are FeetUS and the weighting of the old STAR*LEV data was set to 0.05 feet total per survey line,
the following inline would cause a constant 0.05 feet standard error for all following observations regardless of the section val-
ues entered. The entered section length values are ignored.

The last example line turns the ".VLEVEL" option off indicating that any subsequent data will not need conversion from the old
STAR*LEV data format.

.VLEVEL MILES                #Indicates sections are in Miles
V  101-102   2.5443  2.32    #2.32 Miles will be converted to Feet
.VLEVEL TURNS                #Indicates sections are in Turns
V  101-102   2.5443   8      #The number of Turns is 8
.VLEVEL NONE=0.05            #Indicates to assign 0.05 and ignore
V  101-102   2.5443  123     #section values, 123 for this line
.VLEVEL OFF                  #Turns the option off

Note that if your old STAR*LEV section data is already in Feet, Meters or Turns, the data is already compatible with
STAR*NET except the "V"codes should be "L" codes. You can use the ".VLEVEL" inline to define the old data to STAR*NET,
but in such a case, youmay find it easier to simply edit your old STAR*LEV data files and change the data line codes from "V"
to "L" and just be done with it!

5.8 ENTERING 3D DATA IN A 2D ADJUSTMENT
STAR*NET allows you to enter 3D formatted data into a 2D adjustment. Your 3D data will be reduced automatically to 2D, and
the adjustment will be processed as if you hadmanually reduced the data before entering it into the data file.

When the "Adjustment Type" in the Project Options/Adjustment dialog is set to 2D, the program expects to find data in 2D
format. However, to instruct the program to read data entered in 3D format, youmust precede any group of 3D data lines with
the ".3D" inline option. This tells STAR*NET what sort of data to expect, and allows for proper checking and reduction to hori-
zontal. If you switch back to 2D data format, precede those lines with the ".2D" inline option.

3D data containing slope distances must be in the form of lines that include both the distance and zenith so that STAR*NET
can reduce the slope distance to horizontal. This data can be in the form of M, BM, DM, DV or T data lines. A slope distance
entered as a single observation using the "D" line can not be included within a ".3D" section of data since the program has no
way to reduce it. However, a horizontal distance (with DELTA mode on) may be included in any form within a ".3D" section of
data. Any vertical information on that data line is simply ignored. 

The following data prepared for a 2D adjustment includes a section of 3D formatted lines that will be reduced automatically to
horizontal when read in by the program.
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#Entering both 3D data and 2D data in a 2D adjustment

C    1       12135.223  13111.435 ! !
C    2       13324.665  15245.223 ! !
D    2-1                 1327.34
M    2-1-3   134-45-12   2244.348
D    3-2                 2244.341
M    3-2-4   144-12-56   3325.028

.3D   #Change to 3D data format
DV   4-3                 3325.123   90-22-34  #reduce to horizontal
M    4-3-5   287-44-53   2554.242   90-55-44
DV   5-4                 2554.247   89-04-15
M    5-4-6   166-55-34   5594.110   91-12-33
.DELTA ON
DV   6-5                 5592.751   118.312   #use the horizontal
M    6-5-7   172-21-47   4437.993   -66.345
.2D   #Change back to 2D data format
M    7-6-12  128-55-12   1022.143
M    7-6-23   98-23-11   3255.445

5.9 ENTERING 2D DATA IN A 3D ADJUSTMENT
As discussed in the previous section, STAR*NET allows you to enter 3D data into a 2D adjustment. The program simply
reduces the 3D data down to 2D in that case. Entering 2D data into a 3D adjustment, however, is amuch different situation.

For a 3D adjustment to work, 3D coordinates must be either present or computable for all connected stations in the network!
So, for any station in a 3D adjustment whose elevation is not fixed, theremust be some 3D observation data present that will
cause its elevation to be computed during the adjustment process. Therefore, 2D data of any kindmay be entered into a 3D
adjustment as long as elevations for all referenced network points are determinable in some fashion.

When your Adjustment Type in the Project Options/Adjustment dialog is set to 3D, the program by default expects data in 3D
format. However, to instruct the program to read data entered in a 2D format, youmust precede any group of 2D data lines with
the ".2D" inline code. If you switch back to 3D data lines, precede those lines with the ".3D" inline option to tell the program
what to expect.

The following data prepared for a 3D adjustment includes a section of 2D formatted data lines. Note that stations "45" and "46"
have no other observations entered which will establish their elevations!  For this data to actually solve in a 3D adjustment,
either fixed elevations for these two points must be entered, or additional observations somewhere else in the datamust exist
to define their elevations.
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#Entering 2D data in with a 3D adjustment
#
C    1       12135.223  13111.435  1000.0  ! ! !
C    2       13324.665  15245.223  1299.9  ! ! !
M    2-1-3   134-45-12   2244.348  91-22-54  5.1/5.2
M    3-1-4   144-12-56   3324.222  89-56-54  5.3/5.0

.2D   #Change to 2D data format
M    3-2-45  287-44-53   2554.242
M    5-4-46  166-55-34   5554.771
SS   5-4-88   76-45-22    943.342

.3D   #Change back to 3D data format
M    5-4-7   172-21-47   4437.993  90-55-32  5.6/5.2
M    5-4-23   98-23-11   3255.445  90-45-51  5.6/5.7

Note that "SS" sideshot data can be freely entered in a 3D adjustment in 2D format (or reduced from 3D to 2D format using the
".3REDUCE" inline). Sideshot points are computed after the adjustment is completed. An elevation value of "-99999" is pub-
lished for any sideshot whose elevation is not determined.

5.10 ENTERING "REFERENCE ELEVATIONS" IN A 2D PROJECT
As described in the Chapter 4, "Options," a "Project Elevation" is assigned to all points in 2D Local andGrid projects so that
certain data reduction calculations, such as reducing slope distance and zenith observations to horizontal can be performed
using curved earth geometry.

In addition, for 2D "Local" jobs, an elevation needs to be known to perform calculations when the user chooses to have his data
reduced to a given datum. Likewise, for 2D "Grid" jobs, an elevation is necessary to determine grid factors.

In certain cases youmay wish to assignmore than a single project elevation to points in a 2D project so that the calculations
mentioned above can be performedmore accurately. There is an inline ".PELEVATION" described earlier in this chapter in Sec-
tion 5.7, "Inline Options" that allows the default project elevation to be redefined for various parts of the project.

You can also assign elevations to individual points in a 2D adjustment. Simply use any of the data types containing an "elev-
ation" field to enter an elevation value. These values, used in the calculations mentioned above, are considered "reference"
elevations and will list in the results as such. These elevations need not be entered as fixed. Fixity codes or required standard
error placeholders entered for these values will be ignored.

In the example data for a 2D project shown below, elevation values entered for specific points are assigned as their reference
elevations. All other points in the network are assigned the current "Default Project Elevation" as their reference elevations.
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#Entering "Reference Elevations" in a 2D project
C    1     12135.223  13111.435 ! !
C    2     13324.665  15245.223 ! !
.3D  #Change to 3D format to include reference elevation information
C    21    13243.345  15344.547  875  ! ! &
E    31    865
E    33    920
.2D  #Change back to 2D data format
M    2-1-3   134-45-12   2244.348
M    3-2-4   144-12-56   3325.028

Because the earth is curved, reductions to grid or to a given datum in a 2D job is only as accurate as the project elevation or indi-
vidual reference elevations supplied by you. It is highly recommended that you run full 3D adjustments using complete 3D data
to avoid any inaccuracies or approximations whenever possible.

5.11 USING STANDARD ERRORS TO WEIGHT YOUR OBSERVATIONS

What do weights mean?
STAR*NET allows you to individually weight each observation in the adjustment. This feature provides you with great flexibility
in performing adjustments. However, it also requires a basic understanding of the concepts involved. Otherwise, youmay
adversely affect the quality of the adjustment results.STAR*NET’s statistical tests will usually indicate a problem with obser-
vation weights, but you should still understand the implications of your inputs. Therefore, the next few paragraphs present a
brief description of weights and their meaning.

Throughout the discussion, we will refer to the sample distance input line below:

D TOWER-823 132.34 0.04 5.4/5.1

The distance has a standard error of 0.04 in whatever linear units are set in the project options. The standard error is the square
root of the variance of the input value. They are bothmeasures of the precision with which the input value was derived. A small
variance and standard error indicate a precisemeasurement, and a large value indicates an imprecisemeasurement. Note that
a small variance does not necessarily indicate an accuratemeasurement. Rather, it indicates that multiple readings of, for
example, a single distance, clustered closely together. If themeasuring instrument had a large systematic error, then this pre-
cisemeasurement may be rather inaccurate. For example, tenmeasurements of a distancemade with an EDM that is out of
calibrationmay agree closely, but may all be significantly different than the true value.

Another way to state the precision of an observation is its weight. Weight is inversely proportional to variance: as the variance
decreases, the weight increases. In other words, a precisemeasurement with a low variance should be given a large weight in
the adjustment so that it will havemore influence. When you indicate the standard error of an input value (0.04 in the example
above), STAR*NET converts it internally to a weight by squaring the value to compute the variance and then inverting it. This
results in a value of 625 for the example.

Theoretically, though, the weight and variance are inversely proportional to each other. STAR*NET assumes the pro-
portionality constant to be 1.0. How does this assumption affect you? If the standard errors that you assign to your obser-
vations are not realistic, and the constant should have had a value significantly different from 1.0, the adjustment will frequently
fail the Chi Square statistical test. This situationmay not affect your computed coordinate values very much, but you should
always investigate the reasons for an adjustment failing the Chi Square test. This topic is explained inmore detail in Chapter 8,
"Analysis of Adjustment Output ."
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In general, you should always use standard errors, global project defaults or otherwise, that reflect the conditions and equip-
ment used to collect your field data. If you believe, for example, that your angles are "good" to within plus or minus 4 seconds,
then do not use a standard error of 2 seconds to get a "better" adjustment. It will not help. You will likely get a Total Error Factor
in your adjustment statistics that is very different than 1.0, and the adjustment will fail the Chi Square test.

Except for direction sets, STAR*NET assumes that all input observations are uncorrelated. This means, for example, that
there is no interdependence between two distancemeasurements or between angular and distance observations. Note that the
output coordinates from the program will almost certainly have correlation between their Northing and Easting coordinates.
Refer to the section "Ellipse Interpretation," in Chapter 8, "Analysis of Adjustment Output" for further information on output
coordinate correlation.

Why do I want to use weights?
Independent weights assigned to observations allow STAR*NET to solve the survey network more rigorously. Less precise
measurements (larger standard errors, smaller weights) will have less of an influence on the solution, while more precise val-
ues (smaller standard errors, larger weights) will havemore of an impact. For example, if you are combining some old survey
data using tapedmeasurements with a new survey usingmodern EDMmeasurements, youmay want to give the taped dis-
tances higher standard errors (lower weight) than the EDMmeasurements.

In order to introduce constraints into a network, it becomes possible to fix an observation by giving it a very high weight (very
small standard error). For example, youmay wish to have a certain azimuth along a line - simply fix the input value with a small
standard error by using the "!" symbol. Conversely, some input values may be only approximations that you would like not to
influence the adjustment. They can be left free by giving them low weights (high standard errors) with the "*" symbol.

STAR*NET has two special codes ("!" and "*") to allow you to indicate fixed and free observations, in order to simplify data
input. You should normally use these special codes rather than creating your own very low or very large standard error values
to fix or free observations.

How do I weight observations?
1. For most data, you will want the default standard error values assigned that you have set in the Project Option-

s/Instrument dialog, or the default values set by your use of the Instrument Library facility and an ".INSTRUMENT"
inline option. To use the current default standard error values for all observations on a data line, simply leave the entire
standard error field blank.

M 3-2-4 125-30-20     595.25

2. If you want an observation to be free in the adjustment, and have no influence, use the "*" symbol. Or to inherit the cur-
rent default weight, use the "&" symbol. For example, in a 2D formattedmeasure line, you could free the angle obser-
vation and leave the distance weight the same as the current default by entering the following data. Remember that you
must enter all standard error values (or symbols) for observations on a data line, or none.

M 3-2-4 125-30-20     595.25 *     &

In this case, the angle will have no weight or influence in the network adjustment and it will not be counted in the stat-
istical summary. A residual, however, will be displayed in the adjusted angles section of the output listing.

3. If you want an observation to be fixed in the adjustment, use the "!" symbol. For example, the following line fixes the
bearing between "tower" and "p1".

B tower-p1 N45-30-31.02 !



Chapter 5: Preparing Input Data

- 119 -

Be careful when fixing observations. If you were to fix the coordinates of two points, and then fix the distance between
them at some slightly incorrect value, you will likely get an adjustment that cannot converge. STAR*NET cannot
resolve such inconsistencies in your data.

4. If you want to use an actual standard error, enter the actual numerical value. For angular measurements, enter the stand-
ard error in seconds when DMS units are being used, or in milligons (GON/1000) whenGONS are being used. The fol-
lowing line gives angle P1-P2-P3 a standard error of 12.5 seconds. Remember that explicitly entered standard errors are
used exactly as given and are not inflated by centering errors unless the ".ADDCENTERINGON" inline option is used.

A P1-P2-P3 23-21-13.6 12.5

The values you use for standard errors might be obtained from the specifications of instrument manufacturers, past exper-
ience, or the results of a preceding computation.

Again, it must be emphasized that you should use realistic values. As explained in Chapter 8, "Analysis of Adjustment Out-
put," the entire adjustment is checked with a statistical test. Frequently, a cause for failing this test is the assignment of unreal-
istically small standard errors to your input values. On the other hand, do not make your global standard errors overly large, just
to ensure that the adjustment passes the test. This will have the effect of unnecessarily increasing the size of the error ellipses
around the computed points, and unfairly representing the confidence of your computed coordinates.

If you observemultiple readings for your observations and are entering themean values into STAR*NET, the question is some-
times asked as to whether you should use a different standard error as computed from averaging each set, or use the same
standard error for all averaged sets based on themanufacturer’s "population" standard deviations. The answer is that we recom-
mend you base your standard errors on themanufacturer’s stated specifications – or the results of a controlled field test. Stand-
ard errors computed from such small observation samples (i.e. sets containing 2, 4, 10, 20, etc. repeats) are not that
statistically significant!

Calculating the proper standard errors to use based on amanufacturer’s stated standard deviations is discussed in detail in
Chapter 4, "Options."

The following table summarizes the relationship between weights, precision and the influence on the adjustment.

"Strong"
Measurement

"Weak"
Measurement

Standard Error LOW HIGH
Weight HIGH LOW
Precision HIGH LOW
Influence HIGH LOW

5.12 PROVIDING APPROXIMATE COORDINATES
For a least squares adjustment to work, approximate coordinates (and elevations if you are running a 3D adjustment) must
exist for all adjustable stations in a network. Fortunately, STAR*NET has the ability to look through your data and figure out the
approximate coordinates and elevations based on the actual angle, distance and vertical observations present in the data file.
They are automatically computed using a variety of methods including angle-angle intersection, and angle-distance com-
putation.

Often, however, you will have to enter approximate coordinates for a station or two to help STAR*NET get started calculating
other approximate coordinates. For example, in the first sample project in the tutorial, we gave approximate coordinates for the
first traverse backsight point. STAR*NET will tell you when it can’t compute coordinates by posting amessage in the error file.
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When a network has a full compliment of entered angles and distances, simply providing fixed or approximate coordinates for
some station directly adjacent to another station having known coordinates (or supplying a fixed or approximate bearing or azi-
muth adjacent to another station in the network having known coordinates) is normally all that is required to allow STAR*NET
to complete the job of computing the remaining approximate coordinates.

Some networks will require you to provide coordinates for many or all of the stations. In the case of a pure trilateration project
(distances only) for example, you would have to supply approximate coordinates for all points since STAR*NET is not be able
to determine coordinates from distances alone.
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CHAPTER 6: RUNNING ADJUSTMENTS
6.1 OVERVIEW
STAR*NET allows you to specify several types of processing to perform on your input data.

You can request a full adjustment of your network with or without cluster detection, a check of the data only, a special blunder
detection run, a preanalysis of a proposed survey network, or a loop check of your level or GPS network.

Note, Blunder Detect, Preanalysis, andGPS Loop Check are not available when running Level Network Adjustments.

6.2 ADJUST NETWORK
To perform an adjustment of your network, chooseRun > Adjust Network, or press the Run Adjustment tool button.

When running the adjustment, STAR*NET reads one or more data files you have specified in the Data Files dialog. These file
are read in the order they appear in the dialog. As data lines are read and the adjustment proceeds, the status line at the bottom
of the STAR*NET window shows the progress.

In addition, a Processing Summary window appears on your screen to summarize the progress and results of the adjustment.
When an adjustment finishes, a short statistical summary is displayed in this window indicating how each observation data
type fit into the adjustment. The total error factor for the adjustment is shown and an indication of whether or not the Chi Square
Test passed. A more detailed statistical summary is included in the output listing. Refer to Chapter 8, "Analysis of Adjustment
Output" for more information on adjustment statistics and results.

If errors or warnings were generated during processing, this is indicated at the end of the progress information shown in the Pro-
cessing Summary window. These errors or warnings should always be reviewed as they may indicate errors in your data you
must correct, or warnings that may require your attention. Thesemessages can be reviewed by selectingOutput > Errors or
by clicking the Error File tool button. After checking thesemessages, youmay have to edit your data and rerun the adjustment.

The STAR*NET adjustment produces a number of files. For example, the listing file contains the complete results of the adjust-
ment run. The points file contains the coordinates of your adjusted points. The error file lists any errors or warnings generated
during the run. These files, other output files and a network plot can be viewed from selections  in the Output menu.

6.3 AUTO-ADJUST
Auto-adjust will automatically detect outliers in your adjustment, remove them, and readjust the network iteratively until:

1. An error is encountered ...or...
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2. Themaximum iteration value is reached ...or...

3. All standardized residual values fall below themax. std. res. value

This adjustment type is not meant to replace a standard adjustment, but will display the adjustment results in the listing file,
allowing you to locate and remove outliers from your adjustment.

Max. Std. Res.

This is themaximum allowable value for standardized residuals in the adjustment. STAR*NET will keep iterating through
adjustments until all standardized residuals fall below this value. If this condition is met, the auto-adjust dialog will close upon
completion. Increasing this value will decrease the quality of the adjustment, but may decrease the number of iterations to com-
plete. Decreasing this value will increase the quality of the adjustment, but may make a solution impossible.

Outliers Removed per Adjustment

This is the number of outlyingmeasurements removed per adjustment iteration. STAR*NET will sort all standardized residuals
by value, and remove themeasurements associated with the top n values, where n is the number set in this field. Increasing
this valuemay remove data that was not an outlier, but was being affected by the actual outlier. For example, if twomeas-
urements are going to the same point, one can be an outlier, but both can have higher standardized residuals.

Max. Adjustments

This is themaximum number of adjustments allowed in the iterative process. STAR*NET will remove outliers as previously
described until themaximum adjustment value is met, if no other conditions have been satisfied. Increasing this valuemay res-
ult in a long operation. Decreasing this valuemay increase the chances of being unable to complete the operation.

START

The START button will begin the automatic iterative adjustment process.

Stop
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The Stop button will stop the adjustment process after the current iteration has been completed.

X

Clicking the X in the top corner will close the dialog if no adjustment is running. If an adjustment is running, it will stop the adjust-
ment after the current iteration has been completed and close the dialog.

Progress Indicator

The text in the lower left corner will indicate the progress of the iterative adjustment, allowing you to decide if you would like to
wait for the process to complete, or click Stop to try another method.

Auto-adjust is currently unavailable in batch processing.
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CHAPTER 7: RUNNING ADJUSTMENTS
Adjust Network with Cluster Detection
STAR*NET has the ability to auto-detect point clusters found in a project and automatically create the .Alias inline option for
each cluster detected.

The Network Adjustment with the Cluster Detection preforms two types of adjustments. The first one will run an adjustment
and analyze the coordinates in the project to locate all points that are close together and assigns one point per group to be the
"True Point" and lists the others as its aliased point. Any points being held as "Fixed" will be automatically assigned as the true
point for that particular cluster. If multiple points in a cluster have constraints, it will choose themost constrained point as the
true point.

Once this adjustment has been ran, a preliminary report is generated that displays the results of the cluster detection. This
Cluster Detection report indicates which points STAR*NET has assigned to be the true point and which points will be used as
an alias to the true point. The user can then verify each True point and its clustered aliased points and edit any alias they don't
agree with or change the true point and re run the adjustment to reflect the changes made. After the user is satisfied with the
Cluster Detection results they will press the "Save and Continue" button on the Cluster Detection report to apply the current
cluster settings and re-run the adjustment now using the aliases generated from the cluster detection routine in the final adjust-
ment. If the user is not satisfied with the results, they can press the "Save and Exit" button to save the current changes and
exit out of the cluster detection window. This allows the user to go over the data files again for verification and if any edits are
needed. When the Adjust Network with Cluster Detection is ran again it will reflect any new changes made to the data files.
Now the user can switch between the previously saved cluster settings and the newly created one and compare them using
the "Restore to calculated" and Restore to previously saved" buttons on the cluster detection report.

If checkedON from the Listing file "Listing File Options" on page 45 tab, the listing file will display all inline alias options gen-
erated and indicate which, if any were used in the final adjustment. This will greatly reduce the amount of time and possible
error users may introduce having tomanually enter in the .Alias inline option for each point into the .dat or .gps files.

The Special "Special Options" on page 52 page will contain a group of settings to control this features tolerance values and an
auto deselection of clustered points that fall outside of the set tolerance distance.

The Cluster Detection dialog has a handy toolbar to assist the user with the navigation of each of the detected clusters and it's
settings.

Expand / Collapse all Clusters - This will either expand or collapse all detected clusters found by the routine.

Find Point - Finds the selected point in the "Find Point" window.

Find Point in Plot - Finds the selected point in the "Network Plot" window.

Zoom In / Out - Zooms in and out from the selected point in the "Network Plot" window.

Zoom to Plot Extents - Does a Zoom to extents in the "Network Plot" window.

Restore to Calculated - Restores the Cluster Detection settings to the default calculation.

Restore to Saved - Restores the Cluster Detection settings to the last Saved state.
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Themiddle section shows each "True" point in the cluster and all aliased points assigned to that particular key point in a tree
format. All Points held as "Fixed" will automatically be assigned as the True Point in its cluster. Users will use the check boxes
to indicate if the point is to be used in the cluster or not. It also provides the Delta North, East and overall distance from each
aliased point to the true point.

The lower section of the Cluster Detection dialog gives the user a brief overview of the highlighted point with any aliased or
skipped points related to it and whether or not it falls within the set tolerance.

Save & Exit - This will save the current cluster settings and stop without running a second adjustment.

Save & Continue - This will save the current cluster settings and run another adjustment with the new aliased points applied.

7.1 DATA CHECK ONLY
Before you run an adjustment the first time, youmay wish to simply check the input data rather than run the adjustment.
ChooseRun > Data Check Only to run this routine. This is not an adjustment! When you run Data Check Only, a modified ver-
sion of the listing file is generated, and you can plot the unadjusted network.

The Data Check Only feature performs two functions:

1. First, all input data is read intomemory. If you have any syntax errors in your data files, STAR*NET will issue error or
warningmessages in the error file which you can review and take any action required. Your input data observations will
be summarized in the listing file.

2. Secondly, all observations (angles, distances, etc.) found in the input data are checked for consistency with the approx-
imate coordinates.
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Whenever STAR*NET reads in data, approximate coordinates are computed for all points using the observations found in your
data. The program then calculates the difference between each "entered" observation and its respective "inversed" observation
calculated from the approximate coordinates. Your listing file will contain a section entitled "Differences from Observations" for
each data type. Some observations will show no differences since they may have been used to actually calculate the approx-
imate coordinates. But other observations not used to calculate coordinates may show some differences. When observations
in a network are consistent with each other, differences shown in the listing should be quite small. The appearance of large dif-
ference values likely indicates bad observations, or errors in preparing data.

This ability to check consistency of input observations to approximate coordinates is particularly useful for finding "badly" fit-
ting observations being added to a known "good" network. Simply supply the coordinates from your previous good adjustment
of the network as approximate coordinates in your new data. (When approximate coordinates are supplied, they won’t be com-
puted from the observations.) Run the Data Check Only routine and then check the listing for any of the new observations not
fitting the "good" approximate coordinates.

As indicated above, the Data Check Only routine only reads in data and does a simple check of consistency between obser-
vations and approximate (calculated or entered) coordinates. For amore rigorous method of finding blunders, see Blunder
Detect in the next section.

7.2 BLUNDER DETECT
This is amodified form of adjustment that can be used to find various types of blunders in your input data file. ChooseRun >
Blunder Detect to run this routine. Blunder Detect is never used in place of a normal adjustment, it is a data debugging tool
only! When you run Blunder Detect, a modified version of the listing file is generated. Your listing file will contain a section
entitled "Differences from Observations" for each data type. In the example shown below, the best fit angles are listed in the
Angle column, followed by their differences from the input values. The largest difference is listed at the end of each data type.
Or, if you have chosen in the listing options to have output observations sorted by residual size, your output will be sorted by
observations having the largest differences shown first.

Differences From Observations
=============================

Differences from Observed Angles

At     From   To           Angle          Difference
3      4      5        153-38-56.31       1-00-17.19
9      1      7        159-51-49.11       0-00-00.76
11     10     12         4-59-09.78     -53-00-35.34
15     14     16        42-48-09.82       0-00-05.68

Largest Difference from Observed Angle
11     10     12         4-59-09.78     -53-00-35.34

Blunder Detect functions by performing several iterations, successively deweighting observations that do not fit into the net-
work in an attempt to isolate those observations that contain blunders. The routine works best in a situation where you have a
strong, over-determined network. This means that you should have as many redundant distances and angles as possible. The
Blunder Detect routine will be of little or no help in determining blunders in simple traverses. To utilize Blunder Detect is a
strong argument for collecting additional field data wherever possible. If you can tie across traverses to other stations, or
observe angles to distant stations in the network, your chances of detecting gross errors aremuch improved. Of course, you
will also improve the adjustment results.
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Using the Blunder Detect routine can be very effective under certain circumstances in locatingmultiple gross errors in your
input data. However it is not useful in analyzing survey networks that contain the normal small random errors present in all field
measurements. You should not run Blunder Detect "just to see if things are OK", because it may give youmisleading indic-
ations of problems when there are none. You should reserve its use for those cases where you have a number of large resid-
uals in your input data you cannot account for.

7.3 PREANALYSIS
When you chooseRun > Preanalysis, STAR*NET processes the network using a list of approximate coordinates for all sta-
tions supplied by you, and a list of observation codes to indicate which distances, angles, and other field data will be observed.
No actual field observation data is required. STAR*NET will analyze the geometric strength of the network using your approx-
imate layout and the instrument accuracies supplied as observation standard errors. The predicted accuracy of each station
will be computed, and error ellipses generated.
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# Approximate coordinates for proposed survey
#
C   1   51002   101009   !  !
C   2   51005   101343
C   3   51328   101291
C   4   51416   101073

#
# Proposed Observations
#
D   1-2
D   2-3
D   3-4
D   4-1
D   1-3                 
A   2-1-3
A   3-2-4
A   4-3-1
A   1-4-2
A   1-4-3
#
# Fixed Bearing
#
B   1-2  ?  !

The example above shows a small Preanalysis data file. To indicate roughly where the survey points are planned, approximate
coordinates are required for all stations,. These approximate coordinates must be entered before any of the planned obser-
vation lines!

The distance and angle lines show which observations are planned. Observation standard errors default to the global values for
each data type. If an explicit standard error is required, for example to fix a bearing as shown in the data above, use  the "?"
character as a place holder for the unknown data. An example in Appendix-A, the STAR*NET Tour, provides another, some-
what larger, sample Preanalysis data set.
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You can also run Preanalysis using an existing data set that contains field data. All observations will be ignored. This can be
useful if you wish to simulate the addition of new field measurements to an existing survey, perhaps to improve positional
accuracies in one part of the network. With STAR*NET’s Preanalysis option, you simply add distance or angle lines (without
field data) to an existing data file, run the preanalysis, and look at the predicted error ellipses. Note however that approximate
coordinates must be supplied for all points in the network even though observations already exist on the lines of data.

After Preanalysis has completed, you can view the Listing File to see the predicted standard deviations and error ellipses for
the proposed survey stations. Note that there are no residuals listed, because no actual field datameasurements were entered
or processed. You can also choose to view the plot and look at the predicted error ellipses superimposed on the network. The
actual dimensions and orientations of the ellipses can help you to decide whether your proposed survey will meet the required
specifications for individual point accuracies.

If the predicted ellipses are too large, youmay need to addmore observations, improve the accuracy of your observations (by
reducing their standard errors), or possibly both. On the other hand, if your ellipses are extremely small, youmay be able to
reduce the amount of field data you are planning to acquire.

To use Preanalysis correctly, youmust make several assumptions:

1. That you can indeed survey the approximate configuration proposed in the data file. Once you get into the field, obstruc-
tions may force you to change your plans. The use of topographic maps and aerial photographs to plan the survey
design can help reduce this problem.

2. That you can observe distances and angles to the accuracy you specified in the project options. Preanalysis will not
help you if you simulate the network tomuch greater accuracy than you can actually measure it.

3. That your field measurements will not contain blunders.

Even with these constraints, Preanalysis is a powerful tool to help you test various network configurations before any field
work is done, and to test the effects of adding new measurements to an existing survey.

7.4 LEVEL LOOP CHECK
Loop closure checking is a new blunder detection feature in STAR*NET Version 7. It is selected from the "Run" menu.

Level loop closure checking is available to the following project types:

l 3D Local

l 3D Grid

l Lev

STAR*NET will automatically construct loops from the "L" Level records from your input data. No other special data or inline
options are required to perform the loop check. It will determine closed loops that exist when a series of L observations closes
back to an earlier station (like a-b-c-d-a), and open loops when a series of L observations exist between two fixed stations (like
A-b-c-d-E, where A and E are fixed stations). Multiple loops may exist, and they may share common connections.

While constructing these loops, STAR*NET will average any redundant observations for each connection, and will auto-
matically reject any observations that do not fit that connection within expected statistical tolerances. While the L level records
are directional in nature, the loop check uses them bi-directionally which allows reverse observations like a-b and b-a to be aver-
aged together.

STAR*NET will construct Minimal Loops from your data, and themisclosure of eachminimal loop will be reported. For
example, if you have a loop a-b-c-d-a and another observation a-c, it will detect the two smaller "minimal" loops a-b-c-a and a-c-
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d-a, and themisclosure of each will be reported rather than the overall large loop. This makes it easier to determine the source
of any blunder, by eliminating as much "valid" data as possible from your manual data auditing process.

Observations that form a loop or traverse between fixed stations have expected coordinate closure values. For perfect obser-
vations, the closure for observations forming a loop is zero. For a traverse between fixed stations, the expected closure is the
inverse between the fixed start and end points.

Level loop closure can generate a plot of the level network if horizontal coordinates for all of the stations in the level network are
either provided in the data file or computed from the observations.

Sample Data

####################
## Control ##
####################
.3D
C 1 1000 1000 10 ! ! !

####################
## Plot ##
####################
.2D
C 2 1000 2000 ! !
C 3 3000 2000 ! !
C 4 3000 1000 ! !

####################
## Level Data ##
####################

## Forward Data
.3D
L 1-2 1.000 1000
L 1-3 3.000 2236
L 1-4 3.000 2000
L 2-3 2.000 2000
L 3-4 0.000 1000

## Redundant Data (blunder present)
.data on
L 1-2 1.002 1000
L 1-3 3.001 2236
L 1-3 3.200 2236 # blunder rejected

## Redundant Data (reject connection)
.data off
L 1-2 1.002 1000
L 1-3 3.100 2236 # blunder rejected
L 1-3 3.200 2236 # blunder rejected

Listing File Output

If there were any errors or warnings, you will be referred to the Error Log; It the Loop Check has run successfully, the results
will be output to the Listing file.
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Along with the Summary and any optional sections as specified in the Listing File Options, you will see two sections spe-
cifically pertaining to the Loop Check:

Listing File: Differential Level Loop Check Connection Averages

This section of the Listing file includes all of the averaged connection data for each connection in the loops. The first line of
each section shows the two station numbers defining the connection, along with its Average Elevation Difference and Average
StdErr. The following lines shows the Elevation Difference and StdErr for each individual observation of that connection as
compared to the average.

Differential Level Loop Check Connection Averages
=================================================

From To Elev Diff StdErr File:Line

1 2 1.0010 0.0014
Difference: -0.0010 0.0020 1:21
Difference: 0.0010 0.0020 1:29

1 3 3.0005 0.0021
Difference: -0.0005 0.0030 1:22
Difference: 0.0005 0.0030 1:30
Difference: 0.1330 0.0030 1:31 Rejected

Youwill notice that one of the observations between stations 1 and 3 above has beenmarked as "Rejected." If the "Quick File
References" option is enabled in your Listing File Options then the "File:Line" columnwill be displayed, which can help you eas-
ily locate the source of the rejected observation (in this case, Line 31 of File 1). This means that STAR*NET has determined
that this observation is outside acceptable tolerances, and has therefore rejected and excluded this observation from the aver-
age of this connection.

If all observations for a particular connection are Rejected, then the entire connection will be rejected and excluded from the net-
work; if this occurs then the loop check will try to find any alternative loops based on the remaining valid connections.

Listing File: Differential Level Loop Check Closures

This section of the Listing file includes the averaged values of each connection (as computed in the above section) and the
total misclosure of eachminimal loop defined by your leveling data. Each connection will be displayed with either "Average" if
the connection was based on averagingmultiple observations as shown in the previous section, or a "File:Line" reference if
there were no redundant observations to average.

For a closed loop, the expectedmisclosure is zero; for an open traverse between two fixed stations, the expected sum is the
inverse between the two stations.
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Differential Level Loop Check Closures
======================================

From To Elev Diff StdErr File:Line

3 2 -2.0000 0.0028 1:24
2 1 -1.0010 0.0014 Average
1 3 3.0005 0.0021 Average
Observed Sum: -0.0005

4 3 -0.0000 0.0020 1:25
3 1 -3.0005 0.0021 Average
1 4 3.0000 0.0028 1:23
Observed Sum: -0.0005

Traditional survey adjustments (Angle Balance, Compass Balance, etc) cannot be performed from this loop closure, so the
order of the From-To points defining each connection is not a factor. This loop check is intended solely as a blunder detection
tool, to help you find erroneous leveling observations which should be examinedmanually. Typically, a closure error or rejected
connection will be the result of a blunder in the field such as entering an incorrect station name for a redundant measurement.

7.5 GPS LOOP CHECK
GPS Loop closure checking is a new blunder detection feature in STAR*NET Version 7. It is selected from the "Run" menu.

GPS loop closure checking is available to the following project types:

l 3D Grid

l 2D Grid

STAR*NET will automatically construct loops from the "G1" GPS Vector records from your input data. No other special data or
inline options are required to perform the loop check. It will determine closed loops that exist when a series of G1 observations
closes back to an earlier station (like a-b-c-d-a), and open loops when a series of G1 observations exist between two fixed sta-
tions (like A-b-c-d-E, where A and E are fixed stations). Multiple loops may exist, and they may share common connections.

While constructing these loops, STAR*NET will average any redundant observations for each connection, and will auto-
matically reject any observations that do not fit that connection within expected statistical tolerances. While the G1 vector
records are directional in nature, the loop check uses them bi-directionally which allows reverse vectors like a-b and b-a to be
averaged together.

STAR*NET will construct Minimal Loops from your data, and themisclosure of eachminimal loop will be reported. For
example, if you have a loop a-b-c-d-a and another vector a-c, it will detect the two smaller "minimal" loops a-b-c-a and a-c-d-a,
and themisclosure of each will be reported rather than the overall large loop. This makes it easier for you to determine the
source of any blunder, by eliminating as much "valid" data as possible from your manual data auditing process.

Vectors that form a loop or traverse between fixed stations have expected coordinate closure values. For perfect observations,
the closure for observations forming a loop is zero. For a traverse between fixed stations, the expected closure is the inverse
between the fixed start and end points.

GPS loop closure can generate a plot of the GPS network. Unlike Level loop closures, horizontal coordinates do not need to be
provided in the data file; GPS data is sufficient to produce the horizontal coordinates.

Sample Data
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# Project Settings
# Adjustment
# Type 3D
# Units Meters
# Grid NAD83
# Zone CA Zone 3
# Avg Elev 100
# Geoid -32
# GPS
# Enable default weight for G1 only vectors

####################
## Control ##
####################

.data on
C 1 646210.759201 1844193.216901 100.000000 ! ! !
C 6 646220.759201 1844330.216901 100.000000 ! ! !

####################
## GPS Data ##
####################

## Forward Data
.data on
G1 1-2 53.8593 24.8804 80.4996
G1 1-4 64.9198 -34.5161 31.5287
G1 2-4 11.0596 -59.3980 -48.9696
G1 3-2 -94.0746 24.7369 -54.0951
G1 3-4 -83.0147 -34.6606 -103.0651
G1 5-3 0.6876 51.7405 48.7089
G1 5-4 -82.3271 17.0799 -54.3562
G1 5-6 -27.4584 -14.9158 -75.9376

## Duplicate Forward Data (blunder present)
.data on
G1 1-2 53.4374 24.2124 81.1126 1/2 # good
G1 1-2 53.4374 24.2124 81.1126 1/3 # blunder
## Reject 2-4
.data on
G1 2-4 21.0596 -59.3980 -48.9696 # blunder

Listing File Output

If there were any errors or warnings, you will be referred to the Error Log; if the Loop Check has run successfully, the results
will be output to the Listing file.

Along with the Summaries and any optional sections as specified in the Listing File Options, you will see two sections spe-
cifically pertaining to the Loop Check:

Listing File: GPS Vector Loop Check Connection Averages

This section of the Listing file includes all of the averaged connection data for each connection in the loops. The first line of
each section shows the two point numbers which define the connection along with the Average Elevation Difference and Aver-
age StdErr for that connection. The following lines shows the Elevation Difference and StdErr for each individual observation of
that connection, and its source.
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GPS Vector Loop Check Connection Averages
=========================================

From To Delta X Delta Y Delta Z StdErr File:Line

1 2 53.8593 24.8804 80.4996 0.0099
Difference: 0.0000 -0.0000 -0.0000 0.0140 1:27
Difference: -0.0000 0.0000 0.0000 0.0140 1:38
Difference: 0.2812 0.4454 -0.4086 0.0140 1:39 Rejected

2 4 Rejected
Difference: -5.0000 0.0000 0.0000 0.0150 1:29 Rejected
Difference: 5.0000 0.0000 0.0000 0.0148 1:42 Rejected

Youwill notice that one of the observations between stations 1 and 2 above has beenmarked as "Rejected." If the "Quick File
References" option is enabled in your Listing File Options then the "File:Line" columnwill be displayed, which can help you eas-
ily locate the source of the rejected observation (in this case, Line 50 of File 1). This means that STAR*NET has determined
that this observation is outside acceptable tolerances, and has therefore rejected and excluded this observation from the aver-
age of this connection.

If all observations for a particular connection are Rejected, then the entire connection will be rejected and excluded from the net-
work; if this occurs then the loop check will try to find any alternative loops based on the remaining valid connections. In this
simple you will notice that the connection between 2 and 4 has been completely rejected, so it will not be used when con-
structing theminimal loops.

Listing File: GPS Vector Loop Check Closures

This section of the Listing file includes the averaged values of each connection (as computed in the above section) and the
total misclosure of eachminimal loop defined by your vector data. Each connection will be displayed with either "Average" if
the connection was based on averagingmultiple observations as shown in the previous section, or a "File:Line" reference if
there were no redundant observations to average.

For a closed loop, the expected sum is zero; for an open traverse between two fixed stations, the expected sum is the inverse
between the two stations.
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GPS Vector Loop Check Closures
==============================

From To Delta X Delta Y Delta Z StdErr File:Line

3 4 -83.0147 -34.6606 -103.0651 0.0139 1:31
4 1 -64.9198 34.5161 -31.5287 0.0133 1:28
1 2 53.8593 24.8804 80.4996 0.0099 Average
2 3 94.0746 -24.7369 54.0951 0.0131 1:30
Observed Sum: -0.0006 -0.0010 0.0009

5 3 0.6876 51.7405 48.7089 0.0150 1:32
3 4 -83.0147 -34.6606 -103.0651 0.0139 1:31
4 5 82.3271 -17.0799 54.3562 0.0132 1:33
Observed Sum: 0.0000 -0.0000 0.0000

1 4 64.9198 -34.5161 31.5287 0.0133 1:28
4 5 82.3271 -17.0799 54.3562 0.0132 1:33
5 6 -27.4584 -14.9158 -75.9376 0.0144 1:34
Observed Sum: 119.7885 -66.5118 9.9473
Expected Sum: 119.7894 -66.5105 9.9461

Traditional survey adjustments (Angle Balance, Compass Balance, etc) cannot be performed from this loop closure, so the
order of the From-To points defining each connection is not a factor. This loop check is intended solely as a blunder detection
tool, to help you find erroneous leveling observations which should be examinedmanually. Typically, a closure error or rejected
connection will be the result of a blunder in the field such as entering an incorrect station name for a redundant observation.
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CHAPTER 8: VIEWING AND PRINTING OUTPUT

8.1 OVERVIEW

The output menu allows you to view output files resulting from running an adjustment, or from running any of the other types of
processing from the Runmenu described in the last chapter. The "Listing" and "Plot" are the two types of output that you usu-
ally will view immediately after an adjustment. There are tool buttons provided for these two outputs so you can quickly and
easily select them.

8.2 OUTPUT FILES
The following output can be viewed and printed directly from this menu. Some of these files are created only if options are set in
the Project Options requesting them.

l Listing File - This file is themost important of all output files. It contains detailed results from the current run and is the
main output document from an adjustment. The information in this file includes summary of input, adjustment statistical
summary and adjusted observations and residuals output. It is described in detail in the next chapter, "Analysis of
Adjustment Output."

l Error File –Only created when the run produces errors or warnings.

l Coordinates File – Adjusted coordinates/elevations, optional.

l Lat/Longs File – Adjusted Geodetic Positions from a grid job, optional.

l Ground File – Scaled-to-Ground coordinates, optional.

l Dump File – Comma delimited coordinate information file, optional.

l Plot – The graphical network screen plot is created by the program from a special binary file created during the run. For a
level network plot to be created, horizontal reference coordinates must be supplied for all stations.

8.3 LISTING FILE
To view the Listing, chooseOutput > Listing, or press the Listing tool button.
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The listing file maintains an internal "table of contents" which knows the location of all major sections. You can press the tool
buttons on the listing window’s frame to jump forward or backward in the file one heading at a time, a whole section at a time, or
to the end or top of the file. And, of course, you can scroll using the scroll bars.

You can also pop up a "Listing Index Tree" window by pressing the Listing Index Tree button on the listing window tool bar, or
by right-clicking anywhere on the listing. This window displays a table of contents for the entire listing file. Use this Index Tree
to quickly jump to specific sections of the listing. Click any listing section to jump to that location. Open and close listing sec-
tions using the [+] and [-] tree items just as you would inWindows Explorer.

Both the Listing and Listing Index Tree windows have amemory, and each window will appear the same size and at the same
location the next time STAR*NET is run. Resize these windows and position them in any way you prefer. For example, in the
STAR*NET window shown above, listing window has been sized large enough to show the whole width of the listing, and the
index window small and off to one side. If your screen size and resolution is sufficient to show both windows simultaneously,
you can check the "Keep on Top" box on the Index window, as shown above, so that when the listing window is active, the
Index will always pop up – a convenience!

To search for text in your listing file, either select "Find" from the Edit dropdown dialog on themain window, or simply press
Control-F.

You can Preview or Print your listing anytime the Listing window is active. Before doing either, you should use the "Text Page
Setup" dialog from the File menu to set printing options such as what printer to use, portrait or landscape printing orientation,
desiredmargin sizes, and page numbering. Once these options are set, they will remain set until you again want to change
them.

If you wish, preview your listing by choosing File > Print Preview, or by pressing the Print Preview tool button on themain win-
dow.

To print your listing file, choose File > Print, or press the Print tool button on themain window, or press the Print button from
the Print Preview window.

When you print, a print dialog opens and allows you to choose to print "all" of the listing, or a selected page range in the listing.
Or if you have highlighted a few lines in the listing window, for example some adjusted angle observations and residuals, you
can choose to print this "Selection" only.
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Important! Note that if the listing file text is edited external to STAR*NET, the internal table of contents will be lost, and the
"Listing Index Tree" and the navigation tool buttons will no longer work. If you need to edit you listing for one reason or another,
first make a copy of it (your "ProjectName.lst" file) and then edit the copy!

8.4 ERROR FILE
During an adjustment, errors or warnings messages may be issued by the program. If the processing summary indicates that
there were errors or warnings, you should always view them to see what course of action should be taken.

To view the Error file, chooseOutput > Errors, or press the Errors tool button. Note that the Errors tool button (the red exclam-
ationmark) only becomes active if an error file has been created. And like other output files, when the error file window is act-
ive, the file can be printed by choosing File > Print, or by pressing the Print tool button.

An extensive list of error and warningmessages and their meanings can be found later in Appendix D: Errors & Warnings.

8.5 ADJUSTED POINTS
Several types of adjusted point files are optionally created during an adjustment, including the coordinates, latitudes and lon-
gitudes (for grid jobs), and scaled-to-ground coordinates. View any of these files by selecting them from theOutputmenu.

The example coordinates file illustrated below contains North, East and Elevation values from a 3D adjustment network adjust-
ment using the Standard edition.

For the LEV edition, the Coordinates file will contain only the adjusted elevations. View this file by selecting “Coordinates” from
theOutput menu.

And like any of the output files, the file can be printed by choosing File > Print, or by pressing the Print tool button.

Another output file, the comma-delimited dump, contains detailed information about every adjusted station. It can be viewed
and printed just like the other adjusted points files above, however, its primary purpose is for importing into a spread sheet or
database program as discussed in Chapter 4, "Options."

8.6 NETWORK PLOT
To view the Plot, chooseOutput>Plot, or press the Plot tool button.
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Four tool button groupings allow you to perform several plotting functions:

l The first group are zoom buttons. Use them to zoom in and out, zoom to extents, and return to the previous zoom.

l The next group includes "Center-on-Click" and "Pan" features. These buttons set modes which remain in effect until the
button is again pressed, or until you right-click on the plot. Use the "center-on-click" mode to click on a network feature
and cause that point to center in the plot window. When the "pan" mode is active, a small hand appears as themouse
cursor. Drag this hand to pan the plot image.

l The next two buttons bring up "Find" and "Inverse" dialogs. Type a point name in the Find dialog or select it from the list.
Press "Find" and the plot will center on that point. In the Inverse dialog, type point names in the From/To fields, or select
them from the list, or click the points in the plot (which fills-in the names) and press "Inverse." An information box
appears showing the inversed distance, azimuth and elevation difference. See the example above. Note that the Find
and Inverse dialogs bothmay bemoved off to the side of the plot, and they will stay there, out of the way, while the plot
window is open.

l The next button brings up a Plot Options dialog which is explained next.

l The last button brings up a Layer Manager dialog which is used for overlaying georeferenced data files (including raster
images, shapefiles, CAD drawings, andmany other different formats) from a local file or an online source onto your net-
work plot.

Plot Options
Press the "Plot Options" tool button to view and edit several network plot settings.



Chapter 8: Viewing and Printing Output

- 141 -

In this dialog, several network plot display options can be set which affect the appearance of the plotted image. Plotting options
are saved in the "project" options so that when a project is opened another time, the plot will have the same appearance. Each
project remembers its own individual plot options.

Network stations are always drawnwith the followingmarker symbols, independently of the color and size options specified in
the dialog.

Symbol Description
l Circle Station is not fixed on any axis
uDiamond Station is partially fixed, on at least one axis
n Square Station is horizontally fixed - that is, fixed on the x and y axes but not on the z axis
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5 Triangle Station is fully fixed on all axes.

You can individually turn on and off various network and sideshot objects such as station names, markers, descriptors,
ellipses and  relative ellipses.

Press the "Apply" button any time to see the effects of any setting changes.

Popup "Quick Change" Menu
Pop up a "Quick Change" menu by right-clicking anywhere on the plot. Click any item on themenu to perform a single function.
For example, to quickly turn network "Names" off, first right-click to get the quick changemenu, and then click the "Show
Names" item to uncheck or disable names.

You can also access all the "Tool Button" functions from this popupmenu as well as bring up the full the Plot Options dialog dis-
cussed on the previous page.

Use this quick changemenu for an easy way to access the Plot Page Setup dialog for setting up the printer before previewing
or printing a network plot. Printing of your plot is described later in this section.

Other basic mouse operations in the plot window include the following:

l Drag a box around any area of the plot to quickly zoom in. Drag a zoom-box by holding down the left mouse button and
dragging a rectangular enclosure.

l Double-click any point or line to get its adjusted information including error ellipse values if error propagation was per-
formed. The information box can bemoved off to one side, out of the way. Double-click another point or line and the
information box will refresh.
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The example shown is adjusted information for station 5 including coordinates, elevation and error propagated ellipse val-
ues.

l As youmove themouse around the plot window, North and East coordinates displayed in the status line are con-
tinuously updated with the project coordinates at themouse pointer. The width of the window is shown in project units
so that any time you zoom in, or resize the window, you always have a good sense of the plot scale.

Just like with the ListingWindow, the Plot Window also has amemory. Once you size and locate the window, the next time the
program is run and a plot is displayed, the plot window automatically appears the same size and in the same location.

Layer Manager
Press the "Layer Manager" toolbar button to display georeferenced data files or online data in your network plot.
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Layer Controls

The STAR*NET network will always be displayed above any external data, and any vector files (like drawings or shapefiles)
will always be displayed above any raster files (like images). Layers are drawn in the order shown on the list (top-to-bottom),
and items higher in the list may be obscured by like-format items lower in the list. This behaviour is opposite to a CAD dra-
worder commandwhich some users may expect.

You control the display order of like-format files, for example if you havemultiple raster images that cover or obscure each
other using the display controls.

Press tomove the selected layer up to the top of the list (drawn first).

Press tomove the selected layer up one position.

Press tomove the selected layer down one position.

Press tomove the selected layer down to the bottom (drawn last).

Press to show or hide the selected layer, or check/uncheck its visibility checkbox.

Press to unload the selected layer. (The data file itself is never deleted.)

Open Data File

Over 150 supported file formats can be displayed in your network plot including Raster Images, DWG/DXF Drawings,
Shapefiles, LiDAR, MrSID, GeoPDF, GeoTIFF, Microstation DGN, ASCII Coordinates, ESRI, ERDAS, Garmin, KML,
COLLADA, Sketchup, andmany many many more...

You will be prompted to browse to and select a supported data file.
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Depending on the file format you select, youmay be prompted for projection details for your data file. Datum parameters are
read directly from the current STAR*NET project into the "StarNetDatum" option, so unless you are reprojecting from a dif-
ferent datum all you need to do is ensure the projection details are correct for your selected data file. Some file formats already
contain embedded projection data, in which case you will not see this prompt.

Download Online Data

Online data sources are tile-based and new tiles may be downloaded as your view changes, so the level of detail will generally
increase as you zoom in or decrease as you zoom out. Youmay notice a delay as new tiles are downloaded to your local
cache.
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Select Data Source

The DownloadOnline Data button allows you to download layers from various predefined online sources, or from any other cus-
tom-definedWMS (WebMap Service), WCS (WebCoverage Service), OSM (OpenStreetMap Tiles), GoogleMaps Tiles, or
TMS (Tile Map Service) source.

Any online data sources labeled with "[PREMIUM CONTENT]" require a subscription to the selected third-party online service.
You will be prompted for account credentials (along with information on how to subscribe), and youmay be directed to visit that
mapping service's website and/or prompted to install a helper application provided by that mapping service.

AddNew Source: Add your own customWMS (WebMap Service), WCS (WebCoverage Service), OSM (OpenStreetMap
Tiles), GoogleMaps Tiles, or TMS (Tile Map Service) data source. You will be prompted for the URL and any applicable para-
meters depending on the service type.

Remove Source: Remove any data sources you added which are no longer wanted. You cannot delete any of the predefined
sources.

Delete Caches Files: Delete the previously-downloaded, cached data files from a specified type of data source. This can be
useful if online data has been updated or if the cached files are corrupt.

Add Sources from File: Import online data sources from an external text file, as a way of sharing online data sources with other
users. All of your custom online data sources are saved in a file namedwms_user_sources.txt so you can share this file with
other users for them to import.
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Select Area to Download

Current Screen Bounds: The downloaded imagery will be bounded by the current network plot view. If your view changes, new
imagery will not be downloaded as you zoom out or pan beyond the downloaded data.

Within Distance of Address: The downloaded imagery will be bounded by the specified distance from a central address.
Addresses can be entered as follows:

street, city, state/country, zip
street, city, state/country
street, zip
city, state/country, zip
city, state/country
zip

Within Distance of Latitude/Longitude:The downloaded imagery will be bounded by the specified distance from a central geo-
detic positions. Geodetic positionmust be entered as decimal degrees, with positive-east/negative-west and positive-
north/negative-south.

Within Latitude/Longitude Bounds of Area: The downloaded imagery will be bounded by your minimum andmaximum geodetic
positions. Geodetic positions must be entered as decimal degrees, with positive-east/negative-west and positive-north/neg-
ative-south.

Entire Data Source Bounds: Any available data will be downloaded as needed. In comparison to the "Current Screen Bounds"
option, if you zoom out or pan away from the previously downloaded data, additional tiles will be downloaded to fill the current
network plot view.

Some online data sources are only available within specific geographic regions, beyond which no imagery tiles can be down-
loaded. For example, USGS imagery is unavailable outside the United States.

8.7 PRINT / PRINT PREVIEW
You can Preview or Print any of your input or output files or the network plot by running the File > Print or File > Print Preview
commands. The two commands are identical, they are both provided tomake it easier for users to find the desired command.
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Use the buttons along the left-side panel to switch between the various files that can be printed. All of the output files can be
selected from their dedicated button, and any of the input data files currently open in the editor can be selected from the pull-
down list at the bottom of the side panel. If a particular file is not available (for example because that output has not been gen-
erated yet), the corresponding button(s) will be disabled.

l Listing

l Errors

l Process Summary

l Coordinates

l Lat/Longs

l Ground Scaled Coordinates

l Dump File

l Network Plot

l Input Data Files (pull-downmenu)

Use the toolbar along the top panel to control printing and view options:

l Print (prints the currently selected file)

l Page Setup (to specify page size, orientation, andmargins)

l 1-page View (zoom to fit entire page)

l 2-page View (zoom to fit two pages)

l Zoom to 100% (zoom to actual size)

l Zoom In (zoom in repeatedly)
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l Zoom to Page Height

l Zoom to PageWidth

l Help

l Close Preview

To exit from the Print/Print Preview screen and return to the editor, youmust use the Close Preview button on the top toolbar
panel. Clicking the X button in the top-right corner will exit the entire application after a confirmation prompt.

A few words should be said about composing your network plot on the sheet. Plotting in this program is simply printing a dia-
gram. There is no precise control of plotting scale or sizing of point names or markers. However, the general appearance of the
diagram can be easily controlled by resizing the plot window to the approximate shape and orientation of the target sheet. Place
(by zooming or panning) the network image within the plot window exactly how you want it to appear on your final sheet. Res-
ize the point names andmarkers larger or smaller, resize the ellipses (or turn them off), etc. What you see will be what you get.
Preview the plot, and then if necessary, make any changes before printing. You will need to experiment with this.
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CHAPTER 9: ANALYSIS OF ADJUSTMENT OUTPUT

9.1 OVERVIEW
Your objectives in performing a Least Squares Survey Adjustment are to eliminate blunders from your data, compute the best
fit adjustment for all survey observations simultaneously, and to evaluate the accuracies of the adjusted survey points.

This chapter is designed to help you interpret a STAR*NET adjustment output listing. You can use the output listing to :

l Review all of your input field observations

l Locate and correct gross blunders in your input data

l Analyze the strength of your survey observations

l Determine the positional accuracies of computed points

STAR*NET stores the output from an adjustment in a file called "PROJECT.LST", where "PROJECT" is the name of your cur-
rent project. You can view this file within the program by choosingOutput > Listing, or by pressing the Listing toolbar button.

You control the sections that STAR*NET places in the output listing file by settings in the Project Options/Listing dialog. Dur-
ing the data checking phase, youmay want to produce aminimally detailed listing, and then later, turn on additional sections of
the report you now want included. Depending on the type of adjustment, some of the output listing sections shown below will
not be available. For example, in a 1D level network adjustment, many of the sections shown do not apply.

9.2 SECTIONS OF THE OUTPUT LISTING
l Summary of Files Used andOptions Settings

l Listing of Input Data (optional)

l Adjustment Solution Iterations (optional)

l Summary of Unadjusted Input Observations (optional)

l Adjustment Statistical Summary with Chi Square Test

l Adjusted Station Information (optional)

l Coordinate Changes from Entered Provisionals (optional)

l Adjusted Coordinates (optional)

n Adjusted Elevations and Error Propagation (optional, lev jobs only)

n Adjusted Positions and Ellipsoid Heights (optional, grid jobs only)

n Convergence Angles andGrid Factors at Stations (optional, grid jobs only)

l Adjusted Observations and Residuals (optional)

l Adjusted Angle Observations

l Adjusted DistanceObservations

l Adjusted Differential Level Observations

l Adjusted Bearings and Horizontal Distances (optional)



MicroSurvey STAR*NET ReferenceManual

- 152 -

l Traverse Closures of Unadjusted Observations (optional)

l Sideshot Coordinates Computed After Adjustment (optional)

l Error Propagation (optional)

l Station Coordinate Standard Deviations (optional)

l Station Coordinate Error Ellipses (optional)

l Relative Error Ellipses (optional)

The remainder of this chapter discusses each section of the output listing file, providing hints on adjustment analysis. It con-
cludes with a section of procedures that you can follow to locate and correct errors in your survey data.

9.3 SUMMARY OF FILES USED AND OPTIONS SETTINGS
The first few lines of the listing file identify the version of STAR*NET that you are using, and your licensing information. If you
need to contact MicroSurvey Software Inc. for technical assistance, youmay be asked for this information. The exact time and
date of the run is shown, so that you can keep track of multiple runs of the same project.

The project name, project folder and names of all input data files used in the adjustment are listed next.

Last comes a summary of the option settings that were in effect at run time. These settings are important to have documented
in the output listing file becausemany of these settings, such as default standard errors, refraction index, and instrument or tar-
get centering errors, directly affect your results. Note that when standard errors are changed to an Instrument Library setting by
use of an ".INSTRUMENT" inline option in your data, these standard error settings are also shown in this section.

9.4 LISTING OF INPUT DATA (OPTIONAL)
This section of the listing file is a direct line by line copy of your input data files. This can be useful for historical documentation
purposes, because it contains all of your input data plus any comments you included in your data when it was prepared. This
section is optional, included per the "Copy of Input Data File(s)"checkbox on the Listing File tab of the Project Options dialog,
and normally you will include it only for documentation or debugging purposes.

9.5 ADJUSTMENT SOLUTION ITERATIONS (OPTIONAL)
STAR*NET will optionally list the coordinate changes for each iteration in the adjustment. This section is included per the
"Coordinate Changes for Each Iteration" checkbox in the Listing File tab of the Project Options dialog.

This option is normally used only for analyzing an adjustment that has large errors and will not converge. In that situation, it
may be useful to track the coordinate changes at each iteration to see if some clue to the problem can be found.

For normal runs, you usually will not want to see this information.
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Adjustment Solution Iterations
                ==============================

Iteration # 1
Changes from Last Iteration (FeetUS)

Station            dN            dE            dZ
259             -0.0733        0.0209        0.0124
51              -0.0337       -0.3068        0.1004
52               0.0445       -0.3122       -0.0543
55              -0.2011        0.0993       -0.0223

9.6 SUMMARY OF UNADJUSTED INPUT OBSERVATIONS (OPTIONAL)
STAR*NET prints an optional summary of your unadjusted field observations. These observations are grouped together by
data type and listed with their standard errors.

For example, if you let all distances default to the distance standard error set in the project options, the output listing will show
the values that STAR*NET assigned to those observations.

Observations fixed in the data with the "!" code will show up with a standard error label of FIXED, and those freed with the "*"
symbol will appear with a label of FREE. Observations with the "&" symbol (or no standard error value entered), will show the
default values that were set in the project options.

The following illustrates the format of various parts of this section of the listing file:
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Summary of Unadjusted Input Observations
========================================

Number of Entered Stations (FeetUS) = 52

Fixed Stations      N              E     Description
19             1581.8773      4233.9316  Control-5534  

Free Stations       N              E     Description
1              1717.9598      5398.5404  Iron Pipe
2              1523.7382      5128.6278  Top of Curb
3              2122.6782      5674.2123  Top of Curb 

Number of Angle Observations (DMS) = 85

At        From      To           Angle       StdErr
10        19        1          80-24-50.70      2.00
10        19        2          60-58-55.40      2.00
2         10        6          85-02-30.20      2.00
6         2         33         45-48-30.60      2.00

Number of Distance Observations (FeetUS) = 68

From      To          Obs Dist      StdErr
10        1           896.5470      0.0204
10        2           224.3590      0.0226
2         6           562.3150      0.0242
6         33          496.8680      0.0181

Number of Azimuth/Bearing Observations (DMS) = 4

From      To           Bearing         StdErr
8         9         N03-17-06.00E       FIXED
21        22        S88-51-16.10W       10.00

The standard errors listed in the "Summary of Unadjusted Input Observations" section just illustrated reflect the effects of sev-
eral option settings. For example, if the instrument or target centering error, set in the Project Options/Instrument settings, has
a non-zero value, the standard errors displayed for angles and distances will be inflated from their input values, especially on
short sights. Also, if distance or elevation difference PPM values have been specified, the standard errors for distance or elev-
ation difference observations will be inflated to reflect the PPM component.

If you are running a 3D adjustment, the distance and zenith observations may be listed with special flags to indicate which data
types and correction options are in effect for each data line. For example, if you enter "Inline Options" that allow you tomix
slope distances and horizontal distances, or turn the curvature and refraction off and on, you will be able to easily verify the
data types used and which correction types have been set by reviewing these flags.

1. For distances, the "S" and "H" flags indicate whether the distance observation was entered as a "slope" value or an a
"horizontal" value.

2. For zenith angles, an "*" following the zenith observation value indicates that it had been "precorrected" by the user for
both earth curvature and refraction.

The following illustrates the appearance of these flags:
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Number of Distance Observations (FeetUS) = 31

From     To        Distance      StdErr       HI      HT  Type
121      2        2382.1342      0.0345    5.000   5.782   S
121      19       2699.1143      0.0349    5.000   5.955   S
121      4        3213.6255      0.0452    5.500   5.650   S
132      88       3523.5332      0.0425    0.000   0.000   H

Number of Zenith Observations (DMS) = 31
(Zeniths Marked (*) are Precorrected for Curvature & Refraction)

From     To           Zenith     StdErr       HI      HT
121      2        113-00-51.00    10.00    5.000   5.782
121      19       103-21-43.50*   10.00    5.000   5.223
121      4        114-15-27.25    10.00    5.000   4.850

If you use the ".REFRACTION" inline option to change the "Refraction Coefficient"  in the data file, an additional columnwill
display in the listing of zenith angles indicating the refraction constant internally applied to each zenith observation during the
adjustment processing.

9.7 ADJUSTMENT STATISTICAL SUMMARY
The Statistical Summary, although short, contains some of themost useful and important information in the entire adjustment
listing. You should always review it, especially if you are having problems with your adjustment.

Adjustment Statistical Summary
==============================

Convergence Iterations  =      4
Number of Stations      =      7

Number of Observations  =     32
Number of Unknowns      =     16
Number of Redundant Obs =     16

Observation   Count   Sum Squares         Error
of StdRes        Factor

Coordinates       3         0.623         0.644       
Angles      10        10.042         1.424

Directions       2         0.084         0.285
Distances       8         5.843         1.212

Az/Bearings       1         0.012         0.024
Zeniths       8         0.484         0.355

Total      32        17.065         1.032

The Chi-Square Test at 5.00% Level Passed
Lower/Upper Bounds (0.775/1.260)
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Convergence Iterations

The first item in this section indicates how many iterations were performed to get convergence. If an adjustment does not con-
verge, a warning will be posted above this listing section to alert you to the fact. If increasing the number of iterations does not
help, other problems in your network datamay be preventing a proper solution. In this case, these problems must be found and
corrected!

Number of Stations, Observations, Unknowns, and Redundant Observations

The second item indicates how many stations are actually included in the network. Any station included in your data file, but
not actually connected to any other station by one or more observations, is not included in this count.

The next three lines indicate the numbers of observations, unknowns and redundant observations in the network. The number
of redundant observations, often called the "Degrees of Freedom" of the network, is equal to the number of observations in the
network minus the number of unknowns. This is also sometimes called the redundancy of a network.

Error Factors

The following discussion relating to the calculation of the individual and total error factors is general in nature and illustrates
how certain values are created for 2D and 3D networks. The same information, however, also applies to simple 1D level net-
works.

The total number of observations in the network define the number of condition equations to be solved by the adjustment. Basic-
ally, each observation such as distance, angle, or partially fixed coordinate contributes one condition equation. Note that any
coordinate component entered with a standard error value (i.e. not fixed or not free) is considered an observation just like an
angle or distance. The “count” of coordinates in the statistics listing is the number of individual components (northings, east-
ings or elevations) that have standard errors given, not the number of stations. For example, the count of 3 shown in the sample
listingmight indicate that a northing, easting and elevation have each been entered with a standard error. Measurements such
an angles and distances that are entered as “free” (using the “*” code) are not included in the observation count. A “free” obser-
vation does not contribute in any way to the adjustment, and therefore will not affect the statistics.

The number of unknowns are counted by adding up the "adjustable" coordinate components. Each 2D station will add two
unknowns (or less depending on whether any components are fixed), and in a likemanner, each 3D station will add three
unknowns. Any northing, easting or elevation component that is entered as fixed (using the "!" code) is not counted as an
unknown. In addition, every direction set present in the data will add another unknown. (Each set of directions includes a single
unknown orientation that will be solved during the adjustment.) The network is considered "uniquely determined" if the obser-
vations equals the unknowns, and "over-determined" if the observations exceeds the unknowns, making the number of redund-
ant observations or degrees of freedom greater than zero. The network cannot be solved if the degrees of freedom are less than
zero.

For example, a simple 2D quadrilateral with two fixed stations has four unknowns (two free stations times two coordinates per
station). If five distances and eight horizontal angles aremeasured, the number of redundant observations is equal to nine (13 -
4). In general, themore redundant observations the better. However, the added observations should be spread evenly through-
out the network. If you hadmeasured only the four exterior distances of a quad, you would not add as much strength by meas-
uring those distance twice, compared tomeasuring the cross-quad distances, even though youmight add the same number of
degrees of freedom to the solution.

Next, the Statistical Summary contains a line for each data type existing in the network. Each line lists a count of the number
of observations of that type, the sum of the squares of their standardized residuals, and an error factor. A residual is the amount
the adjustment changed your input observation. In other words, the residual is simply the difference between the value you
observed in the field, and the value that fits best into the final adjusted network. The standardized residual is the actual residual
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divided by its standard error value. This value is listed in the "StdRes" column for every observation in the "Adjusted Obser-
vations and Residuals" section of your output listing file. See page 1 for more details and a sample listing.

To compute each total in the "Sum Squares of StdRes" column, each Standardized Residual is squared and summed. (This
total is also often called the sum of the squares of the weighted residuals.) A large total for this summation is not that mean-
ingful in itself, because the size of the total is a function of the number of observations of that data type. The totals displayed in
the Error Factor column, however, are adjusted by the number of observations, and are a good indication of how well each data
type fits into the adjustment. Among different data types, these Error Factors should be roughly equal, and should all approx-
imately be within a range of 0.5 to 1.5. If for example, the Error Factor for angles is equal to 15.7 and that for distances is equal
to 2.3, then there is almost certainly a problem with the angles in the adjustment.

An Error Factor may be large for several reasons. Theremay be one or more large errors in the input data, theremay be a sys-
tematic error (i.e. EDM calibration problem), or youmay have assigned standard errors that are unrealistically small. Note also
that a large angle error can easily inflate the distance Error Factor, due to the interconnection of common stations. The final sec-
tion in this chapter provides a number of techniques for locating potential sources of problems in the adjustment.

The "Total Error Factor" is an important item in the Statistical Summary. It is calculated as the square root of the Total Sum of
the Squares of the Standardized Residuals divided by the Number of Redundancies:

SQRT (Total Sum Squares of StdRes / Number of Redundancies)

The Total Error Factor is also commonly referred to as the Reference Factor, or the Standard Error of Unit Weight. This value is
used for statistical testing of the adjustment, as explained in the next section.

Chi Square Test

Finally, at the end of the Statistical Summary, there is an indication whether on not the adjustment passed the Chi Square test.
This test is discussed next.

9.8 CHI SQUARE TEST
After the iterations of an adjustment solution cease, STAR*NET tests the adjustment to determine whether the resulting resid-
uals are likely due to random errors by performing a two-tailed Chi Square statistical test at the significance level specified in
the Project Options General dialog. A 5% significance level is the generally accepted level to accept or reject a statistical hypo-
thesis.

In statistics, a χ2 value (a Chi Square statistic) derived from a process having random errors will, on infinite repetition, produce
a frequency distribution that is a function of the number of degrees of freedom. For example, assuming a 5% significance level,
the two-tailed Chi Square test checks whether a particular χ2 value falls within themiddle 95% region of all possible χ2 values
in the distribution. If it does, the χ2 value is accepted (i.e. the Chi Square test passed) as due to random error influences. If not,
the χ2 value fell either in the lower 2.5% or upper 2.5% of the distribution (the Chi Square test did not pass), and it is assumed
due to non-random error causes – systematic errors, blunders, incorrect standard errors, etc.

In a least squares adjustment of survey observations, the sum of the squares of the standardized residuals is a χ2 statistic.
The frequency distribution for this statistic could be determined by repeatingmany times without systematic error or blunder
the same exact survey and adjustment, each time producing a new and likely different sum of the squares of standardized
residuals. The collection of sums can be represented as a frequency distribution which can then be used to test acceptance of
the residuals in the first survey. Fortunately, this huge effort isn’t necessary because we know that all χ2 statistics, including
the sum of the squares of the standardized residuals, conform to themathematical formula for the Chi Square distribution,
which is dependent only on the number of degrees of freedom.
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In a STAR*NET survey adjustment, the number of degrees of freedom is the difference between the number of observations
and the number of unknowns, i.e. the redundancy in the survey. Observations consist of the usual field measurements that are
not declared free, together with any coordinate values entered with partial fixity. The count of unknowns includes all connected
coordinates that are not fixed, one internal orientation for each direction set, and the computed transformations applied to GPS
vectors.

An alternate view of the Chi Square test is that it compares the Total Error Factor obtained in the adjustment against its expec-
ted value of 1.0. The total error factor is a function of the sum of the squares of the standardized residuals and the number of
degrees of freedom in the adjustment. When the sum of the squares of the standardized residuals is exactly in themiddle of its
random distribution and as the number of degrees of freedom increases, the total error factor approaches exactly 1.0.  The
assumption that the adjustment residuals are due solely to random influences is rejected when the total error factor is smaller
than or larger than 1.0 by somemagnitude dependent on the number of degrees of freedom and the confidence level desired.

The Chi Square test can fail by exceeding the upper bound or the lower bound. When the test fails, a warning is printed at the
end of the Statistical Summary indicating which bound was exceeded. This example failed by exceeding the upper bound.

Warning: The Chi-Square Test at 5.00% Level Exceeded Upper Bound
Lower/Upper Bounds (0.522/1.480)

When the Chi Square test fails by exceeding the upper bound, this indicates that youmay have excessive residuals and/or you
may havemisstated the observation standard errors by setting them too small. You should always determine the reason a Chi
Square test fails by exceeding the upper boundary andmake necessary corrections.

When the Chi Square test fails by exceeding (being lower than) the lower bound, there is usually no serious problem but you
should still determine the reason why. This usually indicates that the residuals are smaller than what is expected relative to the
applied standard errors. If you feel your standard errors are proper, no changes are necessary.

In summary, the Chi Square test, often called the "goodness-of-fit test," statistically tests whether your residuals are due to nor-
mal random errors. If the adjustment fails the test, first check the standard error values (weighting) you have assigned to your
observations. And if the Chi Square test failed by exceeding the upper bound, then check for mistakes which can include blun-
ders in your actual observations, fieldbook recording errors, or data preparation errors such as incorrectly enteredmeas-
urements or misnamed stations in the input data file.

9.9 ADJUSTED STATION INFORMATION
Coordinate Changes from Entered Provisionals (Optional)
STAR*NET optionally lists differences between hand-entered provisional coordinates and final adjusted coordinates. This
option is particularly useful in deformation studies where the purpose is to determine how much certain stations moved since
the previous survey.  To do this, enter the specific adjusted coordinates from your previous survey as provisional (approximate)
coordinates for a new survey, and request this optional listing section in the Listing options dialog. Only changes from these
hand-entered provisional coordinates will be shown in this special output listing section.
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          Adjusted Station Information
          ============================

        Coordinate Changes from Entered Provisionals (FeetUS)

Station           dN           dE           dZ
319             0.0000       0.0000       0.0000
46             -0.5022      -0.2278      -1.6420
552            -1.0064       0.9188       0.9973
559            -1.0477       0.7678       0.9115
560             0.2513       0.4325       0.2234

When entering provisional coordinates to be used as the basis for computing the changes as described above, it is important to
place these coordinate values at the beginning of your data so that they will be read "first" during the processing.

Why is this?When STAR*NET reads data and finds more than one set of approximate  coordinates for a particular station, only
the "first" coordinate values are remembered. The remaining are ignored. Therefore, placing your provisional coordinates first in
the data assures you that some other approximate coordinates may be already existing later in the data will not corrupt your
desired results.

Youmight consider creating your "provisional" coordinates in a separate file, and placing this file as the first entry in your data
file list. Then at some future time when you want to update the provisional coordinates for a subsequent run, simply replace
that file’s contents with the newer provisional coordinates.

Adjusted Coordinates (Optional)
STAR*NET optionally includes the final adjusted coordinates in the listing file. Since these coordinates are usually written to
your output coordinates file youmay wish to eliminate this section from your listing file to make it shorter.

Adjusted Coordinates (FeetUS)

Station            N            E            Elev  Description
522           5002.0000    5000.0000    1000.0000  Iron Bar
546           5531.5463    6023.3234    1023.1328  Hole in One
552           5433.9901    6117.9812    1432.3413  

Adjusted Elevations and Error Propagation (Optional)
Output reporting for the Adjusted Elevations and Error Propagation for a level network adjustment is shown in the same listing
section as illustrated by the output below. If error propagation is not performed, the station standard deviation and percent con-
fidence values will not be output.
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Adjusted Elevations and Error Propagation (FeetUS)
==================================================

Station                Elev       StdDev       95%     Description
TIDAL1                1.3750     0.000000    0.000000  NGS Ref 1
TIDAL2                2.1650     0.000000    0.000000  NGS Ref 2
BM75                 23.7680     0.000000    0.000000
BM26                 57.1290     0.000000    0.000000  Brass Cap 1939
129                  13.7299     0.007673    0.015040
125                  39.6867     0.009283    0.018194  At Hyde
130                  35.8643     0.009869    0.019343  Central
128                  25.5307     0.010557    0.020692
etc ...

Adjusted Positions and Ellipsoid Heights (Optional)
This optional listing section, available in grid jobs, contains the adjusted latitudes and longitudes with ellipse heights. Please
see the Additional Listing Sections for Grid Adjustments topic in Chapter 11 for additional details.

Convergence Angles and Grid Factors at Stations (Optional)
This optional listing section, available in grid jobs, shows computed convergence angles and grid factors (scale, elevation and
combined) for every station in the network, as well as average project values. Please see the Additional Listing Sections for
Grid Adjustments topic in Chapter 11 for additional details.

9.10 ADJUSTED OBSERVATIONS AND RESIDUALS (OPTIONAL)
STAR*NET next lists all adjusted observations and their residuals. A residual is the difference between the observed value and
the corresponding value computed from the adjusted coordinates. The sizes of the residuals are an indication of how well your
observations have fit into the adjusted network. The observation standard errors you specified are also listed to show you how
much weight each observation had in the adjustment. Although this section of the listing is optional, it is an important one that
you normally will want included.

Adjusted Observations and Residuals
===================================

Adjusted Angle Observations (DMS)

At      From    To        Adj Angle     Residual  StdErr StdRes
1       701     2      123-40-27.22  -0-00-00.12    4.55   0.0
2       1       3      217-11-36.03  -0-00-00.94    4.99   0.2
3       2       4      113-53-19.28*  0-00-21.27    5.18   4.1*

Adjusted Distance Observations (FeetUS)

From    To         Adj Dist     Residual  StdErr StdRes
1       2          537.5551       0.0351  0.0211   1.7
2       3          719.5360       0.0260  0.0273   1.2
3       4          397.6922       0.0322  0.0202   1.5
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You should examine the residuals carefully to see whether they appear reasonable. STAR*NET computes an additional value
called the Standardized Residual (StdRes), which is equal to the residual divided by its standard error. This ratio takes into
account the different types of observations (i.e. angles and distances) and the different units of standard error (i.e. seconds and
feet) assigned to them, and and lets you easily make comparisons of the changes to all observations as "Standardized" resid-
uals.

You can also think of this value as the ratio between your observation’s actual fit in the adjustment (its residual), and your estim-
ate of the strength (your input standard error). If the ratio is less than 1.0, it actually fit better than you had estimated. If it is lar-
ger than one, it didn’t fit as well. However, Standardized Residuals usually have a value greater than 3.0 before we can really
say that there is a problem. Values greater than 3.0 are flagged with "*" to help you locate them quickly. The cause of any
flagged values should be investigated. However, no observation should be deleted until a good reason is found for the problem.
A large residual in a particular observationmay be the result of a blunder in some other observation.

A flag of "*" next to an adjusted angle or direction is an indicator to the user that themeasurement was detected as part of a
Face-2measurement, and that it's angle will be approximately 180 degrees different from Face-1 observations between the
same two points. Adjusted zenith angles are not flagged in this method, as any angle over 180 degrees should be recognized
as Face-2.

9.11 ADJUSTED BEARINGS AND HORIZONTAL DISTANCES (OPTIONAL)
This listing section shows the adjusted bearing (or azimuth) and horizontal distance between each point which is connected by
field observations. In addition, connected stations specified in a ".RELATIVE" inline option are shown.

Adjusted Bearings (DMS) and Horizontal Distances (FeetUS)
=========================================================

(Relative Confidence of Bearing is in Seconds)

From    To            Bearing    Distance       95% RelConfidence
Brg   Dist       PPM

1       2       N01-23-51.01E    205.0388   13.22  0.0547  266.6328
2       3       N63-26-08.29W    134.1889   11.67  0.0553  412.2775
3       4       S31-25-40.66W    105.4493   13.92  0.0556  527.5248
3       7       N17-39-05.66W    115.4440    9.04  0.0534  462.6009
4       5       S68-11-49.87W    161.5606   14.77  0.0554  342.9421
5       6       S05-21-27.54E    160.7097   14.52  0.0457  284.1620
6       1       N81-36-22.22E    308.3068   13.03  0.0563  182.4629

The section also shows the relative error in azimuth and distance between the station pairs. These relative errors are shown
only if error propagation is performed. The relative errors of the distance and azimuth for each course are based on the respect-
ive components of its relative ellipse and are shown at the confidence level selected for the adjustment. The distance precision
shown as Parts per Million (PPM) is computed by dividing the relative distance error by the length of the line then times
1,000,000.

9.12 TRAVERSE CLOSURES OF UNADJUSTED OBSERVATIONS (OPTIONAL) 
If you entered any of your observations using "Traverse" data, you can choose to include a summary of the traverses, along
with closure errors and precisions, and angular misclosures. For each traverse, courses are listed with bearings (or azimuths)
and horizontal distances that are based on unadjusted input angle and distance entries. If the traverse closes on itself or to
another station in the network, the coordinatemisclosure is listed. If possible, an angular misclosure is also shown.
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The bearings or azimuths created for the traverse closure printout are based on input angles that have been "pre-corrected" for
traverse angular misclosure when present. Each angle is corrected by an equal amount, and then the linear closure is cal-
culated. Many governmental agencies want to see this kind of closure analysis. It is important to note, however, that these cor-
rections to angles are created only for the benefit of this traverse closure printout. Actual corrections required for the angles are
determined during the rigorous least squares adjustment and are displayed as angle residuals!

When you run a full least squares adjustment, the traverse closures begin and end on your adjusted coordinates, showing
exactly how your original unadjusted field traverses fit into the final adjusted network. (This can be quite meaningful when you
have interconnected traverses).

When you run "Data Check Only" from the Runmenu, however, the traverse closures for open traverses will be based only on
approximate coordinates. These closures may depend on data entry order, and are quite different and less meaningful than
those obtained after the adjustment.

Traverse Closures of Unadjusted Observations
============================================
(Beginning and Ending on Adjusted Stations)

TRAVERSE 1
Error Angular   = -3.00 Sec, 6 Angles, -0.50 Sec/Angle
Error Linear    = 0.0051 S, 0.0126 W
Horiz Precision = 0.0135 Error in 1075.2400, 1:79434, 12.59 PPM

From       To         Unadj Bearing    Unadj Dist
1          6          S81-36-22.22W BS
1          2          N01-23-50.72E      205.0300
2          3          N63-26-08.78W      134.1900
3          4          S31-25-40.72W      105.4400
4          5          S68-11-50.22W      161.5700
5          6          S05-21-27.28E      160.7100
6          1          N81-36-22.22E      308.3000
TRAVERSE 2: Smith Ranch Cutoff
Error Angular   = -0.51 Sec, 6 Angles, -0.09 Sec/Angle
Error Linear    = 0.0673 S, 0.0205 E
Horiz Precision = 0.0703 Error in 909.7100, 1:12939, 77.29 PPM

From       To         Unadj Bearing    Unadj Dist
3          2          S63-26-08.29E BS
3          7          N17-39-06.20W      115.4100
7          8          S79-52-29.88W      284.4000
8          9          S15-07-26.97W      191.6600
9          10         S08-36-51.95E      166.9000
10         6          S82-24-19.86E      151.3400
6          1          N81-36-22.22E FS

The example above illustrates a listing for a 2D adjustment. For 3D adjustments, the listing also includes an unadjusted elev-
ation difference for each traverse course, plus an elevationmisclosure for the traverse.

9.13 SIDESHOT COORDINATES COMPUTED AFTER ADJUSTMENT (OPTIONAL)
If you have included sideshots (lines beginning with the "SS" code) in your data, you can choose to include this section in your
listing file. Since sideshot coordinates will be written to the final adjusted coordinates file youmay wish not to include them in
your listing file to make it shorter in length.
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Sideshot Coordinates Computed After Adjustment
==============================================

Station            N            E         Elev    Description
A33            916.1707    1119.6084   1437.8623  TOE
A34           1083.4697    1084.2969   1441.7944  TOE
X45           1253.9746    1000.2647   1448.8716  CURB FACE
5014          1383.7721    1002.1117   1449.9628  TOE
5023          1403.7304    1008.6017   1452.9255  SHLD
5027          1225.1863    1015.3395   1447.9965  SHLD

9.14 ERROR PROPAGATION (OPTIONAL) 
If you chose to have error propagation performed when you ran your adjustment, you can optionally include any or all of the next
three report sections in your listing file.

Station Coordinate Standard Deviations
The first section of the error propagation listing shows the adjusted station coordinate standard deviations. Standard deviations
represent the amount of uncertainty in the computed coordinates at a "one-sigma" (approximately 67%) level. Fixed stations
are always shownwith zero standard deviations.

Error Propagation
=================

Station Coordinate Standard Deviations (FeetUS)

Station            N             E            Elev

1               0.00000       0.00000       0.00000
2               0.02319       0.02023       0.03812
3               0.02678       0.02217       0.03832
5               0.04556       0.01244       0.02334
104             0.03451       0.02435       0.01425
105             0.04115       0.04251       0.03662

Note that if you are running a Level adjustment, the Standard Deviations are included in the Adjusted Elevations and Error
Propagation section of the Listing.

Station Coordinate Error Ellipses
The next section shows the error ellipses and elevation confidences computed using the confidence level you chose in the pro-
ject options. The error ellipse parameters define the shape and size of the confidence region around each station. In the output
below, for example, you can say with 95% certainty the adjusted station lies somewhere within the ellipse region.
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Station Coordinate Error Ellipses (FeetUS)
Confidence Region = 95%

Station     Semi-Major    Semi-Minor    Azimuth of      Elev
Axis          Axis       Major Axis

1           0.00000       0.00000          0-00      0.00000
2           0.05980       0.04579         29-17      0.07472
3           0.06722       0.05219        159-23      0.07510

If the adjustment passes the Chi Square test, the adjusted coordinate standard deviations are used to compute the error
ellipses directly. However, if the adjustment fails the Chi Square test, the standard deviations are increased by the computed
Total Error Factor, to reflect the weak adjustment. This is done to protect you from generating artificially small ellipses by redu-
cing your global observation standard errors to the point where the adjustment is no longer valid.

Relative Error Ellipses
The last section resulting from error propagation shows relative ellipses and a vertical difference confidence. By default, rel-
ative error ellipse information is computed between each station connected by an observation. Alternately, the ".RELATIVE"
inline options can be used to control exactly which ellipses to compute. Relative ellipses provide an estimate of the accuracy
of the relative positions of two stations. Two stations can have large error ellipses but a small relative ellipse between them, if
their positions are highly correlated. Note that relative ellipses are also inflated by the Total Error Factor if the adjustment fails
the Chi Square test. For detailed information on ellipse and relative ellipse interpretation see the next section.

Relative Error Ellipses
Confidence Region = 95%

Stations       Semi-Major    Semi-Minor    Azimuth of   Vertical
From    To         Axis         Axis       Major Axis
2       13       0.06135       0.03833         63-47      0.06248
4       15       0.07709       0.05626         54-01      0.09281
2       19       0.07856       0.06761        170-50      0.04554

9.15 ERROR ELLIPSE INTERPRETATION
The error ellipse represents the area of uncertainty around a given point. For example, assume that a survey network point is
computed from the intersection of three lines from known points, each line being of ameasured distance and bearing. The
measured distances and bearings all contain some uncertainty, which were expressed as standard errors in the input data.

The resulting computed point then has standard deviations in Northing and Easting (or in X and Y), which are computed and lis-
ted by STAR*NET. The total effect of all the randommeasurement errors results in an error ellipse of a specific size, shape,
and orientation. The ellipse itself is computed by STAR*NET from the standard errors in Northing and Easting and the cor-
relation between those standard errors.

The size of the ellipse is ameasure of the reliability of the computed point position. In a particular survey, a smaller ellipse
means the point has greater reliability than one with a larger ellipse. Values of the semi-major and semi-minor parameters, as
printed in the listing and on the screen, are the actual ground dimensions across half the ellipse, in the long and short directions
respectively. The lengths of the axes depend on the standard errors and correlations of the computed coordinates. If N and E
are of equal precision, then the ellipse will be a circle.



Chapter 9: Analysis of Adjustment Output

- 165 -

The ellipse azimuth is the azimuth of the semi-major axis, and gives the orientation of the ellipse with respect to the ground
coordinate system. The azimuth depends on the correlation between the adjusted coordinates of the point. If they are uncor-
related, the ellipse axes will be parallel to the control axes.

STAR*NET allows you to define your own confidence level. A commonly used confidence level is 95% which produces a 95%
error ellipse. That means that there is a 95% probability that the actual point position lies somewhere within the extents of the
reported dimensions of the ellipse.

The plotted error ellipses provide ameans of analyzing the strength of the survey network, and the reliability of the computed
points. At a first glance, the absolute dimensions of the ellipses provide ameasurement of positional accuracy. The relative
sizes of the ellipses indicate which points are weaker than others within a given network. The shapes and orientations of the
ellipses indicate how the network can be strengthened. An elongated ellipse shows that there is a larger uncertainty in one of
the coordinates, and that perhaps an additional distance or anglemeasurement is required to that station. A large but circular
ellipsemeans that the point is balanced in Northing and Easting (or X and Y), but that more accuratemeasurement techniques
are required, or additional measurements from several other stations are required. If many ellipses are elongated and point in
the same direction, then the network is unbalanced along that direction. Typically, theremay be an azimuth deficiency, and one
side of the network has little resistance to rotation. An additional control point or observed azimuth will help to stabilize the sur-
vey.

As shown in the figure below, the length of the relative ellipse projected onto the line between the two points is ameasure of the
precision of the distance between the two points. The length of the relative ellipse perpendicular to the line is ameasure of the
precision of the bearing between the two stations. A table of actual relative errors in distance and bearing can be generated as
explained earlier in this chapter.

9.16 ADJUSTED OUTPUT FROM "LEVEL" NETWORK ADJUSTMENTS
Since simple 1D level networks contain much less information than 2D or 3D networks containing conventional data, both the
input review and the output reporting have been somewhat simplified. For both input and output reviews, the station names are
never truncated – in all reports the full 15 character station names are always shown.

In addition, output reporting for the Adjusted Elevations and Error Propagation are both shown in the same listing section as
illustrated by the output below:
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Adjusted Elevations and Error Propagation (FeetUS)
==================================================

Station                Elev       StdDev       95%     Description
TIDAL1                1.3750     0.000000    0.000000  NGS Ref 1
TIDAL2                2.1650     0.000000    0.000000  NGS Ref 2
BM75                 23.7680     0.000000    0.000000
BM26                 57.1290     0.000000    0.000000  Brass Cap 1939
129                  13.7299     0.007673    0.015040
125                  39.6867     0.009283    0.018194  At Hyde
130                  35.8643     0.009869    0.019343  Central
128                  25.5307     0.010557    0.020692

The adjusted leveling observations and residuals report from a level network adjustment is similar to the reporting for obser-
vations in 2D and 3D adjustments:

Adjusted Observations and Residuals
===================================

Adjusted Differential Level Observations (FeetUS)

From          To             Elev Diff    Residual   StdErr StdRes
TIDAL1        129              12.3549      0.0099   0.0117   0.8
BM75          129             -10.0381     -0.0151   0.0131   1.1
BM75          125              15.9187     -0.0013   0.0146   0.1
129           130              22.1344      0.0044   0.0160   0.3
130           125               3.8224     -0.0106   0.0138   0.8
129           128              11.8008     -0.0092   0.0169   0.5
128           130              10.3336     -0.0024   0.0148   0.2
125           BM26             17.4423     -0.0157   0.0160   1.0
BM26          126               2.8173      0.0033   0.0163   0.2
130           126              24.0821      0.0171   0.0167   1.0

9.17 LOCATING THE SOURCE OF ERRORS
If the adjustment fails the Chi Square test, there is probably something wrong with the network configuration, the actual obser-
vations, or the weighting. The following suggestions are designed to help you locate and correct errors in your input data.

Some of themajor causes of completely failed or poor adjustments are as follows:

1. Incorrect data entry into STAR*NET - digits transposed, station names wrongly entered, typing errors in controlling
coordinate values, etc.

2. Options set incorrectly such as angle station order set to "At-From-To" but should be set to "From-At-To", or visa versa.
or other options such as project units, refraction constant, etc., set improperly for your job.

3. For grid jobs, the zone set incorrectly or geoid height not entered properly.

4. Field data collection blunders - wrong stations observed, station names incorrectly entered, etc.

5. Incorrect assignment of standard errors to field observations. For example, assigning small standard error to angles on
short sights, but with no centering error value entered in the Project Options/Instrument settings.



Chapter 9: Analysis of Adjustment Output

- 167 -

6. Systematic errors in field data - EDM out of calibration, etc.

7. Invalid geometry of the network - fixed azimuth between fixed stations, 3D point with no vertical observation, etc.
STAR*NET attempts to detect these conditions, but somemay get by and cause problems.

8. Weak network geometry - poor intersection angles, lack of redundancy, etc.

Here are some of the symptoms of a poor adjustment. Frequently, many or all of these symptoms are seen together:

1. Adjustment fails the Chi Square test.

2. Adjustment does not converge within 5 to 10 iterations.

3. Large residuals on observations.

4. Warningmessages about Geometric Weakness in the solution.

5. Extremely large error ellipses on adjusted points.

6. Fixed stations are showing coordinate changes.

Here are a few suggested steps that you can take to determine the source of adjustment problems. As you gain experience,
these steps will become second nature, and you will often be able to sense the cause of the problems without having to pro-
ceed in a step by step fashion.

Remember too that MicroSurvey Software Inc. will try to help you resolve problems. We do request that you attempt to resolve
them by following these steps before you call, because themore experience you develop in analyzing your adjustments, the
better you will be able to handle new situations in the future.

1. Review the Error File, and resolve all errors and warnings that may be present.

2. Check all your option settings. For local (non-grid) jobs, do you have the "Default Scheme" set to match your controlling
coordinates? Are the proper values entered? For grid jobs, is your zone set correctly, and are your entered controlling
coordinates consistent with that zone? In all cases, are your observations consistent with the units  set in your Project
Options?

3. Make sure that all Input Observations are summarized in the listing file. Review the values for any obvious blunders and
their standard errors to see if they look reasonable.

4. If you are using traverse data, select the "Traverse Closures of Unadjusted Observations" listing option, and review the
approximate traverse closures.

5. Run Data Check Only so that a plot file is generated from the input data. View the network graphically, looking for obvi-
ous gaps and blunders in the data. Misnaming of stations will become obvious here, because youmay see themis-
connections across the network.

6. Check that the "Angle Station Order" and "Coordinate Order" options are set correctly – an incorrect setting for either
option will cause real problems!

7. Review the Statistical Summary carefully. See whether there is one data type that has amuch worse Error Factor than
the others. If so, look carefully at the input observations and residuals for that data type.

8. Review the listing of observations and residuals. Look for single residuals that have standardized residuals larger than
3.0, and have been tagged with a "*". Try to determine the cause for the large residuals. Remember that a single gross
error can cause large residuals in a number of observations. Always start by looking at the largest one or two residuals
in each data type. Look for a pattern of the same station being associated with multiple large residuals.
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9. Check your input standard errors. Are they reasonable, and in line with your normal field techniques? Have you included
Centering Error values when you have an adjustment with a lot of short sights?

10. Run aminimally constrained adjustment. If you are tying your survey to a number of fixed points, start off with one fixed
point and a fixed azimuth, or two fixed points, until you have all of the data debugged. Then start fixing (with the “!” sym-
bol) any remaining fixed points one by one.

11. Run the adjustment but restrict it to a single iteration in the Adjustment Options. Look at the changes in coordinates
after the first iteration to see which stations seem to be acting strangely.

12. Run the adjustment with the "Coordinate Changes each Iteration" listing option on, then review that section in the listing
looking for any unusual or excessive changes in coordinates during adjustment.

13. Use the ".DATA OFF" and ".DATA ON" inline options to turn off sections of your input data file. Break it down into
pieces until you find the section where the errors may reside.

14. Unweight observations that you suspect by using a standard error of "*". Run the adjustment and see if your problems
go away. Remember that you will havemuchmore success with this technique if you have a number of redundant obser-
vations in the survey.

15. If you have interconnected traverses, try disconnecting any suspect traverse, when possible, by temporarily renaming
its ending station name and removing its closing angle. Turn it into an open ended traverse that will influence nothing
else. See where the end of the traversemoves to when you adjust. Do other traverses improve?

16. Run Blunder Detect. See Chapter 6, "Running Adjustments" for details.
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CHAPTER 10: TOOLS
10.1 OVERVIEW

The "Tools" menu includes two utilities, a Points Reformatter and a DXF Exporter, as well as view options to Change Font or
Color and Reset your screen Layout.

10.2 POINTS REFORMATTER
To run the Points Reformatter utility, choose Tools > Points Reformatter:

The Reformatter creates a new coordinate file using a format style selected by you. The coordinate values come from the "Pro-
jectName.sbf" binary file created during your last adjustment. Youmay wish, for example, to create a coordinate file com-
patible with your COGO program, or your client’s COGO program. Or youmay want to rearrange items, such as switch North
and East values, or maybe eliminate items, such as outputting a list of point names with elevations and descriptors only.

To run the utility, follow these steps:
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1. Select a format from the "Format Style" dropdown selection box. A sample of the output style will appear in the
"Example of Formatted Output" box. In the example shown on the previous page, the "CommaSeparated" format was
selected. Note that a few format styles are provide with the program, and others may be defined by you as described
later in this section.

2. The output file created will be given your project namewith a "REF" extension (for example, SouthPark.ref). The name
is shown in the "Output to File" field. To use a different name, press the "Change" button and enter a different name.

3. If you need to change any options (as described below), change to the Options tab, make the changes, then return to the
Reformat tab.

4. Press the "Reformat" button to perform the actual reformatting.

5. Finally, to review the contents of the output file, go to the "Output File" tab.

To change reformatting options, go to the "Options" dialog tab:

In the Options dialog, select whether to export main network stations, sideshot stations, or both. You can also choose to have
one or the other, or both sorted by names. If you sort both groups, then you can also choose to have the two coordinate lists
merged.

By default, the Points Reformatter utility creates an export file with a "REF" extension (meaning reformatted). However you
can change this default extension in the options if you wish. Press the "Change" button and enter a new extension. Note that
you are restricted from using certain extensions reserved by the program.

Any options set during a reformatting session are saved and will be used as defaults for the next reformatting run in any project.

Defining Format Styles
A file named "STARNET.FMT" is located in the STAR*NET system directory. It contains several built-in format styles which
are used by the Reformatter utility, and also for output formats selected in the Project Options/Other Files dialog. The file can
be edited with any text editor, or it can also be edited within the Reformatter utility be pressing the "Edit Format Style File" but-
ton. Therefore if you know the basic elements of this definition file, you can then edit it to change any of the current formatting
styles, or add new formatting styles of your own.

The "STARNET.FMT" file can have any number of definition lines. Each line has threemajor parts: the format style title, the
1D/2D/3D indicator, and the formatting definition. Each section is separated from the next by a colon character.
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1. The title includes all the text to the left of the first ":" character and is limited to 22 characters. The title for each line is
the text that appears in the selection list.

2. A "1D" or "2D" or "3D" code follows the first ":" character. It indicates whether the format will be selectable for a 1D
(Lev), 2D or 3D project. If no indicator is entered, the format style can be selected from the dialog dropdown list for any
type project.

3. The portion of the line to the right of the second ":" character is the formatting definition. It contains a combination of spe-
cial characters that tell the Reformatter utility how to format the new coordinate file. Below are a few simple format style
lines which illustrate style titles, 1D/2D/3D indicators and format definitions.

Comma Separated    :1d :p,z,d
Comma Separated    :2d :p,n,e,d
Comma Separated    :3d :p,n,e,z,d

Space Separated    :2d :p n e d
Space Separated    :3d :p n e z d

Name & Descriptor  :   :p d

There are three named styles defined in the example above. The first style has separate formats for 1D, 2D and 3D projects
and the second, for only 2D and 3D projects. The last named style has no 1D/2D/3D indicator entered, and therefore that
format will appear and can be selected from the "Format Style" dropdown for all types of projects.

When entering 1D, 2D and 3D formats for a single style, be sure to spell the style names for each format exactly the same or
they will be interpreted as separate styles!

Spaces following a style name are ignored as well as any spaces before and after the 1D/2D/3D indicator. This allows you to
"line" up the formats tomake themmore readable in the STARNET.FMT file as illustrated above. Spaces following the second
":" character are not ignored, however. They are considered part of the format definition and will cause spaces to be published
in the formatted output.

As discussed above, the portion of each line to the right of the second “:” is the formatting definition and is made up of a com-
bination of special characters that instructs STAR*NET how to format the new points. Only certain characters may be used in
this formatting definition. Each character has a special purpose. A list of all formatting characters and the purpose of each is lis-
ted in the table below.

This: Causes this action:

P or R Point Name is written (left or right justified in a field when a field width is entered, i.e. P15 for left justified).
N Northing is written.
E Easting is written.

H When project options coordinate order is set to "NE", the first occurrence of an "H" writes a Northing, the
second  writes an Easting. The order is switched when the option is "EN".

Z Elevation is written.
D Descriptor is written.
Comma A comma is written.
Space A space is written.
Single Quote A single quote character (') is written.
Double Quote A double quote character (") is written.
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This: Causes this action:
Brackets [ ] Text between the [ and the ] is written.
Slash  ( / ) A new line (carriage return) is written.

These formatting characters may be entered as upper or lower case, and of course in any order - the order you wish your data
items to appear in the reformatted points file. If any characters other than those in the list above are entered (except for the text
entered between the special square bracket characters), an error message "Invalid Definition Style" will be shownwhen the
reformatter routine is used, and you will have tomake a correction to the STARNET.FMT file before the routine will work.

Every formatted line written to the output file is automatically ended with a new line (carriage return). However with the special
"/" slash character available as shown in the list above, you can cause new lines to be inserted anywhere. Perhaps you would
like one or more items on a separate line. Simply use the slash rather than a space or comma separator, and a carriage return
will be inserted.

By default, the precisions used (number of places beyond the decimal) for coordinates and elevations are controlled by the
“Default Precisions” settings existing in the Project Options/Other Files dialog when the adjustment was last run. However,
you can define a different precision if you wish. To specify two places beyond the decimal for a northing definition for example,
“N0.2” would be entered rather than just an “N” definition. Or perhaps you want elevations rounded to the nearest foot or meter
written to your converted file. Just enter is “Z0.0” rather than the normal “Z” definition. The example illustrates defining coordin-
ates exported to two places and elevations to one place.

p n0.2 e0.2 z0.1   

If you want your output items formatted in columns rather than separated by only a space or comma, do this by appending a
"field width" to each definition character. For example, if you want your point names, northings, eastings and elevations lined
up in columnwidths of 10, 15, 15 and 9 spaces respectively, and using default precisions, you would enter either of the fol-
lowing format definitions:

p10n15e15z9           (using the actual column width value)
p10 n14 e14 z8        (or a space plus the remaining width)

You can use this field width value with the P (or R), N, E, H and Z definition codes. When you use a field width with the "P"
point name code, the name string will be left justified in the field width. When you use a field width with the alternate "R" point
name code, the name string will be right justified in the field. Northings, eastings and elevations, when defined with a field width
value, are always right justified.

When using field width values for northings, eastings and elevations as shown above, the decimal precision is controlled by the
"Default Precisions" settings existing in the Project Options/Other Files dialog when the adjustment was last run. However, as
previously described, you can also enter explicit precisions. Simply attach the desired precision to the field width. If we want a
3 place precision for northings and eastings, and 1 place for elevations, the example lines above would look like this:

p10n15.3e15.3z9.1       (using actual column width value)
p10 n14.3 e14.3 z8.1    (or a space plus remaining width value)

It is recommended that you actually use a space separation between defined columnwidths as shown in the last line above.
First, the definition is much easier to read. But more importantly, if for one reason or another a coordinate value is large enough



Chapter 10: Tools

- 173 -

to fill the entire field width, the space in the format definition is guaranteed to create a space in the output rather than allowing
the output values to run together.

A few words should be said about the "H" field definition code used to output horizontal coordinate values. Using this code
rather than the "N" and "E" codes guarantees that the same output order specified in your Project Options will also be used for
exporting coordinates in the Reformatter utility. For example, if the order set in the Project Options was "EN" for the last adjust-
ment run, the following definition would output an Easting for the first "H" and a Northing for the second "H" code.

p10 h14.3 h14.3 z9.1

The double quote character (") and square brackets characters are particularly useful for converting to certain third-party COGO
formats. Many formats require that the descriptor begin (or be surrounded by) the double quote character. Simply include the
quote character in your definition exactly where you want it to be in the output. Also some formats require specific text strings
to be included in the file to identify the line. Say for example that you wanted each converted output coordinate line to begin
with the characters "PNT", followed by the easting, northing, elevation, point name and the descriptor in that order. Also you
would like every item separated from the next by a space, and you need the descriptor surrounded by double quotes. The entire
format definition, including the format style title might look like this:

My COGO Format  :3D :[PNT] e n z p "d"

A definition, of course, can also be created to export coordinates to a format that can be directly read by STAR*NET as data.
Coordinates for STAR*NET always begins with the character "C" and descriptors begin with an single or double quote char-
acter.

Therefore the two format definitions below will create coordinate files for 2D and 3D projects that can be read back into
STAR*NET as data. In these example definitions the "H" code has been used to output the northings and eastings in the same
order used in the last run of the adjustment for a project, listed in columns and with a given precision. The first group defines
"free" provisional coordinates, and the second group defines "fixed" coordinates because of the added "! ! !" fixity code text.

STAR*NET Data       :2D :[C] p15 h16.5 h16.5 'd
STAR*NET Data       :3D :[C] p15 h16.5 h16.5 z12.3 'd

STAR*NET Fixed Data :2D :[C] p15 h16.5 h16.5 [! !] 'd
STAR*NET Fixed Data :3D :[C] p15 h16.5 h16.5 z12.3 [! ! !] 'd

10.3 DXF EXPORTER
To run the DXF Exporter utility, choose Tools > DXF Exporter:
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The DXF Exporter will produce a DXF file that can be used to transfer a scaled plot of a project into an AutoCAD, MicroSurvey
CAD, or other compatible software packages. By default, the file is given the name of the project, however you can change it
to whatever you want.

1. Enter a scale you wish to use inWorld Units per Plotting Unit (i.e. 200 feet/inch). Marker and lettering sizes are given in
plot units (i.e. 0.125 inches). You can specify a slant (i.e. 15 degrees) for lettering. Lettered items include point names,
descriptors, and optional elevation labels.

2. Lines, ellipses, relative, point names, markers, descriptors, etc. are put on their own layers.

3. If your job is 3D, you can choose to export only 2D coordinates (eliminating elevations) so that distances in your graph-
ics program will be horizontal rather than slope values.

4. Use the Apply Coordinate Transformations option and its associated Settings button to apply transformation factors to
the exported DXF file, for example if you want to export the drawing using ground-scaled coordinates from a grid job.
The Settings button will open the Ground File Options dialog (see Chapter 4), with any transformation settings already
defined via the Project Options.

5. Use the Layer Definition section to specify which elements (stations, labels, and ellipses) to include or exclude in the
DXF file, and to specify layer names, colors, and linetypes for each element. Multiple layer sets can be saved and
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reused as desired, for example if you have clients with different deliverable requirements.

If error propagation was performed, you can choose to have error ellipses included in your DXF export through the Layer
Definition section. Ellipses will be exported with the same exaggeration as last viewed in the network plot, so it is recom-
mended that you preview the plot prior to exporting a DXF file.

6. Press the "Check Size" button to check the approximate sheet size required for the extents of the plot based on the
given scale. The size calculated is based on themaximum andminimum point coordinates only, so you should allow
extra size for ellipses, long point names and descriptors.

7. Press "Export!" to actually perform the DXF export.

The settings selected (scale, marker and lettering sizes, slant, items included, etc.) are saved on a project basis. Therefore,
when you exit a project, and then return later to it, the sameDXF option settings will appear.

When you are using the DXF Exporter on what you consider a "typical" project, you can press the "Save Settings as Typical"
button to save the current DXF settings as typical defaults. Then whenever you start a new project, these saved typical set-
tings will be used as starting settings. All settings are saved except the ellipse exaggeration that is uniquely handled as
required for each project.

Exporting a "LEV" Project to a DXF file
The PLUS, PRO and LEV editions allow running stand-alone level networks. When reference northing and easting coordinates
are entered for all stations in the network, the network diagram can graphically displayed in STAR*NET and therefore the it can
also be exported to a DXF file. The "Ellipses" options box on the DXF Exporter dialog will be inactive since horizontal ellipses
are not calculated in a level network.

Loading the DXF File into AutoCAD
The DXF file exported from STAR*NET can be directly imported into a new drawing by AutoCAD andmost other graphics pro-
grams supporting the DXF file format.

If you want to import STAR*NET DXF files into an AutoCAD drawing environment that already has an established drawing pro-
totype with defined entities (i.e. some third party COGO packages), here are two ways to accomplish this:

1. Themost straight-forward way is to import the DXF into AutoCAD as a new drawing that has no prototype drawing
already set, and then immediately save it to a standard DWGdrawing file. This file can then be read into another draw-
ings that already has defined entities.
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2. Another way is to first insert the STAR6.DWG prototype file, supplied with your installation, into your existing drawing
to define the entities in the DXF file, and then you can read the DXF directly into your existing drawing.  The
STAR6.DWG file is located in the same directory that STAR*NET was installed. This file contains all the entity defin-
itions and layer names used by the DXF export, but no actual drawing items.

Many versions of AutoCAD exist as well as numerous other graphics programs capable of importing DXF files, and it is
impossible to provide detailed instructions for each in this manual. Refer to instructions supplied with your particular graphics
program for the its particular methods of importing DXF files.

10.4 KML EXPORTER
STAR*NET can export a .kml or .kmz file which can be used to transfer a plot of the project into the Google Earth™mapping
service (or other compatible software packages).

Google Earth andGoogle Earth Pro are available for download from www.google.com/earth

To run the KMLExporter utility, choose Tools > KML Exporter. This tool is only available with Grid projects, because all
coordinates must be converted to geodetic positions (latitude/longitude). Local projects with assumed coordinates cannot be
exported, nor can Lev projects.

http://www.google.com/earth
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Place Name: will appear in the Places sidebar when you open the file in Google Earth. By default it will be set to the name of
your current project file, but you can change it to anything.

File name: will be the name of the kml or kmz file you export. By default it will be set to the name of your current project file,
with either a .kml or .kmz extension (whichever format was used last.) The Browse button will let you select the export folder,
filename, and format - .kml is an uncompressed text format and .kmz is a compressed binary format.

Organize into folders: will cause subfolders to be created within your Place in the Places sidebar, corresponding to the folder
names specified on the following lines for each station and connection class. This makes it easier to quickly toggle the display
of all entities of particular class by checking or unchecking the folders. All stations and connections will be colored accordingly.

Altitude: controls how the elevation data will be handled by Google Earth.

l Clamp to ground: will clamp your elevations to the Google Earth ground surfacemodel.

l Relative to ground: will use your elevations relative to the Google Earth ground surfacemodel. For example, a point
with elevation 0 will lay directly on the surface, and a point with elevation 10 will lay 10meters/feet above the surface.
This option is not available in a 2D project.

l Absolute: will use your elevation values directly. Note that any stations or connection lines that fall beneath the Google
Earth ground surfacemodel will be obscured by it and will not be visible. This option is not available in a 2D project.

Extend Paths to Ground: will cause a vertical line to be extended from your stations to the ground surfacemodel, and a ver-
tical plane to be extended from your connection lines to the ground surfacemodel.

Open after export: will cause your exported file to be opened by whatever default program is associated with the .kml or .kmz
filetype. This will usually be Google Earth, if it is installed.

Save as company defaults: The settings selected (folder names and colors, etc) are saved on a project basis. Therefore,
when you exit a project, and then return later to it, the same KML option settings will appear. When you are using the KML
Exporter on what you consider a "typical" project, you can use this option to save the current KML settings as typical defaults.
Then whenever you start a new project, these saved typical settings will be used as starting settings.

Google®, GoogleMaps™ andGoogle Earth™ are trademarks of Google Inc.

10.5 LANDXML EXPORTER
STAR*NET can export a LandXML file which can be used to transfer adjustment results to other compatible software pack-
ages.
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To run the LandXMLExporter utility, choose Tools > LandXML Exporter. This tool is available with 2D and 3D projects, as
well as Lev projects where approximate horizontal coordinates have been defined for the network stations.

The LandXML file will contain the following project data:

l Adjusted point coordinates

l Connection Lines

The Project and Author details specified on the dialog are all optional, if provided they will appear within the header of the
LandXML file.

l Project Name

l Project Description

l Author Name

l Author Email

l Author Company

l Author URL

View after export: will cause your exported file to be opened by whatever default program is associated with the .xml filetype.
This is the same as double-clicking on the exported file in yourWindows file explorer.

Save as company defaults: The specified settings are saved on a per-project basis. Therefore, when you exit a project, and
then return later to it, the same options will appear. When you are using the LandXMLExporter on what you consider a "typical"
project, you can use this option to save the current LandXML settings as typical defaults. Then whenever you start a new pro-
ject, these saved typical settings will be used as starting settings.
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10.6 EDITOR OPTIONS
The look and feel of the integrated editor can be customized using the Tools > Change Font and Color command. This com-
mand is only available if a data file is currently open in the editor, otherwise it will be temporarily disabled.

Editor
On the Editor tab, you can specify various display and behavior options.

Editor Font
On the Editor Font tab, you can specify the default text options such as the font, size, and default color options. You can only
select from fixed-width fonts like Courier; variable width fonts like Arial are not available.
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Syntax Color
The Syntax Color tab can be used to override the default syntax highlighting options for the various data types (Comments,
Inline Options, etc).

You can change the Text Color, Background Color, Selected Color, and Selected Background Color for the following pre-
defined Attribute types used in STAR*NET data files (*.dat and *.gps). Other file extensions can be used in the editor but will
not be colored using the Syntax Color options.

Comment (Multi-Line): All lines within a .DATA OFF / .DATA ON block.
Comment (Single-Line): Any text following a # character.
Constant: Any predefined inline option constants (for example, "OFF" or "ON" in a .DATA inline option.)
Description: Any text following a ' character.
Fixity: Any predefined fixity codes, including * ! & and ?
Inline: Any predefined inline option (for example ".DATA")
Keywork: Any predefined STAR*NET data code (for example C, DV, M, L, etc)
Normal Text: Everything else.

Reset Font and Color Options
To reset the Font and Color Options to factory default settings, you can exit from STAR*NET, delete the following three files,
and restart STAR*NET:

1. My Documents\MicroSurvey\StarNet\_dat.schclass

2. My Documents\MicroSurvey\StarNet\colorSchema0.ini

3. My Documents\MicroSurvey\StarNet\SyntaxEdit.ini

If these files are not present, STAR*NET will recreate them with default settings.
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10.7 RESET LAYOUT
You can Reset the customizable screen layout to factory defaults by running the Tools > Reset Layout command. The Reset
Layout commandwill prompt you to exit from STAR*NET, and when you restart the program any customizations you had
made will be reverted to factory defaults.

This can be useful if you have lost any of the panels and cannot reopen something.

The default layout may not be appropriate for all display sizes and resolutions, and we do recommend that you experiment with
customizing the interface to best suit your specific needs and workflow habits.

10.8 LANGUAGES
If you have installed amulti-language version of STAR*NET, you can switch languages by running the Tools > Languages
command. After changing the language, youmust exit and restart the program.

Please note that only the currently installed languages will be listed, and not all installations contain multiple languages.
Contact MicroSurvey Software Inc. or your local STAR*NET dealer for more details on the available languages.

File Encoding
You can choose how you would like to encode your input and output files. The default is to always create non-unicode format
files (checkbox off), also known as ANSI.

When "Use Unicode Format for Input and Output Files" is unchecked off:

l Opening ANSI DAT files will remain as ANSI.

l Opening Unicode DAT files will remain as Unicode.

l Opening ANSI GPS files will remain as ANSI.

l Opening UnicodeGPS files will remain as Unicode.

l All converters will create ANSI DAT files.

l All output files such as Listing (LST), Error (ERR), Coordinates (PTS), Lat / Long (POS), Ground (GND) and Dump
(DMP) will be ANSI.

When "Use Unicode Format for Input and Output Files" is checked on:

l Opening ANSI DAT files will convert to a Unicode formatted file. A backup of the old DAT file will occur and will have an
extension of ".SNBAK" appended to the original file name.

l Opening Unicode DAT files will remain as Unicode.

l Opening ANSI GPS files will convert to a Unicode formatted file. A backup of the old GPS file will occur and will have an
extension of ".SNBAK" appended to the original file name.

l Opening UnicodeGPS files will remain as Unicode.

l All converters will create Unicode DAT files.

l All output files such as Listing (LST), Error (ERR), Coordinates (PTS), Lat / Long (POS), Ground (GND) and Dump
(DMP) will be Unicode.
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CHAPTER 11: ADJUSTMENTS IN GRID COORDINATE
SYSTEMS
11.1 OVERVIEW
The surface of the earth is curved. However, for most surveying purposes, it is more convenient to assume that the earth is
flat, and to work with rectangular plane coordinates, such as Northings and Eastings.

When surveys are performed in very small areas and using arbitrary coordinates, the surveyor canmake the assumption that
he or she is working on a plane that is tangent to the earth in the area of interest. Any errors resulting from this assumption are
generally acceptable. In this case, the surveyor can run STAR*NET adjustments using a "Local" coordinate system.

However, for surveys performed over larger extents, and to higher accuracies, the physical shape of the earth does become a
factor. And, even for small local surveys, it is often required that they be connected into a larger overall coordinate reference
system consistent for an entire city, county or region. The solution to this problem is to project the curved surface of the earth
onto another surface, such as a cylinder or a cone. The new surface can then be laid flat onto a plane, and serve as the basis
for map display and computations. As long as themathematical functions for transforming between the earth surface and the
flat plane are known, the surveyor canmeasure surface field data in the curved earth system, and accurately represent it in a
projected "Grid" coordinate system.

STAR*NET supports the following grid coordinate systems:

1. NAD27 and NAD83 – Defined grid zones used in the United States

2. UTM - Universe TransverseMercator zones used domestically and internationally

3. Custom –Domestic and international user-defined grid systems

This chapter describes how STAR*NET works with grids, selecting of grid system zones from the Project Options dialog,
options relating to grid, output listing sections that reflect the affects of the grid reductions, and setting up of custom grid sys-
tems.

The STAR*NETmanual does not attempt to be a text book in this subject. If you plan to run adjustments in grid coordinate sys-
tems, whether it be projections specific to the United States, or other projections around the world, we suggest that you read
some technical information relating to these systems to get a general idea of the calculations required for working these pro-
jections. There are excellent text books that go into great detail explaining each system.

11.2 HOW STAR*NET WORKS WITH GRID SYSTEMS
STAR*NET adjusts your surveyed observations "on-the-plane." What this means is that, using the projection formulas for the
selected grid system and ellipsoid, and the entered geoid height, STAR*NET takes the surveyed datameasured at earth-sur-
face level and fits it all together on the grid plane during an adjustment. Handling the adjustment in this fashion provides one
consistent rectangular system to combine different types of observations in an understandable way. These types of obser-
vations include: surveyed surface observations reduced by the program, enteredmeasurements already on the grid plane (for
example, entered grid bearings, or grid distances frommaps), andGPS vectors rotated to north, east and up vector com-
ponents on the specified grid plane. Handling of GPS vectors is supported in the STAR*NET-PROEdition.

However, what this alsomeans is that, since grid adjustments use the actual grid plane during the adjustment process, the
size of your project is restricted to the approximate extent of the grid system boundary so that geodetic-to-grid formulas remain
accurate. STAR*NET is designed for typical survey grid projects in relatively small areas spanning up to a few hundred kilo-
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meters, the extent of a typical grid system. The program cannot be used to adjust survey observations in a single project that
spans thousands of kilometers or miles, coveringmultiple grid zones.

11.3 UNITS OF LENGTH
STAR*NET allows you to select different length units: US Survey Foot, International Foot, andMeter are built into the program
and the user may define additional units of length in the Custom file, "STARNET.CUS" described later in this chapter. The US
Survey Foot is defined as 1200/3937 of ameter, and the International Foot as 0.3048meter, which is shorter by about 2 PPM.

It is up to you tomake sure that your project is using the proper units for your particular known control coordinates. For
example, official NAD27 coordinates are given in US Survey Feet, and NAD83 in either Meters or US Survey Feet. However,
there are someNAD83 zones that were originally defined using International Feet!

11.4 SIGNS OF GEODETIC POSITIONS
The sign convention for Longitudes is set as a preference in the Project Options/General dialog settings. The use of "positive"
west longitudes (those west of Greenwich) is preferred by most users in the USA and Canada; "negative" west longitudes by
the international community. Whichever convention preference you select for a project, it will be used for all grid systems. Note
that if you consistently use one sign convention for all projects, be sure to set that preference in your company options so that
all new projects will be defaulted to that convention.

The sign convention for Latitudes is always positive to the north of the equator, and negative to the south.

11.5 SELECTING A GRID COORDINATE SYSTEM
When you select "Grid" from the Coordinate System group in the Project Options Adjustment dialog, all grid-related items on
the dialog become active.
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The first button in this section (labeled "CA83-III" in the above image) will either display the name of the currently selected sys-
tem, or it will be blank if one has not yet been selected. Press this button to open the Select Project Coordinate System dialog,
from which you can select the appropriate coordinate system for your project.
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The Select Project Coordinate System dialog appears so you can choose a particular grid zone. STAR*NET includes over
3800 predefined coordinate systems, which are divided up into logical Coordinate System Groups for various regions.

The example above indicates that California Zone 3, located in the State Planes NAD83 group, is currently selected.

Once a zone is selected, the name of the zone appears on the large button to the right of the grid system field to indicate the cur-
rent zone within the grid system.

The "Coordinate System Details" button will show more details for the currently selected system including its Ellipsoid, Datum
and Projection parameters. For all predefined coordinate systems, these parameters are for informational purposes only and
cannot bemodified.
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See the next three sections for examples of choosing State Planes, UTM andCustom zones.

11.6 SELECTING A STATE PLANE ZONE
State Plane Coordinate System (SPCS) is used in the United States, with zones based on the NAD27, NAD83, and HARN
(aka HPGN) datums.

To select a State Plane zone, choose theGrid option in the Coordinate System section of the Project Options Adjustment dia-
log, then press the button to select a new zone as described in the Selecting aGrid Coordinate System topic.
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The Select Project Coordinate System dialog will appear:
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To select a State Plane zone, first select the appropriate coordinate system group:

l State Planes, NAD27: SPCS zones based on the NAD27 datum

l State Planes, NAD83: SPCS zones based on the NAD83 datum

l State Planes, HARN: SPCS zones based on the HARN/HPGN datum

Then select the appropriate coordinate system zone from that group by selecting it from the list.

For example, to select a zone that would includeOakland, California, you would select California Zone III.

Finally, press OK to actually choose the zone and exit the selection dialog.

11.7 SELECTING A UTM ZONE
Universal TransverseMercator (UTM) zones cover the earth in 6 degree zones, starting with Zone 1 which spans 180West to
174West, and increasing eastward to Zone 60 which spans 174 East to 180 East.

To select a UTM zone, choose theGrid option in the Coordinate System section of the Project Options Adjustment dialog, then
press the button to select a new zone as described in the Selecting aGrid Coordinate System topic.
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The Select Project Coordinate System dialog will appear:
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To select a UTM zone, first select the appropriate UTM coordinate system group:

l UTM Zones, NAD83: zones 1 through 60, based on the NAD83 datum

l UTM Zones, NAD27: zones 1 through 60, based on the NAD27 datum

l UTM Zones, HARN: zones 10 through 18, based on the HARN/HPGN datum

l UTM Zones, North: zones 1 through 60, based on various international datums/ellipsoids (northern hemisphere)

l UTM Zones, South: zones 1 through 60, based on various international datums/ellipsoids (southern hemisphere)

Then select the appropriate coordinate system zone from that group by selecting it from the list.

For example, to select a zone that would includeOakland, California, which has a longitude of  approximately 123 degrees
west, you would select UTM zone 10 which spans between 120 and 126 west of Greenwich.

Finally, press OK to actually choose the zone and exit the selection dialog.

Note that values for latitudes in your data should not be used beyond +80 or -80 degrees in the north and south hemispheres
respectively.

Also as mentioned earlier in this chapter, always to use proper signs for latitudes and longitudes in your data! Use positive lat-
itudes for points north of the equator, and negative latitudes for points south of the equator. And for longitudes, use signs based
on the "Longitude Sign Convention" selected in the Project Options/General dialog.

11.8 SELECTING A CUSTOM ZONE
Custom zones are coordinate system zones individually defined by the user. They may be zones defining specific international
locations (for example, the Great Britain national grid, Ireland grid, Singapore grid, etc.) or special township or county coordin-
ate system grids now being commonly implemented in the United States. Users might even wish to set up special grid system
for a particular project.

To select a custom zone, choose theGrid option in the Coordinate System section of the Project Options Adjustment dialog,
then press the button to select a new zone as described in the Selecting aGrid Coordinate System topic.
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The Select Project Coordinate System dialog will appear:
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To select a custom zone, first select the "User-Defined Systems" coordinate system group.

Then select the appropriate coordinate system zone from that group by selecting it from the list.

Along with the name of your coordinate system, you will also see the description that was entered for it. Unlike with the pre-
defined coordinate systems, the Datum and Ellipsoid names will be the same as your custom system.

Press OK to actually choose the custom zone and exit the dialog.

Parameters for custom coordinate systems are stored in three binary files called Coordsys, Datums, and Elipsoid which are all
located in theMapping subfolder of your STAR*NET system directory. Besides the custom coordinate system zone defin-
itions, these files also contain all of the predefined coordinate system, datum, and ellipsoid definitions.

The ability to create and edit custom coordinate systems is a very important feature in the STAR*NET package. The process
of defining custom information is described in detail later in this chapter.

11.9 ENTERING A GEOID HEIGHT
In general, you work with elevations in STAR*NET, which are the heights above the geoid usually determined by differential lev-
eling. However, in the grid calculations performed during an adjustment, distances are reduced to the ellipsoid, not the geoid.
Therefore STAR*NETmust know the heights of points above the ellipsoid.

The geoid height at a point is defined as the height above the ellipsoid minus the height above the geoid. Therefore, by entering
the average geoid height for your project, the program can determine reasonably accurate ellipsoid heights for all points to per-
form the necessary geodetic calculations.

Enter the average geoid height value for your project in the "Grid Jobs" options group in the Project Options/Adjustment dialog
as shown below.

The geoid height value is always entered inmeters, and don’t forget to use the proper sign! In the conterminous US, for
example, the geoid is below the ellipsoid, so the geoid height is negative. In Alaska, the opposite is true, so the value is pos-
itive.
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Note that providing an approximate "average" project geoid height is adequate for working with conventional observations
since their elevations are based on the geoid anyway.

When working with GPS vectors, however, accurate geoid heights must be known for every point since vectors are based on
the ellipsoid. The geoid height at each point is the single value that properly connects a GPS point’s ellipsoid height to its actual
orthometric elevation! The STAR*NET-PRO edition, which handles GPS vectors, includes the ability to enter geoid heights at
every station as well as perform full geoid modeling. The STAR*NET-PRO edition also allows you to define vertical deflections
at every point as well as perform vertical deflectionmodeling. This can be quite important for combining GPS Vectors with con-
ventional observations when significant geoid undulations are present.

11.10 ENTERING DATA FOR GRID SYSTEM ADJUSTMENTS
Remember that in a "Grid" coordinate system adjustment, you are normally supplying field observations in a ground-surface
system that will be reduced to fit your supplied coordinates, which are in a grid system.

All station coordinates must be supplied as grid values in the form of either coordinates or geodetic positions (latitudes and lon-
gitudes). You cannot combine "grid" and arbitrary "local" coordinates in the same adjustment.

Input data for a grid coordinate system adjustment is prepared and entered the sameway as for a local coordinate system,
except for the following differences:

1. Entered station coordinates must be grid coordinates or geodetic positions.

2. Entered station heights are normally supplied as orthometric elevations. Although ellipsoid heights may be entered, the
"standard" STAR*NET edition is designed to handle "terrestrial" adjustments using elevation-based observations.

In the "Professional" STAR*NET edition, however, station heights are sometimes supplied as ellipsoid heights because
of the GPS vector handling facilities. To derive orthometric elevations from these ellipsoid heights, accurate geoid
heights are provided for every station, or geoidmodeling is performed.

3. By default, bearings or azimuths are entered as grid values.

But if you want to enter geodetic (or observed) bearings or azimuths, use the ".MEASURED" inline option to change the
input mode. The program internally converts these values to grid by computing and applying proper corrections.

4. By default, all other input data, the angle and distance observations, are entered as observed surfacemeasurements.
These observations are internally reduced to the grid plane values during the adjustment.

But if you want to enter angle and distance values that have already been reduced to grid (information taken from amap
for example), use the ".GRID" inline option to change the input mode. Corrections will not be computed for these values.

Descriptions of the ".MEASURED" and ".GRID" inline option datamodes mentioned above are fully detailed in Chapter 4,
"Options".

11.11 ADDITIONAL LISTING SECTIONS FOR GRID ADJUSTMENTS
As discussed in Chapter 8, "Analysis of Adjustment Output", several additional or altered parts to the listing file are generated
when you run a grid adjustment. As shown in the following example, the Summary of Unadjusted Input Observations listing
reflects the t-T differences for angles and the combined scale factors for distances.
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Summary of Unadjusted Input Observations
========================================

Number of Measured Angle Observations (DMS) = 6

At      From    To           Obs Angle   StdErr     t-T 
1       27      2          90-44-18.31     2.00   -1.14 
2       1       3         265-15-55.29     2.00   -1.20 
3       2       4          82-48-26.91     2.00   -1.26 
4       3       5         105-03-08.64     2.00   -1.28 

Number of Measured Distance Observations (FeetUS) = 5

From    To           Obs Dist   StdErr   Comb Grid 
1       2           4805.4680    0.030   1.0000077 
2       3           3963.6940    0.030   1.0000125 
3       4           4966.0830    0.030   1.0000161 
4       5           3501.2230    0.030   1.0000110 

The listing that shows adjusted azimuths and horizontal distances, now displays grid azimuths as well as adjusted distances
for both grid and ground.

Adjusted Azimuths (DMS) and Horizontal Distances (FeetUS)
=========================================================

(Relative Confidence of Azimuth is in Seconds)
From  To    Grid Azimuth   Grid Dist       95% RelConfidence

Grnd Dist     Azi    Dist       PPM
1     2      91-04-51.60   4805.7540   12.33   0.0961   19.9968   

4805.7169
2     3     176-20-40.57   3963.8439   11.48   0.1590   40.1130  

3963.7943
3     4      79-09-21.79   4966.3902    9.41   0.1492   37.6402   

4966.3100
4     5       4-12-30.82   3501.1951   15.62   0.1273   25.6323   

3501.1567

This optional listing for grid adjustments shows computed convergence angles and grid factors (scale, elevation and combined)
for every station in the network. Average project values are also listed at the end of the table.
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Convergence Angles (DMS) and Grid Factors at Stations
=====================================================

(Grid Azimuth = Geodetic Azimuth – Convergence)
(Elev Factor Includes a -30.50 M Geoid Height Correction)

Convergence    ------- Factors -------
Station      Angle           Scale x  Elevation  =  Combined
1          0-30-16.53   1.00004201   0.99996555   1.00000756
6          0-37-07.56   1.00004798   0.99996523   1.00001351
2          0-32-41.20   1.00004232   0.99996233   1.00000487
3          0-32-47.67   1.00005166   0.99996538   1.00001700
4          0-35-14.76   1.00004954   0.99997002   1.00001956

Proj Ave:  0-34-22.15   1.00004628   0.99996567   1.00001184

And finally this listing section contains the adjusted grid coordinates with elevations, and the adjusted latitudes and longitudes
with ellipse heights. These two parts are each optional and are selected by settings in the Project Options.

Adjusted Station Information
============================
Adjusted Coordinates (Meters)

Station               N             E         Elev    Description
1              61367.0060   660318.6260   1244.5300
6              58949.0873   673994.0150   1324.7786
2              61276.1121   665123.5876   1240.3974
3              57323.2277   665376.0984   1379.5684

Adjusted Positions and Ellipsoid Heights (Meters)
(Average Geoid Height = -30.500 Meters)

Station             Latitude           Longitude      Ellip Ht

1              42-33-00.011496     89-15-56.245898  1214.0300
6              42-31-37.314471     89-05-58.042921  1294.2786
2              42-32-55.640147     89-12-25.695430  1209.8974
3              42-30-47.468871     89-12-16.281481  1349.0684

11.12 DEFINING A CUSTOM ZONE
Note that STAR*NET 8 now includes over 3800 predefined coordinate systems, so be sure to check the coordinate system
group for your region before defining a custom zone to see if it already exists.
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APPENDIX A: DEMONSTRATION TOUR
A.1 OVERVIEW
STAR*NET is a program package that performs least squares adjustments of two- and three-dimensional survey networks and
level networks. It is menu driven for ease of use, and allows you to edit your input data, run your adjustment and view the
adjustment results all from within the program. STAR*NET also includes graphics display routines that allow you to view your
network, including the error ellipses from your adjustment.

Although STAR*NET is easy to use, it is also very powerful, and utilizes the latest rigorous adjustment and analysis tech-
niques. In three dimensional mode, it performs a simultaneous adjustment of three dimensional data, not simply an adjustment
of horizontal followed by an adjustment of vertical. This makes STAR*NET well suited to the processing of total station data,
and the analysis of data sets for establishing control for close-range photogrammetry and structural deformationmonitoring.
However, it is equally suitable for the adjustment of traditional horizontal traverses.

This tutorial is designed to be used with the STAR*NET Program. The supplied sample data files will acquaint you with some
of the capabilities of the package:

l Example 1: Two dimensional traverse network. This example shows you the basic features of STAR*NET, and lets you
run an adjustment and view the output results in both listing and graphical formats.

l Example 2: Combined triangulation/trilateration network.

l Example 3: Three dimensional traverse network.

l Example 4: Same three dimensional network, but processed as a grid job.

l Example 5: Resection.

l Example 6: Traverse with Sideshots.

l Example 7: Preanalysis of a network.

l Example 8: Simple GPS Network (contained in the STAR*NET-PRO supplementary manual)

l Example 9: Combining Conventional Observations andGPS (contained in the STAR*NET-PRO supplementary
manual)

l Example 10: Differential Level Network

In the tutorial, we will go through the same sequence of operations that you would normally follow when creating and adjusting
a survey network. The normal sequence of operations one goes through in adjusting a project is: set project options, create
input data, run an adjustment, review results including viewing both an adjusted network plot and an output listing report. But in
these examples, we will be just reviewing options and data, not setting options and creating new data.

A.2 EXAMPLE PROJECT FILES
The example projects provided for this tutorial are located in your "My Documents\MicroSurvey\StarNet\Examples\" folder.
Each sample project consists of a "Project" file (a file with a ".SNPROJ" extension) and at least one "Data" file (a file with a
".DAT" extension). An existing project is opened by selecting its "SNPROJ" file from theOpen Project dialog.

The "Project" file contains all the option settings for a project such as whether it is a 2D or 3D job, a local or grid job, all instru-
ment standard error settings, andmuchmore information. The project file also includes a list of all data files that are considered
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part of the project. All settings are preset for these sample projects, so you can simply review them and not be concerned about
setting any yourself.

All "Data" files used in STAR*NET are simple text files that may be prepared within the program or external to the program
using any text editor. All of the input data files for the sample projects are provided, with full comments, to help you get an idea
of how to use STAR*NET to handle your adjustment problems. It is not required that you edit any of these sample data files
when running the sample projects.

In all following examples in this tour, the instructions simply ask you to open a named project. Choose File > Open Project, or
press the Open tool button, and the following dialog will appear allowing you to select one of the existing sample projects.

If for some reason the sample projects as shown above do not appear, browse to your "My Docu-
ments\MicroSurvey\StarNet\Examples\" folder and you will find them there.
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Example 1: Two Dimensional Traverse Network
The first example project demonstrates the functioning of STAR*NET's mainmenu system. You will run an adjustment for a
project, then view the results in both graphical and listing formats. After running this example, you should have a basic under-
standing of how the program works. Later examples will show more data types and go intomore detail about program options.
(Comments following the # character are ignored.)

# 2D Job with Multi-Loop Traverses

C    1     5045.572   5495.338  ! !  # fixed coordinates
C    6     5000       5190           # approximate coordinates

TB   6  # traverse backsight to point 6
T    1       99-47-25   205.03
T    2      115-10-00   134.19
T    3       94-51-53   105.44
T    4      216-46-09   161.57 'Existing post
T    5      106-26-42   160.71 'Iron pipe
T    6       86-57-49   308.30
TE   1  # end this loop at Point 1

TB   2  # traverse backsight to point 2
T    3      225-47-02   115.41
T    7       97-31-36   284.40
T    8      115-14-57   191.66
T    9      156-15-44   166.90
M    9-8-5   83-45-28   161.95  # add a tie-in course to 5
T    10     106-12-32   151.34
TE   6      164-00-42    1      # end at 6, turn angle into 1

B    8-7   n79-52-31e  !  # fixed bearing
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1. Run STAR*NET and open the "Tutorial01-Trav2D.snproj" example project.

2. TheMain STAR*NET interface will appear:

The STAR*NET 10 interface is extremely customizable so your screenmay look somewhat different. All of the panels
can be rearranged and resized as desired.

All program operations can be selected from the dropdownmenus, and themost common operations can be selected by
pressing one of the toolbar buttons. Pause your mouse pointer over each button to see a short description of its function.

3. ChooseOptions > Project, or press the Project Options tool button.
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The "Adjustment" options page includes settings that describe the project, whether it is a 2D, 3D or Lev type, local or
grid, linear and angular units used, and information about the datum scheme. A realistic "Average Project Elevation"
should be entered if you are asking the program to reduce observations to some common datum, but this is not the case
in this sample job so we’ve left the value at zero. Other important calculations based on this average project elevation
are described in the full manual. Only relevant items on this options dialog are active. For example, other sections of this
dialog and other dialogs will be active or inactive (grayed-out) depending on whether the adjustment is a 2D or 3D or a
Lev type, or Local or Grid system.

The "Lev" adjustment type is available in the PRO, PLUS and LEV editions. Most example projects shown are 2D or
3D. Example 10 illustrates a "Lev" type.

4. Review the "General" options by clicking the "General" tab. This page includes settings that are very general in nature
that you seldom need to change during the life of a job. Some of these settings are actually "preferences" which
describe the order you normally enter your coordinates (North-East, or visa versa), or the station name order you prefer
when entering angles (At-From-To or From-At-To).

5. Review the "Instrument" options page. Here you see default values used in the adjustment, such as standard errors for
each of the data type, instrument and target centering errors, and distance and elevation difference proportional (PPM)
errors. These are some of themost important parameters in the program since they are used in the weighting of your
observation data. Since this is a 2D network, you will notice that only 2D standard error items are active.
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Note that instrument and target centering errors can be included to automatically inflate the standard error values for dis-
tance and angle observations. Entering horizontal centering errors causes angles with "short sights" to be less import-
ant in an adjustment than those with "long sights." Likewise, in 3D jobs, a vertical centering error can also be included to
cause zenith angles with short sights to be less important in an adjustment than those with long sights.

6. Review the "Listing File" options page. These options allows you to control what sections will be included in the output
listing file when you run an adjustment. Note that the Unadjusted Observations andWeighting item is checked. This
causes an organized review of all of your input observations, sorted by data type, to be included in the listing – an import-
ant review of your input.

The Adjusted Observations and Residuals section, is of course, themost important section since it shows you what
changes STAR*NETmade to your observations  during the adjustment process – these are the residuals.
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Note that the Traverse Closures section is also checked. This creates a nicely formatted summary of your traverses
and traverse closures in the listing. You’ll see these and the other selected sections later in this tutorial project once you
run the adjustment and then view the listing.

The last part of this options page allows you to set options that affect the appearance of observations or results in the
listing. Note that you can choose to have your unadjusted and adjusted observation listing sections shown in the same
order the observations were found in your data, or sorted by station names.

You can also choose to have the adjusted observations listing section sorted by the size of their residuals – sometimes
helpful when debugging a network adjustment.

7. Finally, review the "Other Files" options page. This menu allows you to select additional output files to be created during
an adjustment run. For example, you can choose to have a coordinate points file created. Or when adjusting a "grid" job,
you can choose to have a geodetic positions file created.
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The optional "Ground Scale" file is particularly useful then running grid jobs. You can specify that the adjusted coordin-
ates (grid coordinates in the case of a grid job) be scaled to ground surface based on a combined scale factor determ-
ined during the adjustment, or a factor given by the user. These newly-created ground coordinates can also be rotated
and translated by the program.

The optional "Station Information Dump" file contains all information about each adjusted point including point names,
coordinates, descriptors, geodetic positions and ellipse heights (for grid jobs) and ellipse information. The items are
comma delimited text fields which can be read by external spread sheet and database programs – useful for those wish-
ing to create custom coordinate reports. This "Dump" file and the "Ground Scale" file are described in detail in the full
manual.

The Coordinate Points andGround Scaled Points files can both be output in various formats using format specifications
created by the user. The user-defined formatting specifications are discussed in the full manual.

8. The "Special" option tab includes a positional tolerance checking feature to support certain government (such as
ACSM/ALTA) requirements, but is not discussed in this tutorial. The "GPS" and "Modeling" option tabs are active in the
"PRO" edition. See Examples 8 and 9 later in this tutorial for a description of the "GPS" options menu.

9. This concludes a brief overview of the Project Options menus. After you are finished reviewing thesemenus, press
"OK" to close the dialog.

10. Our next step is to review the input data. Refer to the Data Input Files panel, or go toView > Data Input Files to open it
if it has been closed. In this dialog you can add data files to your project, remove files, edit and view them, or rearrange
their position in the list. The order of the list is the order files are read during an adjustment. You can also "uncheck" a file
to temporarily eliminate it from an adjustment – handy when debugging a large project containingmany files. This simple
project includes only one data file.
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The data file should already be open in the internal STAR*NET editor, but you can double-click the filename to open any
of the attached data files for editing. Take aminute to review the data.

11. Run the adjustment! ChooseRun > Adjust Network, or press the Run Adjustment  toolbar button. The Processing
Summary panel will show the progress.
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When the adjustment finishes, a short statistical listing is shown in the Processing Summary window indicating how
each type of data fit the adjustment. The total error factor is shown plus a statement indicating whether the Chi Square
Test passed, a test on the "goodness" of the adjustment.

After adjusting a network, you will want to view the network plot, or review the adjustment listing.

We’ll view the network plot next.

12. To view the plot, chooseOutput > Plot, or press the Network Plot  tool button.
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Like all panels, you can resize and reposition the plot window for viewing convenience. The size and location of most
windows in STAR*NET are remembered from run to run.

Experiment with the tool keys to zoom in and zoom out. Also zoom into any selected location by "dragging" a box
around an area with your mouse. Use the "Pan" tool to set a panningmode, and small hand appears as your mouse
pointer which you can use to drag around the image. Click the "Pan" tool again to turn themode off. Use the "Find" tool
to find any point in a large network. Use the "Inverse" tool to inverse between any two points on the plot. Type names
into the dialog or simply click points on the plot to fill them in (see the example above).

Pop up a "Quick Change" menu by right-clicking anywhere on the plot. Use this menu to quickly turn on or off  items
(names, markers, ellipses) on the plot.

Click the "Plot Options" tool button to bring up a plot properties dialog to changemany plotting options at one time includ-
ing which items to show, and sizing properties of names, markers, and error ellipses.

Double-click any point on the plot to see its adjusted coordinate values and error ellipse dimensions. Double-click any
line on the plot to see its adjusted azimuth, length, elevation difference (for 3D jobs), and relative ellipse dimensions.

Choose File > Print Preview or File > Print, or the respective tool buttons on the program’s mainframe tool bar, to pre-
view or print a plot. More details using the various plot tools to view your network and printing the network plot are dis-
cussed in the full operatingmanual.

When you are finished viewing the adjusted network plot, let’s continue on and review the output adjustment listing
next.

13. To view the listing, chooseOutput > Listing, or press the Listing tool button.
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The listing file shows the results for the entire adjustment. First, locate and size the listing window large enough for your
viewing convenience. This location and size will be remembered. Take a few minutes to scroll through the listing and
review its contents. For quick navigation, use the tool buttons on the window frame to jump forward or backward in the
file one heading at a time, a whole section at a time, or to the end or top of the file.

For quicker navigation to any section in the file, right-click anywhere on the listing, or press the Index Tree tool button to
pop up a "Listing Index" (as shown above). Click any section in this index to jump there. Click [+] and [-] in the index to
open and close sections as you would inWindows Explorer. Relocate the index window to any convenient location and
it will stay. Check the "Keep on Top" box on the index window if you want it to always be present when the listing is act-
ive.

Using one of the navigationmethods described above, go to the section named "Summary of Unadjusted Input Obser-
vations." Note that each observation has a standard error assigned to it. These are the default values assigned by the
program using the project options instrument settings reviewed earlier in step 5.

Still in the listing, further on, look at the "Statistical Summary." This important section indicates the quality of the adjust-
ment and how well each type of data such as angles, distances, etc. fit into the overall adjusted network.

Always review the "Adjusted Observations and Residuals" section! It shows how much STAR*NET had to change
each observation to produce a best-fit solution. The size of these residuals may pinpoint trouble spots in your network
data.

Take a look at the "Traverse Closures of Unadjusted Observations" section. This project had data entered in traverse
form, and in the Project Options, this report was selected as one of the sections to include in the listing. For each tra-
verse, courses are listed with unadjusted bearings (or azimuths) and horizontal distances. When possible, angular mis-
closures are shown along with the amount of error per angle. The linear misclosures are shown based on unadjusted
angles "corrected" by the per-angle error. Many governmental agencies want to see this kind of closure analysis. But it
is important to note, however, that these corrections are only for the benefit of this traverse closure listing. Actual cor-
rections to angles are calculated during the least squares adjustment, and are shown as residuals.
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At the end of the listing, review the Error Propagation listing section. You will find the standard deviation values and the
propagated error ellipse information for all adjusted stations. Also present are relative error ellipses between all station
pairs connected by an observation.

This concludes the quick review of the listing. You’ll note that much information is shown in this file – it contains just
about everything youmight want to know about the results of an adjustment. In some cases, youmay only wish to see
a subset of this information, so remember that you can tailor the contents of this file by selecting which sections to
include in the Project Options/Listing file menu.

14. In the "Project Options/Other Files" menu reviewed in step 7, an option was set to create an adjusted coordinates file.
ChooseOutput > Coordinates to view this file. Any additional files created can also be viewed from this menu.

15. This completes the review of the "Trav2D" example project. We have toured themain optionmenus, the input data dia-
log, performed an adjustment, reviewed the output listing contents in some detail and viewed network plots. Now that
you have a good idea how the program works, the remaining tutorial examples can be examined with aminimum of
explanation.

The sample project that you have just stepped through is a realistic example of a small two dimensional multi-loop traverse.
Note that only a few simple steps are required to run an adjustment:

l Set options for your project

l Create one or more data files

l Run the adjustment

l Review both graphical and listing output

The "listing file" you reviewed by choosingOutput > Listing is the final adjustment report produced from the STAR*NET run.
Once a project is adjusted to your satisfaction, youmay want to get a printout of this listing for your records. This file is a text
file having the name of your project, plus a "lst" extension. A  listing file named "Tutorial01-Trav2D.lst" therefore, was created
by running this example.

The listing file can be printed from within the program by choosing File > Printwhile the listing window is open and active.

The adjusted coordinates for this project are in a file named "Tutorial01-Trav2D.pts" and like the listing file, can be simply prin-
ted from within the program. Since the points are in text format, many COGO programs will be able to read them directly.

However for your convenience, there is a "Points Reformatter" utility that can be run from the "Tools" menu. This utility allows
export adjusted coordinates to several standard formats, as well as custom formats defined by you

Another utility available from the "Tools" menu is a "DXF Exporter" which creates a network plot in AutoCAD compatible DXF
format.

STAR*NET offers many options and has extensive features not described in this tutorial, but in general, most adjustments can
be performed in the straight forward fashion illustrated by this example. At this point, youmay wish to go back and review the
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actual data file used for this example. Note that the "Traverse" mode of data entry is very easy and efficient. Multiple traverses
can be entered in one file, and additional distance and angle observations can be freely mixed with the traverse data, so as to
keep observations in the same order as your field book.

The remaining examples illustrate more STAR*NET capabilities and data types. It is assumed after following all the steps
detailed in this first example project that you are now somewhat familiar with the operation of the program. The following
examples do not always go into detail describing the individual program functions.
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Example 2: Combined Triangulation/Trilateration 2D Network
This example illustrates the adjustment of a simple triangulation-trilateration network. In the sample data file, many data lines
are entered using the "M" code. This is themost commonly used data typemeaning all "measurements" to another station. All
the remaining independent observation are entered on a single "A" and "D" data lines.

# Triangulation/Trilateration 2D Network

C    1    5102.502    5793.197   ! !
C    3    7294.498    6940.221   ! !
C    2    5642        7017

# Angle and Distance Observations at Perimeter
M    2-1-3   111-08-11   1653.87
M    2-1-6    77-24-52   1124.25
M    3-2-4    87-07-04   1364.40
M    3-2-6    40-58-15    951.92   4.0  .03
M    4-3-5   120-26-52   1382.49
M    4-3-6    44-14-21    983.86
M    5-4-1   110-34-04   1130.75
M    5-4-6    39-46-29   1493.54
M    1-5-2   110-43-40   1337.89
M    1-5-6    65-36-54   1548.61

# Angles at Center Point
A    6-5-4    64-01-01
A    6-4-3    89-36-55
A    6-3-2   105-18-27
A    6-2-1    57-28-12

# Distance Cross-ties
D    1-4       2070.76
D    2-5       2034.47

1. Open the "Tutorial02-Net2D.snproj" example project.

2. Choose Input > Data Files, or press the Data Files tool button to open the Data Files dialog. Then press "View" to view
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the "Tutorial02-Net2D.dat" example data file.

Note that theMeasure lines contain horizontal angle and distance observations from one station to another. The stand-
ard errors for observations normally default to Instrument setting values defined in the Project Options as discussed in
the last example. However, for illustration purposes, explicit standard errors have been added to one of the data lines in
this example. Close the view window.

3. Run the adjustment, by choosingRun > Adjust Network, or by pressing the Run Adjustment tool button.

4. ChooseOutput > Plot or press the Network Plot tool button to view the network graphically. Experiment by resizing the
plot window larger and smaller by dragging the corners or edge of the plot window.

5. Zoom into a section of the plot by dragging your mouse pointer around some part of the network. For example, drag a
zoom box around just points 1 and 2. Note the status information at the bottom of the plot window. The North and East
coordinates are shown for the location of themouse pointer as youmove it around the plot. TheWidth value shown is
the width of the plot window in ground units, FeetUS in this example. This width value will give you a good sense of
scale when you are zoomedway into a very dense plot. Zoom out by pressing the Zoom All button.

Right-click anywhere on the plot to bring up the "Quick Change" menu. Click the "Show Relative Ellipses" item tomake
relative ellipses display. These ellipses represent the relative confidences in azimuth and distance between con-
nections in the network. Double click any line and to see its adjusted azimuth and distance values plus its relative
ellipse dimensions. Likewise, double click any point to see its adjusted coordinates and ellipse dimensions. Chapter 8,
"Analysis of Adjustment Output" in the full manual, includes an extensive discussion of error ellipse and relative error
ellipse interpretation.

6. View the Listing File by choosingOutput > Listing, or by pressing the Listing tool button. Review the various parts of
the listing in the sameway you did for the last example. Be sure to review the "Statistical Summary" section which indic-
ates how well each group of observation types fit into the adjusted network.

Likewise, you should always review the "Adjusted Observations and Residuals" section which shows how much
STAR*NET had to change your observations. You would normally examine this list carefully, especially if the adjust-
ment fails the Chi Square test, to look for possible problems with your data.

7. This completes the review of the "Net2D" example project.
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Example 3: Three Dimensional Traverse Network
This example illustrates the adjustment of a three dimensional network. Data includes two small traverses with slope dis-
tances and zenith angles. An extra cross tie is entered between the two traverses. STAR*NET can also accept 3D data in the
form of horizontal distances and elevation differences.

#  3D Traverse Network

C   A1   10000.00   10000.00    1000.00  ! ! !
C   A2    9866.00    7900.00     998.89  ! ! !

TE  A2  # backsight to A2
T   A1  163-59-26.0   1153.67   91-35-30.0  5.25/5.30
T   1   115-35-06.8   1709.78   90-56-41.6  5.31/5.32
T   2    86-31-37.9   1467.74   90-05-56.2  5.26/5.31
T   3    82-07-57.7   2161.76   88-20-39.6  5.15/5.22
TE  A1   75-45-17.6     1   # closing angle to  1

TB  1   # backsight to 1
T   2   133-21-35.8   2746.28   91-37-53.3  4.98/5.12
T   4   101-39-39.6   1396.76   88-23-31.8  5.23/5.25
T   5   124-35-19.6   3643.41   88-28-02.3  5.35/5.30
TE  A2   80-48-52.2     A1  # closing angle to  A1

M 5-4-3  69-59-28.7   2045.25   89-00-41.0  6.21/5.25

1. Open the "Tutorial03-Trav3D.snproj" example project.

2. Take a look at the Project Options for this project. Note that on the Adjustment options page the "Adjustment Type" is
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now set to 3D. On the samemenu, down in the Local Jobs group of options, we have the Default Datum Scheme set to
"Reduce to a Common Elevation" and the elevation value is set to 0.00 feet. What this means is that we want the job
reduced to sea level. The controlling coordinates given in the datamust be sea level values, and during the adjustment,
observations will be internally reduced to this datum to produce sea level coordinates.

Also while in the Project Options, review the "Instrument" settings page. Note that all settings for vertical observations
are now active. Centering errors of 0.005 feet have been set for both horizontal and vertical centering which will affect
standard errors for all our measurements. Shorter sightings will receive less weight!

3. Examine the input data file. Note that each traverse line now contains additional data elements, the zenith angle and an
"HI/HT" entry giving the instrument and target heights. Coordinate lines now contain an elevation value. The sample
data file contains two small connecting traverses. The "TB" (traverse begin) lines indicate the beginning backsights, and
the "TE" (traverse end) lines indicate at which station the traverses end. In this example, they both contain an optional
closing angle. STAR*NET will use this information in the traverse closure listing, as well as entering them as obser-
vations in the adjustment.

Additional redundancy is provided by an "M" data line containing angle, distance and vertical information between points
on the two traverses.

4. Run the network adjustment and then look at the network graphically. Double click any of the adjusted points and note
the displayed information now includes adjusted elevations and vertical confidence statistics.

5. View the output Listing file. Review the unadjusted observations and note that the standard errors for all angles and
zenith angles are no longer constant values. Because of the "centering error" values entered in the instrument options,
the standard errors assigned to these observations will be larger (less weight) for angles with short sights than for those
with long sights.

Further down in the listing, review the adjustment statistical summary. Since this is a 3D job, you now see additional
items in this list. Review the remaining sections and note the differences from the previous 2D adjustment listing in the
first two example projects. In the Traverse Closures section, for example, vertical traverse closures are shown. And in
the Error Propagation section, standard deviations are shown for elevations, and vertical confidences for ellipses.

6. This completes the review of the "Trav3D" example project.
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Example 4: Three Dimensional Grid Job
This example demonstrates the ability of STAR*NET to reduce ground observations to a grid system plane during the pro-
cessing of a network adjustment.

The following example is the same 3D multiple traverse network illustrated in the previous example. All ground observations
are identical; only the coordinates have been changed to be consistent with NAD83, California Zone 0403.

#  3D Traverse Grid Job

C A1 2186970.930 6417594.370  300.00 ! ! !
C A2 2186836.940 6415494.520  298.89 ! ! !

TB A2  # traverse backsight to A2
T  A1  163-59-26.0   1153.67   91-35-30.0  5.25/5.30
T  1   115-35-06.8   1709.78   90-56-41.6  5.31/5.32
T  2    86-31-37.9   1467.74   90-05-56.2  5.26/5.31
T  3    82-07-57.7   2161.76   88-20-39.6  5.15/5.22
TE A1   75-45-17.6      1  # closing angle to Station 1

TB 1
T  2   133-21-35.8   2746.28    91-37-53.3  4.98/5.12
T  4   101-39-39.6   1396.76    88-23-31.8  5.23/5.25
T  5   124-35-19.6   3643.41    88-28-02.3  5.35/5.30
TE A2   80-48-52.25    A1  # closing angle to Station A1

M 5-4-3  69-59-28.7  2045.25    89-00-41.0  6.21/5.25

1. Open the "Tutorial04-Grid3D.prj" example project.

2. Open the Project Options for this job and review the Adjustment options page. You will see some differences from the
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adjustment options in the last example project:

First, you will note that the Coordinate System is set to "Grid," and the actual grid system chosen from the dropdown
selection list is CA83-III. The zone currently selected, as indicated on the large selection button, is California Zone 3.
How is a zone selected? Simply press the large selection button to bring up the zone selection dialog. Give it a try.

Here you just select from the list to change zones. Press "Show Parameters" to see the zones parameters. Don’t make
a new selection now – just press OK to exit.

Before you exit the Project Options, note another difference in the options from the previous example. At the bottom of
themenu is an options group specific to grid jobs. Here you enter the averageGeoid Height. This value is always
entered inmeters, and it is important to use the correct sign. (It’s negative in the contiguous United States.) For GPS
jobs, it is important to perform geoidmodeling so that a geoid height is determined at every point. But for jobs having
only conventional observations such as this example, an average project geoid height is sufficient since only ground to
grid scaling in affected.

3. Examine the data file if you wish. As mentioned before, the observation data for this example is identical to the previous
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example except that the entered control coordinates are grid coordinates consistent with NAD83, California zone 0403.
The same data set was used for this example so that, if you wish, you can compare output results from two identical
jobs, one run as local, and the other as grid.

4. Run the network adjustment. Look at the network graphically – it will look the same as in the last example. However, if
you double click any of the adjusted points, the displayed coordinates will now, of course, be grid coordinates.

5. View the output Listing file and browse through the various sections as you did in the last example. But since this job is
a "grid" adjustment, you will find some new information present. Go down to the "Adjusted Station Information" section.
First, comes the adjusted grid coordinates. Then directly following are the computed geodetic positions and ellipsoid
heights as shown in the listing window below.

As shown above, next comes a listing of convergence angles and scale factors computed at every station in the net-
work. The factors include the grid scale factor, the elevation factor, and the resulting combined factor.

In the "Adjusted Bearings and Horizontal Distances" section previously seen in other examples in this tour, the bearing
shown is now a "grid" bearing, and both "grid" and "ground" distances are now shown for every network connection.
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Finally, look at the "Traverse Closures of Unadjusted Observations" section. Since this is a "grid" job, the listing  of tra-
verse closures is based on unadjusted bearings and distances that are reduced to the grid plane.

6. See what other files were created by the adjustment by looking at the items that show up in the Output pulldownmenu.
Before we’ve seen the Coordinates file. And now we see a Lat/Longs (geodetic positions) file. The creation of both
these files were requested in the "Project Options/Other Files" menu. Go ahead and view one or both of these files if you
want.

7. Lets revisit the Network Plot, and examine how imagery or other data files can be displayed with any "grid" job. In the
Network Plot panel, press the Layer Manager toolbar button. The Layer Manager lets you overlay georeferenced data
files (over 150 different supported formats) or stream data from onlinemapping services. Press the "DownloadOnline
Data" button, then navigate into the ***POPULAR SOURCES*** or IMAGERY groups and select the "World Imagery"
source, select "Entire Data Source Bounds" as the area to download, then press OK. You will now see "World Imagery"
layer selected in the Layer Manager, and when you Close the layer manager STAR*NET will download the imagery and
display it beneath your network plot. Youmay experience some delay while the imagery is downloaded and cached.
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8. This completes the review of the "Grid3D" example project. Since this was the first "grid" job in our tutorial examples,
we went into extra detail reviewing the option settings and output sections relating to grid adjustments.
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Example 5: Resection
This example demonstrates the use of STAR*NET in solving a resection problem, involving themeasurement of angles from 6
known stations to an unknown point.

# Resection

# Approximate location for the unknown station
#  
C    P48    104500     93600

# Fixed coordinates for the known stations
#
C    1     90132.03     88237.92   ! !
C    2     97418.58     82279.10   ! !
C    3     98696.21     81802.35   ! !
C    4    102911.40     80330.69   ! !
C    5    111203.37     95234.19   ! !
C    6    103278.43    106872.91   ! !

# Occupy "P48" and turn angles to known stations
#
A   P48-1-2      37-35-00.0
A   P48-2-3       5-56-19.4
A   P48-3-4      19-56-18.3
A   P48-4-5     115-34-35.0
A   P48-5-6      78-09-31.0
A   P48-6-1     102-48-30.0

1. Open the "Tuturial05-Resection.snproj" example project.

2. Review the project options if you wish. This is a standard 2D, local project.
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3. Examine the input data file.

Note that all station coordinates are fixed with the "!" symbol, except for the unknown instrument station "P48" which is
free. The angles default to the standard error for angles set in the Project Options/Instrument options menu.

4. Run the adjustment.

Review the processing summary on the screen. Note that in the short statistical summary, the only observation type lis-
ted is the angle, and the adjustment passes the Chi Square test.

5. Look at the network graphically.

You will see only one error ellipse since there is only one unknown point in the whole network.

6. Review the listing file.

It’s quite short since our only observations are angles.

7. This completes the review of the "Resection" example project.
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Example 6: Traverse with Sideshots
This example illustrates data consisting of a simple traverse containingmany sideshots. Sideshots (SS) are single, non-redund-
ant shots that do not affect the adjustment results. You cannot occupy or backsight to a sideshot. These shots are diverted dur-
ing loading of the input data file, and are not processed until after the network is adjusted. Their computed coordinates are
written to both the Listing File and the Points File. Because they are processed after the adjustment, no error propagation is per-
formed on Sideshots. The special sideshot data type is available so that you can process a network containing hundreds or
thousands of sideshots without slowing down the adjustment of the actual network. In particular, this approach lends itself to
the processing of large topo data sets downloaded from data collectors.

#  Traverse with Sideshots

C   1   1000.00   1000.00 1440.28  ! ! !
C   2   1725.18   1274.36 1467.94  ! ! !

#  Begin Field Observations
#
TB  2
T   1      51-59-30  242.42   88-44-35   5.25/5.30
T   59    198-19-55  587.14   89-39-40   5.30/5.50 'IRON PIN
T   572   140-52-34  668.50   80-14-25   5.18/5.22
TE  828

#  Begin Sideshots
#
SS  1-2-3   104-18-07  146.08   90-56-54   5.25/5.33 'TOE
SS  1-2-4    24-33-33  118.64   89-16-07   5.25/5.33 'TOE
SS  1-2-5   339-20-11  254.12   88-03-45   5.25/5.33 'FACE OF CURB
SS  1-2-14  339-35-31  383.90   88-33-17   5.25/5.33 'TOE
etc...

1. Open the "Tutorial06-Sideshots.snproj" example project.

2. View the input data file. Note that the sideshots are entered with the "SS" code. Scroll down and view the entire file; the
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data includes quite a number of sideshots!  Most of the sideshots also have a text descriptor at the end of the line, which
is marked with a single or double quote character.

Remember that the sideshots are processed after the adjustment, and do not slow down the network processing. It is
also important to remember that since sideshots are not actually part of the "adjusted" network, and that you cannot
occupy a sideshot, or backsight to one. You cannot take a sideshot to the same point and expect that point to be adjus-
ted. In all these cases, you should enter your observations with an "M" data line which is included in the actual adjust-
ment.

For simplicity, sideshots in this example were all entered following the traverse. However they may be freely intermixed
with traverse data or any other types of data, to preserve the same order recorded in your field book or data collector.

3. Run the adjustment. The adjustment of the traverse proceeds very quickly, and the sideshots are processed inde-
pendently after the adjustment is completed.

Note that in this particular example, themain traverse is simply an open ended traverse that doesn't even tie into a
known station. So in this case, although all points are computed, nothing is really adjusted. This illustrates how
STAR*NET can be used simply as a data reduction tool. And had we been working in some grid coordinate system, for
example NAD83 or UTM, all the observations would have also been reduced to grid, producing adjusted grid coordin-
ates.

4. View the resulting network graphically - many sideshots fill the plot screen. Zoom into a small group of sideshots. Right-
click the plot screen to bring up theQuick Changemenu, and click the "Show Sideshot Descriptors" item to turn on view-
ing of descriptors. Descriptors often clutter up a plot view, so by default you will usually leave them turned off. You can
also turn sideshots off and on in the Quick Changemenu by unchecking and checking the "Show Sidehots" item.

5. Take a quick look at the adjustment listing file. Looking through the listing you will see a review of the input sideshot
observation data as well as final sideshot coordinates in the "Sideshot Coordinates Computed After Adjustment" sec-
tion. These computed sideshot coordinates, along with the traverse coordinates, also appear in the "points" output file
created during the processing. This file can be viewed by choosingOutput > Coordinates as illustrated in earlier
examples.

6. This completes the review of the "Sideshots" example project.
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Example 7: Preanalysis
This example demonstrates using STAR*NET in the preanalysis of survey networks. Preanalysis means that the network will
be solved using approximate coordinates to locate the stations, and a list of observation stations to indicate which distances
and angles are planned to be observed. No actual field data are required. STAR*NET will analyze the geometric strength of the
network using the approximate layout, and the instrument accuracies supplied as observation standard errors. The predicted
accuracy of each station will be computed, and error ellipses generated. Preanalysis is a powerful tool that will help you to test
various network configurations before any field work is done, or to test the effects of addingmeasurements to an existing net-
work.

You can use any of the 2D and 3D data types provided for in STAR*NET to define a proposed survey. In this simple 2D
example, we traverse around the perimeter, usemeasure lines to define some cross ties, and then fill in some angles.
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# Preanalysis

C    1        51160    52640  ! !
C    2        50935    52530
C    3        50630    53660
C    1001     51160    52950
C    1002     51145    53280
C    1003     50645    53265
C    1004     50915    53570
C    1005     50655    52770
C    1006     50945    52820
C    1007     50865    53160

B    1-2       ?   !
#B   1003-3    ?   5.0    # Uncomment this line to add another bearing

TB   2
T    1
T    1001
T    1002
T    1004
T    3
T    1003
T    1007
T    1006
T    1005
T    2
TE   1

M    1-2-1005
M    1-2-1006
M    1001-1-1006
M    1001-1-1007
M    1002-1001-1007
M    1002-1001-1003
M    1004-1002-1003
A    1003-1007-1002
A    1003-1007-1004
A    1007-1006-1001
A    1007-1006-1002
A    1006-1005-1
A    1006-1005-1001
A    1005-2-1
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1. Open the "Tutorial07-Preanalysis.snproj" example project. This is a "2D" project.

2. View the input data file. Note that all stations have been given approximate coordinates. This defines the network geo-
metry. Note also that the list of distance and angle data lines contains no field observations. Observation standard
errors default to the values set for the various data types in the Project Options/Instrument menu. If a specific standard
error is required, a place holder such as "?" is required on the data line in place of the actual observation.

3. Run the preanalysis by choosingRun > Preanalysis. Note that if you were tomake any other choice from the Run
Menu such as "Adjust Network" or "Data Check Only," errors would result due to themissing observations.

4. View the network graphically. Note that the resulting station error are larger for the stations furthest from the fixed sta-
tion. Also, their shape and orientation suggest an azimuth deficiency in the network. This is the purpose of running a
preanalysis, to study the strength of your planned survey network using only proposed field observations.

5. If you wish, you can experiment with adding another observation to the network. Open the Data Files dialog by choosing
Input > Data Files, or by pressing the Input Data Files tool button. Press the "Edit" button, or simply double-click the
highlighted data file in the list. Locate the line in the data file that has a Bearing from Station 1003 to Station 3. Uncom-
ment the line by deleting the "#" symbol at the beginning of the line, just before the "B" code. Note that this data line has
an explicitly entered standard error of 5 seconds. (This new data, for example, might represent an observed solar azi-
muth.) Save the file and exit from the text editor.

Now rerun the preanalysis by choosingRun > Preanalysis again. Review the new results graphically as described in
Step 4 above. Notice the increased positional confidence provided by the addition of the proposed bearing observation.
The ellipses wewere concerned with are now smaller andmore round. If you wish to see the actual ellipse dimensions,
double-click any point on the plot, or of course you can view the error ellipse information in the listing file as suggested
below.

6. Take a quick look through the listing. Even though no actual observations were provided as input, observation values
(angles and distances) will be shown in the listing. These values are inversed from the given coordinates and standard
errors are assigned to these proposed observations from the Project Options/Instrument menu settings. And of course,
station ellipses and relative ellipses are also shown, their computed values being themain purpose for making a preana-
lysis run.

7. This completes the review of the "Preanalysis" example project.
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Example 10: Differential Leveling Network
This example demonstrates running a stand-alone differential level network adjustment. A stand-alone "Lev" adjustment is
available in the STAR*NET-LEV edition plus the higher-end STAR*NET-PLUS and STAR*NET-PRO editions. Level obser-
vations can also be included in any 3D adjustment in the STAR*NET suite.

#  Simple Level Network with 4 Fixed Benchmarks

#  Fixed Elevations
E   TIDAL1     1.375  !   'NGS Ref 1
E   TIDAL2     2.165  !   'NGS Ref 2
E   BM75      23.768  !  
E   BM26      57.129  !   'Brass Cap 1939

# Leveling Observation Data
L   TIDAL1-129    12.345   20100
L   BM75-129     -10.023   25300
L   BM75-125      15.920   31200
L   129-130       22.130   37400 'Central
L   130-125        3.833   28100 'At Hyde
L   129-128       11.810   41700 
L   128-130       10.336   32100 
L   125-BM26      17.458   37500   
L   BM26-126       2.814   39200  
L   130-126       24.065   40900 
L   128-126       34.422   52200
L   126-127      -15.485   48100
L   128-127       18.95    45300
L   TIDAL2-127    42.321   17700

# To produce an optional plot diagram, 
# supply 2D coordinates at any scale.

.2D
C   TIDAL1  11.0  12.0 
C   TIDAL2   0.2  11.8 
C   BM26     5.4   2.6
C   BM75    12.2   6.4 
C   125      8.7   3.9 
C   126      3.3   4.3 
C   127      1.2   8.0  
C   128      4.0   9.6 
C   129      9.1   8.5 
C   130      6.1   6.7
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1. Open the "Tutorial10-LevNet.snproj" example project.

2. Open the Project Options for this job and review the "Adjustment" options page.
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Here the "Lev" adjustment type has been selected. This is a 1-D network adjustment requiring only elevations used as
benchmark restraints and differential leveling observations as input. The only other setting you will set on this dialog is
the default linear units of the input and output.

3. Review the "General" options page.

Again, only a few options settings are needed for a level network adjustment. There are no iterations required for this
kind of adjustment as the solution is linear. Why is there a "Coordinate Order" option for a level network? As illustrated
by the data, Northing and Easting coordinates may be optionally entered for each station if you want a schematic plot
generated for your level network. More on this later.

4. Review the "Instrument" options page.
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Here the default standard error for the leveling observations is set. Weighting for differential leveling can be defined by
section length or by the turns. For this example network, the elevation difference standard error for each observation will
be propagated by the program using 0.006 Feet per Mile section.

5. Also review the "Listing File" and "Other Files" options pages in the Project Options if you wish. A few options can be
set relating to output for a level network.

6. Examine the data file if you wish. You will note this simple network includes four fixed elevations and 14 leveling section
observation "L" lines. These two types of data lines are the only types required to perform an adjustment. Note however
that 2D coordinates have also been provided for all the stations in the network. These are optional and need be entered
only of you wish the program to create a schematic plot of the level network. Since these coordinates will only be used
to create this plot, the scale of the coordinates makes no difference. Coordinates entered in this example were simply
scaled off a sketch of the network drawn on grid paper.

7. Run the network adjustment.

8. Look at the network graphically. As mentioned above, this is only a schematic plot based on the relative 2D coordinates
entered. Although straight lines are shown between connections, in actual leveling networks these connections may
actually follow along roads, wander around hills, etc.
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While viewing the diagram, double-click any point to get a pop-up information box showing its adjusted elevation and
confidence region values. Double-click on other points and the information will refresh. Double-click on any line to show
its adjusted elevation difference and relative confidence values. The example pop-up box shows information generated
by double-clicking connection 129-128 on the plot diagram.

9. View the output listing and browse through the various sections as you did in previous examples. Go to the "Adjusted
Elevations and Error Propagation" section. Here adjusted elevations, standard deviations and confidence regions are all
shown for all stations. Horizontal coordinates, even though entered for the benefit of creating a plot diagram, are not
shown as they play no part in the adjustment.

Go to the "Adjusted Observations and Residuals" section. Here the adjusted level observations are shown along with
their residuals. Note the standard errors used in weighting the observations are all different because they are propagated
based on the length of the sections.
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10. This completes the "LevNet" example project, the last example in this tutorial.

You have now completed all of the sample projects in this TourWe hope that you now have a basic understanding of the oper-
ation of STAR*NET and how as a versatile tool it can be used not only to provide the best analysis and adjustments possible
but as a valuable aid to survey planning

We now encourage you to experiment with the Demonstration Program by rerunning some of the examples, or trying some of
your own data.

The next section, "Supplemental Information" provides extra details concerning editing your data and the format of data lines
shown in the examples.
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APPENDIX B: ADDITIONAL TECHNICAL INFORMATION
For reference, some general information and formulas used are listed here.

B.1 PROGRAM LIMITS
Limits for input data used in the program:

Number of stations in a network:

Lev, Standard, Plus, or Pro version = 10,000 stations (plus "SS" sideshot points);
Ultimate version = 65,000 stations (plus "SS" sideshot points);
Expired Demo = 0 stations

Length of an input data line: 500 characters
Length of station names: 15 characters
Length of station descriptors: 48 characters
Length of instrument library names: 15 characters

Limits for data in the StarNet.CUS linear units definitions file:

Length of a data line: 128 Characters
Length of a linear "units" name: 8 characters

Limits for data in the StarNet.FMT format definitions file:

Length of data line: 154 characters
Length of format style name: 22 characters
Length of format script definition: 128 characters

B.2 ERROR AND WARNING MESSAGES
Error and warningmessages published by STAR*NET are designed to help you diagnose errors detected in your data or prob-
lems found while adjusting. Most of thesemessages are written to the "PROJECT.ERR" file where "PROJECT" is the name
of your job. To view the errors, select Output > Errors, or press the Errors tool button.

Only a small portion of the possible error or warningmessages are shown here. Most of themessages such as "Input Data File
Does Not Exist", "Invalid File Name" or "Previous Traverse Set Not Properly Ended" need no further explanation and are not lis-
ted. Also, certain internal errors should never appear unless you have problems with your computer system, possibly disk or
memory problems. These also are not listed below.

If you get an error message or warning that is not listed below and you do not understand, please contact technical support at
MicroSurvey Software Inc. for assistance.

Errors
Below are a few commonly-seen error messages listed in alphabetical order. These are errors which cause an adjustment to ter-
minate andmust be corrected before you can successfully perform the adjustment.

Converting Coordinate Produced Invalid Latitude:

Converting Coordinate Produced Invalid Longitude:
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When running "grid" jobs, the program converts back and forth between grid coordinates and geographical positions (latitudes
and longitudes) using published geodetic formulas. If the conversion from coordinates to geographical positions generates cal-
culated values of latitude or longitude that are completely out of a reasonable range (i.e. latitudes greater than 90 degrees), this
error is posted and the processing is terminated.

One likely cause for this is that you have entered signs for longitudes inconsistent with the "longitude sign convention" set in
the Project Options/General Settings dialog. For example, if you have the convention set for positive west longitudes, but enter
a negative longitude in your data, this may cause geodetic formulas to fail.

Another causemight be that, because of typing errors, you entered a grid coordinate value in your data that is way off from
coordinate values consistent with the selected grid zone, or maybe they are entered in units different than units set for the pro-
ject.

Therefore if this error occurs, make sure the correct grid coordinate system has been selected, that signs of all input longitudes
values have been entered using the sign convention chosen for the project, and that all input coordinate values are correct for
your zone, and they are entered using correct units.

Could Not Compute Approximate Coordinates for Following Stations:

Could Not Compute Approximate Elevations for Following Stations:

Coordinates (or elevations in 3D adjustments) could not be automatically computed for the stations listed. Theremay not be
enough observational data to create them. For certain types of data configurations, youmay have to enter approximate coordin-
ates for some or all stations in the network. For example, a trilateration network needs fixed or approximate coordinates for all
stations. This error can also be caused by naming inconsistencies in the data. For example, if you name a point as "JOHN" in
one observation line, and "John" in another, this will cause problems.

Data Type Code Not Recognized

A data line begins with a data type code not recognized by the program.

2D/3D/3R Dimension Changed During Current Traverse

Mapmode Changed During Current Traverse

You cannot turn the inline ".MAPMODE" on or off within a traverse. Themodemay be changed before the "TB" line or after the
"TE" line.

Duplicate Names in AT, FROM, or TO Stations

All names in  AT-FROM-TO or FROM-TO station strings must be different.

Excess or Unrecognizable Input Data

A line of data contains more items than it should have for the specified data type, or a data item was encountered that
STAR*NET did not know how to interpret. For example, on a 2D Measure "M" line, the program expects two observations plus
either, two standard error values, or none. But in this case if only one such item was found, this error message would occur
because the data item is unrecognizable. This error will often occur if you forget to properly set whether a job is a 2D or 3D job
in the Adjustment Options, and you end up entering data of another dimension type the program cannot understand.

Fatal Floating Point Error While Processing Station

A math error, usually caused by a divide by zero, was encountered during processing. Although STAR*NET tries to trap all
such errors, sometimes the problem occurs. Check your data for any unusual situations to see if you can determine the prob-
lem. If you cannot, contact technical support at MicroSurvey Software Inc. for assistance.

Inline Option Code Not Recognized
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Inline Option Code Not Unique

An inline option code is either not one recognized by the program, or is abbreviated using too few letters such that it is not
unique.

Fewer Than 2 Directions in Current Direction Set

A direction set must contain two or more direction observations.

Geometric Weakness in Network

During the processing of the adjustment, the equations happened to be formed in such a way that the solution could not con-
tinue. Sometimes this is caused by the observation data. It could be due to extremely weak intersection angles or very large
standard error values on certain data lines, causing a geometric weakness and an inability to create a proper solution. Some-
times, controlling coordinates are entered with one or more north, east or elevations components having very minimal or no fix-
ity can cause the problem. Check your data for any unusual situations to see if you can determine the reason. If you cannot,
contact technical support at MicroSurvey Software Inc. for assistance. Wemay request a copy of your project be sent to us via
email.

Instrument Block Name Not Found

A block named using the ".INSTRUMENT" inline code is not defined in the instrument library. It has been either misspelled, or
has not been previously defined in the library.

Invalid Level Weight

Invalid Level Data

Bad information found on an ".LWEIGHT" inline option line which changes the current weighting value to use for differential lev-
eling data,  or on an "L" data line defining the leveling observation.

Measured/Grid Mode Changed During Current Traverse

You cannot change the data dimension using ".2D, .3D or .3R" inlines within a traverse. Likewise you cannot change "map-
mode" or whether observations are "measured: or "grid" values during a traverse.

Missing or Invalid Coordinate Value

Missing or Invalid Direction

Missing or Invalid Distance

Missing or Invalid Elevation Difference

Missing or Invalid GPS Vector

Missing or Invalid Horizontal Angle

Missing or Invalid Position Value

Missing or Invalid Station List

Missing or Invalid Zenith Angle

These errors and other "Missing or Invalid" messages not shown indicate an error has been found while trying to read one of the
types of data described in the error message. The actual data line is printed below the error message and an attempt is made to
show you exactly where the problem was encountered.
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Non-Determinant Solution - Check Network Design.
Degrees of Freedom are Less than Zero

There are not enough observations in your data to properly define the geometry of the network or to perform an adjustment. The
degrees of freedom (or number of redundant observations) must be zero or greater. See Chapter 8, "Analysis of Adjustment
Output", for a discussion of degrees of freedom.

Preanalysis Run has been Terminated
Coordinates for all stations must be entered prior to observation data
Coordinates were missing for station xxx

When running Preanalysis, all stations used in the observations must have coordinates (fixed or approximate) supplied in the
data file prior to the observation data.

Reassignment of Coordinate Values

You have entered "fixed" coordinates for a particular stationmore than once, and the coordinate values are not the same caus-
ing a conflict.

Slope Distance Not Allowed in 2D Adj Using 3D Mode

A single observation "D" line defining a 3D slope distance has been entered into a 2D adjustment. This kind of slope distance
cannot be reduced to 2D because there is not a zenith angle directly associated with it. This data linemust be either removed
from the data, or the slope distancemust be combined with a data line that includes a zenith angle.

Station Incorrectly Connected to Network: xxx

An adjustable station does not have enough observations taken to it to correctly connect it to the network. In a 2D adjustment a
station needs be connected by two horizontal observations. In a 3D adjustment a station needs to be connected by two hori-
zontal observations plus a vertical observation. If the elevation is fixed on the 3D station, it then needs only the horizontal
observations. Likewise, if its horizontal coordinates are fixed, only a vertical observation is required to correctly "connect" the
station.

Too Many Stations: Limit is #

An adjustment will be aborted if the applicable station limit is exceeded. With a valid Lev, Standard, Plus or Pro license the limit
is 10,000 stations; with a valid Ultimate or 10-day Demo license the limit is 65,000 stations. With an expired Demo license, the
limit is 0 stations and therefore no network adjustment can be performed.

Two Fixed Stations Have the Same 2D Coordinates: xxx yyy

An observation is found having its two ends defined by two fixed stations having the very same coordinate values. Coordinate
values for each end of an observationmust be different, even if by a small amount. Check your data andmake necessary cor-
rections. Also check to see why you have an observation between two fixed stations anyway. Entering observations between
fixed coordinates can cause problems!

Vertical Observations Not Allowed in 2D Data Mode

Single observation "V" data lines are not allowed within 2D data.

Warnings
All messages in this section are simply warnings or informational messages. They do not cause an adjustment to terminate.
Carefully review any warnings to determine whether any data revisions need bemade on not.

Duplicate Sideshot Name
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The program found a sideshot data line whose sideshot namewas previously used by a prior sideshot data line. Since sideshot
points are independently computed one by one after the adjustment has completed, it makes no difference what the names are
or whether they are repeated. However, for those wishing to keep all points unique in the resulting coordinate files, this mes-
sage offers a warning along with line numbers of the data lines having the repeated names.

Excessive Scale Factor

You have entered a scale factor greater than 1.10 or less than 0.90.

Inline SCALE Option Ignored in Grid Coordinate System

Inline SCALE Option Ignored when Reducing to Common Datum

You have entered an inline scale factor which is being ignored because the network is being run in a "grid" coordinate system
which calculates scale independently. Also when running in a "local" coordinate system, the inline scale factor line is ignored
when the you are reducing to a common elevation – only the elevations and earth radius is considered.

Network Has No Fixed XY Stations

Network Has No Fixed Z Stations

In a 2D or 3D adjustment, you should have at least one station that has fixed horizontal coordinates. In addition, in a 3D adjust-
ment, at least one station should have a fixed elevation. Partially fixed coordinates (i.e. those entered with standard deviations)
in a network will often provide the required amount of fixity to allow the network to successfully solve. Therefore this is only a
warning, not necessarily an error. However, be aware that if components of controlling coordinates have almost no fixity, or no
fixity, the adjustment may fail with a "Geometric Weakness"  or "Singularity" errors – see last section "Errors" for more details.

Network Station Name Reused as One of More Sideshot Stations: xxx

The program found amain network station data line whose station namewas used also by one or more sideshots. Since
sideshot points are independently computed one by one after the adjustment has completed, it makes no difference it sideshot
names are the same as main station names. However, for those wishing to keep all points unique in the resulting coordinate
files, this message offers a warning so that you can search out these sideshots and change their names if desired.

One or more points were found having ZERO elevation while running in
non-local coordinate system. This may cause erroneous scaling! Check
your entered elevations, or your project elevation if running 2D.

When running adjustments in "grid" systems, all stations should have real elevations or at least a real project elevation when
running in 2D. Check your elevations, or if running in 2D, check tomake sure your "project elevation" is not set to zero - unless
of course your project really is right at sea level.

Only One Fixed Station and No Orientation Constraint

If you have only one fixed station in the network, you should have at least one fixed  azimuth or bearing to provide orientation.
Sometimes a partially fixed bearing or azimuth (or a partially fixed station) will provide the orientation required to allow the net-
work to successfully solve. Therefore this is only a warning, not necessarily an error.

Only One Fixed XY Station and No Distances

If you have only one fixed station in the network, you need at least one fixed distance to provide scale. Sometimes a partially
fixed distance (or a partially fixed station) will provide the scale required to allow the network to successfully solve. Therefore
this is only a warning, not necessarily an error

Two Stations Have the Same 2D Estimated Coordinates
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An observation is found having its two ends defined by two stations that have the same approximate coordinates. STAR*NET
changes the coordinates on one slightly (as long as it is not fixed) and continues processing.

Vertical Observations Ignored in 2D Adj Using 3D Mode

Any single observation "V" line entered as 3D data is ignored in a 2D adjustment. Also any elevation difference data value
entered as 3D data on a "T", "M", "DM" or "DV" line is ignored in a 2D adjustment. Themessage is only published once upon
the first encounter of a data line having the ignored data. This is not an error, only a reminder that some data entered by you is
not being used for any purpose in the adjustment.

B.3 REFRACTION
The formula used in the STAR*NET to compute the internal refraction correction to zenith angles is shown in section 3.20,
page 264, "Geodesy," by G. Bomford, Oxford University Press, 1971. This formula states that:

Refraction Correction = Coefficient of Refraction * Central Angle

Where: Central Angle is the angle subtended by the observation line at the earth’s center.

When the program is first installed, a default coefficient value of 0.07 is initialized in the company options. This is considered
an average value that can be used for most average field conditions. However, in the publication, Bomford indicates in Table
1.1 on page 59 that coefficients may vary in extreme cases from "0.81" (about 10meters above bare plains, night, still and
clear) to "-0.10" (about 10meters above bare plains, midday, still and clear, probably with some heat mirage). In the latter case,
with a negative coefficient of refraction, the refraction path would bend toward the ground rather than upward.

B.4 DATUM SCHEMES FOR 2D AND 3D "LOCAL" JOBS
In the Adjustment Options for the project, when you set the coordinate system to "Local" (i.e. you are not running a grid job),
youmust choose a Datum Scheme as discussed in Chapter 4, "Options."  You can choose one of two schemes:

1. Apply an Average Scale Factor: Whatever "Average Scale Factor" you choose is applied to the horizontal com-
ponents of all distances and this becomes the basis for calculating the horizontal coordinates. Elevations of points are
not considered in this scheme. If your project varies greatly in elevation, and you want horizontal coordinates calculated
to a certain elevation (datum), it is up to you to change the scale factor of your job as needed using the ".SCALE" inline
option.

Youmight use this scheme in various parts for small, fairly flat projects. Entering a factor of 1.0 causes your coordin-
ates to be calculated right at the elevation of your observations. Users sometimes choose this scheme to simulate a
grid adjustment by entering a grid factor that is known for the project area.

Even though this datum scheme doesn’t consider elevations, it is still important to enter a realistic "Avg. Project Elev-
ation" for 2D jobs so that any entered 3D slope distances will be properly reduced to horizontal using curved-earth geo-
metry!

2. Reduce to a Common Elevation: Using this scheme, elevations of stations in the project are considered. Using
curved-earth geometry (given earth radius with the divergence of verticals) plus elevations of the instrument and target
points, horizontal distance components are factored up or down to a common elevation. One often-used reduction to a
common datum is the reduction to Sea Level. For this you would enter 0.0 as your "Reduce to Common Elevation"
value.  However, you can enter any elevation, one above, below or right at your project.

You would normally use this scheme for projects containing stations that vary considerably in elevation. This allows you
to choose a consistent elevation datum at which all horizontal coordinates will be created whether it be sea level, an
average project elevation or some other desired elevation.
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Using the "Reduce to a Common Elevation" datum scheme, the factor applied to the horizontal component of a distance
observation is computed by:

Factor  = (R + Common Elevation) / (R + (ElevA + ElevB) / 2)

Where:

R is the given earth radius value
Common Elevation is the given (desired) elevation datum
ElevA + ElevBare the elevations at the ends of the distance observation

Whichever datum scheme you choose, always enter horizontal "controlling" coordinates at the datum you selected. For
example, if you choose to reduce to a "Sea Level" elevation during an adjustment, and you enter some fixed controlling coordin-
ates, these coordinates must be sea level coordinates, not coordinates at your project elevation!

B.5 INSTRUMENT AND TARGET CENTERING ERRORS
Centering Error values entered in the Instrument Options, cause standard errors for turned angles, distances, directions, delta
elevations, and zenith angles to be inflated.

In all following formulas:

I = Horizontal Instrument Centering Error
T =Horizontal Target Centering Error
V =Vertical Centering Error at Instrument and at Target

As described below, the standard error of horizontal turned angles, directions, azimuths and horizontal distances are affected
only by horizontal centering. The standard error of delta elevations are affected only by vertical centering.

Horizontal Turned Angles: The standard error contribution for an angle due to the horizontal centering error of the instrument
is equal to:

Inst StdErr = d3/(d1*d2) * I

Where:
d1 and d2 are the horizontal distances to the targets
d3 is the horizontal distance between the two targets

The standard error contribution for an angle due to the horizontal centering error of both targets is equal to the following:

Target StdErr (Both) = Sqrt(d12+d22) / (d1*d2) * T

Combining the entered standard error for an angle with the standard error contributons from the instrument and target centering,
we get the total standard error for an angle:

Total Angle Std Err = Sqrt( AngStdErr2+ InstStdErr2+ TargetStdErr2 )

Directions: Total standard error, where "d" is the horizontal distance, is equal to:

Total Dir StdErr = Sqrt( DirStdErr2 + I2/d2 + T2/ d2 )

Where:
d is the horizontal distance to the target

Azimuths: Same as directions, but using azimuth standard error the in the formula.

Horizontal Distances: Total standard error is equal to:
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Total Dist StdErr = Sqrt( DistStdErr2+ I2+ T2 )

Delta Elevations: Total standard error is equal to:

Total DeltaElev StdErr = Sqrt( DeltaElevStdErr2 + V2 + V2 )

Since slope distances and zenith angles are both “sloped” observations, their total standard errors are each inflated by both hori-
zontal and vertical centering errors.

In the following formulas:

d = Horizontal distance from instrument to target
s = Slope distance from instrument to target
e = Elevation difference from instrument to target

Slope Distances: The total standard error is equal to:

Total Dist StdErr = Sqrt( DistStdErr2+ (d/s)2 * (I2+ T2) + 2*(e/s)2 * V2 )

Zenith Angles: The total standard error is equal to:

Total Zenith StdErr = Sqrt( ZenithStdErr2 + (e/s)2 * (I2+ T2) + 2*(d/s)2 * V2 )

Notes:

1. The calculations for angle and direction centering error in the formulas shown on this page and the previous page are car-
ried out in radians.

2. In any formula shown above for a linear observation (slope distance, horizontal distance or delta elevation), the resulting
"total" standard error is calculated from the  entered standard error of the observation plus any given centering errors. It
should be noted that the "entered standard error" for any linear observation is made up of a constant part and PPM. See
the discussion of the PPM (Parts per Million) settings starting in Chapter 4, "Options."

3. When standard errors are explicitly entered on an observation data line, these values are by default used as the "total"
standard error value that will be used during the network adjustment. They will not be inflated by centering error.

If there are situations where you would like explicitly entered standard errors to be inflated by entered centering errors,
you can use the ".ADDCENTERING" inline option as described in Chapter 5, "Preparing Data."

4. Centering errors are not applied to differentially leveled elevation differences.

B.6 REFERENCES
The following list of referencematerials is provided for STAR*NET users who wish to study the practical and theoretical
aspects of survey adjustments in more detail.

1. Wolf, Paul R., andGhilani, Charles D., Adjustment Computations, Statistics and Least Squares in Surveying andGIS,
JohnWiley & Sons, Inc., New York, 1997.

An excellent discussion of the theory of survey errors and the use of least squares adjustments of survey networks. A
valuable addition to your library.

2. Buckner, R.B., SurveyingMeasurements and Their Analysis, Landmark Enterprises, Rancho Cordova, California,
1984.
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An important reference text for the student and professional introducing the theory of measurements, instrument use,
propagation of errors in observations, andmuchmore. This easy-to-read book will develop your appreciation of meas-
urements as an art and a science, and it is highly recommended.

3. Anderson, J.M., andMikhail, E.M., Introduction to Surveying, McGraw-Hill, New York, 1985.

This text provides a good introduction to surveying practice. Mathematical concepts are kept as simple as possible, but
the book still treats them rigorously. Survey adjustments and error propagation are not covered in depth.

4. Davis, R.E., Foote, F.S., Anderson, J.M, andMikhail, E.M., Surveying - Theory and Practice, McGraw-Hill, New York,
1981.

The basic mathematical theory of STAR*NET is based on the appendices in this text, although three-dimensional adjust-
ment theory is not developed in the book. The text provides a detailed and rigorous treatment of surveying andmapping.
Several chapters and appendices are devoted to survey adjustment, error propagation, and statistical analysis. This
book is recommended for those requiring an in-depth theoretical and practical treatment of surveying andmapping.

5. Mikhail, E.M., andGracie, G., Analysis and Adjustment of Survey Measurements, Van Nostrand Reinhold Company,
1981.

This book introduces the basic concepts of obtaining and adjusting survey measurements. It is systematic, rigorous,
and practical in its approach. It covers the basics of Least Squares Adjustment and statistical analysis, with many
example problems. It uses matrix algebra throughout, and is recommended for those STAR*NET users requiring a solid
introduction to survey adjustment.

6. Observations and Least Squares, IEP, New York, 1976.

This text provides a complete development of Least Squares analysis techniques. It concentrates on Least Squares
Adjustments, error propagation, and statistical analysis. It is theoretical in orientation, but does include some solved
problems.

7. Richardus, P., Project Surveying, North-Holland Publishing Company, Amsterdam, 1966.

Yet another treatment of survey adjustments and optimization, with more of an emphasis on engineering applications.

8. Krakiwsky, E.J, ed., Papers for the CISM Adjustment and Analysis Seminars, Canadian Institute of Surveying andMap-
ping, Ottawa, 1987.

A useful collection of papers covering adjustment theory at an elementary and an advanced level.

9. Press, W.H., Flannery, B.P., Teukolsky, S.A., and Vetterling, W.T., Numerical Recipes - The Art of Scientific Com-
puting, Cambridge University Press, Cambridge, 1986.

This work is a valuable reference book on the art of scientific computing. It contains algorithms for matrix manipulations,
statistical tests, eigenvector determination, etc.

0.1 THIRD-PARTY NOTICES
The following notices apply to specific third-party software components used within MicroSurvey STAR*NET. All copyrights,
permissions, disclaimers, warranties, etc apply only to the applicable third-party component and not to MicroSurvey
STAR*NET in its entirety. For more information please contact MicroSurvey Software Inc..

Scintilla
License for Scintilla and SciTE



MicroSurvey STAR*NET ReferenceManual

- 242 -

Copyright 1998-2002 by Neil Hodgson <neilh@scintilla.org>

All Rights Reserved

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission
notice appear in supporting documentation.

NEIL HODGSON DISCLAIMS ALLWARRANTIES WITH REGARD TOTHIS SOFTWARE, INCLUDINGALL IMPLIED
WARRANTIES OFMERCHANTABILITY AND FITNESS, IN NOEVENT SHALLNEIL HODGSON BE LIABLE FOR ANY
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGESWHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER
TORTIOUS ACTION, ARISINGOUTOFOR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.
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